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Anotācija 

Anotācija gala ziņojumam “Pētījums Eiropas Savienības fondu 2021. -2027. gada plānošanas 
perioda ieguldījumu priekšnosacījumu izpildei” 

 

Pētījuma mērķis, uzdevumi un galvenie rezultāti 
latviešu valodā 

The objective, tasks and the main results of the 
research 

Pētījuma mērķis ir izpētīt elektronisko sakaru tīklu 
infrastruktūras un elektronisko sakaru pakalpojumu 
kvalitātes atbilstību Savienojamības paziņojuma  
mērķiem, sagatavojot esošās un plānotās platjoslas 
piekļuves pakalpojumu pieejamības un infrastruktūras 
kartējumu un, veicot analīzi par piemērotāko intervences 
modeli, izstrādāt datos balstītu pamatojumu platjoslas 
valsts atbalsta politikas plānošanai. 

Pētījumā apkopota informācija par elektronisko sakaru 
komersantu ļoti augstas veiktspējas VHCN tīklu (kur 
iespējams nodrošināt platjoslas piekļuves pakalpojumus 
ar datu pārraides ātrumu vismaz 100 Mbit/s) attīstības 
plāniem turpmākajiem 3 gadiem, kas ietver informāciju 
par plānotajiem elektronisko sakaru pakalpojumiem 
tehnoloģiskajā (piemēram, izmantojot optisko tīklu, 4. vai 
5.paaudzes mobilo sakaru tīklu) un teritoriālajā griezumā 

Sagatavots esošās un plānotās platjoslas piekļuves 
infrastruktūras un pakalpojumu pieejamības un 
kvalitātes kartējums. Veikta analīze par piemērotāko 
intervences modeli, kas balstīts uz platjoslas valsts 
atbalsta politikas plānošanu. 

Informācija tiks izmantota platjoslas politikas plānošanai 
2021. – 2027.g. plānošanas periodā, tostarp, Platjoslas 
elektronisko sakaru tīklu attīstības plāna 2021.-
2027.gadam izstrādei. 

The research aims to examine the compliance of the quality 
of electronic communications network infrastructure and 
electronic communications services to the objectives of the 
European Interoperability Framework by preparing existing 
and planned broadband access and infrastructure mapping 
and developing an evidence-based basis for broadband 
state financial aid policy analysis by analysing the most 
appropriate intervention model. 

The study summarizes information on the development 
plans of very high-performance VHCN networks of 
electronic communications merchants (where it is possible 
to provide broadband access services with a data 
transmission speed of at least 100 Mbit/s) for the next 3 
years, which includes information on planned electronic 
communications services in technological (e.g. optical 
network, 4th or 5th generation mobile networks) and 
geographical aspects. 

A mapping of the availability and quality of existing and 
planned broadband access infrastructure and services has 
been prepared. An analysis of the most appropriate 
intervention model based on broadband state financial aid 
policy planning has been performed. 

The information will be used for broadband policy planning 
in years 2021 - 2027 in the planning period, including the 
development of the Development Plan for the Broadband 
Electronic Communications Network for years 2021 - 2027. 

Galvenās pētījumā aplūkotās tēmas: 

Elektronisko sakaru tīklu infrastruktūra, elektronisko 
sakaru pakalpojumi un augstas veiktspējas VHCN tīklu 
attīstība 

The major topics of the research: 

Electronic communications network infrastructure, 
electronic communications services, and the development 
of high-performance VHCN networks. 

Pētījuma pasūtītājs: 

Latvijas Republikas Satiksmes ministrija 

Customer: 

Ministry of Transport of the Republic of Latvia 

Pētījuma īstenotājs: 

PricewaterhouseCoopers SIA 
Reģistrācijas numurs: 40003142793 
Juridiskā adrese: Rīga, Krišjāņa Valdemāra iela 21 - 
21, LV-1010 

SIA CSE COE 
Reģistrācijas numurs: 40103995402 
Juridiskā adrese: Rīga, Elizabetes iela 22 - 30, LV-1050 

The research conductor: 

PricewaterhouseCoopers SIA 
Registration number: 40003142793 
Legal address: Rīga, Krišjāņa Valdemāra iela 21 - 21, LV-
1010 

SIA CSE COE 
Registration number: 40103995402 
Legal address: Rīga, Elizabetes iela 22 - 30, LV-1050 
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Pētījuma īstenošanas gads: 

2020. gads 

Research implementation period: 

The year 2020 

Pētījuma finansēšanas summa un finansēšanas 
avots: 

34 800.00 EUR + PVN 
Iepirkums tiek finansēts Eiropas Sociālā fonda 
tehniskās palīdzības projekta “Tehniskā palīdzība 
Satiksmes ministrijai Eiropas Savienības fondu 2021.-
2027.gada plānošanas perioda ieguldījumu 
priekšnosacījumu izpildei” Nr.10.1.3.0/19/TP/003 
ietvaros 

Amount and source of research financing: 

 
EUR 34 800.00 + VAT 
The procurement is financed within the framework of the 
European Social Fund technical assistance project 
“Technical Assistance to the Ministry of Transport for the 
Fulfilment of Investment Preconditions of the European 
Union Funds for the 2021 - 2027 Planning Period” 
No.10.1.3.0/19/TP/003 

Pētījuma klasifikācija: 

Kompleksi analītiski pētījumi un izstrādes – pētījumi, ko 
veic, lai nodrošinātu starpnozaru sociāli ekonomisko 
procesu analīzi, izzinātu valsts (tajā skaitā nozaru vai 
teritoriju) ilgtspējīgas attīstības un globālās 
konkurētspējas tendences, izaicinājumus un iespējas. 

Research classification: 

Complex analytical research and development - research 
carried out to provide analysis of cross-sectoral socio-
economic processes, to find out the tendencies, 
challenges, and opportunities of sustainable development 
and global competitiveness of the country (including 
sectors or territories). 

Politikas joma, nozare: 

Infrastruktūra, elektroniskie sakari 

Policy field, branch: 

Infrastructure, electronic communications 

Pētījuma ģeogrāfiskais aptvērums: 

Visa Latvija 

Geographic scope of the research: 

The entire Latvia 

Pētījuma mērķa grupa/-as: 

Elektronisko sakaru politikas plānotāji un īstenotāji, kas 
izstrādā politikas plānošanas dokumentus, normatīvo 
aktu projektus un īsteno elektronisko sakaru politiku 
Latvijā. 

Research target group/-s: 

Electronic communications policy planners and 
implementers who develop policy planning documents, 
draft regulatory enactments, and implement electronic 
communications policy in Latvia. 

Pētījumā izmantotās metodes pēc informācijas 
ieguves veida: 

Methods applied in the research by information 
gathering: 

x 
1) tiesību aktu vai politikas plānošanas 
dokumentu analīze 

1) analysis of legislation or policy planning documents  

x 2) statistikas datu analīze 2) statistical data analysis 

x 3) esošo pētījumu datu sekundārā analīze 3) secondary analysis of existing research data 

x 
4) padziļināto/ekspertu interviju veikšana un 
analīze 

4) in-depth/expert’s interviews and analysis 

 5) fokusa grupu diskusiju veikšana un analīze 5) holding of focus groups discussions and analysis 

 6) gadījumu izpēte 6) case studies 

x 
7) kvantitatīvās aptaujas veikšana un datu 
analīze 

7) quantitative survey and data analysis 

 8) citas metodes (norādīt, kādas) 8) other methods (indicate, which ones) 

Kvantitatīvās pētījuma metodes 
(ja attiecināms): 

Quantitative research methods 
(if applicable): 

 1) aptaujas izlases metode 1) selective survey method 

 
2) aptaujāto/anketēto respondentu/vienību 
skaits 

2) number of surveyed/questioned respondents/units 
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Kvalitatīvās pētījuma metodes 
(ja attiecināms): 

Qualitative survey methods 
(if applicable): 

 
1) padziļināto/ekspertu interviju skaits (ja 
attiecināms) 

1) number of in-depth/expert’s interviews (if applicable) 

 
2) fokusa grupu diskusiju skaits (ja 
attiecināms) 

2) number of focus group discussions (if applicable) 

Izmantotās analīzes grupas (griezumi) Analysis groups used (cross-cuts) 

Pētījuma pasūtītāja kontaktinformācija 

Latvijas Republikas Satiksmes ministrija 
Rīga, Gogoļa iela 3, LV-1743, Latvija 

Customer contacts 

Ministry of Transport of the Republic of Latvia 
Rīga, Gogoļa iela 3, LV-1743, Latvija 

Pētījuma autori (autortiesību subjekti) 

PricewaterhouseCoopers SIA 
Reģistrācijas numurs: 40003142793 
Juridiskā adrese: Rīga, Krišjāņa Valdemāra iela 21 - 
21, LV-1010 

SIA CSE COE 
Reģistrācijas numurs: 40103995402 
Juridiskā adrese: Rīga, Elizabetes iela 22 - 30, LV-1050 

Authors of the research 

PricewaterhouseCoopers SIA 
Registration number: 40003142793 
Legal address: Rīga, Krišjāņa Valdemāra iela 21 - 21, LV-
1010 

SIA CSE COE 
Registration number: 40103995402 
Legal address: Rīga, Elizabetes iela 22 - 30, LV-1050 
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Kopsavilkums 

1. Interneta piekļuves pakalpojumi fiksētās vietās 

Projekta ietvaros tika anketēti elektronisko sakaru komersanti ar mērķi iegūt detālus datus par šobrīd 
esošajiem nodrošinātajiem pakalpojumiem un par nākamo trīs gadu laikā plānotajiem pakalpojumiem. 
Uz aptaujas anketu atbildēja 24 komersanti jeb 15.6% no tiem 153 komersantiem, kas, atbilstoši SPRK 
datiem, sniedz interneta piekļuves pakalpojumus gala lietotājiem stacionārā vietā un kam tika nosūtīts 
uzaicinājums piedalīties aptaujā. Lielākā daļa norādīja, ka datus nevar sniegt, minot dažādus iemeslus 
(nav pienākuma to darīt, nav resursu, komercnoslēpums, personas datu aizsardzība vai pakalpojumus 
gala lietotājiem vairs nesniedz vai tuvākajā laikā pārtrauks to darīt, pakalpojumi, izmantojot mobilos 
tīklus, nav piesaistīti konkrētai pakalpojumu saņemšanas vietai u.c.).  

Lai arī respondentu atsaucības līmenis bija zems, savus datus iesniedza lielākie interneta pieslēgumu 
nodrošinātāji fiksētā vietā – Tet, Baltcom un Balticom, kas kopā apkalpo apmēram 89% interneta 
pieslēgumu gala lietotājiem. Tāpat savus datus par pakalpojumiem fiksētā vietā iesniedza LMT, SIA 
IT S un SIA “OTTV”. 

Turpmāk, lai iegūtu pilnu pārskatu par pieejamajiem interneta piekļuves pakalpojumiem valstī, iesakām 
Satiksmes ministrijai izvērtēt iespējas iekļaut normatīvajos aktos noteikumu, ka elektronisko sakaru 
komersantiem ir pienākums pēc pieprasījuma sniegt valsts iestādēm pilnu informāciju par to 
nodrošinātajiem interneta pieslēgumiem gala lietotājiem līdz pieslēguma adreses līmenim. 
 
 
2. Mobilās interneta piekļuves pakalpojumi 

Projekta ietvaros visiem 3 mobilajiem sakaru operatoriem, kas sniegto pakalpojumu ietvaros nodrošina 
arī interneta pieejas pakalpojumu, tika nosūtītas anketas par mobilo sakaru tīklu bāzes stacijām, kas 
tiek izmantotas mobilās interneta piekļuves pakalpojumu sniegšanai. Datus par bāzes staciju 
atrašanās vietām un izmantotām tehnoloģijām iesniedza LMT un Tele2 (tikai par daļu no savām bāzes 
stacijām). Papildus informācija par visu operatoru mobilo sakaru tīklu bāzes stacijām tika iegūta no 
VAS “Elektroniskie sakari”. VAS “Elektroniskie sakari” sniegtie dati iekļauj informāciju par kopumā 7937 
bāzes stacijām, kas izvietotas 3341 dažādās vietās. 
 
 
3. Ļoti augstas veiktspējas VHCN tīklu attīstības plāni 

Gan fiksēto sakaru operatoriem, gan mobilo sakaru operatoriem, tika nosūtītas arī speciālas anketas 
par ļoti augstas veiktspējas VHCN tīklu attīstības plāniem turpmākajiem 3 gadiem. Atbilde tika saņemta 
tikai no Tet.  
 
Tet iesniegtajā sarakstā 119 teritorijām - valsts novadiem un pilsētām - norādīts pieslēgumu skaits, kur 
Tet ir ieinteresēts nodrošināt optisko tīklu. Kopā tie ir 366 706 pieslēgumi, kas ietver 222 884 
patreizējos Tet nodrošinātos pieslēgumus, kur nav optiskā tīkla. Visām teritorijām ir norādīts, ka tīklu 
attīstībai Tet ir interese izmantot valsts atbalsta instrumentus. Nepieciešamību pēc tiem Tet pārstāvji 
apstiprināja arī intervijās. 
 
Mobilo sakaru operatori intervijās norādīja, ka viņu VHCN tīklu attīstības plāni ir saistīti ar 5G tīklu 
izvēršanu. Konkrētu informāciju par to komersanti nesniedza, atsaucoties uz komercnoslēpumu un 
neskaidru normatīvi bāzi un praksi attiecībā uz kopēji lietojamas 5G infrastruktūras izbūvi. 
 
4. Esošie sociālekonomiskie virzītājspēki pašvaldībās 

Projekta ietvaros tika veikta pašvaldību aptauja, kuras ietvaros ietvaros tika nosūtītas anketas 119 
pašvaldībām (110 novadiem un 9 republikas pilsētām), atbildes saņemtas no 93 respondentiem.  
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Anketēšanas mērķis bija uzzināt pašvaldību viedokli par interneta pieejamību pašvaldībā dažādām 
lietotāju grupām sadalījumā pa sociālekonomiskajiem virzītājspēkiem, kā arī par to, kādiem 
sociālekonomiskie virzītājspēkiem prioritāri būtu jānodrošina ātrgaitas interneta pakalpojumi. 

Kopsavilkuma tabula ar esošās situācijas analīzi no pašvaldību darbinieku skatu punkta: 
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Nav pieejams 2 1 2 2 2 3 7 2 

Pamata platjosla 
(ātrums no 
144kb/s līdz 30 
Mb/s) 

38 46 54 53 29 30 29 45 

Ātra platjosla 
(ātrums no 30 līdz 
100 Mb/s) 

40 28 25 25 43 15 5 13 

Īpaši ātra platjosla 
(ātrums virs 100 
Mb/s) 

5 5 3 4 6 4 3 4 

Nepieciešami 
uzlabojumi 

6 5 7 7 7 13 13 16 

Grūti pateikt 2 8 2 2 6 28 36 13 

 

Aptaujas rezultātā pašvaldības norādīja, ka augstākā prioritāte ātrgaitas interneta pakalpojumu 
pieejamībai jānosaka izglītības iestādēs un zinātnes institūcijās, veselības aprūpes iestādēs, valsts un 
pašvaldību iestādēs. Vidējā prioritāte aprēķināta matemātiski, ņemot vērā pašvaldību vērtējumu par 
katra no sociālekonomiskajiem virzītājspēkiem prioritāti. Detalizēta informācija ir iekļauta tabulā zemāk. 

 
Vidējā prioritāte Vieta 

Izglītības iestādes un zinātniskās institūcijas 2.34 1 

Ārstniecības iestādes 3.76 2 

Valsts un pašvaldību iestādes 3.95 3 

Uzņēmējdarbība 4.14 4 

Bibliotēkas 4.45 5 

Kultūras iestādes un sabiedriskie centri 5.35 6 

Tūrisms 5.86 7 

Transporta infrastruktūra un transporta mezgli 6.23 8 

 
5. ĢIS datubāze un analīzes rezultāti 

No pētījuma ietvaros saņemtajiem datiem un publiski pieejamiem datiem izveidota ĢIS datubāze. 
Visiem ģeotelpiskajiem datiem vektoru datu formātā izmantota Merkatora transversālās projekcijas 
plaknes koordinātas LKS-92 TM. Visi aprēķini, izmantojot Q-GIS analīzes rīkus, veikti divdimensiju 
telpā, neizmantojot augstuma elementus. Visi izveidotie ĢIS datubāzes datu slāņi saglabāti ESRI 
Shape datu formātā, ko var aplūkot un rediģēt ar Q-GIS programmatūru. ĢIS datubāze tiek nodota kā 
atsevišķs ziņojuma pielikums (saarhivēti dati ZIP datu formātā). ĢIS datubāze izmantota analītiskiem 
pētījumiem. 
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Projekta ietvaros, izmantojot Q-GIS analīzes rīkus, tika izveidoti dažādi analītiski datu slāņi. Būtiskākie 
no tiem, ir šādi: 

• mobilo sakaru teorētiskais pārklājums;  

• fiksēto sakaru pieslēgumi, tajā skatā pieslēgumi ar piekļuvi optikai; 

• baltās teritorijas (netiek garantēts vismaz 30Mbps piekļuves ātrums); 

• VHCN balstās teritorijas (netiek garantēts vismaz 100Mbps piekļuves ātrums);  

• iespējamie jaunie mobilo sakaru torņi, lai nodrošinātu mobilo sakaru pārklājumu potenciālajās 
baltajās teritorijās; 

• iedzīvotāju skaita prognoze, 

• uzņēmumu iespējamās atrašanās vietas. 

 
Par baltām teritorijām atbilstoši ES pamatnostādnēm valsts atbalsta noteikumu piemērošanai attiecībā 
uz platjoslas tīklu ātru izvēršanu tiek uzskatītas tādas teritorijas, kurās nākamās paaudzes piekļuves 
tīklu pašlaik nav un kurās tuvāko triju gadu laikā tie netiks ierīkoti. Projekta ietvaros tika analizētas 
teritorijas, kurās nav mobilo sakaru pārklājuma un kurās šobrīd nav arī fiksēto pieslēgumu ar piekļuvi 
optikai. Šādi nosacījumi ir līdzvērtīgi balto teritoriju definīcijai, kurās netiek garantēts vismaz 
30Mbps piekļuves ātrums. Projektā tika konstatēts, ka fiksēto sakaru pieslēgumi, kuriem ir piekļuve 
optikai, atrodas tikai mobilo sakaru teorētiskajā pārklājumā. Līdz ar to par baltajām teritorijām (netiek 
garantēts vismaz 30Mbps piekļuves ātrums) var uzskatīt tās Latvijas valsts teritorijas daļas, kurās nav 
mobilo sakaru pārklājuma. No ĢIS sākotnējā analīzes rezultāta manuāli tika izņemtas teritorijas, kuras 
pēc platības bija mazākas par 20 ha un kurās nebija neviena deklarētā dzīves vieta (deklarēto dzīves 
vietu skaits noteikts, izmantojot pēc SM pasūtījuma CSP sagatavotos datus par iedzīvotāju skaitu 
2019.gadā 100x100m režģī). Dati uzrāda, ka šādi identificētās baltās teritorijas aizņem 10 106km2 lielu 
teritoriju jeb 15.65% no visas Latvijas valsts teritorijas. Šajās teritorijās dzīves vietas deklarētas 43.3 
tūkstošiem iedzīvotāju. Tāpat šajās teritorijās ir identificētas 5 izglītības iestādes (skolas) un 32 kultūras 
objekti (bibliotēkas). 
 

Attēls 1. Karte ar potenciālām baltajām teritorijām 

 
Avots: PwC un CSE COE pētījums. 
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Attiecīgi, izmantojot Open Street Map un LĢIA Vietvārdu datubāzē pieejamos datus par apdzīvotām 
vietām un potenciālo balto teritoriju robežas, tika izveidots potenciāli baltajās teritorijās esošo ciemu 
saraksts. 
 
Lai sniegtu platjoslas datu pārraides pakalpojumus baltajās teritorijās, kā viens no scenārijiem projektā 
tika izskatīta iespēja būvēt jaunus mobilo sakaru torņus. Tika pieņemts, ka jaunajiem mobilo sakaru 
torņiem vidēji pārklājuma sektors ir riņķis ar rādiusu 4 km. Jauno mobilo sakaru torņu iespējamais 
izvietojums tika noteikts manuāli, analizējot CSP sagatavotos datus par 2019.gada iedzīvotāju skaitu 
100x100m režģa šūnās, lai jaunie mobilo sakaru torņi aptvertu pēc iespējas vairāk iedzīvotāju. 
Pavisam šādi tika sagatavoti dati par 200 mobilo sakaru torņiem, kas ļautu sniegt mobilo sakaru 
pakalpojumus apmēram 19.7 tūkstošiem iedzīvotāju baltajās teritorijās. 
 

Attēls 2. Jaunie mobilo sakaru torņi baltajās teritorijās 

 
Avots: PwC un CSE COE pētījums. 

 
Projekta ietvaros tika analītiski noteiktas arī baltās teritorijas, kurās šobrīd nav pieejams platjoslas 
pakalpojums ar piekļuves ātrumu vismaz 100 Mbps (VHCN baltās teritorijas). Tika pieņemts, ka 
šādu simetrisku piekļuves ātrumu šobrīd var nodrošināt tikai fiksēto sakaru pieslēgumu punkti ar 
piekļuvi platjoslas optikai. Lai noteiktu šādas VHCN baltās teritorijas, tika meklētas teritorijas, kurās 
nav fiksēto sakaru pieslēgumu punktu ar piekļuvi platjoslas optikai. Šiem aprēķiniem izmantots CSP 
1x1 km režģa šūnu datu slānis (skatīt attēlu tālāk tekstā).  
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Attēls 3.VHCN Baltās teritorijas 

 

Avots: PwC un CSE COE pētījums. 

 
6. Pieejas scenāriji valsts intervences noteikšanas principiem VHCN tīklu izvēršanā 

Scenāriju izstrāde balstīta uz Rokasgrāmatā par ieguldījumiem ātrdarbīgu platjoslas sakaru tīklu 
attīstībā1 noteiktajiem izveides modeļiem, intervijām ar lielākajiem interneta pieejas pakalpojumu 
nodrošinātājiem, piemēram, Tet, LMT, TELE2; nozares asociācijām, piemēram, Latvijas interneta 
asociācija un vidējās jūdzes infrastruktūras nodrošinātāju LVRTC. 

Projekta ietvaros izvērtēto scenāriju mērķis ir uzlabot interneta pieejamību baltajās teritorijās. Interneta 
pieejamība var tikt nodrošināta, izmantojot mobilo operatoru pakalpojumus (mobilais internets) vai 
optiskā kabeļa pieslēgumu, tādēļ katram no piedāvātajiem scenārijiem norādīts, kāda veida interneta 
pieejamība tiks uzlabota. Analizējot scenārijus, jāņem vērā, ka mobilā interneta pieejamība un kvalitāte 
ir atkarīga no vienlaicīgo lietotāju skaita un, ja jānodrošina garantēts ātrums valstij svarīgu funkciju 
nodrošināšanai, piemēram VUGD vajadzībām, tīklā jāveido virtuāls apakštīkls. 
 
Iespējamo attīstības scenāriju apkopojums sniegts tabulā (skatīt tabulu tālāk tekstā). 

Tabula 1. Iespējamie attīstības scenāriji 

Parametri 1. scenārijs:  
Publiski pārvaldīta 
tīkla modelis – 
vidējā jūdze 

2. scenārijs: 
Publiski pārvaldīta 
tīkla modelis – 
pēdējā jūdze 

3. scenārijs: 
Privāti pārvaldīta 
tīkla modelis 

4. scenārijs: 
Operatora 
subsidēšanas 
modelis 

Plānotās 
investīcijas 
apraksts 

Investīcijas esošās 
vidējās jūdzes 
infrastruktūras 
savienošanā ar 
mobilo sakaru 

Investīcijas optiskā 
tīkla izveidei pēdējā 
jūdzē, izmantojot 
esošo vidējās jūdzes 
infrastruktūru.   

Konkursa kārtībā 
izvēlēts privātais 
operators plāno un 
nodrošina interneta 
pakalpojumu 

Investīcijas 
optiskā tīkla 
izveidē un 
paplašināšanā  

                                                
1 https://ec.europa.eu/newsroom/dae/document.cfm?doc_id=12891 
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Parametri 1. scenārijs:  
Publiski pārvaldīta 
tīkla modelis – 
vidējā jūdze 

2. scenārijs: 
Publiski pārvaldīta 
tīkla modelis – 
pēdējā jūdze 

3. scenārijs: 
Privāti pārvaldīta 
tīkla modelis 

4. scenārijs: 
Operatora 
subsidēšanas 
modelis 

komersantu 
torņiem, kā arī 
jaunu mobilo 
sakaru torņu 
būvniecība pie 
esošās vidējās 
jūdzes 
infrastruktūras. 

pieejamību VHCN 
baltajās teritorijās  

Konkurss var tikt 
organizēts pa visu 
valsts teritoriju, 
plānošanas 
reģioniem vai 
pašvaldībām 

Konkursa 
nosacījums – 
tehnoloģiski neitrāls 

Investīciju 
mērķa joma 

Vidējā jūdze Pēdējā jūdze Vidējā jūdze un / vai 
pēdējā jūdze – 
privātā operatora 
izvēle 

Vidējā jūdze un 
pēdējā jūdze 

Veikto 
investīciju 
īpašnieks 

Valsts vai valsts 
kapitālsabiedrība 

Pašvaldības, kas 
iznomā izveidoto 
infrastruktūru 
interneta 
pakalpojumu 
nodrošinātājam 

Privātais operators Privātais 
operators 

Tehnoloģija Tehnoloģiju neitrāls 
risinājums 

Optiskais internets Tehnoloģiju neitrāls 
risinājums 

Optiskais internets 

Interneta 
pieslēguma 
ātrums 

Vismaz 100 Mbit/s 

Pieejamais ātrums 
atkarīgs no 
vienlaicīgā 
interneta lietotāju 
skaita 

Līdz 1 Gbit/s, vismaz 
100Mbit/s. 

 

Vismaz 100 Mbit/s – 
prasības noteiktas 
konkursa 
nosacījumos. 

Definēts diennakts 
laika īpatsvars, kad 
pieejams vismaz 
noteiktais ātrums. 

Līdz 1 Gbit/s, 
vismaz 100Mbit/s. 

 

Investīciju 
atdeves 
novērtējums 
(aprēķini uz 20 
gadiem) 

-115.9 milj. EUR 

Investīciju atdeve 
atkarīga no mobilo 
sakaru torņu 
izvietojuma un to 
cik liels ir plānoto 
lietotāju skaits 
konkrētajā teritorijā. 

Galvenie ieguvēji 
būs 
mājsaimniecības.  

-49.8 milj. EUR 

Investīciju atdeve 
atkarīga no 
izvēlētajiem 
objektiem kam tiek 
pievilkts optiskais 
internets 

Sociāl-
ekonomiskajiem 
spēkiem šāda veida 
investīcijām būs 
vislielākā atdeve 

 

-667.7 milj. EUR 

Mājsaimniecību 
skaits, kam tiks 
nodrošināta 
interneta 
pieejamība atkarīgs 
no privātā operatora 
piedāvājuma, kā arī 
no tā cik daudz 
mājsaimniecībām 
nav pieejams 
internets noteiktajā 
teritorijā 

-865.5 milj. EUR 

Investīciju atdeve 
ir atkarīga no 
investīciju 
stratēģijas, kurās 
teritorijās tiek 
veiktas 
investīcijas un kas 
ir primārie 
interneta 
pakalpojumu 
saņēmēji, 
piemēram, 
galvenie sociāl-
ekonomiskie 
virzītājspēki 

Teritorijas Baltās teritorijas, arī 
pieguļošās pelēkās 
un melnās 
teritorijas. 

VHCN baltās 
teritorijas un baltās 
teritorijas 

VHCN baltās 
teritorijas, arī 
pieguļošās pelēkās 

VHCN baltās 
teritorijas 
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Parametri 1. scenārijs:  
Publiski pārvaldīta 
tīkla modelis – 
vidējā jūdze 

2. scenārijs: 
Publiski pārvaldīta 
tīkla modelis – 
pēdējā jūdze 

3. scenārijs: 
Privāti pārvaldīta 
tīkla modelis 

4. scenārijs: 
Operatora 
subsidēšanas 
modelis 

un melnās 
teritorijas. 

Labuma guvēji Iedzīvotāji, 
komersanti, valsts 
un pašvaldību 
institūcijas, sociāl-
ekonomiskie 
virzītājspēki 

Iedzīvotāji, 
komersanti, valsts un 
pašvaldību 
institūcijas, sociāl-
ekonomiskie 
virzītājspēki 

Iedzīvotāji, 
komersanti, valsts 
un pašvaldību 
institūcijas, 
sociālekonomiskie 
virzītājspēki 

Iedzīvotāji, 
komersanti, valsts 
un pašvaldību 
institūcijas, sociāl-
ekonomiskie 
virzītājspēki 

Projekta 
īstenotājs 

Publiska iestāde, 
piemēram, LVRTC 

Publiska iestāde, 
piemēram, 
pašvaldība vai 
plānošanas reģions 

Privātais operators 
(izvēlēts konkursa 
kārtībā) 

Privātais 
operators, kas tiek 
izvēlēts konkursa 
kārtībā 

Pašvaldību 
iesaiste 

Pašvaldības 
nodrošina 
nepieciešamo 
atbalstu pie optiskā 
tīkla izveides, zemi 
un atļaujas jaunu 
mobilo operatoru 
sakaru torņu 
izbūvei 

Pašvaldības 
nodrošina 
nepieciešamo 
atbalstu pie optiskā 
tīkla izveides. 
Pašvaldība iznomā 
izbūvēto 
infrastruktūru 

Konkursa 
organizēšanu var 
nodrošināt 
plānošanas reģions 
vai pašvaldība  

Pašvaldības 
nodrošina 
nepieciešamo 
atbalstu pie 
optiskā tīkla 
izveides, tai skaitā 
atļaujas un ātru 
dokumentu 
saskaņošanu  

Avots: PwC un CSE COE pētījums. 

 
Projekta ietvaros apskatīti arī platjoslas interneta pieejamības nodrošināšanas projekti Via Baltica 
autoceļa un Rail Baltica dzelzceļa maršrutos Latvijas teritorijā. Šo projektu apkopojumi sniegti tabulā 
zemāk.  
 

Tabula 2. 5G Via Baltica un 5G Rail Baltica projektu apkopojums 

Parametri 5. scenārijs:  
5G Via Baltica 

6. scenārijs: 
5G Rail Baltica 

Plānotās 
investīcijas 
apraksts 

Investīcijas, kas atbalsta 5G tīkla izveidi – 
investīcijas vidējās jūdzes optiskajā tīklā 
un mobilo sakaru torņos, kas atbilst 5G 
prasībām. Uzbūvētā infrastruktūra 
pieejama visiem mobilo sakaru 
operatoriem 

Investīcijas, kas atbalsta 5G tīkla izveidi – 
investīcijas 5G mobilo sakaru bāzes 
staciju izvietošanai. Uzbūvētā 
infrastruktūra pieejama visiem mobilo 
sakaru operatoriem 

Investīciju 
mērķa joma 

Vidējā jūdze  Vidējā jūdze  

Veikto 
investīciju 
īpašnieks 

Valsts vai valsts akciju sabiedrība 
(LVRTC) 

Valsts vai valsts akciju sabiedrības 
(LVRTC un/vai RB Rail) 

Tehnoloģija Mobilais internets Mobilais internets 

Interneta 
pieslēguma 
ātrums 

Līdz 1 Gbit/s, 

  

Līdz 1 Gbit/s, 

Investīciju 
atdeves 
novērtējums 

-13.2 milj. EUR 

Investīciju atdeve ir atkarīga no satiksmes 
intensitātes pa Via Baltica trasi, 

-3.7 milj.EUR 

Investīciju atdeve ir atkarīga no vilcienu 
plūsmas intensitātes, iedzīvotāju, 
komersantu, valsts un pašvaldību 
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Parametri 5. scenārijs:  
5G Via Baltica 

6. scenārijs: 
5G Rail Baltica 

(aprēķini uz 20 
gadiem) 

iedzīvotāju, komersantu, valsts un 
pašvaldību institūciju skaita un darbības 
Via Baltica teritorijā 

institūciju skaita un darbības Rail Baltic 
5G teritorijā 

Teritorijas Teritorija ap Via Baltica Teritorija ap Rail Baltic trasi 

Labuma guvēji Satiksmes dalībnieki pa Via Baltica, 
iedzīvotāji, komersanti, valsts un 
pašvaldību institūcijas, nākotnē autonomo 
automobiļu lietotāji. 

Rail Baltic pasažieri, iedzīvotāji, 
komersanti, valsts un pašvaldību 
institūcijas 

Projekta 
īstenotājs 

Valsts akciju sabiedrība, piemēram, 
LVRTC 

Valsts vai valsts akciju sabiedrības 
(LVRTC un/vai RB Rail) 

Pašvaldību 
iesaiste 

Pašvaldības nodrošina nepieciešamo 
atbalstu pie mobilo sakaru torņu izbūves 

Nav plānota  

Avots: PwC un CSE COE pētījums. 

 
 
7. Pamatojums nepieciešamai valsts intervencei 

Savienojamības paziņojuma stratēģiskie mērķi 2025. gadam ir šādi2: 
 

• visām Eiropas mājsaimniecībām gan laukos, gan pilsētās ir pieejams interneta pieslēgums 
ar vismaz 100 Mbiti/s3 lejupielādes  ātrumu, ko var uzlabot līdz gigabitu ātrumam; 

• gigabitu savienojamība ir visiem galvenajiem sociālekonomiskajiem virzītājspēkiem;  

• pilsētu teritorijām un visām sauszemes transporta maģistrālēm ir nepārtraukts 5G 

pārklājums (starpposma mērķis 2020. gadam - 5G savienojamība kā pilnvērtīgs 

komercpakalpojums ir pieejama vismaz vienā lielā pilsētā katrā dalībvalstī, pamatojoties uz 

komerciālu ieviešanu 2018. gadā); 

• mobilo sakaru pieejamība visur, kur cilvēki dzīvo, strādā, ceļo un satiekas. 

Savienojamības paziņojuma stratēģiskie mērķi 2025. gadam var tikt sasniegti izmantojot dažādus 
plānotos pasākumus un finansējuma iespējas, tai skaitā: 

• NAP2027 noteiktos pasākumus platjoslas infrastruktūras attīstībai; 

• ES fondu 2021.-2027.gada plānošanas perioda Eiropas reģionālās attīstības fonda 
finansējumu (3.1. prioritātei - 32 907 750 EUR); 

• CEF2 finansējumu – 5G Baltijas jūras koridors; 

• Citus finansējuma avotus. 

Savienojamības paziņojuma stratēģisko mērķu sasniegšanā izmantojot publisko finansējumu jāņem 
vērā valsts atbalsta nosacījumi, kas ir atkarīgi no finansējuma avota: 

• ES tieši administrētajam finansējumam, piemēram, CEF2, izvērtējami piemērojamie valsts 
atbalsta nosacījumi, gadījumos kad nepieciešams nacionālais līdzfinansējums. Izvērtējums 
balstāms uz principu, ka gadījumos, ja finanšu līdzekļus tiešā veidā piešķir EK aģentūra un 
valsts iestādēm nav ietekmes attiecībā uz līdzekļu piešķīrumu, tad tas nav uzskatāms par valsts 
atbalstu. Gadījumos, kad par ES tieši administrētā finansējuma nacionālā līdzfinansējuma daļu 
lemj dalībvalsts, tad komercdarbības atbalsta kontroles normas ir ievērojamas.  

                                                
2 https://ec.europa.eu/digital-single-market/en/policies/improving-connectivity-and-access 
3 Platjoslas elektronisko sakaru tīkls, kas nodrošina datu pārraides ātrumu100 Mbiti/s, ir ļoti augstas veiktspējas tīkls jeb 
VHCN (Very high capacity network).  
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• ES fondu, valsts un pašvaldību finansējumam izvērtējami valsts atbalsta nosacījumi, tai skaitā 
ņemot vērā spēkā esošo normatīvo regulējumu: 

o Komisijas Regula (ES) Nr. 651/2014  ar ko noteiktas atbalsta kategorijas atzīst par 
saderīgām ar iekšējo tirgu piemērojot Līguma 107. un 108. pantu4; 

o Komisijas komunikācija, ES pamatnostādnes valsts atbalsta noteikumu piemērošanai 
attiecībā uz platjoslas tīklu ātru izvēršanu, 2013/C 25/015; 

o Komisijas paziņojums par Līguma par Eiropas Savienības darbību 107.panta 1.punktā 
minēto valsts atbalsta jēdzienu, 2016/C 262/016; 

• 1.scenārija attīstības gadījumā, ja investīcijas veic valsts kapitālsabiedrība un veiktās 
investīcijas var izmantot operatori, tad investīcijas uzskatāmas par valsts atbalstu. 

• 2.scenārija gadījumā, ja investīcijas tiek veiktas ne tikai sociālekonomiskajiem virzītājspēkiem, 
bet veiktās investīcijas var izmantot arī operatori, tad investīcijas uzskatāmas par valsts 
atbalstu. 

• 3.scenārija gadījumā, piešķirot finansējumu konkursa kārtībā izvēlētam operatoram, 
investīcijas uzskatāmas par valsts atbalstu. 

• 4.scenārija gadījumā, piešķirot finansējumu konkursa kārtībā izvēlētam operatoram, 
investīcijas uzskatāmas par valsts atbalstu. 

• 5.scenārija gadījumā - 5G Via Baltica koridora izveide, ja veiktās investīcijas izmantos arī 
operatori, investīcijas uzskatāmas par valsts atbalstu. 

• 6.scenārija gadījumā - Rail Baltica koridora izveide, ja veiktās investīcijas papildus 
izmantojamas arī pakalpojumu sniegšanai pasažieriem, investīcijas uzskatāmas par valsts 
atbalstu.  

                                                
4 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX:32014R0651&qid=1602704139143 
5 https://eur-lex.europa.eu/legal-content/GA/TXT/?uri=CELEX:52013XC0126(01) 
6 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX%3A52016XC0719%2805%29 
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Executive Summary 

1. Internet access services at fixed locations 

Within the scope of the research, electronic communications companies were surveyed to obtain 
detailed data on the currently provided services and the services planned for the next three years. 24 
merchants or 15.6% of the 153 merchants who (according to The Public Utilities Commission 
(PUC) data) provide Internet access services to end-users at a stationary location and to whom an 
invitation to participate in the survey was sent responded to the questionnaire. Most indicated that data 
could not be provided for various reasons (no obligation to do so, lack of resources, trade secret, 
protection of personal data or no longer providing or will soon provide services to end-users, services 
via mobile networks are not placed, etc.). 

Although the response rate was low, the largest Internet service providers at a fixed location - Tet, 
Baltcom, and Balticom - submitted their data, which together serve about 89% of end-users of Internet 
connections. LMT, SIA IT S and SIA OTTV also submitted their data on services at a fixed location. 

In the future, to obtain a full overview of available Internet access services in Latvia, we recommend 
the Ministry of Transport to evaluate the possibility to include in laws and regulations the condition 
that electronic communications merchants are obliged to provide complete information to the public 
authorities upon request. 
 

2. Mobile Internet access services 

Within the scope of the research, questionnaires were sent to all 3 mobile communication operators, 
which also provide Internet access service within their service offering. The survey contained questions 
about mobile communication network base stations used for mobile Internet access services. Data on 
base station locations and technologies used were provided by LMT and Tele2 (only for a part of their 
base stations). Additional information on the base stations of all operator’s mobile communication 
networks was obtained from SJSC “Electronic Communications Office of Latvia (ECO)”. The data 
provided by SJSC “ECO” includes information on a total of 7937 base stations located in 3341 different 
geographies. 

3. Very high-performance VHCN network development plans 

Special questionnaires on very high-performance (Very High Capacity Networks (VHCN) network 
development plans for the next 3 years were also sent to both fixed and mobile operators. The reply 
was received only from Tet. 

The list submitted by Tet for 119 territories (municipalities and cities) indicates the number of 
connections where Tet is interested in providing an optical network. In total, these are 366,706 
connections, which includes 222,884 current connections provided by Tet without an optical network. 
All areas have indicated an interest in using state funding instruments for network development. The 
need for additional state funding was also confirmed by Tet representatives in the interviews.  

During the interviews mobile operators indicated that their VHCN network development plans are 
related to the choice of 5G networks. The operators did not provide specific information due to trade 
secrets and unclear regulatory frameworks, and their practices regarding the construction of shared 
5G infrastructure. 

4. Existing socio-economic drivers in local governments 

Within the scope of the research, a survey of local governments was conducted, where questionnaires 
were sent to 119 local governments (110 municipalities and 9 cities), answers were received from 93 
respondents. The survey aimed to find out the opinion of local governments on the availability of the 
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Internet in the municipality for different user groups categorized by socio-economic drivers, as well as 
questions to which socio-economic drivers should have the priority to high-speed Internet services. 

Please see below the summary table with analysis of the current situation from the local governments 
point of view: 

Table 1. Internet availability 
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Not available 2 1 2 2 2 3 7 2 

Basic speed 
Internet (speed 
from 144kb/s to 
30 Mb/s) 

38 46 54 53 29 30 29 45 

Fast speed 
Internet (speed 
from 30 to 100 
Mb/s) 

40 28 25 25 43 15 5 13 

Very high-speed 
Internet (speed 
from 100 Mb/s) 

5 5 3 4 6 4 3 4 

Improvements 
needed 

6 5 7 7 7 13 13 16 

Not sure 2 8 2 2 6 28 36 13 

 

As a result of the survey, local governments indicated that the highest priority for the availability of high-
speed Internet services should be set in educational institutions and scientific institutions, health care 
institutions, municipal and state institutions. Detailed information is available in the table below. 
 

Table 2. Priority for the availability of high-speed Internet services 
 

Average priority Place 

Educational Institutions and Scientific institutions 2.34 1 

Health care institutions 3.76 2 

Municipal and state institutions 3.95 3 

Entrepreneurship 4.14 4 

Libraries 4.45 5 

Cultural and Public centres 5.35 6 

Tourism 5.86 7 

Transportation 6.23 8 

 

5. GIS database and analysis results 

A Geographic information system (GIS) database has been developed from the data received within 
the research and publicly available data. The coordinates of the Mercator transverse map projection 
LKS-92 TM were used for all geospatial data in vector data format. All calculations using Q-GIS 
analysis tools were performed in two-dimensional space without the use of height elements. All created 
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data layers in the GIS database are saved in the ESRI data format, which can be viewed and edited 
with Q-GIS software. The GIS database is available as a separate report attachment (archived data in 
ZIP data format). The GIS database was used for analytical research. 
During the research, various analytical data layers were created using Q-GIS analysis tools. The most 
important are: 

• Geographical coverage of mobile communications; 

• Fixed communication connections, including connections with access to optics; 

• Potential white areas (at least 30Mbps access speed is not guaranteed); 

• VHCN white areas (at least 100Mbps access speed is not guaranteed); 

• Possible new mobile towers to provide mobile coverage in potential white areas; 

• Population forecast; 

• Possible locations of enterprises. 

White areas are defined as areas where next-generation access networks do not currently exist and 
will not be installed in the next three years according to the EU guidelines for the application of state 
available financing rules to the rapid deployment of broadband networks. Also, areas where there is 
no mobile coverage and where there are currently no fixed connections with access to optics were 
analysed. Such conditions are equivalent to the definition of white areas where an access speed 
of at least 30Mbps is not guaranteed. During the project it was discovered that fixed-line connections 
with access to optics are only within the theoretical coverage of mobile communications. Therefore, 
those parts of the territory of Latvia where there is no mobile coverage cannot be considered as 
potential white territories (access speed of at least 30Mbps is not guaranteed). Areas with less than 20 
ha and those that had no officially declared place of residence were manually removed from the initial 
GIS analysis (the number of officially declared places of residence was determined by using data on 
the population in 2019 in a 100x100m grid prepared by the Central statistical Bureau (CSB) on behalf 
of the Ministry of Transport). The data shows that the identified white territories occupy an area of 
10,106 km2 or 15.65% of the entire territory of Latvia. Approximately 43.3 thousand inhabitants have 
declared places of residence in these territories. Also, 5 educational institutions (schools) and 32 
cultural objects (libraries) have been identified in these territories. 
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Figure 1. Map with indicated potential white areas 

 
Source: Research done by PwC and CSE COE. 

 
Furthermore, using the data on populated places and the borders of potential white areas available in 
the Open Street Map and the Latvian Geospatial Information Agency (LGIA) Place Names Database, 
a list of villages in potential white areas was created. 

To provide broadband data services in potentially white areas, one of the scenarios in the research 
was the possibility of building new mobile towers. It was assumed that the average coverage sector for 
new mobile towers is a circle with a radius of 4 km. The possible location of the new mobile towers was 
determined manually by analysing the data prepared by the CSB on the population of 2019 in 
100x100m grid cells so that the new mobile communication towers would cover as many people as 
possible. In total, data on 200 mobile towers were prepared using this approach, which would allow 
providing mobile communication services to approximately 19.7 thousand inhabitants in potentially 
white areas. 
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Figure 2. New mobile towers in the white areas 

 

Source: Research done by PwC and CSE COE. 

 

During the project white areas were analytically identified where broadband service with an access 
speed of at least 100Mbps (VHCN white areas) is not currently available. It was assumed that such 
symmetric access speeds could currently only be provided by fixed access points with access to 
broadband optics. To identify such VHCN white areas, we were searching for the areas without fixed 
access points that have access to broadband optics. The CSB 1x1 km grid cell data layer was used 
for these calculations (see figure below). 
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Figure 3. VHCN White territories 

 

Source: Research done by PwC and CSE COE. 

 

6. Approach scenarios for the principles of the state intervention in the deployment of VHCN 
networks 

Scenario development is based on the development models7 set out in the Handbook on Investments 
in the Development of High-Speed Broadband Networks, interviews with major Internet access service 
providers, such as Tet, LMT, TELE2; industry associations, such as the Latvian Internet Association 
and the “middle mile” infrastructure provider The Latvia State Radio and Television Centre SJSC 
(LSRTC). 

The scenarios evaluated within the project aim to improve the availability of the Internet in white areas. 
The availability of the Internet can be ensured by using the services of mobile operators (mobile 
Internet) or an optical cable connection, therefore for each of the proposed scenarios the type of 
Internet availability is indicated. When analysing the scenarios, it was considered that the availability 
and quality of mobile Internet depend on the number of concurrent users and, if a guaranteed speed 
is provided for the provision of nationally important functions, such as the State Fire and Rescue 
Service (SFRS), a virtual subnet must be created in the network. 

A summary of possible development scenarios is provided in the table (see table below). 

 

                                                
7 https://ec.europa.eu/newsroom/dae/document.cfm?doc_id=12891 
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Table 3. Possible development scenarios 

Parameters Scenario 1: 

Public Managed 
Network Model - 
Middle Mile 

Scenario 2: 

Public Managed 
Network Model - 
Last Mile 

Scenario 3: 

Privately managed 
network model 

Scenario 4: 

Operator 
subsidization 
model 

Description of 
the planned 
investment 

Investments for the 
connection of the 
existing middle mile 
infrastructure with the 
towers of mobile 
communication 
companies, as well as 
the construction of 
new mobile 
communication towers 
at the existing middle-
mile infrastructure. 

Investment in the 
last mile of the 
optical network 
using the existing 
middle mile 
infrastructure. 

The private operator 
selected through a 
procurement process 
and it ensures the 
availability of Internet 
services in the white 
areas. 

The procurement 
can be organized 
throughout the 
country, planning 
regions, or 
municipalities. 

Competition 
condition - 
technologically 
neutral. 

Investments in the 
creation and 
expansion of the 
optical network. 

Investment 
target area 

Middle mile. Last mile. Middle mile and/or 
last mile - choice of 
private operator. 

Middle mile or last 
mile. 

Owner of the 
investments 
made 

State or state 
ownership. 

Municipalities that 
lease the 
established 
infrastructure to 
an Internet 
service provider. 

Private operator. Private operator. 

Technology Technology neutral 
solution. 

Optical internet. Not specified. Optical internet. 

Internet 
connection 
speed 

At least 100 Mbit/s 

The available speed 
depends on the 
number of 
simultaneous Internet 
users. 

Up to 1 Gbit/s, at 
least 100Mbit/s. 

 

At least 100 Mbit/s – 
requirements are 
specified in the 
procurement 
conditions. 

The time of the day 
is specified when at 
least the defined 
speed is available. 

Up to 1 Gbit/s, at 
least 100Mbit/s. 
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Parameters Scenario 1: 

Public Managed 
Network Model - 
Middle Mile 

Scenario 2: 

Public Managed 
Network Model - 
Last Mile 

Scenario 3: 

Privately managed 
network model 

Scenario 4: 

Operator 
subsidization 
model 

Evaluation of 
return on 
investment 
(calculations 
for 20 years) 

-115.9 mEUR 

The return on 
investment depends 
on the location of 
mobile communication 
towers and the 
number of planned 
users in an area. 

The main beneficiaries 
will be households. 

-49.8 mEUR 

The return on 
investment 
depends on the 
selected objects 
to which the 
optical Internet is 
attracted. 

Socio-economic 
drivers will have 
the highest return 
on this type of 
investment. 

-667.7 mEUR 

The number of 
households that will 
have access to the 
Internet depends on 
the offer of the 
private operator, as 
well as on how many 
households do not 
have access to the 
Internet in the 
defined area. 

-865.5 mEUR 

The return on 
investment depends 
on the investment 
strategy in which the 
investments are 
made, and which 
are the primary 
recipients of Internet 
services, such as 
the main socio-
economic drivers. 

Territories White areas, including 
adjacent gray and 
black areas. 

White areas. White areas, 
including adjacent 
gray and black 
areas. 

White areas. 

Beneficiaries Residents, 
businesses, state and 
local government 
institutions. 

Residents, 
businesses, state 
and local 
government 
institutions. 

Residents, 
businesses, state 
and local 
government 
institutions. 

Residents, 
businesses, state 
and local 
government 
institutions. 

Project 
implementer 

Public authority, for 
example LSRTC. 

A public authority, 
such as the 
municipality or 
planning region. 

Private operator 
(selected through a 
procurement). 

Private operator 
(selected through a 
procurement). 

Involvement of 
local 
governments 

Municipalities provide 
the necessary support 
for the establishment 
of an optical network, 
land and permits for 
the construction of 
communication towers 
for new mobile 
operators. 

Municipalities 
provide the 
necessary 
support for the 
establishment of 
an optical 
network. The 
municipality rents 
out the built 
infrastructure. 

The organization of 
the competition can 
be provided by the 
planning region or 
the municipality. 

Municipalities 
provide the 
necessary support 
for the 
establishment of the 
optical network, 
including the 
coordination of 
permits and 
documents. 

Source: Research done by PwC and CSE COE. 

 

Within the scope of the project, broadband internet access projects on the Via Baltica and Rail Baltica 
railway routes in the territory of Latvia are also considered. Summaries of these projects are given in 
the table (see table below). 
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Table 4. Summary of 5G Via Baltica and 5G Rail Baltica projects 

Parameters Scenario 5:  
5G Via Baltica 

Scenario 6: 
5G Rail Baltica 

Description of 
the planned 
investment 

Investments in support of the 5G network 
- investments in Middle mile optical 
networks and 5G-compliant mobile 
towers. The infrastructure built is available 
to all mobile operators. 

Investments in support of the 5G network 
- investments in Middle mile 5G-compliant 
mobile towers. The infrastructure built is 
available to all mobile operators. 

Investment 
target area 

Middle mile  Middle mile  

Owner of the 
investments 
made 

State or state joint stock company State or state joint stock company 
(LSRTC and/or Rail Baltica) 

Technology Mobile internet Mobile internet 

Internet 
connection 
speed 

Up to 1 Gbit/s 
  

Up to 1 Gbit/s 

Evaluation of 
return on 
investment 
(calculations for 
20 years) 

-13.2 mEUR 
The return on investment depends on the 
traffic intensity along the Via Baltica route, 
the number of residents, businesses, 
state and municipal institutions and 
activities in the Via Baltica area. 

-3.7 mEUR 
The return on investment depends on the 
intensity of train traffic, the number of 
residents, businesses, state and 
municipal institutions and activities in the 
territory of Rail Baltica 5G. 

Territories The area around Via Baltica The area around the Rail Baltica route 

Beneficiaries 
Road users on Via Baltica, residents, 
businesses, state and municipal 
institutions, future autonomous car users. 

Rail Baltica passengers, residents, 
businesses, state and municipal 
institutions. 

Project 
implementer 

State joint stock company (e.g. LSRTC). State or state joint stock company 
(LSRTC and/or Rail Baltica) 

Involvement of 
local 
governments 

Municipalities provide the necessary 
support for the construction of mobile 
towers 

Not planed. 

Source: Research done by PwC and CSE COE. 

 

7. Justification for the intervention of governmental authorities 

The strategic objectives of the European Interoperability Framework for 2025 are8: 

• All European households, both in rural and urban areas, have access to an Internet 
connection with a download speed of at least 100 Mbit/s9, which can be upgraded to gigabit; 

• Gigabit connectivity is one of the main socio-economic drivers; 

• Urban areas and all motorways have continuous 5G coverage (intermediate target for 2020 
- 5G connectivity is available as a full-fledged commercial service in at least one large city in 
each Member State, based on commercial deployment in 2018); 

• Accessibility of mobile communications wherever people live, work, travel, and meet. 

The strategic goals of European Interoperability Framework for 2025 can be achieved through a variety 
of planned measures and funding opportunities, including: 

• Measures specified in NAP2027 for the development of broadband infrastructure; 

• European Regional Development Fund financing for the 2021 - 2027 period (for priority 3.1 - 
32,907,750 EUR); 

• CEF2 funding - 5G Baltic Sea Corridor; 

                                                
8 https://ec.europa.eu/digital-single-market/en/policies/improving-connectivity-and-access 
9 Platjoslas elektronisko sakaru tīkls, kas nodrošina datu pārraides ātrumu100 Mbiti/s, ir ļoti augstas veiktspējas tīkls jeb 
VHCN (Very high capacity network).  
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• Other sources of funding. 

Achieving the strategic objectives of the European Interoperability Framework through public funding 
must consider governmental financing conditions that depend on the source of the funding: 

• EU directly administered funding, such as CEF2, is not subject to state financial aid conditions, 
but in cases where national co-financing is required, it is necessary to assess governmental 
financing requirements – the decision on the requirement and sum of national co-financing. 

• The conditions for EU funding, government and municipal financial support must be evaluated 
including consideration of the regulations and laws: 

o European Commission Regulation No 651/2014 declaring certain categories of aid 
compatible with the internal market in application of Articles 107 and 108 of the Treaty10; 

o Communication from the European Commission, EU Guidelines for the application of 
State aid rules about rapid deployment of broadband networks, 2013/C25/0111; 

o European Commission Notice on the concept of State financial aid referred to in Article 
107 (1) of the Treaty, 2016/C262/0112; 

• In case of development of Scenario 1, if the investments are made by a state capital company 
and the investments made can be used by operators, then the investments are considered to 
be state financial aid. 

• In the case of Scenario 2, if the investments are made not only for socio-economic drivers, but 
the investments can also be used by operators, then the investments are considered to be state 
financial aid. 

• In the case of Scenario 3, when allocating financial resources to an operator selected through 
a procurement procedure, the investment is considered to be state financial aid. 

• In the case of Scenario 4, when allocating financial resources to an operator selected through 
a procurement procedure, the investment is considered to be state financial aid. 

• In the case of Scenario 5 - the creation of the 5G Via Baltica corridor, if the investments made 
will also be used by operators, the investments are considered to be state financial aid. 

• In the case of Scenario 6, if the investments made are used only for the provision of services 
to passengers, the necessity of state investments would not be assessed. 

 

  

                                                
10 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX:32014R0651&qid=1602704139143 
11 https://eur-lex.europa.eu/legal-content/GA/TXT/?uri=CELEX:52013XC0126(01) 
12 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX%3A52016XC0719%2805%29 
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Definīcijas saistībā ar atbalstu 
platjoslas infrastruktūra 

Tabula: Ziņojumā lietotie termini  

Termins13 Skaidrojums 

Abonentlīnija jeb 
„pēdējā jūdze” 

Elektronisko sakaru piekļuves tīkla daļa. Fiksētajās līnijās no pēdējā 
piekļuves mezgla līdz galalietotāja iekārtai, bezvadu risinājumos no 
operatora bāzes stacijas līdz galalietotāja iekārtai un fiksētā bezvadu 
risinājuma gadījumos no pēdējās komersanta bāzes stacijas līdz 
galalietotāja iekārtai. 

Ar platjoslas tīkliem 
saistīti 
inženiertehniskie 
darbi 

Inženiertehniskie darbi, kas nepieciešami platjoslas tīkla izvēršanai, 
piemēram, ceļa uzrakšana, lai ieguldītu (platjoslas) kabeļu kanalizāciju 

Atvilces 
maršrutēšanas tīkls 
jeb “vidējā jūdze” 

Elektronisko sakaru tīkla daļa ar lielu caurlaidspēju, veidota datu pārraides 
nodrošināšanai starp maģistrālo tīklu un „pēdējo jūdzi”(abonentlīniju). 

Ātra platjosla Platjoslas tīkls ar trīs lejupielādes ātrumu no 30 Mb/s līdz 100 Mb/s. 

Baltā teritorija Teritorija, kurā nākamās paaudzes piekļuves tīklu pašlaik nav un kurā 
tuvāko triju gadu laikā tie netiks ierīkoti. 

ES vadlīnijas valsts 
atbalstam platjoslas 
tīklu izvēršanai14 

Dokumentā apkopoti Komisijas politikas principi attiecībā uz Līgumā 
noteikto valsts atbalsta noteikumu piemērošanu pasākumiem, ar ko 
vispārīgi atbalsta platjoslas tīklu izvēršanu (2. iedaļa), un skaidrota šo 
principu piemērošana, novērtējot atbalsta pasākumus, ar ko atbalsta ātru 
platjoslas pamata un ļoti ātrdarbīgu nākamās paaudzes piekļuves (NGA) 
tīklu izvēršanu (3. iedaļa). 

Fiziskā atsaiste Nodrošina piekļuvi galalietotāja piekļuves līnijai un dod iespēju konkurenta 
datu pārraides sistēmām tieši pārraidīt datus pa šo līniju 

Īpaši ātra platjosla Platjoslas tīkls ar trīs lejupielādes ātrumu virs 100 Mb/s. 

Kabeļu kanalizācija Pazemes cauruļvadi, ko izmanto platjoslas tīkla (optiskās šķiedras, vara vai 
koaksiālo) kabeļu ieguldīšanai 

VHCN baltā teritorija Teritorija, kurā pašlaik nav VHCN tīkli (nākamās paaudzes piekļuves tīkli, 
kas nodrošina ātrumu vismaz 100Mbit/s) un kurā tuvāko triju gadu laikā tie 
netiks ierīkoti. 

Maģistrālais jeb 
pamata tīkls 

Elektronisko sakaru tīkla daļa (t.sk., tā iekārtas) ar lielu datu caurlaidspēju, 
veidota datu pārraidei starp nacionālo transporta tīklu piekļuves punktiem 
nacionālajam maģistrālajam tīklam. 

Melnā teritorija Teritorija, kurā ir vai nākamajos trīs gados tiks izvērsti vismaz divi atsevišķi 
nākamās paaudzes piekļuves tīkli. 

                                                
13 EK Regula 651/2014 
14 https://eur-lex.europa.eu/legal-content/LV/TXT/HTML/?uri=CELEX:52013XC0126(01)&from=LV 



  
  

“Pētījums Eiropas Savienības fondu 2021. -2027. gada plānošanas perioda ieguldījumu priekšnosacījumu izpildei”     (gala ziņojums)
   

PwC, CSE COE   26 

Termins13 Skaidrojums 

Nākamās paaudzes 
piekļuves (NGA) 
tīkls 

Moderns tīkls, kam piemīt vismaz šādi parametri: a) tie uzticami nodrošina 
pakalpojumus ar ļoti lielu datu pārraides ātrumu uz vienu abonentu, 
izmantojot optiskās šķiedras (vai līdzvērtīgas tehnoloģijas) atvilci tik tuvu 
lietotāja telpām, lai ļoti lielais datu pārraides ātrums būtu reāli nodrošināts; 
b) tos var izmantot dažādiem modernajiem digitālajiem pakalpojumiem, 
tostarp apvienotajiem IP pakalpojumiem; un c) tie nodrošina ievērojami 
lielāku augšupielādes ātrumu (salīdzinājumā ar pamata platjoslas tīkliem). 
Pašreizējā tirgus un tehnoloģiju attīstības posmā NGA tīkli ir: a) optiskās 
šķiedras piekļuves tīkli (FTTx), b) moderni kabeļu tīkli un c) atsevišķi 
modernie bezvadu piekļuves tīkli, kas spēj uzticami nodrošināt lielu datu 
pārraides ātrumu uz vienu abonentu 
Tīkli, kuros viens tīkls nodrošina visu informācijas apmaiņu un pakalpojumu 
(balss, datu un mediju, piemēram, video) nodrošināšanu, pārvēršot 
informāciju IP paketēs līdzīgi kā tas tiek darīt interneta datu pārraides 
gadījumā 

Pamata platjosla Platjoslas tīkls ar trīs lejupielādes ātrumu no 144 kb/s līdz 30 Mb/s. 

Pelēkā teritorija Teritorija, kurā ir tikai viens nākamās paaudzes piekļuves tīkls vai tas tiks 
izvērsts nākamo trīs gadu laikā un ja nākamo triju gadu laikā netiks izvērsts 
cits nākamās paaudzes piekļuves tīkls. 

Platjosla Ātrgaitas telekomunikāciju sistēmas, kas nodrošina vienlaicīgas balss, 
ātrgaitas  datu pārraides un video pēc pieprasījuma informācijas apmaiņas 
nodrošināšanu. Digitālā programma Eiropai15 definē 3 platjoslas datu 
pārraides ātrumus – 2, 30 un 100 megabiti sekundē, savukārt Eiropas 
elektronisko sakaru kodekss16 definē platjoslas mērķi 1 gigabits sekundē   

Platjoslas pasīvā 
infrastruktūra 

Platjoslas tīkls, kurā nav aktīvo komponentu. Parasti tas ietver 
inženiertehnisko infrastruktūru, kabeļu kanalizāciju, tumšo šķiedru un āra 
sadales skapjus 

Vairumtirdzniecības 
līmeņa piekļuve 

Piekļuve, kas operatoram dod iespēju izmantot cita operatora infrastruktūru. 
Plašākā iespējamā piekļuve, kas jānodrošina attiecīgajā tīklā, pašreizējā 
tehnoloģiju attīstības posmā ietver vismaz turpmāk minētos piekļuves 
produktus. FTTH/FTTB tīkliem: piekļuve kabeļu kanalizācijai, piekļuve 
tumšajai šķiedrai, atsaistīta piekļuve abonentlīnijai un piekļuve bitu plūsmai. 
Kabeļu tīkliem: piekļuve kabeļu kanalizācijai un piekļuve bitu plūsmai. FTTC 
tīkliem: piekļuve kabeļu kanalizācijai, atsaistīta piekļuve abonentapakšlīnijai 
un piekļuve bitu plūsmai. Pasīvajai tīkla infrastruktūrai: piekļuve kabeļu 
kanalizācijai, piekļuve tumšajai šķiedrai un/vai atsaistīta piekļuve 
abonentlīnijai. ADSL platjoslas tīkliem: atsaistīta piekļuve abonentlīnijai un 
piekļuve bitu plūsmai. Mobilajiem vai bezvadu tīkliem: bitu plūsma, kopīga 
piekļuve stabiem un piekļuve atvilces maršrutēšanas tīkliem. Satelītu 
platformām: piekļuve bitu plūsmai 

 

                                                
15 https://eur-lex.europa.eu/legal-content/LV/TXT/HTML/?uri=CELEX:52010DC0245&from=lv 
16 https://ec.europa.eu/digital-single-market/en/news/proposed-directive-establishing-european-electronic-communications-
code 
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Saīsinājumi 

Tabula: Ziņojumā lietotie saīsinājumi  

Saīsinājums Skaidrojums 

Bite SIA Bite 

CEF2 The Connecting Europe Facility (Eiropas infrastruktūras savienojuma 
instruments)  

CORINE COoRdinate INformation on the Environment (koordinētas vides informācijas 
programma) 

CSP Centrālā statistikas pārvalde 

DPE Digitālā programma Eiropai 

EK Eiropas Komisija 

ELFLA Eiropas Lauksaimniecības fonds lauku attīstībai 

ERAF Eiropas Reģionālās attīstības fonds 

ES Eiropas Savienība 

ESRI Environmental Systems Research Institute 

FTTP Fiber to the Premises (optikas pieslēgums līdz datu centram) 

ĢIS Ģeogrāfiskās informācijas sistēma 

HD High Definition (augstas izšķirtspējas) 

IKT Informācijas un komunikāciju tehnoloģijas 

IS Informācijas sistēmas 
IT Informācijas tehnoloģijas 

KF Kohēzijas fonds 

LĢIA Latvijas Ģeotelpiskās informācijas aģentūra 

LMT SIA “Latvijas Mobilais telefons” 

LVRTC Latvijas Valsts radio un televīzijas centrs 

MK Ministru kabinets 

NAP Nacionālais attīstības plāns 

OECD Organisation for Economic Co-operation and Development (Ekonomiskās 
sadarbības un attīstības organizācija) 

OSM Open Street Map (ielu karte) 

PPP Publiskā un privātā partnerība 

SPRK Sabiedrisko pakalpojumu regulēšanas komisija 

STEAM Science, Technology, Engineering, Arts, Mathematics (Zinātne, Tehnoloģija, 
Inženierzinātne, Māksla, Matemātika) 

Tele2 SIA Tele2 

TeT SIA TET 

VASES VAS “Elektroniskie sakari”. 

VDB Vietvārdu datubāze 

VHCN Ļoti augstas veiktspējas tīkls (vismaz 100Mbps) (angļu valodā Very High 
Capacity Network) 

VTNP Vispārējas tautsaimnieciskas nozīmes pakalpojums 

VUGD Valsts ugunsdzēsības un glābšanas dienests 

VZD Valsts zemes dienests 
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1. Interneta piekļuves pakalpojumi 
fiksētās vietās 

Darba uzdevuma mērķis ir iegūt no elektronisko sakaru komersantiem datus par esošajiem 
nodrošinātajiem pakalpojumiem un par nākamo trīs gadu laikā plānotajiem pakalpojumiem. 
Saņemtos datus salāgot ar Valsts zemes dienesta Adrešu reģistru un sagatavot datu apkopojumu. 

Projekta ietvaros 153 komersantiem, kas, atbilstoši SPRK datiem, sniedz interneta piekļuves 
pakalpojumus gala lietotājiem stacionārā vietā, tika nosūtītas anketas par interneta piekļuves 
pakalpojumu teritoriālo pieejamību17, kvalitāti un tehniskajiem datiem. 

No interneta piekļuves pakalpojumu sniedzējiem fiksētās vietās uz aptaujas anketu atbildēja 24 
komersanti jeb 15.6%, taču lielākā daļa no atbildētājiem (18 jeb 75% no respondentiem) norādīja, ka 
datus nevar sniegt, minot dažādus iemeslus (nav pienākuma to darīt, nav resursu, komercnoslēpums, 
personas datu aizsardzība vai pakalpojumus gala lietotājiem vairs nesniedz vai tuvākajā laikā 
pārtrauks to darīt, pakalpojumi, izmantojot mobilos tīklus, nav piesaistīti konkrētai pakalpojumu 
saņemšanas vietai u.c.).  

Rezumējot, var teikt, ka, kaut arī respondentu atsaucības līmenis ir bijis zems, datus ir snieguši lielākie 
interneta pieslēgumu nodrošinātāji fiksētā vietā – Tet, Baltcom un Balticom, kas kopā apkalpo 
apmēram 89% interneta pieslēgumu gala lietotājiem. Datus par pakalpojumiem fiksētā vietā iesniedza 
arī LMT, SIA IT S, kā arī SIA “OTTV”18. 

Iegūtie dati tika apvienoti ar Adrešu reģistra datiem, lai pēc pieslēguma adreses kodiem atrastu to 
ģeogrāfiskās koordinātes. Vairāki respondenti nebija snieguši šos adrešu kodus, šajos gadījumos 
sākumā bija nepieciešams tos noteikt, parsējot adresi kā simbolu virkni un veicot vaicājumus Adrešu 
reģistra datu bāzē, ko SM bija nodevusi izpildītāja rīcībā. 

Excel tabula, kas satur pilnu iegūto informāciju par pieslēgumiem, ir pievienota ziņojumam kā 7. 
pielikums. Šie dati ir vizualizēti ĢIS un prezentēti ziņojuma 5. sadaļā. 

Ieteikumi 

Pētījuma ietvaros iegūti un ģeogrāfiskajām koordinātēm piesaistīti dati par apmēram 89% fiksēto 
interneta pieslēgumu valstī. 

Lai saņemtu reprezentatīvākus datus par komersantu nodrošinātajiem interneta 
pieslēgumiem, būtu jāpanāk lielāka komersantu ieinteresētība datu iesniegšanā.  

Lai iegūtu pilnu pārskatu par pieejamajiem interneta piekļuves pakalpojumiem valstī, iesakām 
izvērtēt iespējas iekļaut normatīvajos aktos noteikumu, ka elektronisko sakaru komersantiem ir 
pienākums pēc pieprasījuma sniegt valsts iestādēm pilnu informāciju par to nodrošinātajiem 
interneta pieslēgumiem gala lietotājiem līdz pieslēguma adreses līmenim. 

 

                                                
17 Attiecināms arī uz pakalpojumiem, kurus elektronisko sakaru komersants ir spējīgs tehniski nodrošināt 4 nedēļu laikā pēc 
klienta pieprasījuma. 
18 SIA “OTTV” datus iesniedza papīra formātā un tie nav iekļauti elektroniskajā pārskatā. 
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2. Mobilās interneta piekļuves 
pakalpojumi 

Darba uzdevuma mērķis ir iegūt un apkopot, datus par elektronisko sakaru komersantu esošajiem 
nodrošinātajiem mobilās interneta piekļuves pakalpojumiem, kā arī plānotajiem pakalpojumiem 
nākamo trīs gadu laikā. 

Projekta ietvaros valsts 3 mobilajiem sakaru operatoriem, kas sniegto pakalpojumu ietvaros nodrošina 
arī interneta pieejas pakalpojumu, tika nosūtītas anketas par mobilo sakaru tīklu bāzes stacijām, kas 
tiek izmantotas mobilās interneta piekļuves pakalpojumu sniegšanai: to adresēm, izmantotajām mobilo 
sakaru tehnoloģijām, pieslēguma veidiem ātrgaitas internetam. Papildus informācija par visu operatoru 
mobilo sakaru tīklu bāzes stacijām tika iegūta arī no VAS “Elektroniskie sakari”. 
 
Excel tabula, kas satur pilnu iegūto informāciju par mobilo operatoru bāzes stacijām, ir pievienota 
ziņojumam kā 8. pielikums. Šie dati ir vizualizēti ĢIS un prezentēti ziņojuma 5. sadaļā  

 

Ieteikumi 

Turpmāk jebkurai organizācijai, lai iegūtu pārskatu par mobilo bāzes staciju izvietojumu valstī, 
būtu jāsadarbojas ar VAS “Elektroniskie sakari”, kas regulāri apkopo šādu mobilo operatoru sniegto 
informāciju. 
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3. Ļoti augstas veiktspējas VHCN 
tīklu attīstības plāni 

Darba uzdevuma mērķis ir apkopot informāciju par elektronisko sakaru komersantu ļoti augstas 
veiktspējas VHCN tīklu (kur iespējams nodrošināt platjoslas piekļuves pakalpojumus ar datu 
pārraides ātrumu vismaz 100 Mbit/s) attīstības plāniem turpmākajiem 3 gadiem, kas ietver 
informāciju par plānotajiem elektronisko sakaru pakalpojumiem tehnoloģiskajā (piemēram, 
izmantojot optisko tīklu, 4. vai 5. paaudzes mobilo sakaru tīklu) un teritoriālajā griezumā. 

Lai iegūtu nepieciešamo informāciju, komersantiem, kas tika anketēti pirmā un otrā darba uzdevuma 
ietvaros, tika nosūtītas arī speciālas  anketas par ļoti augstas veiktspējas VHCN tīklu attīstības plāniem 
turpmākajiem 3 gadiem. Tika saņemtas tikai 2 atbildes – aizpildīta anketa no Tet un tukša no LMT.  
 
Pilna Tet sniegtā informācija ir pievienota ziņojumam kā 9. pielikums. Šajā sarakstā 119 teritorijām - 
valsts novadiem un pilsētām norādīts pieslēgumu skaits, kur Tet ir ieinteresēts nodrošināt optisko tīklu. 
Kopā tie ir  366 706 pieslēgumi, kas ietver 222 884 patreizējos Tet nodrošinātos pieslēgumus, kur nav 
optiskā tīkla. Visām teritorijām ir norādīts, ka tīklu attīstībai ir interese izmantot valsts atbalsta 
instrumentus. Nepieciešamību pēc tiem Tet pārstāvji apstiprināja arī intervijās.  
 
Mobilo sakaru operatori intervijās norādīja, ka viņu VHCN tīklu attīstības plāni ir saistīti ar 5G tīklu 
izvēŗšanu. Konkrētu informāciju par to komersanti nesniedza, atsaucoties uz komercnoslēpumu un 
neskaidru normatīvi bāzi un praksi attiecībā uz kopēji lietojamas 5G infrastruktūras izbūvi. 
 

Ieteikumi 

Informācija par platjoslas tīklu attīstības plāniem parasti ir komersantu komercnoslēpums. 
Lai komersanti sniegtu šādu informāciju, viņiem ir jārada motivācija vai jābūt redzamiem ieguvumiem 
no tā.  

Mobilo sakaru komersantu VHCN tīklu attīstības plāni ir saistīti ar 5G tīklu izvēršanu. Konkrētu 
informāciju par to operatori nesniedza, atsaucoties uz komercnoslēpumu un neskaidru normatīvo 
bāzi un praksi attiecībā uz kopēji lietojamas 5G infrastruktūras izbūvi valstī. 

Lai iegūtu pārskatu par komersantu plāniem izvērst VHCN tīklus un izvērtētu valsts atbalsta iespējas 
tam, iesakām iekļaut normatīvajos aktos noteikumu, ka elektronisko sakaru komersantiem ir 
pienākums pēc pieprasījuma sniegt valsts iestādēm šādu informāciju vismaz tajos gadījumos, kad 
komersanti pretendē uz valsts atbalstu. 
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4. Esošie sociālekonomiskie 
virzītājspēki pašvaldībās 

Darba uzdevuma mērķis ir apkopot informāciju par to teritorijā esošajiem sociālekonomiskajiem 
virzītājspēkiem (piemēram, skolām, slimnīcām, pašvaldību un valsts iestādēm, uzņēmumiem, 
pētniecības iestādēm, bibliotēkām u.c.) un sakārtot tos sarakstā pašvaldību norādītā prioritārā 
secībā. 

 

4.1. Sociālekonomisko virzītājspēku definīcija 

Elektronisko sakaru tīklu infrastruktūras un elektronisko sakaru pakalpojumu nepieciešamību un 
kvalitātes prasības nosaka sociālekonomiskie virzītājspēki, pie tam katrai no grupām var būt dažādas 
prasības attiecībā uz nodrošināto interneta pakalpojumu kvalitāti, tai skaitā interneta ātrumu un 
kvalitātes atbilstību. 
 

Sociālekonomiskie virzītājspēki tiek definēti kā “struktūras, kas ar savu uzdevumu, pēc savas 
būtības vai ar atrašanās vietu var tieši vai netieši radīt svarīgus sociālekonomiskus labumus 
iedzīvotājiem, uzņēmumiem un vietējām kopienām, kuras atrodas to apkārtējā teritorijā”19.  
Par sociālekonomiskajiem ieguvumiem var uzskatīt ietekmi uz tādiem aspektiem kā 
elektroenerģijas ražošanas izmaksas; sistēmas integrācijas izmaksas; atbalsta izmaksas; 
siltumnīcefekta gāzu emisijas; apgādes drošība; gaisa un cits vietējs piesārņojums; inovācija20. 

 

2020. gada februārī publicēts ziņojums “Supporting the implementation of CEF2 Digital”21, kas veidots 
ar mērķi atbalstīt Eiropas Komisiju to nepieciešamo budžeta līdzekļu noteikšanā, kas vajadzīgi, lai 
izpildītu CEF2 Digital programmā noteiktās darbības, kā arī palīdzēt sagatavoties gaidāmās CEF2 
regulas īstenošanai, nosakot galvenās tirgus nepilnību jomas, potenciālās prioritātes un finansēšanas 
strukturālos modeļus. Ziņojumā iekļauti sociālekonomisko virzītājspēku piemēri, izglītības iestādes, 
ārstniecības iestādes, kopienu ēkas un bibliotēkas, transporta mezgli (ostas, dzelzceļa stacijas, 
autobusu pieturas, lidostas), reģionālās un valsts pārvaldes iestādes, kā arī citi publisko pakalpojumu 
sniedzēji, jauniešu centri, tirdzniecības centri, sporta centri, operatīvie dienesti (policija, ugunsdzēsēju 
brigādes, neatliekamās palīdzības izsaukuma punkti), militārie objekti, industriālās zonas un digitāli 
ietilpīgi uzņēmumi. 
 
Sociālekonomiskie virzītājspēki ir viens no galvenajiem faktoriem, kas tiek ņemts vērā plānojot 
nepieciešamās investīcijas platjoslas attīstībā, gan vidējai jūdzei, gan pēdējai jūdzei. To nosaka arī 
priekšlikumā Eiropas Parlamenta un Padomes Regulai, ar ko izveido Eiropas infrastruktūras 
savienošanas instrumentu un atceļ Regulu (ES) Nr. 1316/2013 un (ES) Nr. 283/2014 (COM/2018/438 
final)22, kura 8. pantā minēts, ka finansējuma prioritātes noteikšanas primārais kritērijs tiek noteikts 
“darbībām, kuras veicina pieeju ļoti augstas veiktspējas tīkliem, kas spēj nodrošināt gigabitu 
savienotību sociālekonomiskajiem virzītājspēkiem, piešķir prioritāti, ņemot vērā sociālekonomisko 
virzītājspēku funkciju, uz šādas savienotības pamata pieejamo digitālo pakalpojumu un 

                                                
19 https://eur-lex.europa.eu/legal-content/LV/ALL/?uri=CELEX:52018PC0438 
20 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX:52018PC0438 
21 https://op.europa.eu/en/publication-detail/-/publication/8947e9db-4eda-11ea-aece-01aa75ed71a1/language-en 
22 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX:52018PC0438 
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lietojumprogrammu nozīmīgumu un potenciālos sociālekonomiskos ieguvumus iedzīvotājiem, 
uzņēmumiem un vietējām kopienām, tostarp iespējamo pozitīvo netiešo ietekmi savienotības ziņā”. Kā 
digitālās nozares finansējamās darbības nosauktas “darbības, ar kurām atbalsta sociālekonomisko 
virzītājspēku gigabitu savienotību”. 
 

 

Ieteikumi 

Izvērtējot nākotnes attīstības scenārijus, ņemt vērā arī izvēlēto scenāriju ieguldījumu interneta 
pieejamībai sociālekonomiskajiem virzītājspēkiem, piemēram, pieņemot, ka viens  
sociālekonomiskais virzītājspēks ir viens uzņēmums.  
 

 

4.2. Sociālekonomisko virzītājspēkiem nepieciešamā infrastruktūra 

Novērtējumā “EISI2 Digitalizācija ieviešanas atbalsts - SMART 2018/0018” (“Supporting the 
implementation of CEF2 Digital – SMART 2018/0018)23 iekļautas prasības attiecībā uz trīs 
sociālekonomisko virzītājspēku nepieciešamo savienojumu, lai nodrošinātu nepieciešamo darbību: 
izglītības iestādēm, veselības aprūpes iestādēm un bibliotēkām.  
 
Izglītības iestādēm nepieciešama FTTP savienojamība, jo ir daudz paralēlo lietotāju, īpaši 
maksimuma stundā. Inovatīvām un modernām e-apmācību platformām nepieciešams ātrāks 
savienojums (vismaz 1 Gbps uz 1000 lietotājiem), ņemot vērā dažādu vizuālo materiālu straumēšanai 
nepieciešamo savienojumu ātrumu. Protams, pieslēguma ātrumu ietekmē arī citi aspekti, piemēram, 
esošo savienojumu tehniskais stāvoklis, latentums – skolu mācību stundās un universitāšu lekcijās. 

Tabula 3. Sociālekonomisko dzinējspēku interneta lietošanas profili un nepieciešamais savienojums 

 Lietojums  

Nepieciešamais 

savienojums 

2020. gadā 

Izglītības 

iestādes 

Izglītojamo skaits > 50 

Savienojuma paralēlais lietojums: 50 procenti 

Statistiskais multipleksēšanas pastiprinājums 

maksimumstundā: 2 

21 Mb/s (video ir būtisks izglītībā)  

Min. 681 Mbps  

Avots: https://op.europa.eu/en/publication-detail/-/publication/8947e9db-4eda-11ea-aece-
01aa75ed71a1/language-en 

Otrs sociālekonomiskais virzītājspēks, kur nepieciešams ātrs interneta savienojums ir veselības 
aprūpes iestādes. Veselības aprūpes iestādēm nodrošināms FTTP savienojums, jo e-veselības 
lietotnēs noris augstas izšķirtspējas attēlu apmaiņa, HD video komunikācija, telemātika un 
telemedicīna, kā arī lielu datņu pārsūtīšana), turklāt slimnīcās bieži ir liels paralēlo lietotāju skaits, kas 
veicina augstu sakaru pieprasījumu. Tāpat pietiekams savienojums nepieciešams, lai pārsūtītu lielas, 
augstas izšķirtspējas datnes, piemēram, magnētiskās rezonanses vai datortomogrāfijas attēlus (datņu 
izmēri var sasniegt terabaitus). 
 

                                                
23 https://op.europa.eu/en/publication-detail/-/publication/8947e9db-4eda-11ea-aece-01aa75ed71a1/language-en 

https://op.europa.eu/en/publication-detail/-/publication/8947e9db-4eda-11ea-aece-01aa75ed71a1/language-en
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Tabula 4. Sociālekonomisko dzinējspēku interneta lietošanas profili un nepieciešamais savienojums 

 Lietojums  

Nepieciešamais 

savienojums 

2020. gadā 

Ārstniecības 

iestādes 

Augstas izšķirtspējas attēlu, lielu datņu pārsūtīšana 

Liels skaits paralēlo lietotāju 

HD videosakari  

Ātrgaitas optiskā 

interneta 

pieslēgums  

Avots: https://op.europa.eu/en/publication-detail/-/publication/8947e9db-4eda-11ea-aece-
01aa75ed71a1/language-en 

Trešā sociālekonomisko virzītājspēku grupa ir bibliotēkas un pētījumā tiek pieņemts, ka bibliotēkās 
lielās pilsētās ir nodrošināti ātrdarbīgi savienojumi, tādēļ uzmanība jāpievērš mazajām bibliotēkām, kur 
iespējams mazs paralēlo lietotāju skaits un nepieciešama pamata video komunikācija. Publiskajām 
bibliotēkām nepieciešamos savienojumus rekomendē Amerikas Bibliotēku asociācija (ALA) un pamata 
kritērijs ir apmeklētāju skaits. Ja bibliotēku apmeklē mazāk nekā 50 000 cilvēku, platjoslas ātrumam 
jābūt vismaz 100 Mbps, bet, ja bibliotēku apmeklē vismaz 50 000 cilvēku un vairāk, platjoslas ātrumam 
jāsasniedz 1 Gbps. Tāpat tiek rekomendēts 1 Mbps katrai ar internetu savienotajai ierīcei24. 

Tabula 5. Sociālekonomisko dzinējspēku interneta lietošanas profili un nepieciešamais savienojums 

 Lietojums  

Nepieciešamais 

savienojums 

2020. gadā 

Mazās 

bibliotēkas 

(ārpus 

pilsētām) 

Lielākais paralēlo bibliotekāru skaits: 2 

Lielākais paralēlo bibliotēkas lietotāju skaits: 8 

Statistiskais multipleksēšanas pastiprinājums: 2 

4,6 Mb/s (ieskaitot video pamatsakarus un darba meklēšanu) 

Min. 59 Mbps  

Avots: https://op.europa.eu/en/publication-detail/-/publication/8947e9db-4eda-11ea-aece-
01aa75ed71a1/language-en 

 

Ieteikumi 

Dažādi literatūras avoti norāda nepieciešamo interneta savienojumu ātrumu sociālekonomiskajiem 
virzītājspēkiem, bet ieteikums būtu kā nepieciešamo savienojamības ātrumu noteikt 1 Gbit/s. 

 

4.3. Sociālekonomisko virzītājspēkiem pieejamā platjoslas 
infrastruktūra Latvijā 

Projekta ietvaros tika nosūtītas anketas 119 pašvaldībām (110 novadiem un 9 republikas pilsētām), 
atbildes saņemtas no 93 respondentiem. Anketēšanas mērķis bija uzzināt pašvaldību viedokli par 
interneta pieejamību pašvaldībā dažādām lietotāju grupām sadalījumā pa sociālekonomiskajiem 
virzītājspēkiem. Iesniegto anketu izejas dati tiek nodoti atsevišķā pielikumā MS Excel datu formātā 
(SM_Anketa_pašvaldībām_OCT29_2020.xlsx). 

                                                
24 https://ecfsapi.fcc.gov/file/1090767678599/American%20Library%20Association%20Section%20706%20Comments%209_7_16.pdf 
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Interneta pieejamība izglītības iestādēm un zinātniskajām institūcijām 

“Vai interneta savienojums nodrošināts izglītības iestādēm un zinātniskajām institūcijām?” 

Attēls 4. Interneta nodrošinājums izglītības iestādēm un zinātniskajām institūcijām 

 

Avots: PwC un CSE COE anketēšanas rezultāti 

Saskaņā ar pašvaldību anketēšanas rezultātiem 41% izglītības iestādēm un zinātniskajām institūcijām 
nodrošināts pamata internets, bet 43% - ātrs internets. Piecās no aptaujātajām pašvaldībām minētajām 
iestādēm nodrošināts īpaši ātrs internets, bet 2 pašvaldībās savienojums nav pieejams.  

Svarīga ir ne tikai interneta pieejamība, bet arī interneta izmantojamība. Izglītības un zinātnes 
ministrijas pasūtītajā pētījumā “Datu apkopojums un ārvalstu un Latvijas pieredzes analīze par digitālo 
mācību līdzekļu pieejamību un izmantošanu vispārējās izglītības mācību satura nodrošināšanai”25 
analizēta starptautiskā pieredze, piemēram, OECD valstīs, ieviešot dažādus mācību līdzekļus un 
pāreju uz STEAM perspektīvu, kā arī izpētīta situācija Latvijā. Vairumam skolu nav pieejamas e-
grāmatas, arī audiogrāmatu skaits ir neliels. Dažādi digitālie uzskates līdzekļi plaši tiek izmantoti 
sākumskolā un pamatskolā, bet retāk – vidusskolā. Tomēr skolēnu personiskās ierīces tiek reti 
izmantotas – tas ierasti ir matemātikā un angļu valodā, bet krietni retāk citos mācību priekšmetos.  

Pētījuma ietvaros analizēta arī interneta pieejamība. 74,4% aptaujāto skolu internets pieejams pilnībā, 
bet 21,1% - daļēji. Vairākās skolās tas pieejams tikai bibliotēkā, ir drošības ierobežojumi, tīkla 
pārslodze. 65,5% skolu izmanto arī intranetu, 22,9% respondentu – skolu – to plāno izveidot, lai 
darbinieki un / vai izglītojamie varētu savstarpēji dalīties ar šo informāciju. 22,6% skolu regulāri izmanto 
mācīšanās platformas, 32,1% - bieži, savukārt 37,6% skolu šādas platformas izmanto atsevišķās 
situācijās.  

Interneta pieejamība veselības aprūpes iestādēm  

“Vai interneta savienojums nodrošināts ārstniecības iestādēm?” 

49% aptaujāto pašvaldību veselības aprūpes iestādēm nodrošināts pamata internets, 30% - ātrs 
internets, bet vien 5% pašvaldību – īpaši ātrs internets. Jāņem vērā, ka 1 aptaujātajā pašvaldībā 
(2,78%) interneta savienojums veselības aprūpes iestādēm nav nodrošināts. 

 

 

 

 

                                                
25 https://izm.gov.lv/images/statistika/petijumi/Datu-apkopojums-un-rvalstu-un-Latvijas-pieredzes-analze-par-DML_2018.pdf 
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Attēls 5. Interneta nodrošinājums ārstniecības iestādēm 

 

Avots: PwC un CSE COE anketēšanas rezultāti 

Interneta pieejamība bibliotēkām  

“Vai interneta savienojums nodrošināts bibliotēkām?” 

Bibliotēkām pamata internets nodrošināts 58% aptaujāto pašvaldību, bet 27% - ātrs internets, savukārt 
3 aptaujāto pašvaldību bibliotēkās nodrošināts īpaši ātrs internets. 2 aptaujāto pašvaldību bibliotēkās 
interneta savienojums nav pieejams.  

Attēls 6. Interneta pieejamība bibliotēkās 

 

Avots: PwC un CSE COE anketēšanas rezultāti 

Interneta pieejamība bibliotēkās pamatā attīstīta “Trešā tēva dēla” projekta ietvaros, ko 2007. gadā 
īstenot uzsāka Kultūras ministrijas valsts aģentūra Kultūras informācijas sistēmas (tagad - Kultūras 
informācijas sistēmu centrs)26. Projekts attīstīts ar Bila un Melindas Geitsu fonda līdzekļiem 16,2 
miljonu ASV dolāru apmērā, valsts līdzfinansējumu, kā arī Microsoft ziedoto programmatūru 7,9 miljonu 
ASV dolāru apmērā.  

Projekta sākotnējais mērķis bija nodrošināt iespēju ikvienam Latvijas iedzīvotājam bez maksas 
izmantot informācijas tehnoloģiju sniegtās iespējas – datortehniku un internetu, kā arī saņemt 
konsultācijas to lietošanā – jebkurā pašvaldību publiskajā bibliotēkā27. 

Interneta pieejamība kultūras un sabiedriskajiem centiem  

“Vai interneta savienojums nodrošināts kultūras un sabiedriskajiem centriem?” 

57% aptaujāto pašvaldību kultūras un sabiedriskajos centros nodrošināts pamata internets, 27% - ātrs 
internets, bet 4 aptaujāto pašvaldību kultūras un sabiedriskajos centros – īpaši ātrs internets. 2 
pašvaldībās interneta savienojums kultūras un sabiedriskajiem centriem nav pieejams.  

                                                
26 https://www.biblioteka.lv/informacija-par-projektu-tresais-teva-dels-articleitem-282/ 
27 https://www.kis.gov.lv/lv/jaunums/atzimes-publisko-biblioteku-attistibas-projekta-tresais-teva-dels-10-gadu-jubileju 
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Attēls 7. Interneta pieejamība kultūras un sabiedriskajiem centriem 

 

Avots: PwC un CSE COE anketēšanas rezultāti 

Interneta pieejamība pašvaldību funkciju nodrošināšanai  

“Vai interneta savienojums nodrošināts Jūsu pašvaldības funkciju nodrošināšanai un pašvaldības 
teritorijā atrodošos valsts institūciju funkciju nodrošināšanai?” 

46% aptaujāto pašvaldību nodrošināts ātrs internets pašvaldības funkcijām un pašvaldības teritorijā 
atrodošos valsts institūciju funkcijām, bet 31% - pamata internets, savukārt 6% aptaujāto pašvaldību – 
īpaši ātrs internets. 2 pašvaldībās interneta savienojums nav pieejams.  

Attēls 8. Interneta pieejamība pašvaldības un valsts institūcijām 

 

Avots: PwC un CSE COE anketēšanas rezultāti 

Interneta pieejamība uzņēmējdarbībai  

“Vai interneta savienojums nodrošināts Jūsu pašvaldības sociālekonomiskajiem virzītājspēkiem – 
uzņēmējdarbībai?” 

Sociālekonomiskajiem virzītājspēkiem – uzņēmumiem  – 32% aptaujāto uzņēmumu nodrošināts 
pamata internets, 16% - ātrs internets, bet četrās pašvaldībās – īpaši ātrs internets. Trīs aptaujātajās 
pašvaldībās interneta savienojums uzņēmējdarbībai nav pieejams.  

Attēls 9. Interneta pieejamība uzņēmējdarbībai 

 

Avots: PwC un CSE COE anketēšanas rezultāti 
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Interneta pieejamība transporta infrastruktūrai un transporta mezgliem  

“Vai interneta savienojums nodrošināts Jūsu pašvaldības sociālekonomiskajiem virzītājspēkiem – 
transporta infrastruktūrai, tostarp transporta mezgliem?” 

Transporta infrastruktūrai un transporta mezgliem pamata internets nodrošināts 31% aptaujāto 
pašvaldību, 5% - ātrs internets, bet 8% aptaujāto pašvaldību transporta infrastruktūrai interneta 
savienojums nav nodrošināts.  

Attēls 10. Interneta pieejamība transportam 

 

Avots: PwC un CSE COE anketēšanas rezultāti 

Interneta pieejamība tūrismam  

“Vai interneta savienojums nodrošināts Jūsu pašvaldības sociālekonomiskajiem virzītājspēkiem – 
tūrismam?” 

Tūrismam pašvaldībās galvenokārt nodrošināts pamata internets (48% aptaujāto pašvaldību), 14% 
aptaujāto pašvaldību – ātrs internets, bet 4% - īpaši ātrs internets. 2 aptaujātajās pašvaldībās interneta 
savienojums tūrismam nav pieejams.  

Attēls 11. Interneta pieejamība tūrismam 

 

Avots: PwC un CSE COE anketēšanas rezultāti 

Prioritāri attīstāmie interneta pieejamības pakalpojumi  

Projekta ietvaros pašvaldības norādīja uz sociālekonomiskie virzītājspēkiem, kam prioritāri būtu 
jānodrošina interneta pakalpojumi. Kā augstākā prioritāte ir norādītas izglītības iestādes un zinātnes 
institūcijas, veselības aprūpes iestādes, valsts un pašvaldību iestādes. Detalizēta informācija ir iekļauta 
tabulā zemāk. 

Tabula 6. Sociālekonomisko spēku interneta rādītāju attīstība 

 Vidējā prioritāte Vieta 

Izglītības iestādes un zinātniskās institūcijas 2.34 1 
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 Vidējā prioritāte Vieta 

Ārstniecības iestādes 3.76 2 

Valsts un pašvaldību iestādes 3.95 3 

Uzņēmējdarbība 4.14 4 

Bibliotēkas 4.45 5 

Kultūras iestādes un sabiedriskie centri 5.35 6 

Tūrisms 5.86 7 

Transporta infrastruktūra un transporta mezgli 6.23 8 

Avots: PwC un CSE COE anketēšanas rezultāti 

 

 

Ieteikumi 

Saskaņā ar anketēšanas rezultātiem daudzām pašvaldībām ir grūti izvērtēt par interneta pieejamību 
saimnieciskās darbības veicējiem un transporta nozares pārstāvjiem, tādēļ pašvaldībām plānojot 
attīstību lielāka uzmanība varētu tikt pievērsta interneta pieejamībai kā ļoti svarīgai infrastruktūras 
komponentei pašvaldību teritorijā un Platjoslas `es centrs varētu nodrošināt pašvaldībām 
nepieciešamo konsultatīvo atbalstu. Palielināt pašvaldību un plānošanas reģionu lomu un atbildību 
interneta pieejamības nodrošināšanā. 

Saskaņā ar anketēšanas rezultātiem nepieciešamas investīcijas, lai nodrošinātu ātra interneta 
pieejamību galvenajiem sociālekonomiskajiem virzītājspēkiem, jo 32% pašvaldību, 57% kultūras 
iestāžu, 58% bibliotēku, 49% veselības aprūpes iestāžu, 41% izglītības iestāžu un 48% tūrisma 
nozares pārstāvju ir pieejams tikai pamata internets. Plānojot atbalstu pēdējās jūdzes projektiem, 
investīcijas veikt, lai pirmkārt nodrošinātu īpaši ātra interneta pieslēgumu galvenajiem 
sociālekonomiskajiem virzītājspēkiem. 

Anketēšanas ietvaros pašvaldības ir norādījušas galvenos sociālekonomiskos virzītājspēkus, kur 
nepieciešamas investīcijas īpaši ātra interneta pieslēguma nodrošināšanā. Visaugstākā prioritāte ir 
izglītības iestādēm, veselības aprūpes iestādēm un valsts un pašvaldību iestādēm. Plānojot 
projektus, pēc iespējas ieplānot interneta pieejamības uzlabošanu konkrētas baltās teritorijas, 
piemēram, ciems, visiem sociālekonomiskajiem virzītājspēkiem, tai skaitā arī lielākajiem 
uzņēmumiem. Plānojot investīcijas, izvērtēt nepieciešamo interneta pieejamības ātrumu 
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4.4. Citu valstu pieredze  

Ziņojumā “Atbalsts EISI2 Digitalizācija īstenošanai” (“Supporting the implementation of CEF2 Digital”)28 
norādīta citu valstu plānotā pieeja, lai uzlabotu platjoslas infrastruktūras nodrošināšanu 
sociālekonomiskajiem virzītājspēkiem. Kopumā visām ES dalībvalstīm ir valsts platjoslas attīstības 
stratēģija vai plāns, kas dažkārt ir iekļauts Digitalizācijas programmā. Dažas valstis pievēršas 
konkrētām tehnoloģijām, citas izmanto tehnoloģiski neitrālu pieeju. 

Lielākā daļa valdības stratēģiju un finansēšanas iniciatīvu ir vērstas uz savienojamības uzlabošanu 
jomās, kurās komersantiem nav komerciālas intereses, jo īpaši tā sauktajās “baltajās zonās” vai 
“vidējās jūdzes finansējumā”. Finansējuma iniciatīvu pamatā lielā mērā ir Eiropas reģionālie fondi, jo 
īpaši ELFLA un ERAF.  

Vairākas valstis apvieno atbalstu pamattīkla un platjoslas izvēršanai baltajos rajonos, koncentrējoties 
uz to, lai vienlaikus labāk savienotu publiskās iestādes. Šīs valsts iestādes ietilpst sociālekonomisko 
dzinējspēku kategorijās. Dažās valstīs publiskā finansējuma vai cita finansējuma prioritātes atbalsta 
konkrētus sociālekonomisko dzinējspēku veidus, jo īpaši skolas. 
 

 

Ieteikumi 

Plānojot atbalstu baltajās teritorijās, ņemt vērā arī nepieciešamību nodrošināt īpaši ātru internetu 
sociālekonomiskajiem virzītājspēkiem. 

 
  

                                                
28 https://op.europa.eu/en/publication-detail/-/publication/8947e9db-4eda-11ea-aece-01aa75ed71a1/language-en 
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5. ĢIS datubāze un analīzes rezultāti 

Darba uzdevuma mērķis ir, izmantojot apkopotos datus, sagatavot izmantošanai ģeogrāfiskajā 
informācijas sistēmā (ĢIS) gatavu kartogrāfisko materiālu. 

 

5.1. ĢIS datubāze  

No pētījuma ietvaros saņemtajiem datiem un publiski pieejamiem datiem izveidota ĢIS datubāze. 
Visiem ģeotelpiskajiem datiem vektoru datu formātā izmantota Merkatora transversālās projekcijas 
plaknes koordinātas LKS-92 TM. Visi aprēķini, izmantojot Q-GIS analīzes rīkus, veikti divdimensiju 
telpā, neizmantojot augstuma elementus. Visi izveidotie ĢIS datubāzes datu slāņi saglabāti ESRI 
Shape datu formātā, ko var aplūkot un rediģēt ar Q-GIS programmatūru. ĢIS datubāze tiek nodota kā 
atsevišķs ziņojuma pielikums (saarhivēti dati ZIP datu formātā). 
Ņacionālā līmenī ģeotelpiskos pamatdatus Latvijas teritorijai pamatā gatavo Latvijas Ģeotelpiskās 
informācijas aģentūra un Valsts zemes dienests. VZD dati projektā tika izmantoti administratīvo 
teritoriju robežām un adresēm. LĢIA sagatavotie atvērtie dati vektoru formātā ir ar augstu ģeometrisko 
precizitāti, tomēr tie nav ērti strukturēti, ģeotelpiskie objekti tajos nav ar identificējošu papildus 
informāciju un to izmantošana projektā bez ievērojamas papildus datu apstrādes nav iespējama. Tādēļ 
atsevišķiem datu slāņiem projektā tika izmantota OpenStreetMap datubāze. Tā tika izvēlēta divu 
galveno apsvērumu dēļ: 

1. ērta datu izgūšana ar iespējām ģeotelpiskos objektus identificēt un papildināt 
ar aprakstošu informāciju; 

2. projekta vajadzībām pietiekama datu aktualitāte un ģeometriskā precizitāte. 

 
Tabulā zemāk iekļauta informācija (metadati) par izveidotajiem ĢIS datubāzes datu slāņiem. 

Tabula 7. ĢIS datubāzes saturs 

DATU SLĀNIS DATU LAUKI APRAKSTS 

PAMATKARTE 

OpenStreetMap 
(OSM) 

datu struktūra 
atbilstoši OSM 
noteiktajam (bez 
izmaiņām) 

Dati iegūti, izmantojot tīmekļa rīku OSM datu iegūšanai Overpass 
turbo (overpass-turbo.eu), veidojot nepieciešamos pieprasījumus 
OSM datubāzei un eksportējot tos kā GeoJSON datu formāta 
datnes. Dati pēc tam transformēti uz ESRI Shape datu formātu. 
OSM datubāzes struktūras (objektu metadati) pieejama 
https://wiki.openstreetmap.org/wiki/Map_Features vietnē.  
  

Izglītības 
iestādes 

datu struktūra 
atbilstoši OSM 
noteiktajam (bez 
izmaiņām) 

Skolas_point_merge.zip 
 
Izvēlēti OSM datubāzes dati, kuriem atribūta “amenity” vērtības ir 
“school” (skola), “college” (koledža) vai “university” (universitāte). 
Pavisam pētījumā atlasīti 902 dažādi objekti, kas atbilst minētiem 
atlases kritērijiem. Ģeotelpiskie dati saglabāti ESRI Shape datu 
formātā.  

Veselības 
aprūpes 
iestādes 

datu struktūra 
atbilstoši OSM 
noteiktajam (bez 
izmaiņām) 

Hospital_point_merge.zip 
 
Izvēlēti OSM datubāzes dati, kuriem atribūta “amenity” vērtības ir 
“hospital” (slimnīca). Sākotnējo atlasi koriģēja manuāli, atstājot tikai 
tādus objektus, kuru nosaukums (atribūta “name” vērtība) norādīja uz 
iestādi, kurā notiek stacionāra ārstēšana. Pavisam pētījumā atlasīti 54 

https://wiki.openstreetmap.org/wiki/Map_Features
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DATU SLĀNIS DATU LAUKI APRAKSTS 

dažādi objekti, kas atbilst minētiem atlases kritērijiem. Ģeotelpiskie 
dati saglabāti ESRI Shape datu formātā. 
 

Galvenie 
autoceļi 

datu struktūra 
atbilstoši OSM 
noteiktajam (bez 
izmaiņām) 

Lv_celi.zip 
 
Izvēlēti OSM datubāzes dati, kuriem atribūta “highway” vērtības ir 
“primary”, “secondary” vai “trunk”. Pavisam pētījumā atlasīti 11497 
ceļu segmenti, kas atbilst minētiem atlases kritērijiem. Izmantojot 
atribūta “ref” vērtību, kas satur ceļa nosaukumu (indeksu), ceļa 
segmentiem tika noteikta kategorija – A (Valsts galvenie autoceļi), P 
(Valsts reģionālie autoceļi) vai V (Valsts vietējie autoceļi), jo indeksa 
vērtība satur šo kategorijas burtu un ceļa numuru. Ģeotelpiskie dati 
saglabāti ESRI Shape datu formātā. 
 

Via Baltica 

datu struktūra 
atbilstoši OSM 
noteiktajam (bez 
izmaiņām) 

Via_Baltica.zip 
 
Izmantojot no OSM datubāzes izveidoto galveno autoceļu datu slāni, 
tika atlasīti autoceļu segmenti, kuriem atribūta “int_ref” vērtība ir “E 
67”. Ģeotelpiskie dati saglabāti ESRI Shape datu formātā. 
 

Rail Baltica 

datu struktūra 
atbilstoši OSM 
noteiktajam (bez 
izmaiņām) 

Rail_Baltica.zip 
 
Izvēlēti OSM datubāzes dati Latvijas teritorijai, kuriem atribūta 
“railway” vērtības ir “proposed” (projektēts) un atribūta “name” vērtība 
ir “Rail Baltica”. Ģeotelpiskie dati saglabāti ESRI Shape datu formātā. 
 

   

Kultūras 
iestādes 

Sākotnējā datu 
struktūra (bez 
izmaiņām) 

Kulturas_objekti.zip 
 
Dati iegūti no Atvērto datu portāla. Izmantoti Kultūras centru 
statistikas dati par 2018 gadu - 
https://data.gov.lv/dati/lv/dataset/kulturas-centru-statistika . 
Dati no Atvērto datu portāla iegūti CSV datu formāta. Pēc tam atlasīti 
tikai tādi ieraksti, kuriem atribūta “Nozare” vērtības ir “Arhīvi, 
“Bibliotēkas”, “Kino izrādīšanas vietas” vai “Kultūrizglītības iestādes”. 
Pavisam pētījumā atlasīti 1754 dažādi objekti, kas atbilst minētiem 
atlases kritērijiem. Izmantojot QGIS funkcionalitāti (Layer-> Add 
Layer-> Add Delimited Text Layer un Layer-> Save As) izveidots ĢIS 
datu slānis. Ģeotelpiskie dati saglabāti ESRI Shape datu formātā. 
 

   

Administratīvi 
teritoriālais 
iedalījums 
(līnijas) 

Adrešu reģistra 
dati atbilstoši VZD 
noteiktajam (bez 
izmaiņām) 

Adm_rob_nov.zip 
 
VZD sniegtie dati ESRI Shape datu formātā: 

• Teritorijas.shp un  

• TeritorijuCentroidi.shp. 

Ģeotelpiskā informācija un atribūti atbilstoši VZD specifikācijai  
   

Adreses (punkti) 

Adrešu reģistra 
dati atbilstoši VZD 
noteiktajam (bez 
izmaiņām) 

VZD sniegtie dati ESRI Shape datu formātā: 

• Ekas.shp 

Ģeotelpiskā informācija un atribūti atbilstoši VZD specifikācijai  
   

100x100 m Grid 
CSP lietotais 
100x100m režģis 
(bez izmaiņām) 

Grid_LV_100.zip 
 
Dati iegūti no CSP mājas lapas: 

https://data.gov.lv/dati/lv/dataset/kulturas-centru-statistika
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DATU SLĀNIS DATU LAUKI APRAKSTS 

https://www.csb.gov.lv/lv/statistika/kartes-un-telpiskie-dati. 
 
100×100 m režģa pārklājums Latvijas teritorijai. Ģeotelpiskie dati 
ESRI Shape datu formātā.  

   

1x1 km Grid 
CSP lietotais 
1x1km režģis (bez 
izmaiņām) 

Grid_LV_1k.zip 
 
Dati iegūti no CSP mājas lapas: 
https://www.csb.gov.lv/lv/statistika/kartes-un-telpiskie-dati. 
 
1×1 km režģa pārklājums Latvijas teritorijai. Ģeotelpiskie dati ESRI 
Shape datu formātā.  

   

Valsts atbalsta 
programmas 
Nr.SA.33324 
dati (līnijas)  

LVRTC dati bez 
izmaiņām (kabeļu 
līnijas 1. & 2.kārtai) 

LVRTC Platjosla linijas TM.zip 
 
LVRTC sniegtie dati KML datu formātā:  

• Platjosla1 kārta.kml,  

• Platjosla2.kml,  

• Platjosla2 plānota.kml. 

Dati satur tikai ģeotelpisko informāciju bez atribūtiem. Ģeotelpiskie 
dati saglabāti ESRI Shape datu formātā.  

   

Valsts atbalsta 
programmas 
Nr.SA.33324 
dati (punkti)  

LVRTC dati bez 
izmaiņām (optiskā 
tīkla piekļuves 
punkti) 

LVRTC Platjosla pieslegumi TM.zip 
 
LVRTC sniegtie dati KML datu formātā:  

• Platjosla1 punkti.kml, 

• Platjosla2 punkti.kml. 

Dati satur tikai ģeotelpisko informāciju bez atribūtiem. Ģeotelpiskie 
dati saglabāti ESRI Shape datu formātā.  

   

Mobilo 
operatoru bāzes 
stacijas un torņu 

VASES sniegtie 
dati par mobilo 
operatoru bāzes 
stacijām 

VASES mobilas stacijas.zip 
 
Informācija par visu operatoru bāzes stacijām, kā arī dati par torņiem 
un buferzonām ap šiem torņiem. 
Ģeotelpiskie dati saglabāti ESRI Shape datu formātā. 
 

   

CORINE Land 
Cover (laukumi) 

LĢIA dati (bez 
izmaiņām) 

CORINE.zip 
 
Dati iegūti no LĢIA mājas lapas 
http://map.lgia.gov.lv/index.php?lang=0&cPath=4_17&txt_id=131 
(CLC lejupielāde). Informācija satur 2012.gada zemes virsmas 
apauguma apsekojuma datus. Dati atbilstoši Eiropas Vides 
Aģentūras specifikācijai. 
Ģeotelpiskie dati ESRI Personal Database datu formātā, kas 
transformēti uz ESRI Shape datu formātu.  

   

PĒTĪJUMA DATI 

Administratīvi 
teritoriālais 
iedalījums (42 
novadi) 

 

Adm_rob_nov42.zip 
 
Administratīvi teritoriālās vienības robežas, kas būs spēkā pēc 
2021.gada 30.jūnija (dati iegūti no VZD admin. teritoriālā iedalījuma 
datiem) 
Ģeotelpiskie dati saglabāti ESRI Shape datu formātā.  

https://www.csb.gov.lv/lv/statistika/kartes-un-telpiskie-dati
https://www.csb.gov.lv/lv/statistika/kartes-un-telpiskie-dati
http://map.lgia.gov.lv/index.php?lang=0&cPath=4_17&txt_id=131
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DATU SLĀNIS DATU LAUKI APRAKSTS 
 Area Administratīvi teritoriālās vienības laukums 
 Novads42 Administratīvi teritoriālās vienības nosaukums 
 ATVK_C Administratīvi teritoriālās vienības kods 

   

Jaunie mobilo 
sakaru torņi 
baltajās 
teritorijās 

 

New_cell_towers.zip 
 
Projekta laikā izveidots datu slānis ar iespējamiem 200 jauniem 
mobilo sakaru torņiem (to atrašanās vietām), lai izveidotu papildus 
mobilo sakaru pārklājumu baltajās teritorijās. 
Ģeotelpiskie dati saglabāti ESRI Shape datu formātā.  

   

Komersantu 
fiksēto sakaru 
pieslēgumu 
punkti 

 

Fiksetie_all.zip, Fiksetie_grid.zip, Fiksetie_grid_optika.zip 
 
No komersantiem saņemtā informācija par fiksēto pieslēgumu 
punktiem, kā arī šo pieslēgumu punktu skaits 1x1km režģa šūnās, 
tajā skaitā tikai pieslēgumu punktu skaits ar piekļuvi platjoslas 
optiskai. 
Ģeotelpiskie dati saglabāti ESRI Shape datu formātā.  

   

Baltās teritorijas  

Platjosla_balta_teritorija.zip, Platjosla_balta_teritorija_novadi.zip  
 
Projekta laikā izveidotās baltās teritorijas (teritorijas, kurās netiek 
nodrošināts vismaz 30Mbps interneta piekļuves ātrums). Arī šo 
teritoriju šķēlums ar 119 novadiem. 
Ģeotelpiskie dati saglabāti ESRI Shape datu formātā.  

   

Iedzīvotāju 
statistikas  dati 
100x100m 
(režģis) 

ID režģa šūnas ID 

 IEDZIVOTAJI Iedzīvotāju skaits režģa šūnā (CSP aprēķini pēc SM pasūtījuma) 
   

Iedzīvotāju 
statistikas  dati 
1x1km (režģis) 

(dati no Atvērto 
datu portāla par 
2019.gadu) 

Grid_LV_1k_population_2019.zip 
 
Dati iegūti no ADP datiem “Pastāvīgo iedzīvotāju skaits, dzimums un 
vecums 1×1 km režģa šūnās” 
(https://data.gov.lv/dati/dataset/iedzivotaji-1km ). Izejas dati sasaistīti 
ar attiecīgo datu režģi un transformēti ESRI Shape datu formātā. 
Datu slānis satur datus gan par 2019.gadu, gan par prognozi 
2027.gadam (pielietojot 5.2.sadaļā minēto metodoloģiju).  

 ID 1x1km režģa šūnas ID 

 Popul19 Iedzīvotāju skaits režģa šūnā 2019.gadā 

 Popul27 Iedzīvotāju skaits režģa šūnā 2027.gadā (prognoze) 

 Popul_delta Iedzīvotāju skaita izmaiņas 2027.gadā (prognoze) 

   

Ekonomiski 
aktīvo 
uzņēmumu 
statistikas  dati 
1x1km (režģis) 

(dati no CSP 
mājas lapas par 
2018.gadu) 

Grid_LV_1k_uzn.zip 
 
Pielietojot 5.2.sadaļā minēto metodoloģiju, iegūti dati par ekonomiski 
aktīvo uzņēmumu iespējamo skaitu katrā 1x1km režģa šūnā.  
Ģeotelpiskie dati saglabāti ESRI Shape datu formātā  

 ID 1x1km režģa šūnas ID 

 Grid_1k_uz 
Ekonomiski aktīvo uzņēmumu iespējamais skaits režģa šūnā 
2018.gadā 

https://data.gov.lv/dati/dataset/iedzivotaji-1km
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DATU SLĀNIS DATU LAUKI APRAKSTS 

   

Teritoriālie dati 
par dažādiem 
interneta 
piekļuves 
veidiem un cita 
informācija 
1x1km (režģis) 

 

Grid_LV_1k_teritorijas_dati.zip 
 
Projektā izveidots speciāls datu slānis attīstības scenāriju analīzes 
vajadzībām. 
Ģeotelpiskie dati saglabāti ESRI Shape datu formātā 

 ID 1x1km režģa šūnas ID 

 FIKS fiksēto pieslēgumu skaits režģa šūnā 

 MOBI 
pazīme vai režģa šūnā 2020.gadā pieejams mobilais pieslēgums (0 
– nē, 1 – jā) 

 OPTI fiksēto pieslēgumu skaits režģa šūnā ar piekļuvi optikai 

 NEW_CELL 

pazīme vai režģa šūnā 2027.gadā plānots mobilais pieslēgums 
jaunām teritorijām, kurās 2020.gadā nav mobilā pieslēguma (0 – nē, 
1 – jā). Šis attiecas tikai uz 1.scenārijā plānotiem 200 jauniem 
mobilo sakaru torņiem. 
 

 SOCEK1 

pazīme vai režģa šūnā 2027.gadā plānots fiksētais pieslēgums ar 
piekļuvi optikai sociāli ekonomiskiem virzītājspēkiem (0 – nē, 1 – jā). 
Šis attiecas tikai uz 2.scenāriju. 
 

 VIA_B 
pazīme vai režģa šūna atrodas Via Baltica 4km koridorā (0 – nē, 1 – 
jā) 

 RAIL_B 
pazīme vai režģa šūna atrodas Rail Baltica 4km koridorā (0 – nē, 1 – 
jā) 

   

1x1km režģa 
dati 
analītiskajam 
darbam ar 
attīstības 
scenārijiem 

 

Grid_LV_1k_2scen_nov42.zip, Grid_LV_1k_3scen_nov42.zip, 
Grid_LV_1k_4scen_nov42.zip, Grid_LV_1k_5scen.zip, 
Grid_LV_1k_6scen.zip 
 
Sagatavoti dati no datu slāņa Grid_LV_1k_teritorijas_dati.zip katram 
no scenārijiem (2., 3., 4., 5. un 6.). 1.scenārijam šādi dati nav 
nepieciešami, jo tie atbilst Grid_LV_1k_teritorijas_dati.zip esošām 
teritorijām ar atribūtu vērtību NEW_CELL = 1. Scenārijiem 2.-4. dati 
satur arī informāciju par to, kuram no jaunajiem 42 novadiem 
attiecīgā 1x1km režģa šūna pieder. 
 

 ID 1x1km režģa ID (sasaistei izmantos CSP identifikatoru) 

 

FIKS, MOBI, OPTI, 
SOCEK1, 
NEW_CELL, 
VIA_B, RAIL_B 

Skatīt Grid_LV_1k_teritorijas_dati.zip 
 aprakstu. 

 P_POPUL27 Izdzīvotāju skaits režģa šūnā 2027.gadā (prognoze) 

 U_UZN_SK Iespējamais uzņēmumu skaits režģa šūnā 2018.gadā 

 NOVADS42 Jaunā novada nosaukums 

 ATVK_C Jaunā novada kods 

Avots: PwC un CSE COE pētījums 

 

Darbam ar izveidoto ĢIS datubāzi nepieciešama Q-GIS programmatūra (versija 2.18 vai jaunāka). Datubāzes 
dati izvietojami uz lokāla datora vai servera, kuram ir piekļuve ar Q-GIS programmatūru. Izmantojama standarta 
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Q-GIS funkcionalitāte (skat. https://www.qgis.org/en/docs/index.html ). ĢIS analīzes veikšanai nepieciešams arī 
uzstādīt Q-GIS spraudņus mmqgis29 un Processing30 

 

5.2. Analīzes rezultāti  

5.2.1. Fiksētie platjoslas pieslēgumi 

Projekta ietvaros tika saņemti dati no komersantiem31 par fiksēto platjoslas sakaru pieslēgumu 
atrašanās vietām (adresēm). Izmantojot šo sniegto informāciju CSV datu formātā, tika sagatavots ĢIS 
datubāzes slānis ESRI Shape datu formātā (izmantota Layer->Add layer->Add Delimited Text layer un 
attiecīgi Layer -> Save As funkcionalitātes). Izmantojot šos pieslēguma punktu datus, ar ĢIS analīzes 
rīkiem tika aprēķināts šādu pieslēguma punktu skaits katrā CSP 1x1km režģa šūnā (izmantota Vector-
>Analysis Tools->Count points in polygon funkcionalitāte). Iegūtie rezultāti aplūkojami attēlā zemāk. 
 

Attēls 12. Fiksēto sakaru pieslēgumu skaits katrā 1x1km režģa šūnā 

 

Avots: PwC un CSE COE pētījums 

Dati uzrāda, ka fiksēto sakaru pieslēgumi atrodami 6130 CSP 1x1 km režģa šūnās, ko var interpretēt 
kā 6130 km2 lielu teritoriju jeb 9.34% no visas Latvijas valsts teritorijas32. Šajā teritorijā deklarētās 
dzīves vietas ir 1.64 milj. iedzīvotājiem33, jeb 84.1%. Lielākā pieslēgumu koncentrācija ir vērojama 
republikas nozīmes pilsētās un lielākajās apdzīvotās vietās. 

 

                                                
29 A collection of QGIS vector layer operation plugins 
30 Spatial data processing framework for QGIS 
31 Datus iesniedza SIA Tet, SIA Baltcom, SIA Balticom, SIA “IT S” un SIA LMT. 
32 Aprēķini veikti ņemot vērā, ka viss CSP 1x1km režģis Latvijas valsts teritorijai satur 65647 šūnas.  
33 Aprēķinos izmantoti CSP dati par iedzīvotāju skaitu 1x1km režģī 2019.gadā 

https://www.qgis.org/en/docs/index.html
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5.2.2. Fiksētie platjoslas pieslēgumi ar piekļuvi optikai 

No saņemtajiem komersantu datiem varēja atlasīt tos fiksēto sakaru pieslēgumus, kuriem ir 
piekļuve platjoslas optikai, nodrošinot piekļuves ātrumu vismaz 100 Mbps. Tika atlasīti punkti, 
kuriem atribūta PIEEJ_PLAT vērtība ir 1 un, izmantojot ĢIS analīzes rīkus, aprēķināts šādu pieslēgumu 
skaits katrā CSP 1x1km režģa šūnā (izmantota Vector->Analysis Tools->Count points in polygon 
funkcionalitāte). Iegūtie rezultāti aplūkojami attēlā zemāk. 
 

Attēls 13. Fiksēto sakaru pieslēgumu ar pieeju optikai skaits katrā 1x1km režģa šūnā 

 

Avots: PwC un CSECOE pētījums 

Dati uzrāda, ka fiksēto sakaru pieslēgumi ar piekļuvi optikai atrodami 1052 CSP 1x1 km režģa šūnās, 
ko var interpretēt kā 1052 km2 lielu teritoriju jeb 1.60% no visas Latvijas valsts teritorijas34. Šajā teritorijā 
deklarētās dzīves vietas ir 1.35 milj. iedzīvotājiem35 jeb 70.1%. Koncentrācija republikas nozīmes 
pilsētās un lielākajās apdzīvotās vietās ir ievērojami lielāka, nekā fiksētajiem pieslēgumiem kopumā. 

 

5.2.3. Mobilo sakaru teorētiskais pārklājums 

Projekta ietvaros ĢIS datubāzē analītiski tika izveidots datu slānis ar teorētisko mobilo sakaru 
pārklājumu. Mobilo sakaru pārklājumā piekļuves ātrums ir vērtējams kā 30 – 100 Mbps. Aprēķini 
veikti, izmantojot Q-GIS36 analīzes rīkus. Datu slānis iegūts, izmantojot mobilo sakaru operatoru bāzes 
staciju atrašanās vietu datus par 3341 mobilo sakaru torni (saņemti 21/09/2020 no VAS ES).  
 
Aprēķinu metodikā tika pieņemts, ka katrai viena operatora bāzes stacijai ir pārklājums ar vismaz vienu 
tā paša operatora tuvāko bāzes staciju (tādējādi veidojas nepārtraukta viena operatora pārklājuma 
teritorija). Ar ĢIS analīzes rīkiem tika noteikta katrai viena operatora bāzes stacijai tuvākā otra bāzes 

                                                
34 Aprēķini veikti ņemot vērā, ka viss CSP 1x1km režģis Latvijas valsts teritorijai satur 65647 šūnas.  
35 Aprēķinos izmantoti CSP dati par iedzīvotāju skaitu 1x1km režģī 2019.gadā 
36 Atvērtā koda ĢIS lietojumprogramma https://qgis.org/en/site/ 
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stacija un attālums līdz tai (izmantota Vector-> Analysis Tools -> Distance Matrix funkcionalitāte, lai 
atrastu vienu tuvāko punktu). Tika pieņemts, ka pārklājums starp šīm divām bāzes stacijām ir vismaz 
1/3 no aprēķinātā attāluma līdz tuvākajai bāzes stacijai.  
 
Katram viena operatora tornim tikai izveidots pārklājuma sektors ar rādiusu 2/3 no aprēķinātā attāluma 
līdz tuvākajai bāzes stacijai (izmantota Vector -> Geoprocessing Tools -> Variable distance buffer 
funkcionalitāte, sektora rādiusa vērtību katram tornim saglabājot atsevišķā atribūtā). Tika pieņemts, ka 
sektora rādiuss nav mazāks par 4 km. No visiem viena operatora pārklājuma sektoriem, tos apvienojot, 
tika izveidota kopēja viena operatora pārklājuma teritorija (izmantota Vector->Geoprocessing Tools -> 
Dissolve funkcionalitāte ar parametru “Dissolve all”).  
 
Šādas iepriekš minētās darbības tika veiktas ar katra mobilo sakaru operatora datiem. Beigās tika 
apkopti visu trīs mobilo sakaru operatoru pārklājuma dati (divas reizes izmantota Vector-
>Geoprocessing Tools -> Union funkcionalitāte, katrā reizē apvienojot divas datu kopas). No 
apvienotajām visu operatoru pārklājuma teritorijām tika izveidota viena kopēja teritorija (izmantota 
Vector->Geoprocessing Tools -> Dissolve funkcionalitāte ar parametru “Dissolve all”). Iegūtie rezultāti 
aplūkojami attēlā zemāk. 
 

Attēls 14. Teorētiskais mobilo sakaru tīkla pārklājums 

 

Avots: PwC un CSE COE pētījums 

Dati uzrāda, ka teorētiskais mobilo sakaru tīkla pārklājums aptver 59087 CSP 1x1 km režģa šūnas, ko 
var interpretēt kā 59087 km2 lielu teritoriju jeb 90.0% no visas Latvijas valsts teritorijas37. Šajā teritorijā 
deklarētās dzīves vietas ir 1.86 milj. iedzīvotājiem38 jeb 97.7%. 

 

                                                
37 Aprēķini veikti ņemot vērā, ka viss CSP 1x1km režģis Latvijas valsts teritorijai satur 65647 šūnas.  
38 Aprēķinos izmantoti CSP dati par iedzīvotāju skaitu 1x1km režģī 2019.gadā 
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5.2.4. Baltās teritorijas (nav tīkla ar piekļuves ātrumu vismaz 30 Mbps) 

Projekta ietvaros tika analītiski noteiktas baltās teritorijas, kurās šobrīd nav pieejams platjoslas 
pakalpojums ar piekļuves ātrumu vismaz 30 Mbps. Lai noteiktu šādas teritorijas, tika meklētās 
teritorijas, kurās nav mobilo sakaru pārklājuma (ne no viena mobilo sakaru operatora) un kurās nav 
fiksēto sakaru pieslēgumu punktu platjoslai. Šim nolūkam tika izmantoti jau iepriekš izveidotie ĢIS datu 
slāņi ar teorētisko mobilo sakaru pārklājumu un fiksēto sakaru pieslēgumu punktiem. Tika meklēti tādi 
fiksēto sakaru pieslēguma punkti, kuri atrodas ārpus mobilo sakaru teorētiskā pārklājuma (izmantota 
Vector->Research Tools->Select by Location funkcionalitāte un kā ģeometriskās meklēšanas 
parametrus norādot intersects, overlaps, within un crosses). Šādi pieslēgumi netika atrasti. Līdz ar to 
baltās teritorijas tika noteiktas, no Latvijas valsts teritorijas izslēdzot teorētisko mobilo sakaru 
pārklājumu (izmantota Vector->Geoprocessing Tools->Difference funkcionalitāte). No ĢIS sākotnējā 
analīzes rezultāta manuāli izņemtas teritorijas, kuras pēc platības bija mazākas par 20 ha un kurās 
nebija neviena deklarētā dzīves vieta. Pavisam šādi tika identificētas 172 teritorijas. Par deklarēto 
dzīves vietu (jeb iedzīvotāju skaita) datiem izmantoti pēc SM pasūtījuma CSP sagatavotie dati par 
iedzīvotāju skaitu 2019.gadā 100x100 m režģī. Iegūtās potenciālās baltās teritorijas aplūkojamas Attēls 

15. 

Attēls 15. Karte ar baltajām teritorijām 

 

Avots: PwC un CSE COE pētījums. 

 

Dati uzrāda, ka šādi identificētās baltās teritorijas aizņem 10 106km2 lielu teritoriju jeb 15.65% no visas 
Latvijas valsts teritorijas39. Šajās teritorijās dzīves vietas deklarētas 43.3 tūkstošiem iedzīvotāju. Tāpat 
šajās teritorijās ir identificētas 5 izglītības iestādes (skolas) un 32 kultūras objekti (bibliotēkas). 

                                                
39 Aprēķinos izmantota Latvijas valsts kopplatība 2015.gadā no CSP statistikas tabulas ISG040 
https://data1.csb.gov.lv/pxweb/lv/iedz/iedz__iedzskaits__ikgad/ISG040.px 
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Ciemu saraksts iegūts ar ĢIS analīzes rīkiem, atrodot apdzīvotās vietas (ciemus) no LĢIA Vietvārdu 
datu bāzes40 (izmantoti VDB dati tikai par pastāvošiem ciemiem) un Open Street Map (OSM) datiem 
par apdzīvotām vietām Latvijā (ar tipu ‘villages’ jeb ciemi). Sarakstu veido tādas apdzīvotās vietas 
(ciemi), kas atrodas baltajās teritorijās. Jāatzīmē, ka ir virkne balto teritoriju, kurās ciemu nav, bet tās 
ir apdzīvotas pēc CSP datiem, t.i. tajās ir viensētas. Baltajās teritorijās esošo ciemu saraksts sniegts 
6.pielikumā. 

 

5.2.5. Jauni mobilo sakaru torņi baltajās teritorijās 

Projekta ietvaros tika izveidots ĢIS datubāzes slānis ar jauniem mobilo sakaru torņiem 
potenciālajās baltajās teritorijās (nav tīkla ar piekļuves ātrumu vismaz 30 Mbps). Datu slānis tika 
gatavots ar ĢIS analīzes rīkiem un saglabāts ESRI Shape datu formātā. Tika pieņemts, ka jaunajiem 
mobilo sakaru torņiem pārklājums vidēji ir riņķis ar rādiusu 4 km. Jauno mobilo torņu iespējamais 
izvietojums tika noteikts manuāli, analizējot CSP sagatavotos datus par 2019.gada iedzīvotāju skaitu 
100x100 m režģa šūnās, lai jaunie mobilo sakaru torņi aptvertu pēc iespējas vairāk iedzīvotāju. 
Pavisam šajā datu slānī tika izveidoti 200 mobilo sakaru torņi. Katram tornim pārklājuma sektors tika 
veidots, izmantojot ĢIS analīzes rīkus (izmantota Vector->Geoprocessing Tools->Fixed distance buffer 
funkcionalitāte). Šādi noteikto jauno mobilo torņu izvietojumu var aplūkot Attēls 16. 

Attēls 16. Jaunie mobilo sakaru torņi baltajās teritorijās 

 

Avots: PwC un CSE COE pētījums. 

Ar ĢIS analīzes rīkiem tika noteikts, ka ar šādu 200 jaunu mobilo sakaru torņu izvietoju iespējams 
sniegt mobilos sakarus papildus 29.2 tūkstošiem iedzīvotāju no pavisam 43.3 tūkstošiem iedzīvotāju, 
kuriem deklarētas dzīves vietas potenciāli baltajās teritorijās (nav tīkla ar piekļuves ātrumu vismaz 30 
Mbps). 

                                                
40 https://vietvardi.lgia.gov.lv/ 
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5.2.6. VHCN baltās teritorijas (nav tīkla ar piekļuves ātrumu vismaz 100 Mbps) 

Projekta ietvaros tika analītiski noteiktas baltās teritorijas, kurās šobrīd nav pieejams platjoslas 
pakalpojums ar piekļuves ātrumu vismaz 100 Mbps (VHCN baltās teritorijas). Tika pieņemts, ka 
šādu simetrisku piekļuves ātrumu šobrīd var nodrošināt tikai fiksēto sakaru pieslēgumu punkti ar 
piekļuvi platjoslas optikai. Lai noteiktu šādas baltās teritorijas, tika meklētas teritorijas, kurās nav fiksēto 
sakaru pieslēgumu punktu ar piekļuvi platjoslas optikai. Šiem aprēķiniem izmantots CSP 1x1 km režģa 
šūnu datu slānis – tika meklētas režģa šūnas, kurām atribūta OPTI vērtības < 1, t.i. šūnas, kurās optisko 
pieslēgumu nav. Iegūtās baltās teritorijas aplūkojamas Attēls 17. 

Attēls 17.VHCN Baltās teritorijas 

 

Avots: PwC un CSE COE pētījums. 

Dati uzrāda, ka identificētās VHCN baltās teritorijas, ko veido visa Latvijas valsts teritorija, izņemot tās 
teritorijas, kurās ir piekļuve platjoslas optikai, aptver 64595 CSP 1x1 km režģa šūnas jeb 98.4% no 
visas Latvijas valsts teritorijas41. Šajā teritorijā deklarētās dzīves vietas ir 577.95 tūkst. iedzīvotājiem42 
jeb 30.3%. 

 

5.2.7. Sociāli ekonomiskie virzītājspēki 

Projekta ietvaros tika noteikti dati par sociālekonomiskajiem virzītājspēkiem šādās trīs grupās – 
ārstniecības iestādes, izglītības iestādes un kultūras iestādes. 

Ārstniecības iestādes 

                                                
41 Aprēķini veikti ņemot vērā, ka viss CSP 1x1km režģis Latvijas valsts teritorijai satur 65647 šūnas.  
42 Aprēķinos izmantoti CSP dati par iedzīvotāju skaitu 1x1km režģī 2019.gadā 
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Projektā izmantoti Open Street Map dati par ārstniecības iestādēm, kas pilda slimnīcu funkcijas (skatīt 
sadaļu 5.1 ĢIS datubāze, datu slānis “Veselības aprūpes iestādes”). Pavisam izgūti dati par 54 
iestādēm (skatīt Attēls 18). 

Attēls 18. Veselības aprūpes iestādes 

 

Avots: PwC un CSE COE pētījums. 

46,3% jeb 25 šādām ārstniecības iestādēm jau šobrīd ir pieejams Tet ātrgaitas interneta pieslēgums. 
Šāds novērtējums tika piemērots tām iestādēm, kurām pēc ĢIS datiem attālums līdz tuvākajam Tet 
optiskajam pieslēguma punktam ir mazāks par 100m, kas būtu uzskatāms par izejas datu kļūdu. 29 
ārstniecības iestādēm piekļuves VHCN tīklam šobrīd nav un optiskā pieslēguma izveide būtu viens 
no risinājumiem (tikai vienā gadījumā tuvākais optikas piekļuves punkts ir tālāk par 3km). Kopējais 
iespējamā optiskā tīkla garums no tuvākā pieejamā optiskā pieslēguma punkta līdz ārstniecības 
iestādēm ir 25.8 km (attālums pa taisni, kas iegūts ar ĢIS analīzes rīkiem, pareizināts ar 1.3, lai 
modelētu pieslēguma līkumainību). 

Izglītības iestādes 

Projektā izmantoti Open Street Map dati par izglītības iestādēm (skatīt sadaļu 5.1 ĢIS datubāze, datu 
slānis “Izglītības iestādes”). Pavisam izgūti dati par 902 iestādēm (skatīt Attēls 19).  
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Attēls 19. Izglītības iestādes 

 

Avots: PwC un CSE COE pētījums. 

Šobrīd ātrgaitas optiskais internets pieejams 457 izglītības iestādēs jeb 50,6% no apskatīto izglītības 
iestāžu. 97% gadījumu tas ir Tet optiskais pieslēgums. Šāds novērtējums tika piemērots izglītības 
iestādēm, kurām pēc ĢIS datiem attālums līdz tuvākajam optiskajam pieslēguma punktam ir mazāks 
par 100m, kas būtu uzskatām par izejas datu kļūdu. 445 izglītības iestādēm piekļuves VHCN tīklam 
šobrīd nav un optiskā pieslēguma izveide būtu viens no risinājumiem (103 gadījumos tuvākais optikas 
piekļuves punkts ir tālāk par 3km).  

Kopējais iespējamā optiskā tīkla garums no tuvākā pieejamā optiskā pieslēguma punkta līdz 342 
izglītības iestādēm ir 166.7 km (attālums pa taisni, kas iegūts ar ĢIS analīzes rīkiem, pareizināts ar 
1.3, lai modelētu pieslēguma līkumainību). Atlikušajām 103 izglītības iestādēm kopīgais iespējamā 
optiskā tīkla garums sastāda 1087.7 km, un tām būtu jāmeklē alternatīvi pieslēguma risinājumi. 

Kultūras iestādes 

Projektā izmantoti Atvērto datu portālā pieejamie dati par kultūras objektiem (skatīt sadaļu 5.1 ĢIS 
datubāze, datu slānis “Kultūras iestādes”). Pavisam izgūti dati par 1754 dažādiem objektiem (skatīt 
Attēls 20). 
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Attēls 20. Kultūras objekti 

 

Avots: PwC un CSE COE pētījums. 

Šobrīd 748 kultūras objektiem jeb 42,6% no apskatītajiem objektiem ir pieejams optiskais interneta 
pieslēgums. 74,1% gadījumu to var nodrošināt Tet. Šāds novērtējums tika piemērots kultūras 
objektiem, kuriem pēc ĢIS datiem attālums līdz tuvākajam optiskajam pieslēguma punktam ir mazāks 
par 100m, kas būtu uzskatām par izejas datu kļūdu. 1006 kultūras objektiem piekļuves VHCN tīklam 
šobrīd nav un optiskā pieslēguma izveide būtu viens no risinājumiem (439 gadījumos tuvākais optikas 
piekļuves punkts ir tālāk par 3km). 

Kopējais iespējamā optiskā tīkla garums no tuvākā pieejamā optiskā pieslēguma punkta līdz 657 
kultūras objektiem ir 398.3 km (attālums pa taisni, kas iegūts ar ĢIS analīzes rīkiem, pareizināts ar 
1.3, lai modelētu pieslēguma līkumainību). Atlikušajiem 439 kultūras objektiem kopējais iespējamā 
optiskā tīkla attālums ir 4784.3 km, un tām būtu jāmeklē alternatīvi pieslēguma risinājumi. 

 

5.2.8. Iznākumu rādītāju aprēķināšanas metodoloģija nākotnes attīstības 
scenāriju salīdzināšanai 

 
Plānojot turpmāko platjoslas tīkla attīstību, var tikt noteikti dažādi attīstības scenāriji, kuru īstenošanas 
rezultātā tiks sasniegti noteikti projekta mērķi. Zemāk ir uzskaitīti rādītāji, kas ņemami vērā, izvērtējot 
dažādus attīstības scenārijus, kā arī metodoloģija, lai noteiktu rādītāju vērtības. Katram no scenārijiem 
būs savas sasniedzamās iznākuma rādītāju vērtības 2027.gadā. Par ļoti augstas veiktspējas platjoslu 
tiek uzskatīts savienojums ar ātrumu vismaz 100 Mbps. 
 
RCO 41 – Papildu mājsaimniecības ar piekļuvi ļoti augstas veiktspējas platjoslai – mājsaimniecību 
skaits. Vērtības iegūstamas kā starpība starp šī brīža vērtību (mājsaimniecību skaits 2019.gadā) un 
rādītāja vērtību pēc scenārija izpildes (mājsaimniecību skaits 2027.gadā). Rādītāja RCO 41 aprēķiniem 
par šī brīža situāciju izmantoti Atvērto datu portālā pieejamie CSP dati “Pastāvīgo iedzīvotāju skaits, 
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dzimums un vecums 1×1 km režģa šūnās”43. Izmantoti tikai dati par iedzīvotāju skaitu 2019.gadā CSV 
datu formātā. Attiecīgo datu tabulu savienojot ar 1x1 km režģa ĢIS datu slāni, tiek iegūta iedzīvotāju 
skaita karte. 

RCO 42 – Papildu uzņēmumi ar piekļuvi ļoti lielas veiktspējas platjoslas pakalpojumiem – uzņēmumu 
skaits. Vērtības iegūstamas kā starpība starp šī brīža vērtību (jaunākie CSP dati) un rādītāja vērtību 
pēc scenārija izpildes (uzņēmumu skaits 2027.gadā). 

Rādītāja RCO 42 aprēķiniem par šī brīža situāciju izmantota CSP datubāzes tabula SRG010 
“Ekonomiski aktīvi uzņēmumi statistiskajos reģionos, republikas pilsētās un novados”44 . Izmantoti dati 
par ekonomiski aktīvajiem uzņēmumiem republikas pilsētās un novados 2018.gadā (visjaunākie 
pieejamie dati). Atbilstoši šiem datiem 2018.gadā pavisam Latvijā bija 185 006 ekonomiski aktīvi 
uzņēmumi. Attiecībā uz uzņēmumiem interneta pieejamība rēķināta, izmantojot uzņēmuma reģistrēto 
juridisko adresi. 

RCR 53 – Mājsaimniecības, kuras abonē platjoslas pieslēgumus ļoti lielas veiktspējas tīklam – 
mājsaimniecību skaits. Vērtības iegūstamas pēc scenārija izpildes (mājsaimniecību skaits 2027.gadā). 

RCR 54 – Uzņēmumi, kas abonē platjoslas pieslēgumus ļoti lielas veiktspējas tīklam – uzņēmumu 
skaits. Vērtības iegūstamas pēc scenārija izpildes (uzņēmumu skaits 2027.gadā). 

Lai aprēķinātu mājsaimniecību skaitu, tika izmantota CSP datubāzes tabula ISG060 “Privāto 
mājsaimniecību kopējais skaits un mājsaimniecības vidējais lielums statistiskajos reģionos, republikas 
pilsētās, novados, laukos un pilsētās”45. Izmantoti dati par mājsaimniecības vidējo lielumu Latvijā 
2020.gadā. Atbilstoši šai tabulai mājsaimniecības vidējais lielums ir 2.28 personas.  

Līdz ar to aprēķiniem izmantota šāda formula: 

SK = IEDZ / 2.28,  

kur 
SK – mājsaimniecību skaits 2019.gadā un 2027.gadā,  
IEDZ – iedzīvotāju skaits 2019.gadā un 2027.gadā. 
 
Saskaņā ar Savienojamības ziņojumu viens no mērķiem ir nodrošināt augstas veiktspējas platjoslas 
pakalpojumus sociālekonomiskajiem virzītājspēkiem, kas būtu izdalāms kā atsevišķs sasniedzamais 
mērķis, kā arī sasaistāms ar jau noteiktajiem iznākuma rādītājiem RCO 42 un RCR 54. Lai nodrošinātu 
sasaisti ar jau definētajiem rādītājiem, tiek pieņemts, ka viens sociālekonomiskais virzītājspēks ir 
viens uzņēmums.  
 
Sociālekonomisko virzītājspēku gadījumā par RCO 42 un RCR 54 vērtībām tiek noteiktas mērķa 
vērtības, ko iegūst, summējot nodaļā 5.2.7 norādīto veselības aprūpes iestāžu, izglītības iestāžu un 
kultūras objektu skaitu, kuriem plānoti pieslēgumi VHCN tīklam. 
 

5.2.9. Metodoloģija iedzīvotāju skaita prognozei 2027.gadam 

Lai noteiktu plānotās iznākuma rādītāju vērtības attiecībā uz mājsaimniecībām 2027.gadā, zemāk 
iekļauta informācija par iedzīvotāju skaita prognozēm 2027.gadā. Šo metodoloģiju piemērosim visiem 
nākotnes attīstības scenārijiem. 

Prognozes dati iegūti no CSP datubāzes tabulas ISG020 “Iedzīvotāju skaits un tā izmaiņas 
statistiskajos reģionos, republikas pilsētās, novadu pilsētās, 21 attīstības centrā un novados”46. 

                                                
43 https://data.gov.lv/dati/eng/dataset/iedzivotaji-1km  
44 https://data.csb.gov.lv/pxweb/lv/uzn/uzn__01_skaits/SRG010.px  
45 https://data.csb.gov.lv/pxweb/lv/iedz/iedz__iedzskaits__ikgad/ISG060.px  
46 http://data1.csb.gov.lv/pxweb/lv/iedz/iedz__iedzskaits__ikgad/ISG020.px  

https://data.gov.lv/dati/eng/dataset/iedzivotaji-1km
https://data.csb.gov.lv/pxweb/lv/uzn/uzn__01_skaits/SRG010.px
https://data.csb.gov.lv/pxweb/lv/iedz/iedz__iedzskaits__ikgad/ISG060.px
http://data1.csb.gov.lv/pxweb/lv/iedz/iedz__iedzskaits__ikgad/ISG020.px
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Izmantoti dati par iedzīvotāju skaitu gada sākumā un iedzīvotāju skaita izmaiņām republikas pilsētās 
un novados laika periodā no 2010.gada līdz 2019.gadam. Lai iegūtu prognozi 2027.gadam, tika 
analizēta iedzīvotāju skaita izmaiņu dinamika pēdējo 10 gadu periodā un pēdējo 5 gadu periodā. Šim 
nolūkam tika analizēta dinamika (izmaiņas) iedzīvotāju skaita izmaiņām šajā laika periodā. Nākotnes 
prognozei par iedzīvotāju skaita dinamiku tika aprēķināta vidējā izmaiņu dinamikas vērtība no pēdējo 
5 gadu perioda un pēdējā gada vērtības, lai prognozē uz nākamiem 7 gadiem tiktu ievērtēta gan ilgāka 
termina tendence (5 gadi), gan pēdējās izmaiņas (2019.gada dati). Izmantojot šo iedzīvotāju skaita 
izmaiņu dinamikas vērtību, katrai republikas pilsētai un novadam tika aprēķinātas prognozes 
iedzīvotāju skaita izmaiņām no 2020.gada līdz 2026.gadam. Izmantojot datus par iedzīvotāju skaitu 
2019.gadā un par izmaiņām katrā nākošajā gadā, tika aprēķināta prognoze iedzīvotāju skaitam 
2027.gadā. Veicot šādus aprēķinus, iegūtā prognoze iedzīvotāju skaitam Latvijā 2027.gadam bija 1.86 
miljoni. 

Nākamajā solī iedzīvotāju skaita prognozes dati republikas pilsētu un novadu griezumā tika pārnesti 
uz 1x1km režģi. Šim nolūkam tika veikti aprēķini ar ĢIS analīzes rīkiem. Izmantojot 1x1 km iedzīvotāju 
režģa datu slāni un administratīvo robežu datu slāni un pielietojot Vector->GeoProcessing Tools-
>Union funkcionalitāti, tika iegūta abu datu slāņu kompozīcija, nosakot katras 1x1 km iedzīvotāju režģa 
šūnas īpatsvaru no novada kopējās platības. Izmantojot šo īpatsvara vērtību katrai šūnai, tika 
aprēķināts teorētiski iespējamais novada vai republikas pilsētas iedzīvotāju skaits konkrētā 1x1km 
režģa šūnā. 

Aprēķiniem izmantota šāda formula: 

 SKi= 
SKnov x PLATi 

PLATnov 
, kur  
SKi – iedzīvotāju skaits tajā 1x1 km režģa šūnas daļā, kas atrodas novadā (republikas pilsētā), 
PLATi – platība tai 1x1 km režģa šūnas daļai, kas atrodas novadā (republikas pilsētā), 
SKnov – iedzīvotāju kopējais skaits novadā (republikas pilsētā), 
PLATnov - novada (republikas pilsētas) kopējā platība. 
 

Sasummējot iedzīvotāju skaitu katrā 1x1 km režģa šūnā, tika iegūts ĢIS datubāzes datu slānis 
“Iedzīvotāju skaits 1x1km režģa šūnās 2027.gadā”. 

 

5.2.10. Metodoloģija uzņēmumu skaita novērtējumam šobrīd un 2027.gadā 

Lai noteiktu plānotās iznākuma rādītāju vērtības attiecībā uz uzņēmumiem 2027.gadā, zemāk iekļauta 
informācija par uzņēmumu skaita prognozēm 2027.gadam. Šo metodoloģiju piemērosim visiem 
nākotnes attīstības scenārijiem. 

Rādītāja RCO 42 aprēķiniem par šī brīža situāciju izmantota CSP datubāzes tabula SRG010 
“Ekonomiski aktīvi uzņēmumi statistiskajos reģionos, republikas pilsētās un novados”47 . Izmantoti dati 
par ekonomiski aktīvajiem uzņēmumiem republikas pilsētās un novados 2018.gadā (visjaunākie 
pieejamie dati). Atbilstoši šiem datiem, 2018.gadā Latvijā bija 185 006 ekonomiski aktīvi uzņēmumi. 

Rādītāja RCO 42 aprēķiniem par situāciju 2027.gadā tika izdarīts pieņēmums, ka uzņēmumu skaits 
varētu būt pieaudzis par 10%. 

Nākamajā solī uzņēmuma skaita dati republikas pilsētu un novadu griezumā tika pārnesti uz 1x1km 
režģi. Šim nolūkam izmantoti šādi četri ĢIS datu slāņi: 

1) administratīvās robežas, 
2) zemes virsmas apaugums “CORINE Land Cover”,  
3) galvenie autoceļi un  

                                                
47 https://data.csb.gov.lv/pxweb/lv/uzn/uzn__01_skaits/SRG010.px  

https://data.csb.gov.lv/pxweb/lv/uzn/uzn__01_skaits/SRG010.px
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4) 1x1km režģa dati visai Latvijas teritorijai.  

Aprēķinos tika pieņemts, ka ekonomiski aktīvi uzņēmumi atrodas urbānās teritorijās, lauksaimniecības 
zemēs vai meža zemēs 1 km attālumā no galvenajiem autoceļiem. 

Izmantojot ĢIS datu analīzes rīkus (Vector->Geoprocessing Tools->Fixed distance buffer 
funkcionalitāte), tika izveidota 1 km buferzona ap Latvijas valsts galvenajiem autoceļiem. Šī buferzona 
izmantota, lai noteiktu tās 1x1 km režģa šūnas, kuras atrodas šajā buferzonā (pilnībā vai daļēji). 

Izmantojot CORINE Land Cover datu slāni, administratīvo robežu datu slāni un 1x1km režģa datu slāni 
un pielietojot Vector->GeoProcessing Tools->Union funkcionalitāti, tika iegūta visu trīs datu slāņu 
kompozīcija, šādā veidā nosakot: 

1) zemes apauguma sadalījumu katrā 1x1km režģa šūnā, 
2) zemes apauguma sadalījumu novada (republikas pilsētas) teritorijā. 

Zemes apauguma sadalījumam izmantots CORINE Land Cover datubāzes pirmā līmeņa iedalījums: 

1) urbāna teritorija, 
2) lauksaimniecības zemes, 
3) meža zemes, 
4) mitrāji, 
5) ūdens tilpes. 

No tālākiem aprēķiniem tika izslēgtas teritorijas ar zemes apauguma klasi “4 – mitrāji” un “5 – ūdens 
tilpnes”. Savukārt atlikušajām zemes apauguma klasēm tika piemēroti šādi koeficienti, lai modelētu 
atšķirīgu uzņēmuma atrašanās varbūtību katrā no klasēm: 

1) urbāna teritorija - koeficients 0.75 (visaugstākā varbūtība),  
2) lauksaimniecības zemes - koeficients 0.15 (pieņēmums, ka 5 reizes zemāka varbūtība nekā 

urbānā teritorijā), 
3) meža zemes - koeficients 0.10 (visu koeficientu summai jābūt 1.0). 

Aprēķini veikti tikai 1x1km režģa šūnām, kas atrodas 1 km buferzonā ap galvenajiem autoceļiem (skat. 
Attēls 21). 
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Attēls 21. Zemes virsmas apaugums 1km ap galvenajiem autoceļiem 

 
Avots: PwC un CSE COE pētījums. 

 
Lai noteiktu uzņēmumu skaitu režģa šūnas daļā, kas atrodas 1.zemes apauguma klasē (urbānā 
teritorija), izmantota šāda formula: 

SK1= 
koef1 x SKnov x PLAT1 

PLATnov 
 
, kur  
koef1 – 1.zemes apauguma klases koeficients, 
SK1 – uzņēmumu skaits tajā 1x1km režģa šūnas daļā, kas atrodas novadā (republikas pilsētā) 1.zemes 
apauguma klasē, 
PLAT1 – platība tai 1x1km režģa šūnas daļai, kas atrodas novadā (republikas pilsētā) 1.zemes 
apauguma klasē, 
SKnov – uzņēmumu kopējais skaits novadā (republikas pilsētā), 
PLATnov - novada (republikas pilsētas) kopējā platība 1km buferzonā ap galvenajiem autoceļiem. 
 
Lai noteiktu uzņēmumu skaitu režģa šūnas daļā, kas atrodas 2.zemes apauguma klasē 
(lauksaimniecības zemes), izmantota šāda formula: 

SK2= 
Koef2 x SKnov x PLAT2 

PLATnov 
, kur 
koef2 – 2.zemes apauguma klases koeficients, 
SK2 – uzņēmumu skaits tajā 1x1km režģa šūnas daļā, kas atrodas novadā (republikas pilsētā) 2.zemes 
apauguma klasē, 
PLAT2 – platība tai 1x1km režģa šūnas daļai, kas atrodas novadā (republikas pilsētā) 2.zemes 
apauguma klasē, 
SKnov – uzņēmumu kopējais skaits novadā (republikas pilsētā), 
PLATnov - novada (republikas pilsētas) kopējā platība 1km buferzonā ap galvenajiem autoceļiem. 
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Lai noteiktu uzņēmumu skaitu režģa šūnas daļā, kas atrodas 3.zemes apauguma klasē (meža zemes), 
izmantota šāda formula: 

SK3= 
Koef3 x SKnov x PLAT3 

PLATnov 
 
, kur  
koef3 – 3.zemes apauguma klases koeficients, 
SK3 – uzņēmumu skaits tajā 1x1km režģa šūnas daļā, kas atrodas novadā (republikas pilsētā) 3.zemes 
apauguma klasē, 
PLAT3 – platība tai 1x1km režģa šūnas daļai, kas atrodas novadā (republikas pilsētā) 3.zemes 
apauguma klasē, 
SKnov – uzņēmumu kopējais skaits novadā (republikas pilsētā), 
PLATnov - novada (republikas pilsētas) kopējā platība 1km buferzonā ap galvenajiem autoceļiem. 
 
Lai noteiktu uzņēmumu skaitu režģa šūnas daļā, kas atrodas novadā (republikas pilsētā), izmantota 
šāda formula:  

SK = SK1 + SK2 + SK3. 
 
Sasummējot uzņēmumu skaitu katrā 1x1km režģa šūnā, tika iegūts ĢIS datubāzes datu slānis 
“Uzņēmumu skaits 1x1km režģa šūnās 2018.gadā”. 
 
 

5.2.11. Nākotnes attīstības scenāriju ietekmētās teritorijas 

Katram no iespējamiem nākotnes attīstības scenārijiem tika izveidots atsevišķs 1x1km režģa datu 
slānis, lai iezīmētu tās 1x1km režģa šūnas, kurās ir vai tiek plānots, ka būs pieejams VHCN tīkls. Šim 
nolūkam izveidots speciāls ĢIS datu slānis 1x1km režģim visai Latvijas teritorijai Grid_lv_1k_teritorijas 
ar īpašiem atribūtiem katrai šūnai: 

FIKS – fiksēto pieslēgumu skaits režģa šūnā 
MOBI – pazīme vai režģa šūnā 2020.gadā pieejams mobilais pieslēgums (0 – nē, 1 – jā) 
OPTI – fiksēto pieslēgumu skaits režģa šūnā ar piekļuvi optikai 
NEW_CELL – pazīme vai režģa šūnā 2027.gadā plānots mobilais pieslēgums jaunām teritorijām, kurās 
2020.gadā nav mobilā pieslēguma (0 – nē, 1 – jā). Šis attiecas tikai uz 1.scenārijā plānotiem 200 
jauniem mobilo sakaru torņiem.  
SOCEK1 – pazīme vai režģa šūnā 2027.gadā plānots fiksētais pieslēgums ar piekļuvi optikai sociāli 
ekonomiskiem virzītājspēkiem (0 – nē, 1 – jā). Šis attiecas tikai uz 2.scenāriju. 
VIA_B – pazīme vai režģa šūna atrodas Via Baltica 4km koridorā (0 – nē, 1 – jā). 
RAIL_B – pazīme vai režģa šūna atrodas Rail Baltica 4km koridorā (0 – nē, 1 – jā). 
 
Pētījumā pieņemts, ka VHCN ar piekļuves ātrumu vismaz 100Mbps, pieejamība 2020.gadā ir tikai tajās 
teritorijās, kurās atrodami fiksētie pieslēgumi platjoslai ar pieeju optikai. Līdz ar to par “VHCN baltajām 
teritorijām” tiek pieņemtas teritorijas, kurās nav fiksētie pieslēgumi ar pieeju optikai. 

Katram scenārijam VHCN plānotās pieejamības teritorijas izmantots kā filtrs, lai atlasītu tās 1x1km 
režģa šūnas, kurām jāveic iedzīvotāju vai uzņēmumu sasummēšana, lai iegūtu attiecīgi RCO 41 vai 
RCO 42 rādītāju vērtības kopumā Latvijas teritorijai. Šīs pašas atlasītās teritorijas ir attiecināmas arī 
uz rādītāju RCR 53 un RCR 54 aprēķināšanu. Katra scenārija ietekmētās teritorijas ir dotas pie 
attiecīgā scenārija apraksta. 
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5.2.12. Aprēķini novadu līmenī 

Aprēķini dažādiem attīstības scenārijiem veikti ne tikai kopumā Latvijas teritorijai, bet skatot datus arī 
jauno 42 administratīvo teritoriju (novadu un valsts pilsētu) griezumā48 (skat. attēlu tālāk tekstā). 

Attēls 22. Administratīvās teritorijas pēc 2021.gada 30.jūnija 

 

Avots: PwC un CSE COE pētījums. 

Esošo statistikas datu pārrēķināšanai uz jaunām administratīvām teritorijām izmantota pārejas tabula 
(skatīt Pielikumu Nr.10). 

Ņemot vērā pašvaldību raksturojošo informāciju (iedzīvotāju skaitu un tā prognozēto dinamiku, 
uzņēmumu skaitu, sociālekonomisko virzītājspēku skaitu), pašvaldības iespējams prioritizēt pēc 
nosacīta ranga. Ranga aprēķins ir veidots, normējot minētos faktorus pret to maksimālajām vērtībām 
un tad summējot tos, katram izmantojot savu svara koeficientu. Tabulā 8. redzams šādi iegūtais valsts 
teritoriju ranžējums 

Tabula 8. Pašvaldību nosacītais rangs 

Novadi un valstspilsētas 
(pēc 30/06/2021) 

Iedzīvotāju 
skaits 

2027.gadā 
(prognoze) 

Iedzīvotāju 
izmaiņas 

(%) 

Ekonomiski 
aktīvie 

uzņēmumi 

Veselības 
aprūpes 
iestāžu 
skaits 

novadā 

Izglītības 
iestāžu 
skaits 

novadā 

Kultūras 
iestāžu 
skaits 

novadā 

Rangs 

Ādažu novads 25287 26.2% 1783 1 5 7 28.90 

Aizkraukles novads 28324 -5.1% 2235 0 13 48 24.97 

Alūksnes novads 13801 -5.3% 1296 1 6 32 19.18 

Augšdaugavas novads 28850 -13.6% 1790 0 10 50 19.86 

                                                
48 https://likumi.lv/ta/id/315654-administrativo-teritoriju-un-apdzivoto-vietu-likums 
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Novadi un valstspilsētas 
(pēc 30/06/2021) 

Iedzīvotāju 
skaits 

2027.gadā 
(prognoze) 

Iedzīvotāju 
izmaiņas 

(%) 

Ekonomiski 
aktīvie 

uzņēmumi 

Veselības 
aprūpes 
iestāžu 
skaits 

novadā 

Izglītības 
iestāžu 
skaits 

novadā 

Kultūras 
iestāžu 
skaits 

novadā 

Rangs 

Balvu novads 16319 -19.5% 1839 1 16 43 20.40 

Bauskas novads 38009 -10.7% 2946 1 27 64 40.58 

Cēsu novads 44772 6.6% 4277 1 40 60 55.34 

Daugavpils 75073 -2.0% 5012 3 26 40 56.27 

Dienvidkurzemes novads 37401 2.9% 3435 1 11 59 40.02 

Dobeles novads 27387 -7.2% 2132 1 20 43 30.25 

Gulbenes novads 18850 -7.7% 1623 0 15 30 16.40 

Jēkabpils novads 40410 -4.6% 3376 1 20 55 38.89 

Jelgava 63990 15.0% 4103 2 20 27 49.92 

Jelgavas novads 29684 -7.2% 2276 0 21 48 27.26 

Jūrmala 52748 11.4% 4071 1 20 27 40.61 

Ķekavas novads 31071 9.5% 2643 0 11 15 21.67 

Krāslavas novads 20323 -19.2% 1817 2 19 44 28.24 

Kuldīgas novads 25830 -10.0% 2998 1 8 44 25.16 

Liepāja 62702 -6.3% 5717 2 22 30 42.35 

Limbažu novads 33022 15.1% 2805 2 12 45 46.15 

Līvānu novads 10775 -0.1% 1002 0 2 17 9.02 

Ludzas novads 20351 -13.9% 1629 2 12 48 29.32 

Madonas novads 24536 -18.3% 2932 1 23 56 30.37 

Mārupes novads 46896 36.5% 3747 0 9 10 36.62 

Ogres novads 62181 7.7% 4918 1 24 50 50.16 

Olaines novads 22115 14.2% 1207 0 5 7 16.22 

Preiļu novads 14044 -12.4% 1819 0 2 36 10.38 

Rēzekne 27890 5.9% 1976 1 10 24 26.77 

Rēzeknes novads 30442 -14.5% 2507 1 7 62 28.70 

Rīga 583605 -6.5% 77053 18 262 232 446.76 

Ropažu novads 46597 45.7% 2870 0 15 20 45.80 

Salaspils novads 24713 2.3% 1708 0 9 8 13.06 
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Novadi un valstspilsētas 
(pēc 30/06/2021) 

Iedzīvotāju 
skaits 

2027.gadā 
(prognoze) 

Iedzīvotāju 
izmaiņas 

(%) 

Ekonomiski 
aktīvie 

uzņēmumi 

Veselības 
aprūpes 
iestāžu 
skaits 

novadā 

Izglītības 
iestāžu 
skaits 

novadā 

Kultūras 
iestāžu 
skaits 

novadā 

Rangs 

Saldus novads 24820 -11.1% 2757 0 18 46 23.11 

Saulkrastu novads 3868 -54.3% 788 1 5 14 -13.74 

Siguldas novads 27660 -7.4% 2672 1 16 29 24.65 

Smiltenes novads 19374 4.0% 1767 1 12 35 28.50 

Talsu novads 34899 -4.3% 3067 1 24 61 41.23 

Tukuma novads 43708 -3.3% 3641 0 38 59 42.97 

Valkas novads 8013 1.3% 611 1 4 14 14.24 

Valmieras novads 47269 -9.6% 4839 2 33 71 54.66 

Ventspils 30603 -10.0% 2435 2 21 21 28.52 

Ventspils novads 11488 -0.3% 887 0 9 23 13.55 

Maksimālā vērtība 583605  77053 18 262 232  

Svara koeficients 1.00 0.50 0.75 1.00 1.00 0.75  

Avots: PwC un CSE COE pētījums. 

Izveidoto ranžējumu var izmantot, nosakot teritorijas, kurās prioritāri uzsākt interneta pieejamības 
uzlabošanu valsta atbalsta īstenošanas scenārijos. 
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6. Pieejas scenāriji valsts intervences 
noteikšanai VHCN tīklu izvēršanā 
un nepieciešamās investīcijas 

Darba uzdevuma mērķis ir, pamatojoties uz apkopotajiem datiem un kartogrāfisko materiālu, 
sagatavot pieejas scenāriju aprakstu, kurā noteikti valsts intervences noteikšanas principi VHCN 
tīklu izvēršanā, lai veicinātu Savienojamības paziņojumā noteikto mērķu izpildi, ņemot vērā fiksēto 
un mobilo sakaru tehnoloģiju pieejamību, to attīstības tendences, apdzīvotības blīvumu, kā arī 
valsts atbalsta programmas Nr.SA.33324 “Nākamās paaudzes tīkli lauku teritorijās” (turpmāk – 
VAP Nr.SA.33324) īstenošanas rezultātā izveidoto platjoslas infrastruktūru.   

Pieejas scenāriji: 

- valsts atbalsta finansējuma optimālākā izmantošana VHCN infrastruktūras izvēršanai, lai 
nodrošinātu vislielāko atdevi sasniegto mājsaimniecību un/vai sociālekonomisko virzītājspēku 
skaita ziņā;  

- valsts atbalsta finansējuma optimālākā izmantošana VHCN infrastruktūras izvēršanai, lai 
nodrošinātu pārklājumu iespējami vairāk teritorijās, kurās nav nodrošināta optiskā tīkla 
infrastruktūra VAP Nr.SA.33324 ietvaros. 

Pamatojoties uz izveidotajiem pieejas scenārijiem, veikt novērtējumu par investīciju 
nepietiekamību konkrētās teritorijās/objektos, lai nodrošinātu piekļuvi ļoti augstas veiktspējas 
(VHCN) tīkliem 

 

6.1. Izejas situācija valsts intervences noteikšanai VHCN tīklu 
izvēršanā 

Pētījuma ietvaros veiktā analīze rāda būtiskas Latvijas VHCN platjoslas pakalpojumu tirgus nepilnības, 
kā arī būtisku nevienlīdzību, kas kavē platjoslas tīklu pakalpojumu pieejamību. Šajā sadaļā iekļauta 
informācija par tirgus nepilnībām un pārskats par platjoslas tīklu pieejamību un atbalsta pasākumu 
mērķteritorijām. 

Platjoslas tīkla pārklājuma esošais līmenis pilsētās un laukos 

Atbilstoši pētījuma datiem, platjoslas fiksētie VHCN pakalpojumi ar datu lejupielādes ātrumu vismaz 
30 Mbps ir pieejami apmēram 9.34% valsts teritoriju, taču tajās dzīvo 84.1% valsts iedzīvotāju.   

VHCN tīkli ar simetrisku ātrumu vismaz 100Mbps, savukārt, pieejami tikai apmēram 1.6% valsts 
teritoriju (lielajās pilsētās un apdzīvotajās vietās), taču tajās dzīvo 70.1% iedzīvotāju.  

Tā kā šīs relatīvi nelielās teritorijas, kur VHCN pakalpojumi ir pieejami, ir pilsētas un lielās apdzīvotās 
vietas, valstī ir ļoti lielas pilsētu/lauku atšķirības platjoslas tīklu pārklājuma ziņā. Šī situācija nav 
apmierinoša un ir jāuzlabo, lai gan tā ir objektīvi saistīta ar zemu iedzīvotāju vidējo blīvumu valstī, 
vēsturiski lielu iedzīvotāju koncentrāciju Rīgas areālā un reģionālajos centros, kā arī ar aktīvu migrāciju 
no lauku teritorijām uz šiem centriem vai uz ārvalstīm. 
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Lai novērstu tirgus nepilnību, kas saistīta ar zemu iedzīvotāju blīvumu lielā daļā valsts teritorijas, kas 
nepieļauj pietiekami ātru VHCN platjoslas tīklu izvēršanas investīciju atmaksāšanos, nepieciešams 
valsts atbalsts šādu platjoslas tīklu izvēršanai teritorijās, kur tie nav pieejami. 

Pētījuma dati un veiktā analīze rāda, ka mobilie tīkli ir pieejami apmēram 90% valsts teritoriju un tajās 
dzīvo apmēram 97.7% valsts iedzīvotāju. Praktisko mobilā tīkla ātrdarbību var novērtēt, balstoties uz 
SPRK regulāri veiktajiem mērījumiem. Atbilstoši SPRK 2019. gada mērījumiem49, pieslēguma ātruma 
vidējās vērtības 95% mērījumu 4G datu pārraides tehnoloģijā 2019.gadā Latvijā bija 36.6 Mbps 
lejupielādei un 19.15 Mbps augšupielādei. Tādējādi var uzskatīt, ka valstī ir nodrošināts labs mobilā 
interneta pārklājums ar vidējo ātrumu ap 30 Mbps. Taču vienlaicīgi jānorāda, ka lejupielādes ātrums 
virs 30 Mbps ir bijis tikai 64% no mērījumu, kas veikti dažādās vietās valstī. SPRK atzīmē, ka, lai gan 
kopumā pakalpojuma pieejamība valstī ir laba, tomēr atsevišķos mērījumos novērotas augšupielādes 
ātruma vērtības, kas ir zemākas pat par 256 Kbps, un šādās teritorijās pakalpojuma pieejamība var 
būt būtiski traucēta.  

Lai novērstu tirgus nepilnību, kas saistīta ar iedzīvotāju neesamību vai ļoti zemu to blīvumu nelielā daļā 
valsts teritorijas, kur mobilie operatori nav ieinteresēti piedāvāt savus pakalpojumus, nepieciešams 
valsts atbalsts pamata vai VHCN platjoslas tīklu izvēršanai šajās teritorijās, tā nodrošinot mobilā tīkla 
pārklājumu visā valsts teritorijā. 

Platjoslas pakalpojumu pieejamības sadalījums pa tehnoloģijām 

Fiksēto platjoslas pakalpojumu jomā Latvijā ir liels VHCN pieslēgumu īpatsvars - 80% pieslēgumu 
nodrošina ātrumus virs 30Mbps un 70% ir optiskie VHCN pieslēgumi, kas nodrošina simetriskus 
lejupielādes un augšupielādes ātrumus virs 100Mbps. VHCN tīklos, kas nodrošina pakalpojumus ar 
ātrumiem starp 30 un 100 Mbps, šobrīd tiek izmantotas dažādas vadu (telefona kabeļi (DSL, VDSL), 
koaksiālie kabeļi (DOCSIS), Ethernet tīkli) un radio tehnoloģijas, kas pakāpeniski tiek aizvietotas ar 
optiku, tā pārejot uz VHCN. 

Mobilie platjoslas pakalpojumi praktiski visur valstī tiek nodrošināti, izmantojot 4G tehnoloģijas.   

Galvenās tendences platjoslas tīklu tirgū 

Galvenā tendence fiksētās platjoslas tirgū ir VHCN optisko tīklu, kas nodrošina  simetriskus ātrumus 
no 100Mbps līdz pat 1 Gbps (atkarībā no klienta vajadzībām) pieejamības palielināšanās.  

Vērojama operatoru investīciju nepietiekamība VHCN tīklu izvēršanai, lai sasniegtu ES gigabitu 
savienojamības mērķus, jo biezi apdzīvotajās teritorijās šie tīkli ir izvērsti un turpmākās investīcijas 
jāveic teritorijās, kur nav sagaidāma ātra to atmaksāšanās. Tam būtu nepieciešams valsts atbalsts. 

Attiecībā uz mobilās platjoslas tirgu var atzīmēt, ka praktiski pilnībā ir notikusi pāreja uz 4G tīkliem 
(tikai 10 no visu 3 mobilo operatoru apmērām 3000 bāzes stacijām nenodrošina 4G). Tādējādi 
apmēram 90% valsts teritorijas ir pieejams 4G mobilais tīkls ar teorētisko lejupielādes ātrumu līdz 
100Mbps (bāzes staciju tiešā tuvumā, ja bāzes staciju izmanto neliels abonentu skaits). Kā jau minēts, 
lejupielādes ātrums virs 30Mbps ir bijis tikai 64% mērījumu dažādās valsts daļās dažādos laikos. 

Platjoslas pakalpojumu mazumtirdzniecības cenas 

Tā kā visi 3 valsts mobilo sakaru operatori savus pakalpojumus piedāvā visā valstī, to  cenas visur ir 
vienādas. Operatoru konkurence nodrošina gala lietotājiem pieejamas cenas, kas sākas no apmēram 
10 EUR mēnesī un iekļauj interneta pieeju ar vidējo ātrumu ap 30Mbps. 

Arī fiksēto platjoslas pakalpojumu mazumtirdzniecības cenas dažādās vietās valstī, kur šādi 
pakalpojumi ir pieejami, ir ļoti tuvas, jo lielākais pakalpojumu sniedzējs Tet piedāvā savus 
pakalpojumus par vienādām cenām visā valstī, un pārējiem tirgus spēlētājiem ir jākonkurē ar līdzīgām 
cenām. Šīs cenas sākas no apmēram 15 EUR mēnesī par pakalpojumu ar simetrisku 100Mbps ātrumu. 

                                                
49https://www.sprk.gov.lv/sites/default/files/editor/ESPD/Faili/Parskati/KVALITATESPARSKATS2019.pdf  
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Te jāņem vērā, ka fiksētie platjoslas pakalpojumi ar ātrumu virs 100Mbps reāli ir pieejami tikai pilsētās 
un lielākās apdzīvotās vietās. 

Taču jaunu optisko tīklu pieslēgumu ierīkošana mazās apdzīvotās vietās individuāliem klientiem tālu 
no vidējās jūdzes tīklu pieslēguma punktiem prasa lielas investīcijas. Lai tās veiktu, pakalpojumu 
sniedzēji bieži prasa klientu līdzdalību, tāpēc efektīvās VHCN platjoslas pakalpojumu izmaksas 
mazstāvu apbūves teritorijās un mazās apdzīvotās vietās var būt augstas un bieži nepieejamas. 

Kopumā var teikt, ka tirgus nepilnība valstī nav saistīta ar dažādām platjoslas pakalpojumu 
mazumtirdzniecības cenām teritorijās ar dažādu konkurētspēju, bet gan ar pieejamajiem 
tehnoloģiskajiem risinājumiem un infrastruktūru platjoslas tīklu attīstībai un savienojamības 
pakalpojumu sniegšanai. 

Vērojama operatoru investīciju nepietiekamība, lai  varētu turpināt nodrošināt VHCN tīklus aizvien 
plašākai iedzīvotāju daļai arī mazāk apdzīvotās teritorijās par tādām pašām cenām kā blīvāk apdzīvotās 
teritorijās. Tam būtu nepieciešams valsts atbalsts. 

Pieejamie tehnoloģiskie risinājumi platjoslas tīklu attīstībai 

Par nozīmīgu nākotnes tehnoloģisko risinājumu platjoslas VHCN tīklu attīstībai un savienojamības 
pakalpojumu sniegšanai valstī būtu jāuzskata optisko tīklu izvēršana, kas nodrošina simetriskus 
ātrumus, sākot no 100Mbps, ar iespēju tos uzlabot līdz 1Gbps.  

Tuvākā nākotnē par vēl vienu VHCN tīklu tehnoloģisko risinājumu varēs uzskatīt 5G mobilo tīklu izbūvi. 
Taču garantētā ātruma nodrošināšana mobilajos tīklos, arī 5G tīklos, kur tīkla šūnas ietvaros lietotāji 
izmanto vienu un to pašu frekvenču diapazonu, prasīs ļoti daudzu bāzes staciju blīvu izvietošanu. 

Tā kā mobilie tīkli valstī pārklāj apmēram 90% teritorijas, šo pārklājumu nepieciešams uzlabot. Šim 
nolūkam atbilstošs tehnoloģiskais risinājums ir 4G tīklu (vai 5G tīklu zemajā frekvenču diapazonā) 
izvēršana, lai nodrošinātu mobilo platjoslas pakalpojumu pieejamību visā valstī. 

Veicot platjoslas pakalpojumu pieejamības uzlabošanu valstī, būtiski ir izmantot “vidējās jūdzes” tīklu 
un pieslēguma punktus, kas tika izbūvēti projekta "Nākamās paaudzes elektronisko sakaru tīkla 
attīstība lauku reģionos" (izbūvēti 177 piekļuves punkti un ieguldīti 1813km optiskā kabeļa) un šobrīd 
tiek izbūvēti projekta "Elektroniskās sakaru infrastruktūras pieejamības uzlabošana lauku teritorijās" 
(paredzēts izbūvēt vismaz 220 piekļuves punktus) ietvaros. Atbilstoši pētījuma izpildes laikā saņemtajai 
informācijai, no izbūvētā optiskā tīkla apmēram 4 000 km garumā šobrīd tiek izmantoti tikai apmēram 
2 000 km un no uzbūvētajiem 401 tīkla piekļuves punktiem pakalpojumu nodrošināšanai tiek izmantoti 
tikai 43 piekļuves punkti. 

Lai novērstu tirgus nepilnības (investīciju trūkums “pēdējās jūdzes” izbūvei līdz gala lietotājam, lokālu 
komersantu neesamība), kuru dēļ pietiekamā mērā netiek izmantots valstī izbūvētais “vidējās jūdzes” 
tīkls, ir nepieciešams papildus valsts atbalsts. 

Konkurences situācija elektroniskās komunikācijas tirgos 

Fiksēto platjoslas pakalpojumu jomā valstī notiek tirgus koncentrācija 4-5 lielāko spēlētāju jomā (Tet, 
Baltcom, Balticom, Dautkom), jo mazajiem uzņēmumiem nepietiek investīciju optisko tīklu izbūvei.  

Valsts atbalsts infrastruktūras izbūvei ļautu atdzīvināt konkurenci fiksēto VHCN pakalpojumu tirgū.  

Mobilo 4G platjoslas pakalpojumu sektorā valstī kopumā valda veselīga konkurence. Taču operatori ir 
izbūvējuši savas neatkarīgas tehniskās infrastruktūras. Daļēja infrastruktūras kopēja izmantošana būtu 
ietaupījusi investīciju kapitālu 5G tīklu izvēršanai un, iespējams, palīdzējusi nodrošināt zemākas 
pakalpojumu cenas gala lietotājiem. 

Attiecībā uz 5G tīklu izbūvi kopēja tehniskās infrastruktūras izbūve būtu izdevīga gan pašiem 
komersantiem, gan klientiem, gan arī valstij kopumā, tāpēc šis tirgus būtu jāregulē, nodefinējot spēles 
noteikumus, kas liek visiem operatoriem kooperēties, neatkarīgi no to īpašnieku sastāva.  
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Viens no risinājumiem varētu būt valsts atbalsts kopīgas 5G tehniskās infrastruktūras izbūvei (optiskie 
tīkli un torņi, atsevišķos gadījumos pat kopīgi izmantojamas 5G bāzes stacijas), kas ļautu ātri nodrošināt 
5G VHCN tīklu pieejamību, samazinātu izmaksas, nodrošinātu pieejamas cenas un ļautu operatoriem 
konkurēt, piedāvājot dažādus pakalpojumus, izmantojot kopīgu infrastruktūru. 

 

 

 

Sagaidāmie saimnieciskie un sociālie ieguvumi no atbalsta pasākumiem 

Realizējot plānotos valsts atbalsta pasākumus, tiktu radīta platjoslas tīklu infrastruktūra, kura nodrošina 
VHCN tīklu pieejamību gala lietotājiem – sociāli ekonomiskajiem virzītājspēkiem, uzņēmumiem un 
iedzīvotājiem. Jaunās interaktīvās komunikāciju iespējas (ieskaitot video sarunas) būtu sociāls 
ieguvums. 

Interneta pieejamības uzlabošana noteiktās teritorijās ar valsts atbalsta palīdzību, dos iespējas 
uzņēmumiem piedāvāt jaunus inovatīvus pakalpojumus, tiks veicinātas attālināta darba iespējas, kā 
arī tiks veicināta teritorijas attīstību, vairāk iedzīvotājiem izvēloties dzīvot šajās teritorijās. 

Ātrgaitas tīklu pieejamība dos iespējas iedzīvotājiem izmantot tiešsaistes pakalpojumus un saņemt 
pakalpojumus no valsts un pašvaldību iestādēm, kā arī mācīties attālināti. 

Interneta pieejamības uzlabošana sociālekonomiskajiem virzītājspēkiem palīdzēs nodrošināt 
iedzīvotājiem labākus pakalpojumus, piemēram, izglītības, veselības kultūras, kā arī veicinās 
ekonomisko izaugsmi.  

Atbalsta pasākumi nodrošinātu arī infrastruktūru mobilo tīklu izveidei teritorijās, kur to pārklājums 
šobrīd ir nepietiekams. Tas nodrošinātu mobilos sakarus un interneta pieejamību, sniedzot augstāk 
minētos ieguvumus vismaz ierobežotā apjomā. 

ES finansētie projekti interneta piekļuves nodrošināšanai  

Līdz šim Latvijā, izmantojot ES fondu līdzekļus50, ir īstenots publiski pārvaldīta tīkla modelis, LVRTC 
veicot investīcijas vidējās jūdzes infrastruktūrā, vadot un tieši kontrolējot to ierīkošanu. LVRTC 
nodrošina izveidotās vidējās jūdzes infrastruktūras pieejamību interneta piekļuves pakalpojumu 
sniegšanas operatoriem. Lielākais izaicinājums attiecībā uz esošo sistēmu ir zemā izveidotās vidējās 
jūdzes infrastruktūras izmantošana. Izmantošanas tarifs 12 EUR / km, kā arī tiek piemērotas dažādas 
atlaides. Daudzos gadījumos izveidotā infrastruktūra nav pievienota mobilo sakaru torņiem (saskaņā 
ar interviju gaitā iegūto informāciju, projekta 2. kārtas ietvaros tiek nodrošināta efektīvāka 
savietojamība ar mobilo sakaru torņiem).  

 

6.2. Pārskats par piedāvātajiem pieejas scenārijiem valsts 
intervences noteikšanai VHCN tīklu izvēršanā 

Pētījuma ietvaros ir izstrādāts viens pieejas scenārijs NG platjoslas tīklu izvēršanai baltajās teritorijas, 
kur nav tīkla ar piekļuves ātrumu vismaz 30 Mbps, trīs scenāriji NG platjoslas tīklu izvēršanai  VHCN 
baltajās teritorijas, kur nav tīkla ar piekļuves ātrumu vismaz 100 Mbps, kā arī 2 scenāriji 5G interneta 
pieejas nodrošināšanai transporta koridoros. Šajā sadaļā aprakstīti izmantotie piekļuves modeļi, kā arī 
dots pārskats par sagaidāmajiem rezultatīvajiem rādītājiem. 

                                                
50 https://likumi.lv/ta/id/278331-darbibas-programmas-izaugsme-un-nodarbinatiba-2-1-1-specifiska-atbalsta-merka-uzlabot-
elektroniskas-sakaru-infrastrukturas 
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Izstrādātie pieejas scenāriji detalizēti aprakstīti nākamajās ziņojuma sadaļās, iekļaujot tur arī 
nepieciešamo investīciju aprēķinu rezultātus. Pilni investīciju aprēķini visiem izstrādātajiem pieejas 
scenārijiem sniegti 11. – 16. pielikumā. 

Projekta ietvaros veikts nepieciešamo investīciju aprēķini balstīti uz daudziem pieņēmumiem, kas var 
mainīties, jo ir saistīti ar tehnoloģiju tālāku attīstību un operatoru pakalpojumu un tirgus attīstības 
pieeju. Piemēram, nepieciešamās infrastruktūras izmaksas, kas var mainīties tālāk attīstoties 
tehnoloģijām, nepieciešamajiem jauniem mobilo sakaru torņiem, kas var mainīties, ņemot vērā mobilo 
sakaru operatoru tīklu attīstības stratēģijas, kā arī no ieņēmumiem no pakalpojumiem, kas var mainīties 
atkarībā no mobilo sakaru operatoru pakalpojumu sniegšanas stratēģijas. Tāpat, piemēram, ikgadējie 
uzturēšanas izdevumi 1% vai 3% gadā no veiktajām investīcijām ir projekta ekspertu vērtējums.  

Tādēļ ziņojumā iekļautie aprēķini ir uzskatāmi tikai par indikatīviem un var būtiski mainīties atkarībā no 
tirgus dalībnieku izvēlētajām stratēģijām, tālāk attīstot interneta pakalpojumu pieejamību.  

Iekļautie aprēķini izmantojami kā izmaksu kategorijas, kuras būtu analizējamas pirms lēmuma 
pieņemšanas, pārskatot tajā brīdī pieņēmumus un veicot atkārtotus aprēķinus ar ziņojumā aprakstīto 
metodoloģiju. 
 

Scenāriji ieguldījumiem interneta pakalpojumu pieejamības nodrošināšanai 

Scenāriju izstrāde balstīta uz Rokasgrāmatā par ieguldījumiem ātrdarbīgu platjoslas sakaru tīklu 
attīstībā51 (Rokasgrāmata) noteiktajiem izveides modeļiem, intervijām ar lielākajiem interneta pieejas 
pakalpojumu nodrošinātājiem, piemēram, Tet, LMT, TELE2; nozares asociācijām, piemēram, Latvijas 
interneta asociācija un vidējās jūdzes infrastruktūras nodrošinātāju LVRTC. 

Saskaņā ar Rokasgrāmatu ir šādi interneta piekļuves izveides modeļi: 
 

➢ Publiski pārvaldīta tīkla modelis. Publiskā iestāde vada un tieši kontrolē tīkla ierīkošanu.  

➢ Privāti pārvaldīta tīkla modelis. Publiskā iestāde rīko iepirkumu un uztic tīkla izveidi un 
ekspluatāciju privātam uzņēmējam. 

➢ Kopienas tīkla modelis. Kopienas tīkla modeļa gadījumā ieguldījumus sakaru tīkla attīstībā 
privātas iniciatīvas ietvaros veic vietējie iedzīvotāji. 

➢ Operatora subsidēšanas tīkla modelis. Publiskā iestāde nolemj tieši neiesaistīties tīkla 
pārklājuma nodrošināšanā un tikai piešķir subsīdijas vienam tirgus dalībniekam tā 
infrastruktūras modernizācijai. 

Plānojot nākotnes iniciatīvas, var tikt izmantoti dažādi scenāriji, esošo publiski pārvaldīta tīkla modeli 
kombinējot ar citiem modeļiem, bet skaidri norādot izveidotās infrastruktūras īpašniekus un uzturētājus, 
kā arī to, vai investīcijas tiek veiktas vidējā vai pēdējā jūdzē. 

Zemāk piedāvāti dažādi attīstības scenāriji, ņemot vērā Rokasgrāmatā aprakstītos izveides principus, 
izņemot kopienas tīkla modeli, jo ņemot vērā iedzīvotāju zemo pirktspēju, kā arī projekta mērķi 
nodrošināt interneta piekļuvi baltajās teritorijās, kur ir mazs iedzīvotāju blīvums, kopienas platjoslas 
modeļa attīstība netiek izvērtēta.    

Piedāvāto scenāriju mērķis ir uzlabot interneta pieejamību baltajās teritorijās. Interneta pieejamība var 
tikt nodrošināta, izmantojot mobilo operatoru pakalpojumus (mobilais internets) vai optiskā kabeļa 
pieslēgumu, tādēļ katram no piedāvātajiem scenārijiem norādīts, kāda veida interneta pieejamība tiks 
uzlabota. Analizējot scenārijus, jāņem vērā, ka mobilā interneta pieejamība un kvalitāte ir atkarīga no 
vienlaicīgo lietotāju skaita un, ja jānodrošina garantēts ātrums valstij svarīgu funkciju nodrošināšanai, 
piemēram VUGD vajadzībām, tīklā jāveido virtuāls apakštīkls. Projekta ietvaros netiek analizēta šāda 
apakštīkla izveide. Scenāriju ietvaros nodefinēta garantētā interneta pieejamības ātruma noteikšanas 

                                                
51 https://ec.europa.eu/newsroom/dae/document.cfm?doc_id=12891 
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metodoloģija, ieskaitot noteikta ātruma pieejamības minimālo īpatsvaru diennakts laikā, kas var būt 
mazāks par 100%. 

Investīcijas var tikt veiktas vidējā jūdzē un pēdējā jūdzē, tāpēc katram no scenārijiem norādīts 
investīciju veids. Paralēli interneta pieejamības attīstībai baltajās teritorijās analizēta 5G koridoru 
attīstība – Rail Baltica (dzelzceļa maģistrāle) un Via Baltica (autotransporta maģistrāle).  

Plānojot investīcijas interneta pieejamībai, būtu īstenojami dažādi papildus pasākumi, lai nodrošinātu 
veikto investīciju pēc iespējas lielāku atdevi un publiskā finansējuma efektīvu izmantošanu: 

➢ Valsts un pašvaldību kapitālsabiedrībām uzlabojot vai būvējot jaunu publisko infrastruktūru 
(ceļu apgaismojumu, ūdensvadu, gāzes vadu, elektrotīklu, ielu un ceļu izbūves vai kapitālo 
remontu gadījumos), to jāapvieno ar optiskā tīkla infrastruktūras izveidi, veicot kopīgus 
investīciju projektus, lai samazinātu nepieciešamās izmaksas.  

➢ Samazināt administratīvo slogu optiskā tīkla infrastruktūras ierīkošanai, atvieglojot un paātrinot 
nepieciešamās dokumentācijas sagatavošanu. 

Scenāriju rezultatīvie rādītāji 

Scenāriju rezultatīvie rādītāji ir noteikti, ņemot vērā plānoto investīciju finansējuma –ES fondu 2021.-
2027.gada plānošanas perioda regulu projektos noteiktos rādītājus, kas attiecas uz mājsaimniecībām 
un uzņēmumiem. Rezultatīvo rādītāju aprēķini veikti, izmantojot 5.2 sadaļā aprakstīto metodoloģiju. 
Pārskats par aprēķinātajiem visu scenāriju rezultatīviem rādītājiem dots Tabulā 9. 
 

Tabula 9. Rezultatīvo rādītāju kopsavilkums katram scenārijam 

  RCO 41 RCO 42 RCR 53 RCR 54 

Sce- 
nāriji 

Teritorijas apraksts, kurā 
VHCN pieejams 2020.gadā 
un plānots 2027.gadā 

Papildu 
mājsaimniecības 
ar piekļuvi ļoti 
augstas 
veiktspējas 
platjoslai – 
mājsaimniecību 
skaits 

Papildu 
uzņēmumi ar 
piekļuvi ļoti 
lielas 
veiktspējas 
platjoslas 
pakalpojumiem 
– uzņēmumu 
skaits  

Mājsaimniecības, 
kuras abonē 
platjoslas 
pieslēgumus ļoti 
lielas veiktspējas 
tīklam - 
mājsaimniecību 
skaits 

Uzņēmumi, kas 
abonē platjoslas 
pieslēgumus ļoti 
lielas veiktspējas 
tīklam – 
uzņēmumu 
skaits  

  (tūkst.) (tūkst.) (tūkst.) (tūkst.) 

1 Mobilie sakari un fiksētie 
pieslēgumi platjoslai 
2020.gadā + 
jaunie torņi baltajās teritorijās 
(vismaz 30Mbps) 2027.gadā 

8.6 
(2020.g – 839.0 

2027.g. – 847.6) 

0.8 
(2020.g – 177.3 

2027.g. – 178.1) 

4.3 
(2020.g – 419.5 

2027.g. – 423.8) 

0.4 
(2020.g – 88.7 

2027.g. – 89.1) 

2 optiskie pieslēgumi 2020.gadā 
+ optiskie pieslēgumi soc. 
ekon. virzītājspēkiem 
2027.gadā +  
mājsaimniecības un 
uzņēmumi 1 km ap soc. 
ekonom. virzītājspēkiem 
2027.gadā 

128.4 
(2020.g – 591.9 

2027.g. – 720.3) 

50.6 
(2020.g – 96.4 

2027.g. – 147.0) 

64.2 
(2020.g – 296.0 

2027.g. – 360.2) 

25.3 
(2020.g – 48.2 

2027.g. – 73.5) 

3 optiskie pieslēgumi 2020.gadā 
+ uzlaboti 2020.gada mobilie 
sakari no 4G uz 5G +  
daļa fiksēto pieslēgumu (kam 
2027.gadā būs piekļuve 
optikai) 

251.1 
(2020.g – 591.9 

2027.g. – 843.0) 

89.8 
(2020.g – 96.4 

2027.g. – 186.2) 

125.5 
(2020.g – 296.0 

2027.g. – 421.5) 

44.9 
(2020.g – 48.2 

2027.g. – 93.1) 
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  RCO 41 RCO 42 RCR 53 RCR 54 

Sce- 
nāriji 

Teritorijas apraksts, kurā 
VHCN pieejams 2020.gadā 
un plānots 2027.gadā 

Papildu 
mājsaimniecības 
ar piekļuvi ļoti 
augstas 
veiktspējas 
platjoslai – 
mājsaimniecību 
skaits 

Papildu 
uzņēmumi ar 
piekļuvi ļoti 
lielas 
veiktspējas 
platjoslas 
pakalpojumiem 
– uzņēmumu 
skaits  

Mājsaimniecības, 
kuras abonē 
platjoslas 
pieslēgumus ļoti 
lielas veiktspējas 
tīklam - 
mājsaimniecību 
skaits 

Uzņēmumi, kas 
abonē platjoslas 
pieslēgumus ļoti 
lielas veiktspējas 
tīklam – 
uzņēmumu 
skaits  

  (tūkst.) (tūkst.) (tūkst.) (tūkst.) 

4 optiskie pieslēgumi 2020.gadā 
+ visi fiksētie pieslēgumi (kam 
2027.gadā būs piekļuve 
optiskai) 

130.9 
(2020.g – 591.9 

2027.g. – 722.8) 

45.0 
(2020.g – 96.4 

2027.g. – 141.4) 

65.4 
(2020.g – 296.0 

2027.g. – 361.4) 

22.5 
(2020.g – 48.2 

2027.g. – 70.7). 

5 optiskie pieslēgumi 2020.gadā 
Via Baltica 4km koridorā + 5G 
tīkls visā Via Baltica koridorā 

17.6 
(2020.g – 0.0 

2027.g. – 17.6) 

7.1 
(2020.g – 0.0 

2027.g. – 7.1) 

8.8 
(2020.g – 0.0 

2027.g. – 8.8) 

3.5 
(2020.g – 0.0 

2027.g. – 3.5) 

6 optiskie pieslēgumi 2020.gadā 
Rail Baltica 4km koridorā + 5G 
tīkls visā Rail Baltica koridorā 

16.8 
(2020.g – 0.0 

2027.g. – 16.8) 

7.3 
(2020.g – 0.0 

2027.g. – 7.3) 

8.4 
(2020.g – 0.0 

2027.g. – 8.4) 

3.7 
(2020.g – 0.0 

2027.g. – 3.7) 

Avots: PwC un CSE COE pētījums. 

 

2019. gadā 99 % uzņēmumu un 85,4 % mājsaimniecību bija pieejams internets. (Avots: CSP, 2020 
https://www.csb.gov.lv/en/press_release/2832). Tajā pat laikā Eiropas Komisijas darba dokumentā 
SWD(2020) 111 final “Digital Economy and Society Index (DESI) 2020”52 norādīti dati, ka: 

1) fiksētai platjoslai kopējais izmantošanas līmenis (take-up) Latvijā ir 64% un 

2) platjoslai līdz 100Mbps izmantošanas līmenis ir tikai 38% (nenodalot fiksēto piekļuvi no mobilās). 

Rezultatīvo rādītājus RCR 53 un RCR 54 aprēķinam līdz ar to tiek pieņemts, ka piekļuvi ļoti lielas 
veiktspējas platjoslas pakalpojumiem 2027.gadā izmantos 50% no mājsaimniecībām un uzņēmumiem, 
kam šādi pakalpojumi būs pieejami. 

 

6.3. Scenārijs Nr.1. – Publiski pārvaldīta tīkla modelis – vidējā jūdze 

1. scenārija mērķis ir izveidot infrastruktūru interneta pieejas pakalpojumu nodrošināšanai teritorijās, 
kur šobrīd nav tīkla ar piekļuves ātrumu vismaz 30 Mbps.  

1.scenārija gadījumā pieņemts, ka VHCN ar piekļuves ātrumu vismaz 30Mbps pieejamība 2020.gadā 
ir teritorijās, kurās ir pieeja platjoslas optikai (datu slānī Grid_lv_1k_teritorijas atribūts OPTI > 0) un 
kurās ir pieejami mobilie sakari (datu slānī Grid_lv_1k_teritorijas atribūts MOBI = 1). 2027.gadā VHCN 
ar piekļuves ātrumu vismaz 30Mbps pieejamība plānota papildus arī baltajās teritorijās, kur tiks 
uzbūvēti jaunie mobilo sakaru torņi (skat. attēlu tālāk tekstā). 

Attēls 23. 1.scenārija ietekmētās teritorijas 

 

                                                
52 https://ec.europa.eu/transparency/regdoc/rep/10102/2020/EN/SWD-2020-111-F1-EN-MAIN-PART-5.PDF 

https://www.csb.gov.lv/en/press_release/2832
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Avots: PwC un CSE COE pētījums. 

 

Parametri Apraksts 

Plānotās investīcijas apraksts Investīcijas esošās vidējās jūdzes infrastruktūras savienošanā ar mobilo 
sakaru komersantu torņiem, kā arī jaunu mobilo sakaru torņu būvniecība 
pie esošās vidējās jūdzes infrastruktūras. 

Mobilo sakaru torņi tiek pieslēgti LVRTC vidējās jūdzes tīklam – optikai. 
Projekta ietvaros jāfinansē arī optiskā tīkla izveide no esošā LVRTC 
vidējās jūdzes tīkla līdz jaunuzbūvētajam mobilo sakaru tornim. Tiek 
pieņemts, ka līdz katram jaunuzbūvētajam mobilo sakaru tornim ir vidēji 
jāaizvelk optika 9 km garumā jeb 200 torņiem 1 800 km optika. 

Ieteicams bāzes stacijas izvietot pēc iespējas tuvāk sociālekonomiskajiem 
virzītājspēkiem vai ceļiem, lai nodrošinātu pēc iespējas labāku interneta 
savienojumu sociālekonomiskajiem virzītājspēkiem, kā arī pēc iespējas 
atbalstītu autonomās transporta vadības iespējas. Precīzs bāzes staciju 
izvietojums nosakāms pēc kopējo investīciju apstiprināšanas. 

Investīciju mērķa joma Vidējā jūdze 

Veikto investīciju īpašnieks Valsts vai valsts kapitālsabiedrība 

Projekta īstenotājs Publiska iestāde, piemēram, LVRTC 

Metodoloģija iznākuma 
rādītāju vērtību noteikšanai 

Metodoloģija iznākuma rādītāju vērtību noteikšanai aprakstīta ziņojuma 
5.sadaļā. 

Iznākuma rādītāji 
Zemāk uzrādīti projekta iznākuma rādītāji. Rādītāju vērtību aprēķina 
metodoloģija iekļauta ziņojuma 5.2. sadaļā. 

Kods Apraksts 
Vērtība 
(tūkst.) 
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Parametri Apraksts 

RCO 41 
Papildu mājsaimniecības ar piekļuvi 
platjoslai – mājsaimniecību skaits 

8.6 

RCO 42 
Papildu uzņēmumi ar piekļuvi 
platjoslas pakalpojumiem – uzņēmumu 
skaits 

0.8 

RCR 53 
Mājsaimniecības, kuras abonē 
platjoslas pieslēgumus– 
mājsaimniecību skaits 

4.3 

RCR 54 
Uzņēmumi, kas abonē platjoslas 
pieslēgumus – uzņēmumu skaits 

0.4 
 

Pašvaldību iesaiste Pašvaldības nodrošina nepieciešamo atbalstu pie optiskā tīkla izveides, 
zemi un atļaujas jaunu mobilo operatoru sakaru torņu izbūvei 

Pieņēmumi un ierobežojumi Aprēķini tiek veikti pieņemot, ka 5G mobilā interneta pakalpojumi tiktu 
nodrošināti 650-800 Mhz frekvenču diapazonā. 

Investīcijas tiek plānotas tikai jaunu mobilo sakaru torņu izbūvei. 
Nepieciešami 200 jauni mobilo sakaru torņi.  

Bāzes stacijas izvietojamas VHCN baltajās teritorijās, bet 
nepieciešamības gadījumā, lai samazinātu projekta izmaksas bāzes 
stacijas izvietojams ārpus baltajām teritorijām, bet ar nosacījumu, ka tiek 
nodrošināta interneta piekļuve baltajām teritorijām  

Izbūvētās bāzes stacijas var tikt izmantotas 4G un 5G tīkliem 

Nepieciešamās investīcijas viena jauna mobilo sakaru torņa izbūvei ir 
apmēram 100 000 EUR 

Vidējās uzturēšanas izmaksas pēc projekta ekspertu vērtējuma var veidot 
3% gadā no veiktajām investīcijām (varētu būt atšķirīgas uzturēšanas 
izmaksas optikas tīklam un mobilo sakaru tornim). Uzturēšanas izmaksas 
nosedz mobilo sakaru operatori, jo viņi izmantos jaunuzbūvētos mobilo 
sakaru torņus 

Investīciju izmantošanas ilgums ir 20 gadi 

Optiskā tīkla izbūves izmaksas ir 30 EUR / m jeb 30 000 EUR par km 

Ieņēmumi tiek rēķinātu uz iedzīvotāju nevis mājsaimniecību, jo tiek 
pieņemts, ka katram iedzīvotājam ir savs mobilais telefons. Tiek pieņemts, 
ka maksa par mobilajiem pakalpojumiem ir 10 EUR mēnesī53, kā arī 
mobilo sakaru operatoram ir iespēja paplašināt sniegto pakalpojumu 
klāstu. Ieņēmumi tiek līdzīgi sadalīti uz visiem mobilo sakaru torņiem, jo 
nav zināms klientu skaits katram tornim kā arī cik un kādi mobilo sakaru 
operatori nodrošinātu pakalpojumus. 

Scenāriju analīze neietver situācijas aprakstu un finanšu aprēķinu 
gadījumos kad LVRTC optika tiek pievilkta pie esošiem mobilo sakaru 
torņiem, jo nav pieejama informācija par to kuriem mobilo sakaru torņiem 
šāda investīcija būtu nepieciešama. Kopumā Latvijā ir 3 341 mobilo 
sakaru torņi. Saskaņā ar intervijās sniegto informāciju pieslēgšanās 
optiskam tīklam varētu būt nepieciešama ¼ no visiem torņiem jeb 
apmēram 660 torņiem. Pieslēgšanās izmaksas var tikt aprēķinātas tikai 
tad, kas ir zināmi precīzi torņi un to attālums līdz optikai. 

                                                
53 Šobrīd visiem operatoriem mobilā telefona viena mēneša abonēšanas cena, kas ietver arī vismaz apjoma ziņā ierobežotu 
interneta pieejamību, sākas no 10€. 
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Parametri Apraksts 

Investīciju atdeve Kopsavilkums investīciju atdeves aprēķiniem: 

Vērtība Rādītājs apraksts 

€400,920.00 Kopējā ieņēmumi gadā, EUR 

€4,996,349.37 (1) Kopējie ieņēmumi 20 gados, EUR (Net 
Present Value ar 5% diskonta likmi)   

€88,000,000.00 (2) Kopējās investīcijas, EUR 
  

€2,640,000.00 Uzturēšanas izdevumi, EUR/gadā (3% no 
investīcijām) 

€32,900,235.30 (3) Kopējie uzturēšanas izdevumi 20 gados, 
EUR  (Net Present Value ar 5% diskonta likmi) 

-€115,903,885.93 (4) Investīciju atdeves aprēķini uz 20 gadiem: 
(4) = (1) – (2) – (3) 

Detalizēti aprēķini sniegti Pielikumā Nr.11 

 

Tehniskais risinājums 

Projekta ietvaros tiek izbūvēta jauna infrastruktūra, papildinot jau esošo vidējās jūdzes optisko tīklu. 
Investīcijas veic publiska iestāde un izveidotā infrastruktūra pieder publiskai iestādei. Var tikt veiktas 
šādas papildus investīcijas (abu veidu investīcijas vai tikai viena veida investīcija): 

➢ Ievilktas jaunas optiskās līnijas (vidējā jūdze) no esošā maģistrālā optiskā tīkla līdz mobilo 
sakaru komersantu torņiem baltajās teritorijās. Izveidotās jaunās optiskās līnijas pieder valsts 
kapitālsabiedrībai. Mobilo sakaru operatoram, kam pieder tornis, jānodrošina piekļuve 
pievilktajai optiskai līnijai arī citiem sakaru operatoriem. Jāņem vērā, ka katram mobilajam 
operatoram ir daudz mobilo sakaru torņu (apmēram  1000), kā arī mobilo sakaru operatori 
koordinē savā starpā infrastruktūras izmantošanu, un daudzi mobilo operatoru torņi jau ir 
pieslēgti maģistrālajiem optikas vadiem. 

➢ Tiek izbūvēti jauni mobilo sakaru torņi (koplietošanas torņi) pie jau esošā optiskā tīkla, kā arī 
veiktas investīcijas nepieciešamajā tehniskajā nodrošinājumā. Uzbūvētie jaunie mobilo sakaru 
torņi pieder valsts kapitālsabiedrībai un mobilo sakaru operatoriem ir iespēja nomāt piekļuvi 
mobilo sakaru tornim. Mobilo sakaru torņi var tikt izmantoti 4G un 5G datu pārraidei. 

Analizējot baltās teritorijas, būtu jānosaka cik daudziem mobilo sakaru operatoru torņiem nepieciešams 
pieslēgums optiskai līnijai, kā arī jāizvērtē jauno mobilo sakaru torņu nepieciešamība. Saskaņā ar 
intervijās sniegto informāciju būtu nepieciešams ar optiskajam tīklam pievienot apmēram 150 mobilo 
sakaru torņus, kā arī izbūvēt 180 jaunus mobilo sakaru torņus. 

Organizatoriskā pieeja 

Investīcijas infrastruktūrā veic publiska iestāde un izveidotā infrastruktūra pieder valstij vai valsts 
kapitālsabiedrībai. Torņu izbūvei var izvēlēties valstij vai pašvaldībai piederošas zemes. 

Stiprās puses Vājās puses 

Uzlabota mobilo sakaru pieejamības 
kvalitāte un ātrums  

Interneta pieejamība tiek nodrošināta, izmantojot 
mobilos sakarus, kas ne vienmēr var nodrošināt 
nepieciešamo ātrumu, piemēram 100 Mbit/s 

Stratēģiski svarīga interneta pieejamības 
infrastruktūra pieder valstij 

Netiek nodrošināts nepieciešamais ātrums 100 
Mbit/s 
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Stiprās puses Vājās puses 

Izveidota koplietošanas infrastruktūra, ko 
var izmantot dažādi mobilo sakaru operatori 

Jaunu mobilo sakaru torņu celtniecība ir sarežģīts 
process, kas saistīts ar nepieciešamās zemes 
pirkšanu vai nomu, atļauju saņemšanu 

Nodrošināta konkurence operatoru starpā 
(visiem vienādi infrastruktūras 
izmantošanas nosacījumi) 

Mobiliem operatoriem nav aktīva sadarbība 
attiecībā uz mobilo sakaru torņu kopīgu 
izmantošanu, jo ir dažādas mobilo sakaru torņu  
būvniecības pieejas, kas ietekmē tālākās 
koplietošanas iespējas. Piemēram, pirkt vai 
nomāt zemi, kas nepieciešama mobilo operatoru 
torņu būvniecībai. Zemes nomas gadījumā, arī 
citiem mobilo sakaru operatoriem varētu būt 
nepieciešams slēgt zemes nomas līgumu, kas 
varētu būt sarežģīti, ja iznomātājs ir valsts vai 
pašvaldību institūcija (jārīko konkurss). 

Jaunie izbūvētie mobilo sakaru torņi var tikt 
izmantoti arī 5G pakalpojumu 
nodrošināšanai 

Valstij būs jānodrošina izveidotās infrastruktūras 
uzturēšana 

Vidējās jūdzes infrastruktūras izbūve var tikt 
stratēģiski plānota no valsts puses 

 

Ir līdzīgas pozitīvas prakses piemēri, 
Lietuvā ir integrēta optikas tīkla un mobilo 
sakaru torņu izbūve. 

  

 

Informācija par Lietuvas pieredzi  

Lietuvā trīs projektu ietvaros novērsta digitālā plaisa starp pilsētām un reģioniem. Pirmā projekta54 
ietvaros izbūvēti 3357 km optiskās šķiedras kabeļu un 3000 km nomāti, izveidojot 935 piekļuves 
punktus. Infrastruktūra projekta ietvaros sastāv no 51 atsevišķa tīkla – katrs vienā pašvaldībā, kopumā 
nodrošinot piekļuvi platjoslai 330 skolām un 467 apakšreģioniem. Izveidotais tīkls pieder Lietuvas 
Transporta un komunikāciju ministrijai. 

Projekta otrās fāzes ietvaros izbūvēti 5775 km optiskās šķiedras kabeļu, izveidojot 2 789 piekļuves 
punktus (fāzes ietvaros piekļuve nodrošināta aptuveni 700 tūkstošiem iedzīvotāju, tostarp 700 skolām 
un 850 bibliotēkām). 

Trešā projekta ietvaros veicināta savienojamība lauku aktivitāšu centros55, piemēram, 
lauksaimniecības, pārtikas ražošanas uzņēmumos, lauku tūrismā un citur. Izbūvēti 486 km optiskās 
šķiedras kabeļu infrastruktūras, savienojot 443 lauksaimniecības objektus. 

2018.gadā 55 dažādi interneta pakalpojumu nodrošinātāji izmantoja izveidoto tīklu un daudzi no tiem 
ir mazie operatori, kas labi izprot vietējās vajadzības. 97% Lietuvas pašvaldību ir vismaz divi interneta 
pakalpojumu nodrošinātāji un 63% pašvaldību ir vismaz 5 interneta pakalpojumu nodrošinātāji.  

 

                                                
54 https://ec.europa.eu/regional_policy/en/projects/lithuania/improving-broadband-access-in-rural-lithuania 
55 https://ec.europa.eu/digital-single-market/en/content/prip-development-broadband-network-infrastructure-rural-areas-
lithuania 
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6.4. Scenārijs Nr.2. – Publiski pārvaldīta tīkla modelis – pēdējā jūdze 

2. scenārijs apraksta situāciju, kad pašvaldības organizē optisko tīklu pēdējās jūdzes izbūvi galvenokārt savās 
teritorijās esošajiem sociāli ekonomiskajiem virzītājspēkiem. 

2.scenārija gadījumā pieņemts, ka VHCN ar piekļuves ātrumu vismaz 100Mbps pieejamība 2020.gadā 
ir tikai teritorijās, kurās ir pieeja platjoslas optikai (datu slānī Grid_lv_1k_teritorijas atribūts OPTI > 0). 
2027.gadā VHCN ar piekļuves ātrumu vismaz 100Mbps pieejamība papildus plānota arī sociāli 
ekonomiskie virzītājspēkiem, kuriem šobrīd nav piekļuves optikas platjoslai, un iedzīvotājiem un 
uzņēmumiem, kas atrodami attiecīgajā 1x1km režģa šūnā (skat. attēlu tālāk tekstā). 

Attēls 24. 2.scenārija ietekmētās teritorijas 

 
Avots: PwC un CSE COE pētījums. 

 

 

Parametri Apraksts 

Plānotās investīcijas apraksts Investīcijas optiskā tīkla izveidei pēdējā jūdzē, izmantojot esošo vidējās 
jūdzes infrastruktūru.   

Investīciju mērķa joma Pēdējā jūdze 

Veikto investīciju īpašnieks Pašvaldības, kas iznomā izveidoto infrastruktūru pašvaldību 
kapitālsabiedrībām, kas nodrošina interneta pieejamības pakalpojumus, vai 
pašvaldības iznomā izveidoto infrastruktūru konkursa kārtībā izvēlētam 
interneta pakalpojumu nodrošinātājam. Jāņem vērā, ka pašvaldību 
kapitālsabiedrībām, lai sniegtu interneta pakalpojumus jākļūst par 
elektronisko sakaru komersantiem, reģistrējoties SPRK. Kā arī jāņem vērā 
Valsts pārvaldes iekārtas likuma un konkurences likuma prasības. 

Otra iespēja – interneta pakalpojumus nodrošina konkursa kārtībā izvēlēts 
operators. 

Tehnoloģija Optiskais internets 
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Parametri Apraksts 

Interneta pieslēguma ātrums Līdz 1 Gbit/s, vismaz 100Mbit/s. 

 

Investīciju atdeve Investīciju atdeve atkarīga no izvēlētajiem objektiem kam tiek pievilkts 
optiskais internets 

Ja tiek pieņemts lēmums pievilkt optisko internetu galvenajiem 
sociālekonomiskajiem spēkiem, tad šāda veida investīcijām būs vislielākā 
atdeve 

Pie optiskā tīkla ievilkšanas būs mazāks skaits mājsaimniecību, kam tiek 
nodrošināta piekļuve internetam salīdzinājumā ar interneta nodrošinājumu 
izmantojot mobilo sakaru operatoru pakalpojumus 

Iznākuma un rezultātu rādītāji 
Zemāk uzrādīti projekta iznākuma rādītāji. Rādītāju vērtību aprēķina 
metodoloģija iekļauta ziņojuma 5.2. sadaļā. 

Kods Apraksts 
Vērtība 
(tūkst.) 

RCO 41 
Papildu mājsaimniecības ar piekļuvi 
ļoti augstas jaudas platjoslai – 
mājsaimniecību skaits 

128.4 

RCO 42 
Papildu uzņēmumi ar piekļuvi ļoti lielas 
jaudas platjoslas pakalpojumiem – 
uzņēmumu skaits 

50.6 

RCR 53 
Mājsaimniecības, kuras abonē 
platjoslas pieslēgumus ļoti lielas 
jaudas tīklam – mājsaimniecību skaits 

64.2 

RCR 54 
Uzņēmumi, kas abonē platjoslas 
pieslēgumus ļoti lielas ietilpības tīklam 
– uzņēmumu skaits 

25.3 

 

Teritorijas VHCN baltās teritorijas 

Labuma guvēji Iedzīvotāji, komersanti, valsts un pašvaldību institūcijas 

Projekta īstenotājs Publiska iestāde, piemēram, pašvaldība vai plānošanas reģions 

Pašvaldību iesaiste Pašvaldības nodrošina nepieciešamo atbalstu pie optiskā tīkla izveides. 
Pašvaldība iznomā izbūvēto infrastruktūru pašvaldību kapitālsabiedrībai, kas 
nodrošina interneta piekļuves pakalpojumus vai iznomā konkursa kārtībā 
izvēlētam interneta pakalpojumu nodrošināšanas komersantam 

Pieņēmumi un ierobežojumi Aprēķini ir veikti optiskā tīkla infrastruktūras nodrošināšanai svarīgākajiem 
sociālekonomiskajiem virzītājspēkiem: izglītības iestādes, veselības iestādes 
un kultūras iestādes. Aprēķini ir veikti visiem tiem sociālekonomiskajiem 
virzītājspēkiem kam nav pieejams ātrs interneta savienojums. 

Tiek pieņemts, ka optika pieslēgums tiek nodrošināts no tuvākā optikas 
pieslēguma neatkarīgi vai optikas tīkls ir LVRTC vai komersanta īpašumā, 
piemēram, Tet. 

Veselības aprūpes iestādes – 29 iestādēm kopējais optiskā tīkla garums no 
tuvākā pieejamā optiskā pieslēguma punkta līdz iestādei ir 25.8 km 

Kultūras iestādes – kopējais optiskā tīkla garums no tuvākā pieejamā optiskā 
pieslēguma punkta līdz 657 kultūras iestādēm ir 398.3 km. Atlikušajām 439 
kultūras iestādēm optika jāvelk tālāk par 3km un kopīgais optiskā tīkla 
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Parametri Apraksts 

attālums sastāda 4784.3 km un šajā gadījumā būtu jāmeklē alternatīvi 
pieslēguma risinājumi. 

Izglītības iestādes – kopējais optiskā tīkla garums no tuvākā pieejamā optiskā 
pieslēguma punkta līdz 342 izglītības iestādēm ir 166.7 km. Atlikušajām 103 
izglītības iestādēm optika jāvelk tālāk par 3km un kopīgais optiskā tīkla 
attālums sastāda 1087.7 km un šajā gadījumā būtu jāmeklē alternatīvi 
pieslēguma risinājumi. 

Izveidoto infrastruktūru varētu izmantot arī citi sociālekonomiskie virzītājspēki, 
kā arī mājsaimniecības, bet nepieciešamās infrastruktūras nodrošināšanas 
izmaksas nav iekļautas aprēķinā  

Investīciju izmantošanas ilgums ir 20 gadi 

Optiskā tīkla izbūves izmaksas ir 30 EUR / m jeb 30 000 EUR par km 

Vidējās uzturēšanas izmaksas pēc projekta ekspertu vērtējuma var veidot 3% 
gadā no veiktajām investīcijām. Uzturēšanas izmaksas nosedz pašvaldības 
iestāde, kas nodrošina interneta pakalpojumus vai mobilo sakaru operators 

Netiek kvantificēti ieņēmumi no interneta pakalpojumu nodrošināšanas, jo 
nav pieejama informācija par sociālekonomisko virzītājspēku maksājumiem 
par interneta pakalpojumu pieejamību. Ņemot vērā, ka internets tiek 
nodrošināts sociālekonomiskajiem virzītājspēkiem galvenie būtu 
sociālekonomiskie ieguvumi. 

Investīciju atdeve Kopsavilkums investīciju atdeves aprēķiniem: 

Vērtība Rādītājs apraksts 

€25,370,040.00 Kopējā ieņēmumi gadā, EUR 

€316,166,774.88 (1) Kopējie ieņēmumi 20 gados, EUR (Net 
Present Value ar 5% diskonta likmi)   

€266,400,000.00 (2) Kopējās investīcijas, EUR   

€7,992,000.00 Uzturēšanas izdevumi, EUR/gadā (3% no 
investīcijām) 

€99,597,985.06 (3) Kopējie uzturēšanas izdevumi 20 gados, 
EUR  (Net Present Value ar 5% diskonta likmi) 

-€49,831,210.18 (4) Investīciju atdeves aprēķini uz 20 gadiem: 
(4) = (1) – (2) – (3) 

Detalizēti aprēķini sniegti Pielikumā Nr.12 

 

 

Tehniskais risinājums 

Projekta ietvaros tiek izbūvēta jauna infrastruktūra – optiskā tīkla infrastruktūra pašvaldības teritorijā. 
Investīciju prioritāte ir optiskā tīkla infrastruktūras nodrošināšana galvenajiem pašvaldības 
sociālekonomiskajiem virzītājspēkiem un pašvaldība izvēlas prioritārās investīciju jomas / objektus. 
Infrastruktūrai jānodrošina piekļuve arī citiem sakaru operatoriem 

Izveidotā optiskā tīkla infrastruktūra tiek pieslēgta LVRTC administrētajam optiskajam tīklam vai arī 
privāto operatoru optiskajam tīklam, izmantojot saimnieciski izdevīgāko risinājumu.  
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Optiskā tīkla izbūvi veic ārpakalpojuma nodrošinātājs, ko pašvaldība izvēlas konkursa kārtībā. 
Nepieciešamības gadījumā Platjoslas kompetences centrs sniedz nepieciešamo konsultatīvo atbalstu.  

Organizatoriskā pieeja 

Investīcijas infrastruktūrā veic pašvaldība, kas izveidoto infrastruktūru iznomā pašvaldību 
kapitālsabiedrībai vai konkursa kārtībā izvēlētam pakalpojumu sniedzējam. Optiskā tīkla infrastruktūras 
izveide jāplāno koordinēti kopā ar citu pašvaldības attīstīto infrastruktūru, kā piemēram, ielu 
apgaismojums, ūdens un kanalizācija (izvērtējams, vai remonta darbu laikā netiks sabojāta optiskā 
tīkla infrastruktūra). Ja iespējams, optiskā tīkla infrastruktūra būtu attīstāma reizē ar elektrības 
pieslēgumu izveidi. 

Nepieciešamības gadījumā pašvaldībām nepieciešamo atbalstu var nodrošināt plānošanas reģioni.  

Stiprās puses Vājās puses 

Izmantota izveidotā vidējās jūdzes 
infrastruktūra  

Pašvaldībām nepieciešama tehniskā kompetence 
un kapacitāte, lai noorganizētu optiskā tīkla 
izbūves projektu pašvaldībā 

Stratēģiski svarīga interneta pieejamības 
infrastruktūra (pēdējā jūdze) pieder 
pašvaldībām 

Pašvaldība nedrīkst nodrošināt interneta 
pakalpojumus, tādēļ funkcija deleģējama kādai no 
pašvaldību kapitālsabiedrībām 

Izveidota koplietošanas infrastruktūra, ko 
var izmantot pašvaldības kapitālsabiedrības  

Varētu būt nepieciešamas izmaiņas likumā “Par 
pašvaldībām”56 attiecībā uz pašvaldību 
veicamajām funkcijām 

Pašvaldība var noteikt prioritāri attīstāmos 
pieslēgumus, piemēram, galvenie 
sociālekonomiskie virzītājspēki 

Internets pirmkārt tiks nodrošināts galvenajiem 
sociālekonomiskajiem spēkiem un daļai no 
iedzīvotājiem attālākos rajonos internets varētu 
tikt nenodrošināts 

Tiek nodrošināta augstas kvalitātes un ātra 
interneta pieejamība līdz 1Gbit/s 

Pašvaldībai būs jānodrošina izveidotās 
infrastruktūras uzturēšana 

Pēdējās jūdzes infrastruktūras izbūve var 
tikt stratēģiski plānota no pašvaldības puses 

Pašvaldībām svarīgi noteikt vienotus principus 
tīkla izmantošanas maksu noteikšanai, kam 
jānodrošina tīkla pieejamības nodrošināšana 
dažādās pašvaldībās   

Investējot galvenajos sociālekonomiskajos 
virzītājspēkos, var tikt nodrošināta interneta 
piekļuve viensētu iedzīvotājiem, izmantojot 
internetu bibliotēkās, izglītības iestādēs, 
klientu apkalpošanas centros 

 

6.5. Scenārijs Nr.3 – Privāti pārvaldīta tīkla modelis  

3. scenārija mērķis ir nodrošināt VHCN tīklu ar piekļuves ātrumu vismaz 100 Mbps galalietotājiem visur 
valstī, kur tas nav pieejams,  organizējot publiskus konkursus pa valsts teritorijām. Šo konkursu secību 
noteiktu izstrādātais valsts teritoriju ranžējums, kas aprakstīts sadaļā 5.2.12. 
 
3.scenārija gadījumā pieņemts, ka VHCN ar piekļuves ātrumu vismaz 100Mbps pieejamība 2020.gadā 
ir tikai teritorijās, kurās ir pieeja platjoslas optikai (datu slānī Grid_lv_1k_teritorijas atribūts OPTI > 0). 
2027.gadā VHCN ar piekļuves ātrumu vismaz 100Mbps pieejamība papildus plānota arī teritorijās, 

                                                
56 https://likumi.lv/doc.php?id=57255 
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kurās šobrīd ir mobilo sakaru pārklājums (datu slānī Grid_lv_1k_teritorijas atribūts MOBI = 1) un 
fiksētais platjoslas pieslēgums bez piekļuves optikai (skat. attēlu tālāk tekstā).  

Attēls 25. 3.scenārija ietekmētās teritorijas 

 
Avots: PwC un CSE COE pētījums. 

 

Parametri Apraksts 

Plānotās investīcijas apraksts Konkursa kārtībā izvēlēts privātais operators plāno un nodrošina interneta 
pakalpojumu pieejamību baltajās teritorijās  

Konkurss var tikt organizēts pa visu valsts teritoriju, plānošanas reģioniem 
vai pašvaldībām (atbilstoši pašvaldību ranžējumam, kas aprakstīts sadaļā 
5.2.12).   

Nosakot pašvaldības, kurās prioritāri uzsākt konkursu organizēšanu, var tikt 
izmantots sadaļā 5.2.12 aprakstītais novadu ranžējums. 

Papildus būtu jāprioritizē arī tās teritorijas, kur šobrīd nav mobilā tīkla 
pārklājuma, vai šādā tīklā netiek nodrošināts 30Mbit/s ātrums. 

Konkursa nosacījums – tehnoloģiski neitrāls 

Investīciju mērķa joma Vidējā jūdze un / vai pēdējā jūdze – privātā operatora izvēle 

Veikto investīciju īpašnieks Privātais operators 

Tehnoloģija Nav noteikta 

Interneta pieejas ātrums Vismaz 100 Mbit/s – prasības noteiktas konkursa nosacījumos. 

Definēts diennakts laika īpatsvars (piemēram, 90%), kad pieejams vismaz 
noteiktais ātrums. 

Investīciju atdeve Mājsaimniecību skaits, kam tiks nodrošināta interneta pieejamība atkarīgs no 
privātā operatora piedāvājuma, kā arī no tā cik daudz mājsaimniecībām nav 
pieejams internets noteiktajā teritorijā 



  
  

“Pētījums Eiropas Savienības fondu 2021. -2027. gada plānošanas perioda ieguldījumu priekšnosacījumu izpildei”     (gala ziņojums)
  

   80 

Parametri Apraksts 

Iznākuma un rezultātu rādītāji 
Zemāk uzrādīti projekta iznākuma rādītāji. Rādītāju vērtību aprēķina 
metodoloģija iekļauta ziņojuma 5.2. sadaļā. 

Kods Apraksts 
Vērtība 
(tūkst.) 

RCO 41 
Papildu mājsaimniecības ar piekļuvi 
ļoti augstas jaudas platjoslai – 
mājsaimniecību skaits 

251.1 

RCO 42 
Papildu uzņēmumi ar piekļuvi ļoti lielas 
jaudas platjoslas pakalpojumiem – 
uzņēmumu skaits 

89.8 

RCR 53 
Mājsaimniecības, kuras abonē 
platjoslas pieslēgumus ļoti lielas 
jaudas tīklam – mājsaimniecību skaits 

125.5 

RCR 54 
Uzņēmumi, kas abonē platjoslas 
pieslēgumus ļoti lielas ietilpības tīklam 
– uzņēmumu skaits 

44.9 

 

Teritorijas VHCN Baltās teritorijas, bet iespējama interneta pakalpojumu pieejamības 
uzlabošana arī konkrētās pelēkajās un melnajās teritorijās (piemēram, 
teritorijās, kur 2020.gadā pieejami fiksētie platjoslas pieslēgumi bez 
piekļuves optikai). 

Labuma guvēji Iedzīvotāji, komersanti, valsts un pašvaldību institūcijas 

Projekta īstenotājs Privātais operators (izvēlēts konkursa kārtībā) 

Pašvaldību iesaiste Gadījumos, ja konkurss par interneta pieejamības nodrošināšanu tiek rīkots 
plānošanas reģiona līmenī vai pašvaldības līmenī, konkursa organizēšanu 
var nodrošināt plānošanas reģions vai pašvaldība  

Pieņēmumi un ierobežojumi Investīcijas tiek plānotas, lai nodrošinātu vismaz 100 Mbit/s ātrumu visiem 
iedzīvotājiem, kam tas nav pieejams 2020.gadā, pieļaujot 100 Mbit/s ātruma 
pieejamību diennakts laika, kas mazāka par 100%, lai neizslēgtu mobilos 
operatorus un saglabātu tehnoloģisko neitralitāti. 

Nepieciešamo Investīciju novērtējums bāzēts uz pieņēmumu, ka pēdējā 
jūdze mājsaimniecībām tiek nodrošināta, izmantojot 5G mobilos tīklus, kas 
darbojas zemākajā frekvenču diapazonā (650-800MHz). 

Lai nodrošinātu 5G mobilo sakaru pieejamību nepieciešami apmēram 200 
mobilo sakaru torņi baltajās teritorijās un apmēram 305 mobilo sakaru torņi 
pārējā valsts teritorijā, kur šobrīd nav pieejami fiksētie platjoslas pieslēgumi 
ar piekļuvi optikai. Katra mobilā sakaru torņa investīciju izmaksas ir 100 000 
EUR. Mobilo sakaru torņi atrodas vidēji 9 km attālumā no tuvākā optiskā tīkla 
pieslēguma punkta. 

Investīciju izmantošanas ilgums ir 20 gadi 

Uzturēšanas izmaksas pēc projekta ekspertu vērtējuma var veidot ir 3% gadā 
no veiktajām investīcijām. 

Ieņēmumi no interneta pakalpojumu nodrošināšanas ir 5 EUR mēnesī 
(pieaugums pret 2020.gadu) uz vienu personu un 20 EUR mēnesī 
(pieaugums pret 2020.gadu) uz vienu uzņēmumu. 

Finanšu atdeve Kopsavilkums investīciju atdeves aprēķiniem: 

Vērtība Rādītājs apraksts 



  
  

“Pētījums Eiropas Savienības fondu 2021. -2027. gada plānošanas perioda ieguldījumu priekšnosacījumu izpildei”     (gala ziņojums)
  

   81 

Parametri Apraksts 

€46,420,680.00 Kopējā ieņēmumi gadā, EUR 

€578,504,278.40 (1) Kopējie ieņēmumi 20 gados, EUR (Net Present 
Value ar 5% diskonta likmi)   

€907,105,000.00 (2) Kopējās investīcijas, EUR 

€684,905,000.00 t.sk. jaunas 5G bāzes stacijas uzstādīšana uz 3341 
jau esošiem 4G torņiem un daļu  torņu pieslēgšana 
optikas tīklam (EUR) 

€88,000,000.00 t.sk. 200 jauni 5G torņi Baltajās teritorijās (EUR) – 
torņu izbūve, bāzes staciju uzstādīšana, pieslēgšana 
optikas tīklam 

€134,200,000.00 t.sk. 305 jauni 5G torņi, kur nav optikas (EUR) – torņu 
izbūve, bāzes staciju uzstādīšana, pieslēgšana 
optikas tīklam   

€27,213,150.00 Uzturēšanas izdevumi, EUR/gadā (3% no 
investīcijām) 

€339,135,999.38 (3) Kopējie uzturēšanas izdevumi 20 gados, EUR  
(Net Present Value ar 5% diskonta likmi) 

  

-€667,736,720.98 (4) Investīciju atdeves aprēķini uz 20 gadiem: (4) = 
(1) – (2) – (3) 

Detalizēti aprēķini sniegti Pielikumā Nr.13 

 

Tehniskais risinājums 

Projekta ietvaros tiek nodrošināta interneta pieejamība baltajām teritorijām, un tā ir privātā operatora 
izvēle, kāds tehniskais risinājums un kāda infrastruktūra tiek izmantota pakalpojuma nodrošināšanai.  

Organizatoriskā pieeja 

Augstāk aprakstītās investīcijas infrastruktūrā veic privāts operators, kas ir izvēlēts konkursa kārtībā. 
Konkurss tiek organizēts visai valsts teritorijai vai pakāpeniski pa novadiem, atbilstoši novadu 
ranžējumam, kas aprakstīts sadaļā 5.2.12. Papildus būtu jāprioritizē arī tās teritorijas, kur šobrīd nav 
mobilā tīkla pārklājuma, vai šādā tīklā netiek nodrošināts 30Mbit/s ātrums. 

Konkursa tehniskās specifikācijas kritēriji varētu ietvert minimālo nodrošināmo interneta pieejas 
ātrumu, kā arī definētu diennakts laika īpatsvaru, kad tas pieejams, kā arī minimālo nodrošināmo 
interneta pieslēgumu skaitu mājsaimniecībām, uzņēmumiem, valsts un pašvaldību kapitālsabiedrībām. 
Kā papildus kritēriji var tikt noteikts interneta pieejamības ātrums galvenajiem pašvaldību 
sociālekonomiskajiem virzītājspēkiem, kā arī sadarbība un koordinēta pieeja kopā ar citiem tehniskās 
infrastruktūras (ūdensapgāde, elektrība) nodrošinātājiem.   

Saskaņā ar intervijās sniegto informāciju, operatoram būtu vajadzīgi vismaz 3 gadi, lai izveidotu 
infrastruktūru un nodrošinātu nepieciešamo interneta pieejamību.  

Operators, kurš konkursa kārtībā iegūst tiesības nodrošināt interneta pakalpojumus konkrētās VHCN 
baltajās teritorijās, par konkursa ietvaros iegūto finansējumu izbūvēto infrastruktūru ļauj izmantot 
(nomas līgums) arī citiem interneta pakalpojumu nodrošinātājiem saskaņā ar tīkla atsaistes iespēju 
nodrošināšanu.  

 

Stiprās puses Vājās puses 
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Pieejams ļoti augstas kvalitātes un ātrs 
internets  

Stratēģiski svarīga interneta infrastruktūra pieder 
privātajam operatoram 

Sadarbība ar citiem kritiski svarīgas 
infrastruktūras nodrošinātājiem, iekļaujot 
prasības konkursa nosacījumos 

Projekts ekonomiski izdevīgāks lielās pilsētās un 
Pierīgas reģiona pašvaldībās. 

Izveidota koplietošanas infrastruktūra, ko var 
izmantot dažādi sakaru operatori 

Internets var netikt nodrošināts nepietiekamas 
klientu aktivitātes dēļ 

Nodrošināta konkurence operatoru starpā 
(visiem vienādi infrastruktūras izmantošanas 
nosacījumi) 

 

Plānošanas reģioniem vai pašvaldībām ir 
iespēja ietekmēt un sekmēt interneta 
pieejamību viņu teritorijās, iekļaujot prasības 
konkursa nosacījumos 

Teritorijās, kur pēdējai jūdzei izvēlētais 
tehnoloģiskais risinājums būs 5G tīkli zemo 
frekvenču diapazonā, nākotnē būs 
nepieciešamas papildus investīcijas, lai 
nodrošinātu gala lietotājiem ātrumu līdz 1Gbit/s. 

 

6.6. Scenārijs Nr.4 – Operatora subsidēšanas modelis  

4. scenārija mērķis ir atbalstīt optiskā tīkla izveidi teritorijās, kur šobrīd ir fiksētie interneta pieejas 
pakalpojumi, kas nenodrošina 100Mbps ātrumu. 

4.scenārija gadījumā pieņemts, ka VHCN ar piekļuves ātrumu vismaz 100Mbps pieejamība 2020.gadā 
ir tikai teritorijās, kurās ir pieeja platjoslas optikai (datu slānī Grid_lv_1k_teritorijas atribūts OPTI > 0). 
2027.gadā VHCN ar piekļuves ātrumu vismaz 100Mbps pieejamība papildus plānota arī teritorijās, 
kurās šobrīd ir fiksētais platjoslas pieslēgums (datu slānī Grid_lv_1k_teritorijas atribūts FIKS > 0) bez 
piekļuves optikai (skat. attēlu tālāk tekstā).  
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Attēls 26. 4.scenārija ietekmētās teritorijas 

 
Avots: PwC un CSE COE pētījums. 

 

Parametri Apraksts 

Plānotās investīcijas apraksts Investīcijas optiskā tīkla izveidē un paplašināšanā  

Investīciju mērķa joma Vidējā jūdze un pēdējā jūdze 

Veikto investīciju īpašnieks Privātais operators 

Tehnoloģija Optiskais internets 

Interneta pieejas ātrums Līdz 1 Gbit/s, vismaz 100Mbit/s. 

 

Investīciju atdeve Investīciju atdeve ir atkarīga no investīciju stratēģijas, kurās teritorijās 
tiek veiktas investīcijas un kas ir primārie interneta pakalpojumu 
saņēmēji, piemēram, galvenie sociālekonomiskie virzītājspēki 

Pie optiskā tīkla ievilkšanas būs mazāks skaits mājsaimniecību, kam tiek 
nodrošināta piekļuve internetam salīdzinājumā ar interneta 
nodrošinājumu izmantojot mobilo sakaru operatoru pakalpojumus 

Iznākuma un rezultātu rādītāji 
Zemāk uzrādīti projekta iznākuma rādītāji. Rādītāju vērtību aprēķina 
metodoloģija iekļauta ziņojuma 5.2. sadaļā. 

Kods Apraksts 
Vērtība 
(tūkst.) 

RCO 41 
Papildu mājsaimniecības ar piekļuvi 
ļoti augstas jaudas platjoslai – 
mājsaimniecību skaits 

130.9 
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Parametri Apraksts 

RCO 42 
Papildu uzņēmumi ar piekļuvi ļoti lielas 
jaudas platjoslas pakalpojumiem – 
uzņēmumu skaits 

45.0 

RCR 53 
Mājsaimniecības, kuras abonē 
platjoslas pieslēgumus ļoti lielas 
jaudas tīklam – mājsaimniecību skaits 

65.4 

RCR 54 
Uzņēmumi, kas abonē platjoslas 
pieslēgumus ļoti lielas ietilpības tīklam 
– uzņēmumu skaits 

22.5 

 

Teritorijas Baltās teritorijas 

Labuma guvēji Iedzīvotāji, komersanti, valsts un pašvaldību institūcijas 

Projekta īstenotājs Privātais operators, kas tiek izvēlēts konkursa kārtībā 

Pašvaldību iesaiste Pašvaldības nodrošina nepieciešamo atbalstu pie optiskā tīkla izveides, 
tai skaitā atļaujas un ātru dokumentu saskaņošanu  

Pieņēmumi Šajā scenārijā tiek piedāvāts sakaru operatora subsidēšanas modelis un 
netiek apskatīts pakalpojuma lietotāja subsidēšanas modelis. Subsidējot 
pakalpojumu lietotāju, faktiski tiek stimulēta tikai pakalpojuma lietošana 
noteiktā laika periodā, bet netiek reāli veiktas investīcijas pakalpojuma 
sniegšanai nepieciešamās infrastruktūras attīstībai.  

Investīcijas tiek plānotas, lai nodrošinātu augstas veiktspējas tīkla 
pieejamību mājsaimniecībām, kam šobrīd ir platjoslas pieslēgums, 
neizmantojot optiku. 

Saskaņā ar Tet intervijā sniegto informāciju, vidējās izmaksas optiskā 
tīkla izbūvei mājsaimniecībai baltajās teritorijās ir apmēram 3 000 EUR  

Atbilstoši Tet sniegtajai informācijai investīciju optiskajā tīklā 
izmantošanas reālais ilgums ir 40 gadi 

Uzturēšanas izdevumi optiskajam tīklam ir nelieli. Pēc projekta ekspertu 
vērtējuma tie var veidot 1% gadā no veiktajām investīcijām. 

Ieņēmumi no optiskā interneta pakalpojumu nodrošināšanas vidēji ir 20 
EUR mēnesī uz vienu mājsaimniecību (parasti kopā ar televīzijas 
pakalpojumu). 

Finanšu atdeve Kopsavilkums investīciju atdeves aprēķiniem: 

Vērtība Rādītājs apraksts 

€23,563,140.00 Kopējā ieņēmumi gadā, EUR 

€293,648,807.01 (1) Kopējie ieņēmumi 20 gados, EUR (Net 
Present Value ar 5% diskonta likmi)   

€1,030,722,000.00 (2) Kopējās investīcijas, EUR 

€785,178,000.00 t.sk. mājsaimniecību pieslēgšana optikai 
(EUR) 

€245,544,000.00 t.sk. uzņēmumu pieslēgšana optikai (EUR)   

€10,307,220.00 Uzturēšanas izdevumi, EUR/gadā (1% no 
investīcijām) 

€128,450,743.69 (3) Kopējie uzturēšanas izdevumi 20 gados, 
EUR  (Net Present Value ar 5% diskonta 
likmi) 

-€865,523,936.68 (4) Investīciju atdeves aprēķini uz 20 
gadiem: (4) = (1) – (2) – (3) 
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Detalizēti aprēķini sniegti Pielikumā Nr.14 

Tehniskais risinājums 

Projekta ietvaros tiek izbūvēta jauna infrastruktūra vai esošā infrastruktūra tiek aizvietota ar optisko 
tīklu. Konkurss tiek organizēts pa visu valsti jeb konkrētām teritorijām. 

Piedāvājam konkursa nolikumā norādīt konkrētas baltās teritorijas, kur jānodrošina interneta 
pieejamība, kā arī prasīt sadarbību un koordināciju ar citu veidu tehniskās infrastruktūras 
nodrošinātājiem. Galvenais konkursa vērtēšanas kritērijs būtu nodrošināto interneta pieslēgumu skaits 
mājsaimniecībām, uzņēmumiem, valsts un pašvaldību kapitālsabiedrībām un  sociālekonomiskajiem 
virzītājspēkiem. 

Atbilstoši Tet sniegtajiem datiem, 222 884 Tet platjoslas klientiem šobrīd nav pieejams optiskais tīkls. 
Tet kopumā ir apzinājis 366 706 mājsaimniecību adrešu, kur var pievilkt optisko tīklu, izveidojot to no 
jauna vai nomainot esošo tīklu. 

Organizatoriskā pieeja 

Investīcijas infrastruktūrā veic privāts operators, kas ir izvēlēts konkursa kārtībā.  

Finansējums 

Finansējums būtu nepieciešams optiskā tīkla izbūvei. Saskaņā ar Tet intervijā sniegto informāciju 
vidējās izmaksas optiskā tīkla izbūvei mājsaimniecībai baltās teritorijās ir apmēram 3 000 EUR. 

 

Stiprās puses Vājās puses 

Pieejams ļoti augstas kvalitātes un ātrs 
internets  

Stratēģiski svarīga infrastruktūra pieder privātam 
operatoram 

Komersants tiek izvēlēts konkursa kārtībā Ņemot vērā lielās investīciju izmaksas uz vienu 
km, interneta pieejamība tiek uzlabota 
salīdzinoši nelielam interneta lietotāju skaitam 

Izveidota koplietošanas infrastruktūra, ko var 
izmantot citi sakaru operatori 

Internets netiks nodrošināts attālinātās 
viensētās, jo optiskā interneta ievilkšanas 
izmaksas būs pārāk lielas 

Nodrošināta konkurence operatoru starpā 
(visiem vienādi infrastruktūras izmantošanas 
nosacījumi) 

Projekts ekonomiski izdevīgāks lielās pilsētās 

Projekts var tikt ieviests pakāpeniski, kā arī 
dažādās teritorijās paralēli 

Tiek atbalstīta konkrēta tehnoloģija – optiskā 
tīkla izbūve 

 Tiek subsidēts viens komersants  

 

 

6.7. Scenārijs Nr.5 – 5G Via Baltica  

5.scenārija gadījumā tiek nodrošināts 5G tīkls teritorijā 4km attālumā no Via Baltica autoceļa vidus ass.  
 
Šajā scenārijā tiek pieņemts, ka VHCN ar piekļuves ātrumu vismaz 100Mbps pieejamība 2020.gadā ir 
tikai tajās Via Baltica koridora teritorijās, kurās ir pieeja platjoslas optikai (datu slānī 
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Grid_lv_1k_teritorijas atribūts OPTI > 0). 2027.gadā VHCN ar piekļuves ātrumu vismaz 100Mbps 
pieejamība papildus plānota atlikušajā Via Baltica koridora teritorijā (datu slānī Grid_lv_1k_teritorijas 
atribūts VIA_B = 1) (skat. attēlu tālāk tekstā).  
 

Attēls 27. 5.scenārija ietekmētās teritorijas 

 
Avots: PwC un CSE COE pētījums. 

 

 

Parametri Apraksts 

Plānotās 
investīcijas 
apraksts 

Investīcijas, kas atbalsta 5G tīkla izveidi 57– investīcijas vidējās jūdzes optiskajā 
tīklā un mobilo sakaru torņos, kas atbilst 5G prasībām. Uzbūvētā infrastruktūra 
pieejama visiem mobilo sakaru operatoriem 

Investīciju mērķa 
joma 

Vidējā jūdze  

Veikto investīciju 
īpašnieks 

Valsts vai valsts akciju sabiedrība 

Tehnoloģija Mobilais  

Interneta pieejas 
ātrums 

Līdz 1 Gbit/s 

Investīciju atdeve Investīciju atdeve ir atkarīga no satiksmes intensitātes pa Via Baltica trasi, 
iedzīvotāju, komersantu, valsts un pašvaldību institūciju skaita un darbības Via 
Baltica teritorijā 

                                                
57 Veikt novērtējumu 5G tīkla izbūvei nav iespējams datu nepieejamības dēļ. 
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Iznākuma un 
rezultātu rādītāji 

Zemāk uzrādīti projekta iznākuma rādītāji. Rādītāju vērtību aprēķina metodoloģija 
iekļauta ziņojuma 5.2. sadaļā. 

Kods Apraksts 
Vērtība 
(tūkst.) 

RCO 41 
Papildu mājsaimniecības ar piekļuvi 
ļoti augstas jaudas platjoslai – 
mājsaimniecību skaits 

17.6 

RCO 42 
Papildu uzņēmumi ar piekļuvi ļoti lielas 
jaudas platjoslas pakalpojumiem – 
uzņēmumu skaits 

7.1 

RCR 53 
Mājsaimniecības, kuras abonē 
platjoslas pieslēgumus ļoti lielas 
jaudas tīklam – mājsaimniecību skaits 

8.8 

RCR 54 
Uzņēmumi, kas abonē platjoslas 
pieslēgumus ļoti lielas ietilpības tīklam 
– uzņēmumu skaits 

3.5 

 

Teritorijas Apmēram 8 km plats kanāls, kas ietver Via Baltica trasi 

Labuma guvēji Satiksmes dalībnieki pa Via Baltica, iedzīvotāji, komersanti, valsts un pašvaldību 
institūcijas, nākotnē autonomo automobiļu lietotāji. 

Projekta īstenotājs Valsts akciju sabiedrība, piemēram, LVRTC 

Pašvaldību iesaiste Pašvaldības nodrošina administratīvo atbalstu pie mobilo sakaru torņu izbūves 

Pieņēmumi un 
ierobežojumi 

Atbilstoši LVRTC aprēķiniem, 5G mobilā tīkla nodrošināšanai ap trasi 
nepieciešams 51 mobilo sakaru tornis, no kuriem 10 jāizbūvē no jauna. 

Mobilo sakaru torņi tiek pieslēgti LVRTC vidējās jūdzes tīklam – optikai. Projekta 
ietvaros jāfinansē arī optiskā tīkla izveide no esošā LVRTC vidējās jūdzes tīkla 
līdz jaunuzbūvētajam mobilo sakaru tornim. Tiek pieņemts, ka līdz katram 
jaunuzbūvētajam mobilo sakaru tornim ir vidēji jāaizvelk optika 9 km garumā jeb 
10 torņiem 90 km optika. 

Tiek pieņemts, ka esošais 41 tornis jau ir pieslēgts optiskajam tīklam. 

Investīciiu atdeve rēķināta, pieņemot, ka nepieciešamo torņu skaits ir 2 reizes 
lielāks, lai nodrošinātu garantētu nepieciešamo piekļuves ātrumu liela vienlaicīgo 
lietotāju skaita gadījumā. 

Nepieciešamās investīcijas viena jauna mobilo sakaru torņa izbūvei ir apmēram 
100 000 EUR. 

Finanšu atdeve Kopsavilkums investīciju atdeves aprēķiniem: 

Vērtība Rādītājs apraksts 

€1,761,120.00 Kopējā ieņēmumi gadā, EUR 

€21,947,447.88 (1) Kopējie ieņēmumi 20 gados, EUR (Net 
Present Value ar 5% diskonta likmi)   

€25,610,000.00 (2) Kopējās investīcijas, EUR 

€16,810,000.00 t.sk. jaunas 5G bāzes stacijas uzstādīšana 
uz jau esošiem 4G torņiem un to 
pieslēgšana optikas tīklam (EUR) 
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€8,800,000.00 t.sk. jauni 5G torņi, kur jāsablīvē (EUR) 
  

€768,300.00 Uzturēšanas izdevumi, EUR/gadā (3% no 
investīcijām) 

€9,574,716.21 (3) Kopējie uzturēšanas izdevumi 20 gados, 
EUR  (Net Present Value ar 5% diskonta 
likmi) 

-€13,237,268.33 (4) Investīciju atdeves aprēķini uz 20 
gadiem: (4) = (1) – (2) – (3) 

Detalizēti aprēķini sniegti Pielikumā Nr.15 

 

Tehniskais risinājums 

Projekta ietvaros tiek izbūvēta jauna infrastruktūra vai uzlabota esošā infrastruktūra, lai papildinātu 
esošo vidējās jūdzes optisko tīklu un izbūvētu 4G mobilo sakaru torņus.   

Atbilstoši LVRTC sniegtajai informācijai, 4G un 5G mobilā tīkla nodrošināšanai ap trasi nepieciešams 
51 mobilo sakaru tornis, no kuriem 10 jāizbūvē no jauna. Investīciiu atdeve rēķināta, pieņemot, ka 
nepieciešamo torņu skaits ir 2 reizes lielāks, lai nodrošinātu garantētu nepieciešamo piekļuves ātrumu 
liela vienlaicīgo lietotāju skaita gadījumā. 

Iznomājot izveidoto infrastruktūru mobilo sakaru komersantiem, jānodefinē teritorijas noteiktā attālumā 
no Via Baltica, kur jānodrošina noteikta 5G interneta pieejamība. Papildus tikt noteikta interneta 
pieejamība galvenajiem pašvaldību sociālekonomiskajiem virzītājspēkiem, kā arī sadarbība un 
koordinēta pieeja kopā ar citiem kritiskās infrastruktūras nodrošinātājiem. 

Organizatoriskā pieeja 

Investīcijas infrastruktūrā veic valsts akciju sabiedrība, kas nepieciešamos darbus iepērk konkursa 
kārtībā.  

 

Stiprās puses Vājās puses 

Pieejams ļoti augstas kvalitātes un ātrs 
internets  

Projekts ekonomiskais izdevīgums mobilo 
sakaru komersantiem atkarīgs no satiksmes 
intensitātes pa Via Baltica 

Projekts var tikt ieviests pakāpeniski, kā arī 
dažādās teritorijās paralēli 

Ņemot vērā lielās investīciju izmaksas uz vienu 
km, interneta pieejamība tiek uzlabota 
salīdzinoši nelielam interneta lietotāju skaitam 

Izveidota koplietošanas infrastruktūra, ko var 
izmantot citi sakaru operatori 

Internets netiks nodrošināts no VIA Baltica 
attālinātās teritorijās 

Nodrošināta konkurence operatoru starpā 
(visiem vienādi infrastruktūras izmantošanas 
nosacījumi) 

 

 

6.8. Scenārijs Nr.6 – 5G Rail Baltica  

6.scenārija gadījumā tiek nodrošināts 5G tīkls teritorijā gar plānoto Rail Baltica dzelzlceļa līniju 
(ieskaitot dažādos variantus atsevišķos posmos).  
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Šajā scenārijā tiek pieņemts, ka VHCN ar piekļuves ātrumu vismaz 100Mbps pieejamība 2020.gadā ir 
tikai tajās Rail Baltica koridora teritorijās, kurās ir pieeja platjoslas optikai (datu slānī 
Grid_lv_1k_teritorijas atribūts OPTI > 0). 2027.gadā VHCN ar piekļuves ātrumu vismaz 100Mbps 
pieejamība papildus plānota atlikušajā Rail Baltica koridora teritorijā (datu slānī Grid_lv_1k_teritorijas 
atribūts RAIL_B = 1) (skat. attēlu tālāk tekstā). 
 

Attēls 28. 6.scenārija ietekmētās teritorijas 

 
Avots: PwC un CSE COE pētījums. 

 

Parametri Apraksts 

Plānotās 
investīcijas 
apraksts 

Rail Baltica dzelzceļa līnijas izbūves gaitā paralēli dzelzceļa līnijai tehnoloģiskajā 
kanalizācijā tiek izbūvēta optiskās šķiedras sakaru infrastruktūra. Šo infrastruktūru 
RB Rail plāno izmantot dzelzceļa tehnoloģisko vajadzību nodrošināšanai privātā 
tīkla ietvaros, kā arī iznomāt brīvās optiskā tīkla infrastruktūras jaudas citiem 
pakalpojumu sniedzējiem. Šī infrastruktūra var kalpot kā starpvalstu optiskā tīkla 
savienojums, ko varētu izmantot gan mobilo sakaru operatori, gan publiskā 
sektora iestādes (piemēram, starpvalstu universitāšu tīkla izveidei, korporāciju 
iekšējā tīkla vajadzībām utml.) Dzelzceļa līnijā vidēji ik pa 4km paredzētas vietas 
mobilo sakaru torņu pieslēguma vietas. Šajos punktos tiks nodrošināta iespēja 
pieslēgties optiskā tīkla infrastruktūrai. Investīcijas, kas atbalsta 5G tīkla izveidi – 
investīcijas 5G mobilo sakaru bāzes staciju izvietošanai. Uzbūvētā infrastruktūra 
pieejama visiem mobilo sakaru operatoriem 

Investīciju mērķa 
joma  

Vidējā jūdze  

Veikto investīciju 
īpašnieks 

Valsts vai valsts akciju sabiedrības (LVRTC un/vai Rail Baltica) 

Tehnoloģija Mobilais internets 
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Interneta pieejas 
ātrums 

Līdz 1 Gbit/s, 

Investīciju atdeve Investīciju atdeve ir atkarīga no vilcienu plūsmas intensitātes, iedzīvotāju, 
komersantu, valsts un pašvaldību institūciju skaita un darbības Rail Baltica 5G 
teritorijā 

Iznākuma un 
rezultātu rādītāji 

Zemāk uzrādīti projekta iznākuma rādītāji. Rādītāju vērtību aprēķina metodoloģija 
iekļauta ziņojuma 5.2. sadaļā. 

Kods Apraksts 
Vērtība 
(tūkst.) 

RCO 41 
Papildu mājsaimniecības ar piekļuvi 
ļoti augstas jaudas platjoslai – 
mājsaimniecību skaits 

16.8 

RCO 42 
Papildu uzņēmumi ar piekļuvi ļoti lielas 
jaudas platjoslas pakalpojumiem – 
uzņēmumu skaits 

7.3 

RCR 53 
Mājsaimniecības, kuras abonē 
platjoslas pieslēgumus ļoti lielas 
jaudas tīklam – mājsaimniecību skaits 

8.4 

RCR 54 
Uzņēmumi, kas abonē platjoslas 
pieslēgumus ļoti lielas ietilpības tīklam 
– uzņēmumu skaits 

3.7 

 
 

Teritorijas Teritorija ap Rail Baltica trasi 

Labuma guvēji Rail Baltica pasažieri, iedzīvotāji, komersanti, valsts un pašvaldību institūcijas 

Projekta īstenotājs Valsts vai valsts akciju sabiedrības (LVRTC un/vai Rail Baltica) 

Pašvaldību iesaiste Nav plānota 

Pieņēmumi 5G tīkls tiek izbūvēts sadarbībā ar RB Rail. 

Finanšu atdeve Kopsavilkums investīciju atdeves aprēķiniem: 

Vērtība Rādītājs apraksts 

€1,781,670.00 Kopējā ieņēmumi gadā, EUR 

€22,203,546.30 
(1) Kopējie ieņēmumi 20 gados, EUR (Net 
Present Value ar 5% diskonta likmi) 

 

 

€18,850,000.00 (2) Kopējās investīcijas, EUR 

€0.00 

t.sk. jaunas 5G bāzes stacijas uzstādīšana 
uz jau esošiem 4G torņiem un to 
pieslēgšana optikas tīklam (EUR) 

€18,850,000.00 
t.sk. jauni 5G torņi, kas jāuzbūvē (EUR) 

 

 

€565,500.00 
Uzturēšanas izdevumi, EUR/gadā (3% no 
investīcijām) 

€7,047,379.95 

(3) Kopējie uzturēšanas izdevumi 20 gados, 
EUR  (Net Present Value ar 5% diskonta 
likmi) 
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-€3,693,833.65 
(4) Investīciju atdeves aprēķini uz 20 
gadiem: (4) = (1) – (2) – (3) 

Detalizēti aprēķini sniegti Pielikumā Nr.16 

Veikt detālu novērtējumu 5G tīkla izbūvei nav iespējams datu nepieejamības dēļ. 
Arī detāls ieņēmumu novērtējums nav iespējams, jo atkarīgs no pasažieru skaita, 
kas tiks pārvadāts pa trasi. 

Saskaņā ar RB Rail pārstāvju sniegto informāciju, uz nodevuma izstrādes brīdi 
nav vēl pieņemts lēmums par to, vai pieslēguma punktos, kas paredzēti vidēji ik 
pa 4km, dzelzceļa līnijas izbūves ietvaros tiks izbūvēti arī mobilo sakaru torņi. Tas 
ir atkarīgs no tehnoloģiskajām prasībām, kādas būs noteiktas dzelzceļa privātā 
tīkla tehnoloģijām, lēmums par ko tiks pieņemts 2022.-2023. gadā. Ja RB Rail 
uzbūvēs sakaru torņus, RB Rail būs jāmaksā infrastruktūras izmantošanas maksa, 
kas ilgtermiņā var būt salīdzināma ar 5G torņu izbūves izmaksām. 

 

 Tehniskais risinājums 

Projekta ietvaros tiek izbūvēta jauna infrastruktūra, lai papildinātu esošo vidējās jūdzes optisko tīklu un 
nodrošinātu 5G mobilo sakaru bāzes staciju izvietošanu.  

Vidējās jūdzes izbūvi pa Rail Baltica trasi, izvietojot optikas kabeli 2 kanalizācijas caurulēs, izbūvēs 
uzņēmums RB Rail. Tīklu aparatūras izvietošanai ir paredzēts katrus 4-5 km izveidot speciālas nišas. 
Bāzes staciju izvietošanai, būtu ļoti efektīvi izmantot neliela augstuma torņus, gadījumā ja  RB Rail 
izbūvēs tādus savām vajadzībām. 

Mobilo sakaru tīkls ap Rail Baltica tiks izbūvēts, lai nodrošinātu: 

➢ Ātrgaitas tīklu, kas izveidots plašākā koridorā ap Rail Baltica trasi 

➢ Ātrgaitas tīklu pamatā vilcienu pasažieriem, kas ātri pārvietojas 

Pirmajā gadījumā tīkla izveide notiek kā scenārijā 5 un atbilstošs nepieciešamo investīciju aprēķins ir 
iekļauts tabulā augstāk šajā sadaļā. 

Otrajā gadījumā jāveido sakaru koridors tieši pa vilciena trasi. Šeit būtu nepieciešams iepazīties ar 
operatora Swisscom pieredzi, kas jau šobrīd braucošā ātrgaitas vilcienā spēj nodrošināt datu 
pārraides ātrumu virs 1Gbps, izmantojot jauktu 4G un 5G tīklu un speciāli izveidotu antenu koridoru58. 
Šī scenārija gadījumā iespējams izmantot zemākas jaudas raidītājus, kas nav jāizvieto augstos torņos, 
taču, lai sasniegtu augstu datu pārraides ātrumu, būtiski ir arī citi faktori, piemēram, vilciena logu 
augstfrekvences elektromagnētiskā lauka caurlaidība. Swisscom sola dalīties ar savu pieredzi. 

Organizatoriskā pieeja 

Investīcijas infrastruktūrā veic, ievērojot uzņēmuma RB Rail plānotos darbus un laika grafiku, un ņemot 
vērā RB Rail plānu Rail Baltica projektu realizēt vienkopus kā vienotu tehnoloģisku risinājumu visās 3 
Baltijas valstīs.  

Stiprās puses59 Vājās puses 

Pieejams ļoti augstas kvalitātes un ātrs 
internets  

Ātrs tīkls pieejams tikai vilciena trases tuvumā 

                                                
58 https://www.swisscom.ch/en/about/news/2020/10/21-mehr-bandbreite-im-zug.html 
59 Analizējot scenāriju, kad ātrgaitas tīkls tiek veidots primāri vilcienu pasažieru vajadzībām 
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5G tīkls nodrošina ļoti zemu signāla aizturi un 
ir izmantojams arī Rail Baltica tehniskajām 
vajadzībām privātā tīkla ietvaros 

Ņemot vērā lielās investīciju izmaksas uz visu 
Rail Baltica trases garumu, interneta pieejamība 
tiek uzlabota salīdzinoši nelielam lietotāju 
skaitam 

Izveidota koplietošanas infrastruktūra, ko var 
izmantot vairāki mobilo sakaru operatori 

Vilcienu satiksmes intensitāte, un līdz ar to 
interneta lietotāju skaits varētu būt pārāk mazs, 
lai nodrošinātu mobilo sakaru komersantu 
interesi izbūvēt mobilo sakaru koridoru visas 
Rail Baltica trases garumā 

Izmaksu ekonomija, izvietojot lielu daļu 
optiskā tīkla pa elektropārvades līniju, 
vienlaicīgi ar tās izbūvi 

 

 

6.9. Piedāvāto valsts atbalsta scenāriju kopsavilkums 

Tabulā zemāk iekļauts piedāvāto valsts atbalsta scenāriju kopsavilkums, kurā sniegta informācija par 
katra scenārija galvenajiem parametriem. Visiem scenārijiem investīciju atdeves novērtējums 20 
gadu periodā ir negatīvs. Tas nozīmē, ka šie scenāriji nav realizējami bez papildus atbalsta.  

Tabula 10. Iespējamie atbalsta scenāriji 

Parametri 1. scenārijs:  
Publiski pārvaldīta 
tīkla modelis – 
vidējā jūdze 

2. scenārijs: 
Publiski pārvaldīta 
tīkla modelis – 
pēdējā jūdze 

3. scenārijs: 
Privāti pārvaldīta 
tīkla modelis 

4. scenārijs: 
Operatora 
subsidēšanas 
modelis 

Plānotās 
investīcijas 
apraksts 

Investīcijas esošās 
vidējās jūdzes 
infrastruktūras 
savienošanā ar 
mobilo sakaru 
komersantu 
torņiem, kā arī 
jaunu mobilo 
sakaru torņu 
būvniecība pie 
esošās vidējās 
jūdzes 
infrastruktūras. 

Investīcijas optiskā 
tīkla izveidei pēdējā 
jūdzē, izmantojot 
esošo vidējās jūdzes 
infrastruktūru.   

Konkursa kārtībā 
izvēlēts privātais 
operators plāno un 
nodrošina interneta 
pakalpojumu 
pieejamību VHCN 
baltajās teritorijās  

Konkurss var tikt 
organizēts pa visu 
valsts teritoriju, 
plānošanas 
reģioniem vai 
pašvaldībām 

Konkursa 
nosacījums – 
tehnoloģiski neitrāls 

Investīcijas 
optiskā tīkla 
izveidē un 
paplašināšanā  

Investīciju 
mērķa joma 

Vidējā jūdze Pēdējā jūdze Vidējā jūdze un / vai 
pēdējā jūdze – 
privātā operatora 
izvēle 

Vidējā jūdze un 
pēdējā jūdze 

Veikto 
investīciju 
īpašnieks 

Valsts vai valsts 
kapitālsabiedrība 

Pašvaldības, kas 
iznomā izveidoto 
infrastruktūru 
interneta 
pakalpojumu 
nodrošinātājam 

Privātais operators Privātais 
operators 

Tehnoloģija Tehnoloģiju neitrāls 
risinājums 

Optiskais internets Tehnoloģiju neitrāls 
risinājums 

Optiskais internets 
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Parametri 1. scenārijs:  
Publiski pārvaldīta 
tīkla modelis – 
vidējā jūdze 

2. scenārijs: 
Publiski pārvaldīta 
tīkla modelis – 
pēdējā jūdze 

3. scenārijs: 
Privāti pārvaldīta 
tīkla modelis 

4. scenārijs: 
Operatora 
subsidēšanas 
modelis 

Interneta 
pieslēguma 
ātrums 

Vismaz 100 Mbit/s 

Pieejamais ātrums 
atkarīgs no 
vienlaicīgā 
interneta lietotāju 
skaita 

Līdz 1 Gbit/s, vismaz 
100Mbit/s. 

 

Vismaz 100 Mbit/s – 
prasības noteiktas 
konkursa 
nosacījumos. 

Definēts diennakts 
laika īpatsvars, kad 
pieejams vismaz 
noteiktais ātrums. 

Līdz 1 Gbit/s, 
vismaz 100Mbit/s. 

 

Investīciju 
atdeves 
novērtējums 
(aprēķini uz 20 
gadiem) 

-115.9 milj. EUR 

Investīciju atdeve 
atkarīga no mobilo 
sakaru torņu 
izvietojuma un to 
cik liels ir plānoto 
lietotāju skaits 
konkrētajā teritorijā. 

Galvenie ieguvēji 
būs 
mājsaimniecības.  

-49.8 milj. EUR 

Investīciju atdeve 
atkarīga no 
izvēlētajiem 
objektiem kam tiek 
pievilkts optiskais 
internets 

Sociālekonomiskajie
m spēkiem šāda 
veida investīcijām 
būs vislielākā atdeve 

 

-667.7 milj. EUR 

Mājsaimniecību 
skaits, kam tiks 
nodrošināta 
interneta 
pieejamība atkarīgs 
no privātā operatora 
piedāvājuma, kā arī 
no tā cik daudz 
mājsaimniecībām 
nav pieejams 
internets noteiktajā 
teritorijā 

-865.5 milj. EUR 

Investīciju atdeve 
ir atkarīga no 
investīciju 
stratēģijas, kurās 
teritorijās tiek 
veiktas 
investīcijas un kas 
ir primārie 
interneta 
pakalpojumu 
saņēmēji, 
piemēram, 
galvenie 
sociālekonomiskie 
virzītājspēki 

Teritorijas Baltās teritorijas, arī 
pieguļošās pelēkās 
un melnās 
teritorijas. 

VHCN Baltās 
teritorijas 

VHCN Baltās 
teritorijas, arī 
pieguļošās pelēkās 
un melnās 
teritorijas. 

VHCN Baltās 
teritorijas 

Labuma guvēji Iedzīvotāji, 
komersanti, valsts 
un pašvaldību 
institūcijas, 
sociālekonomiskie 
virzītājspēki 

Iedzīvotāji, 
komersanti, valsts un 
pašvaldību 
institūcijas, 
sociālekonomiskie 
virzītājspēki 

Iedzīvotāji, 
komersanti, valsts 
un pašvaldību 
institūcijas, 
sociālekonomiskie 
virzītājspēki 

Iedzīvotāji, 
komersanti, valsts 
un pašvaldību 
institūcijas, 
sociālekonomiskie 
virzītājspēki 

Projekta 
īstenotājs 

Publiska iestāde, 
piemēram, LVRTC 

Publiska iestāde, 
piemēram, 
pašvaldība vai 
plānošanas reģions 

Privātais operators 
(izvēlēts konkursa 
kārtībā) 

Privātais 
operators, kas tiek 
izvēlēts konkursa 
kārtībā 

Pašvaldību 
iesaiste 

Pašvaldības 
nodrošina 
nepieciešamo 
atbalstu pie optiskā 
tīkla izveides, zemi 
un atļaujas jaunu 
mobilo operatoru 
sakaru torņu 
izbūvei 

Pašvaldības 
nodrošina 
nepieciešamo 
atbalstu pie optiskā 
tīkla izveides. 
Pašvaldība iznomā 
izbūvēto 
infrastruktūru 

Konkursa 
organizēšanu var 
nodrošināt 
plānošanas reģions 
vai pašvaldība  

Pašvaldības 
nodrošina 
nepieciešamo 
atbalstu pie 
optiskā tīkla 
izveides, tai skaitā 
atļaujas un ātru 
dokumentu 
saskaņošanu  

Avots: PwC un CSE COE pētījums. 
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Lai salīdzinātu šos atbalsta scenārijus, jāņem vērā, ka tiem ir dažādi mērķi - 1.scenārijs risina jautājumu 
par teritorijas paplašināšanu, kurā pieejams VHCN tīkls ar piekļuves ātrumu vismaz 30Mbps, savukārt 
2. – 4.scenāriji risina jautājumu par pieejamā VHCN tīkla pakalpojuma kvalitātes uzlabošanu, 
nodrošinot piekļuves ātrumu vismaz 100Mbps. No šāda skatu punkta raugoties, 1.scenārijs nav 
salīdzināms ar 2.-4.scenāriju. 

2.-4.scenāriju salīdzināšanā tiek ņemts vērā investīciju apjoms uz vienu nosacīto VHCN pakalpojuma 
lietotāju un teritorija, kurā investīciju rezultātā tiek uzlabots pakalpojums. Aprēķinot nosacīto lietotāju 
skaitu, tiek ņemti vērā katra scenārija iznākumu rādītāji - mājsaimniecības, kuras abonē platjoslas 
pieslēgumus ļoti lielas jaudas tīklam, un uzņēmumi, kas abonē platjoslas pieslēgumus ļoti lielas 
ietilpības tīklam. Pie kam tiek pieņemts, ka viens uzņēmums ir 4 reizes nozīmīgāks par vienu 
mājsaimniecību (ņemot vērā investīciju atdeves aprēķinos pieņemtos vidējos maksas pieaugumus 
mēnesī vienai mājsaimniecībai un vienam uzņēmumam). Scenāriju salīdzināšanas aprēķini sniegti 
tabulā. 

Tabula 11. Iespējamo atbalsta scenāriju salīdzinājums 

Parametri 1. scenārijs:  
Publiski pārvaldīta 
tīkla modelis – 
vidējā jūdze 

2. scenārijs: 
Publiski pārvaldīta 
tīkla modelis – 
pēdējā jūdze 

3. scenārijs: 
Privāti pārvaldīta 
tīkla modelis 

4. scenārijs: 
Operatora 
subsidēšanas 
modelis 

VHCN plānotais 
interneta piekļuves 
ātrums (Mbps) >30Mbps >100Mbps >100Mbps >100Mbps 

Mājsaimniecību 
skaits 423832 360163 421498 361383 

Uzņēmumu skaits 89073 73513 93120 70724 

Nosacītie lietotāji 
(skaits) 780122 654215 793978 644277 

Kopējās plānotās 
investīcijas (mEUR) 88.0 266.4 907.1 1030.7 

Investīcijas uz 
vienu nosacīto 
lietotāju 
(EUR/lietotāju) 113 407 1142 1600 

Teritorija, kurā 
investīcijas var 
radīt uzlabojumus 
(km2) 12091 7513 58035 5078 

Galīgais investīciju 
novērtējums 
(EUR/lietotāju/km2) 0.01 0.05 0.02 0.32 

Avots: PwC un CSE COE pētījums. 

 
Ņemot vērā scenāriju atšķirīgos mērķus VHCN plānotajā interneta piekļuves ātrumā, praktiska 
salīdzināšana savā starpā ir iespējama tikai 2.-4.scenārijiem. Rēķinot šiem scenārijiem investīcijas uz 
vienu nosacīto lietotāju uz 1 km2, izriet, ka lielākā investīciju atdeve tiktu sasniegta, realizējot 3. valsts 
atbalsta scenāriju. 

 

6.10. Piedāvāto valsts atbalsta scenāriju atbilstība EK regulējumam 

Šajā sadaļā analizēta piedāvāto valsts atbalsta scenāriju platjoslas tīkliem atbilstība EK Regulai (EK) 
Nr. 794/2004, ar ko īsteno Padomes Regulu (ES) 2015/1589, ar ko nosaka noteikumus Līguma par 
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Eiropas Savienības darbību 108. panta piemērošanai60. Konkrēti analizēta atbilstība minētā 
dokumenta III 5. daļai “Papildinformācijas lapa par valsts atbalstu platjoslas tīkliem”. 

Tabula 12. Atbalsta scenāriju atbilstība EK regulējumam 

Parametri Apraksts 

Nepieciešamību pēc valsts 
iejaukšanās, situācijas 
risināšanu, kurā atbalsts var 
sniegt būtisku uzlabojumu, ko 
tirgus pats nespētu 
nodrošināt (p.1.1.) 

 

Nepieciešamība pēc valsts iejaukšanās izriet no fakta, ko VHCN baltajās 
teritorijās (interneta pieejamība zem 100 Mbit/s), kur šī scenārija ietvaros 
ir plānota valsts iejaukšanās, iedzīvotāju blīvums ir nepietiekami liels, lai 
komersanti bez valsts atbalsta varētu veikt nepieciešamās investīcijas un 
nodrošināt veikto investīciju atdevi.  

Saskaņā ar komersantu (interneta pakalpojumu nodrošinātāji) 
anketēšanas rezultātiem uz 2020.gada septembri, nav plānotas 
investīcijas un pakalpojumu nodrošināšana baltajās teritorijā, tādejādi 
tirgus pats par sevi nenodrošina nepieciešamo interneta pieejamību.   

Valsts iejaukšanās, nodrošinot platjoslas infrastruktūru, radīs pozitīvu 
ārējo ietekmi, rodot iespēju komersantiem nodrošināt pakalpojumus gala 
lietotājiem.  

Saskaņā ar iedzīvotāju blīvuma radīto ekonomiju, platjoslas tīklu 
izvēršana parasti ir rentablāka tur, kur potenciālais pieprasījums ir lielāks 
un koncentrētāks, t. i., blīvi apdzīvotās teritorijās. Ieguldījumu lielo 
pastāvīgo izmaksu dēļ vienības pašizmaksa būtiski pieaug, iedzīvotāju 
blīvumam samazinoties. Līdz ar to komerciāli izvērstie platjoslas tīkli ir 
rentabli tikai attiecībā uz kādu iedzīvotāju daļu.  
 
Investīcijas ir plānotas VHCN baltajās teritorijās, jo saskaņā ar 
anketēšanas rezultātiem nav plānotas investīcijas un pakalpojumu 
nodrošināšana, tādejādi tirgus pats par sevi nenodrošina no sabiedrības 
viedokļa efektīvus rezultātus.  

 

Piemērots instruments 
kopīgu interešu mērķa 
sasniegšanai. Atbalsts netiks 
uzskatīts par saderīgu, ja 
mazāk kropļojoši pasākumi 
ļautu sasniegt to pašu 
pozitīvo rezultātu (p.1.2.) 

Risinājums ir tehnoloģiju neitrāls, kā arī investīcijas notiek publiskajā 
infrastruktūrā, kas piederēs valstij, bet valsts nenodrošinās gala 
pakalpojumus klientiem. Izveidotā infrastruktūra būs pieejama visiem 
ieinteresētajiem operatoriem bez ierobežojumiem, tādēļ piedāvātajam 
risinājumam nav ietekme uz konkurenci. Piedāvātā intervence ir 
samērīga, jo investīcijas tiek piedāvātas vidējā jūdzē, ko varēs izmantot 
visi operatori. Vienlaicīgi atzīmējam, ka tirgu mazāk kropļojoši valsts 
atbalsta pasākumi nav identificējami. 

Kāpēc piešķirtais atbalsts ir 
samērīgs, ciktāl tas atbilst 
minimumam, kas 
nepieciešams 
pamudināšanai uz 
attiecīgajiem ieguldījumiem 
vai darbībām (p.1.3.) 

Plānotais atbalsts ir samērīgs, jo nodrošina minimālās nepieciešamās 
investīcijas infrastruktūrā (optisko tīklu izveide un komunikācijas torņu 
izbūve mobilo bāzes staciju izvietošanai), lai atļautu komersantiem 
piedāvāt pēdējās jūdzes interneta piekļuves pakalpojumus, izmantojot 
mobilos 4G un 5G tīklus vai arī fiksētos pieslēgumus. 
 
Tiks nodrošināta nepieciešamā publicitāte pasākuma galvenajām iezīmēm 
un mērķa zonu sarakstam (piemēram, Satiksmes ministrijas mājas lapā), 
publicējot attiecīgo informāciju par projektu un aicinot iesniegt 
komentārus. Pirms publicitātes pasākumu organizēšanas tiks izvērtēts 
kādā detalizācijas pakāpē var tikt publicēts kartogrāfiskais materiāls, 
neizpaužot operatoru konfidenciālu biznesa informāciju. 
 
Atbalsts tiks piešķirs valsts akciju sabiedrībai, jo valsts nodrošinās 
nepieciešamās investīcijas. Īstenojot investīciju projektu pretendenti tiks 
izvēlēti konkursa kārtībā. Izvēles kritēriji konkursa procedūras ietvaros būs 
ekonomiski visizdevīgākais piedāvājums. 
 

                                                
60 https://eur-lex.europa.eu/legal-content/LV/TXT/HTML/?uri=CELEX:02004R0794-20160317&from=LV  

https://eur-lex.europa.eu/legal-content/LV/TXT/HTML/?uri=CELEX:02004R0794-20160317&from=LV
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Parametri Apraksts 

Nodrošinot pieeju izbūvētajai infrastruktūrai visiem operatoriem, tiek 
nodrošināta tehnoloģiskā neitralitāte, kā arī būvējot sakaru torņus pie 
esošās infrastruktūras, tiek nodrošināta esošās infrastruktūras 
izmantošana. 
 

Iespējamā negatīvā ietekme 
uz konkurenci un tirdzniecību 
un konkretizējiet, kādā mērā 
pozitīvā ietekme atsver to 
(p.1.4.) 

Konkurences kropļojumu apmēru var vērtēt pēc ietekmes uz 
konkurentiem, bet ieteiktajā scenārijā atbalsta saņēmējs nenodrošina 
pakalpojumus gala saņēmējiem, bet gan visiem ieinteresētajiem 
operatoriem, tādejādi nevienam operatoram netiks nodrošināts dominants 
stāvoklis tirgū un visiem ir vienādas iespējas.   
 
Atbalsts tiks piešķirts pārredzami, jo tiks investēts infrastruktūrā, ko var 
izmantot visi pakalpojumu sniedzēji. Tiks nodrošināts, ka dalībvalstis, 
uzņēmēji, sabiedrība un Komisija var viegli piekļūt visiem attiecīgajiem 
dokumentiem un būtiskajai informācijai par piešķirto atbalstu. 

Norādiet valsts iejaukšanās 
loģisko pamatu un 
izskaidrojiet paredzamos 
ieguvumus no atbalsta 
pasākuma (piemēram, 
saimnieciskos un sociālos 
ieguvumus, lielāku platjoslas 
pārklājumu un interneta 
izplatības pakāpi utt. (pp.1.3.) 

Plaša piekļuve platjoslai par pieņemamu cenu radīs pozitīvu ārējo ietekmi, 
jo paātrinās visu tautsaimniecības nozaru izaugsmi un inovāciju.  
Valsts iejaukšanās loģiskais pamats ir fakts, ka tirgus nenodrošina 
pietiekamu platjoslas pārklājumu valsts teritorijās ar salīdzinoši mazu 
iedzīvotāju blīvumu. 
 
Galvenais ieguvums šo teritoriju iedzīvotājiem būs pieeja platjoslas tīklam 
komunikācijai un piekļuvei informācijas un kultūras resursiem, valsts un 
pašvaldību nodrošinātajiem pakalpojumiem, kā arī iespēja strādāt 
attālināti, tādejādi nodrošinot darba iespējas arī ārkārtas situācijās un 
ļaujot ekonomēt laiku nokļūšanai līdz darba vietai.  

Plānotās investīcijas var radīt pozitīvu ietekmi un ekonomiskos stimulus 
uzņēmējdarbībai baltajās teritorijās, nodrošinot iespēju darbiniekiem 
strādāt attālināti. Interneta pieeja nodrošina tiešsaistes  pakalpojumu 
pieejamību. 

Kāda ir atbalsta darbības 
joma teritoriālā pārklājuma 
ziņā (pp.2.1.) 

VHCN baltās teritorijas, kas ir norādītas pievienotajā kartē. VHCN baltās 
teritorijas noteiktas tur, kur interneta pieejamības ātrums ir zemāks par 
100 Mbit/s.  Tās veido 98.4% no visas Latvijas valsts teritorijas. Iespējama 
interneta pakalpojumu pieejamības uzlabošana arī konkrētās pelēkajās un 
melnajās teritorijās. 

Investīcijas tiek plānotas pamatā, lai nodrošinātu piekļuvi iedzīvotājiem, 
kuri dzīvos VHCN baltajās teritorijās 2027.gadā. 

Norādiet informāciju (norādot 
datumu) un iesniedziet 
rezultātus, kuri izriet no 
detalizētās kartēšanas un 
pārklājuma analīzes, kas 
veiktas, lai skaidri noteiktu 
mērķteritorijas (pp.2.2.) 

Detalizēta kartēšana un pārklājuma analīze veikta šī projekta ietvaros un 
aprakstīta 5.sadaļā. 

Paskaidrojiet, kāda veida 
“vairumtirdzniecības līmeņa 
piekļuves” saistības tiks 
piemērotas subsidētajam 
tīklam (tostarp piekļuve 
pasīvajai un aktīvajai 
infrastruktūrai, tiesības 
izmantot kabeļu kanalizāciju 
un stabus, tumšo optisko 

Valsts uzņemsies vairumtirdzniecības līmeņa piekļuves saistības 
izveidotajam subsidētajam tīklam, piekļuve optiskā tīkla pasīvajai un 
aktīvajai infrastruktūrai, tiesības izmantot kabeļu kanalizāciju un stabus, 
optisko šķiedru un āra sadales skapjus, kā arī izbūvētos torņu mobilo 
bāzes staciju izvietošanai. 

 
Šāda vairumtirdzniecības līmeņa piekļuve dos sakaru komersantiem 
iespēju konkurēt savā starpā mazumtirdzniecības līmenī, tādējādi 
paplašinot izvēles iespējas un veicinot konkurenci pasākuma aptvertajās 
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Parametri Apraksts 

šķiedru un āra sadales 
skapjus), un cik ilgi piekļuves 
saistības būs spēkā (pp. 
2.12.) 

teritorijās, vienlaikus novēršot reģionālu pakalpojumu monopolu 
veidošanos.  
 
Atbalsta ietvaros tiks nodrošināta vairumtirdzniecības līmeņa piekļuve 
subsidētajai infrastruktūrai visiem komersantiem uz vismaz septiņiem 
gadiem. Pēc septiņu gadu perioda, ņemot vērā iespējamo 5G attīstību, 
izveidotajai infrastruktūrai varētu nebūt tāda pati ietekme uz tirgu. 

 

Kā tiks noteiktas piekļuves 
etaloncenas (pp. 2.13.) 

Vairumtirdzniecības etaloncenas izveidotās infrastruktūras piekļuvei tiks 
noteiktas, pamatojoties uz izveidotās infrastruktūras uzturēšanas 
izmaksām. Kā arī cenas tiks salīdzinātas ar jau pašlaik noteiktajām cenām 
attiecībā uz LVRTC nodrošinātajiem pakalpojumiem. Lai nodrošinātu reālu 
piekļuvi, attiecībā uz visu subsidēto infrastruktūru, tostarp tā daļām, kurās 
izmanto esošo infrastruktūru, tiks piemēroti vienādi piekļuves nosacījumi. 

Vairumtirdzniecības cenu salīdzinoša noteikšana būs svarīgs instruments, 
kas ļaus nodrošināt, ka ar piešķirto atbalstu tiks radīti tādi paši tirgus 
apstākļi kā citos platjoslas tirgos ar aktīvu konkurenci.  

Platjoslas pakalpojumu mazumtirdzniecības cenas valstī tirgus nepilnību 
kontekstā ir analizētas ziņojuma sadaļā 6.1. 

Tā kā atbilstoši šai analīzei, šobrīd valstī platjoslas pakalpojumu 
mazumtirdzniecības cenas efektīvi nosaka tirgus, paredzam, ka 
mazumtirdzniecībā etaloncenu noteikšana nebūs nepieciešama. 

Kādi pasākuma aspekti tiks 
pakļauti uzraudzībai 
(pp.2.16.) 

Atbalsta piešķīrējas iestādes uzraudzīs visas platjoslas projekta 
īstenošanas aktivitātes visā projekta darbības laikā, ņemot vērā, ka 
projekta rentabilitātes faktiskā attīstība jāuzrauga nopietnāk, kā 
gadījumos, kad infrastruktūras ieviesējs ir izraudzīts iepirkuma procedūrā. 

Kāds būs uzraudzības grafiks 
(pp.2.16.) 

Uzraudzības grafiks būs atkarīgs no plānotajām projekta aktivitātēm un 
ietvers uzraudzību pār konkrēto mobilo sakaru torņu izvēli, jo iespējams, 
ka līdz projekta apstiprināšanai mobilo sakaru operatori veic investīcijas 
mobilo sakaru torņos. Uzraudzība attieksies arī uz iepirkuma procedūrām, 
kuru rezultātā tiks izvēlēti uzņēmēji, kas realizēs projektu. Pēc projekta 
pabeigšanas tiks veikta projekta rezultātu uzraudzība vismaz 5 gadus pēc 
projekta pabeigšanas.  

Projekta ieviešanas uzraudzību veiks Satiksmes ministrija un Optiskā 
Tīkla Uzraudzības Komiteja. 

Aprakstiet valsts regulatīvās 
iestādes nozīmi, jo īpaši 
attiecībā uz mērķteritoriju 
noteikšanu, 
vairumtirdzniecības līmeņa 
piekļuves cenu, tostarp 
etaloncenas noteikšanu, 
strīdu risināšanu utt 
(pp.2.17.) 

Tarifus un vairumtirdzniecības pakalpojumu sniegšanas nosacījumus 
noteiks Satiksmes ministrijas sadarbībā ar Optiskā Tīkla Uzraudzības 
Komiteju un saskaņojot ar SPRK. Satiksmes ministrija izstrādās 
vairumtirdzniecības tīkla piekļuves nosacījumu projektu un saskaņos to ar 
SPRK. 

Etaloncenu noteikšana vairumtirdzniecībā un mazumtirdzniecībā 
aprakstīta augstāk (pp. 2.13). 

Vai atbalsta pasākuma 
mērķis ir sasniegt skaidri 
definētus vispārējas nozīmes 
mērķus (pp. 3. - a) 

Atbalsta pasākuma mērķis ir sasniegt skaidri definētus vispārējas nozīmes 
mērķus, kas noteikti Savienojamības paziņojumā – interneta piekļuves 
ātrums vismaz 100 Mbps – mājsaimniecībām, uzņēmumiem un 
sociālekonomiskajiem virzītājspēkiem. 

Vai atbalsta pasākums skar 
tirgus nepilnību vai būtisku 
nevienlīdzību, kas kavē 

Atbalsta pasākums skar tirgus nepilnību, kas kavē platjoslas tīklu 
pakalpojumu pieejamību – nepietiekama tirgus darbinieku interese lielo 
investīciju un salīdzinoši mazās peļņas dēļ, jo teritorijās, kur tiks izvērsts 
tīkls ir salīdzinoši nedaudz potenciālo jauno klientu. 
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Parametri Apraksts 

platjoslas tīklu pakalpojumu 
pieejamību (pp.3. - c) 

Atbalsta pasākuma 
piemērotība, salīdzinot ar 
mazāk kropļojošiem 
instrumentiem, piemēram, 
pieprasījuma stimulēšanu. 
(pp.3. - e) 

Valstī ir plašas teritorijas, kur nav pieejama VHCN infrastruktūra. Plānotie 
pasākumi ir piemēroti šīs problēmas risināšanai, jo paredz valsts atbalstu 
VHCN infrastruktūras izveidei.  

Citi atbalsta pasākumi, piemēram, pieprasījuma stimulēšana varētu 
darboties, ja šāda infrastruktūra būtu izveidota, bet nebūtu pieejama 
cenas dēļ. 

Stimulējošās ietekmes 
izvērtējums, t.sk. atbalsta 
pasākumu pozitīvā ietekme, 
jaunas iespējas, kas tiks 
ieviestas tirgū platjoslas tīklu 
pakalpojumu pieejamības un 
kvalitātes ziņā. (pp.3. - l) 

Realizējot plānotos valsts atbalsta pasākumus, tiktu radīta platjoslas tīklu 
infrastruktūra, kura nodrošina VHCN tīklu (optisko vai 5G mobilo tīklu) 
pieejamību gala lietotājiem (2., 3. un 4. scenārijs), vai arī nodrošina 
infrastruktūru mobilo tīklu izveidei teritorijās, kur to pārklājums šobrīd ir 
nepietiekams (1., 5. un 6. scenārijs). 

Saskaņā ar piedāvātājiem scenārijiem tiktu nodrošināta platjoslas tīkla 
pakalpojumu pieejamība sociālekonomiskajiem virzītājspēkiem, 
uzņēmumiem un iedzīvotājiem, kas  nodrošinās sociālekonomiskos 
ieguvumus visām iesaistītajām grupām. 

Plānotajām izmaiņām 
atbalsta saņēmēja (-u) rīcībā, 
salīdzinot ar situāciju, ja 
nebūtu atbalsts. (pp.3. – m ) 

Tā kā, izmantojot valsts atbalstu, tiks nodrošināta visiem tirgus 
spēlētājiem pieejama infrastruktūra, sagaidāms, ka komersanti sāks 
piedāvāt pakalpojumus teritorijās, kur tas viņiem šobrīd nav izdevīgi. 
Šādās teritorijās, kur tiks izveidota tehniskā infrastruktūra, arī mazākiem 
komersantiem tiks nodrošinātas iespējas ienākt tirgū. 

Ja plānotās investīcijas netiks veiktas, tad nav gaidāmas izmaiņas 
atbalsta saņēmēju rīcībā un noteiktās Latvijas teritorijās nebūs pieejams 
platjoslas internets. 

Pamatojums, ka bez valsts 
atbalsta tajā pašā laikposmā 
un/vai ar tiem pašiem 
nosacījumiem nebūtu 
iespējams veikt līdzīgu 
ieguldījumu platjoslas tīklos. 
(pp.3. - n) 

Piedāvātajiem valsts atbalsta scenārijiem veiktie nepieciešamo investīciju 
un to atdeves aprēķini (sk. sadaļas 6.3 - 6.8 un atbilstošos pielikumus) 
parāda, ka bez valsts atbalsta plānotie pasākumi nav iespējami.  

Nodrošinājums, ka atbalsta 
pasākuma apjoms 
aprobežosies ar 
nepieciešamo minimumu. 
(pp.3. - o) 

Veiktie nepieciešamo investīciju aprēķini (sk. sadaļas 6.3 - 6.8 un 
atbilstošos pielikumus) konkrēti parāda investīciju nepietiekamību naudas 
izteiksmē. Atbalsta pasākumi nepārsniegs šīs aprēķinātās vērtības.  

Avots: PwC un CSE COE pētījums. 
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7. Pamatojums nepieciešamajai 
valsts intervencei 

Darba uzdevuma mērķis ir sagatavot valsts atbalsta principiem atbilstošu pamatojumu 
nepieciešamai valsts intervencei, balstītai uz ilgtspējīgiem investīciju modeļiem, kuri uzlabo 
pieejamību un piekļuvi atvērtai, kvalitatīvai un nākotnes prasībām atbilstošai infrastruktūrai un 
pakalpojumiem, pielāgo finanšu atbalsta formas identificētajām tirgus nepilnībām un ļauj papildus 
izmantot dažādus finansējuma veidus no ES (tostarp CEF2 Digital ) un valsts, un pašvaldībām. 

 

7.1. Sasniedzamie ES līmeņa politikas mērķi 

Definējot Digitālo programmu Eiropai (DPE)61 par ES pamatiniciatīvu, tika skaidri apliecināts, ka 
stratēģijā “Eiropa 2020” ir atzīta IKT nozīme gudras, ilgtspējīgas un integrējošas izaugsmes 
īstenošanā. DPE noteiktais mērķis nodrošināt “platjoslas pamatpakalpojumu pieejamību visiem” tika 
sasniegts 2013. gadā, izmantojot gan virszemes fiksēto un bezvadu, gan satelīta tehnoloģiju. 
Nākamais mērķis saistībā ar platjoslu, kas noteikts DPE, sasniedzot līdz 2020. gadam, ir nodrošināt 
100 % piekļuvi daudz lielākam interneta ātrumam (30 Mb/s) un to, ka 50% ES mājsaimniecību var 
abonēt interneta pieslēgumu ar ātrumu 100 Mb/s.  
 
Lai precīzāk definētu, kādai vajadzētu būt ES interneta savienojamībai nākotnē, Eiropas Komisija 
2016.gada septembrī nāca klajā ar Savienojamības paziņojumu62, kurā ir izklāstīti stratēģiskie mērķi 
attiecībā uz elektronisko sakaru tīklu izvēršanu līdz 2025.gadam. Savienojamības paziņojuma 
stratēģiskie mērķi 2025. gadam ir sekojoši63: 
 

• visām Eiropas mājsaimniecībām gan laukos, gan pilsētās ir pieejams interneta pieslēgums 
ar vismaz 100 Mbiti/s64 lejupielādes  ātrumu, ko var uzlabot līdz gigabitu ātrumam; 

• gigabitu savienojamība ir visiem galvenajiem sociālekonomiskajiem virzītājspēkiem;  

• pilsētu teritorijām un visām sauszemes transporta maģistrālēm ir nepārtraukts 5G 

pārklājums (starpposma mērķis 2020. gadam - 5G savienojamība kā pilnvērtīgs 

komercpakalpojums ir pieejama vismaz vienā lielā pilsētā katrā dalībvalstī, pamatojoties uz 

komerciālu ieviešanu 2018. gadā); 

• mobilo sakaru pieejamība visur, kur cilvēki dzīvo, strādā, ceļo un satiekas. 

 

 

 

 

 

 

                                                
61 https://www.europarl.europa.eu/factsheets/lv/sheet/64/digital-agenda-for-europe 
62Eiropas Komisijas paziņojums “Virzība uz Eiropas Gigabitu sabiedrību”, COM(2016)587, https://eur-lex.europa.eu/legal-
content/LV/TXT/HTML/?uri=CELEX:52016DC0587&qid=1587925627855&from=EN 
63 https://ec.europa.eu/digital-single-market/en/policies/improving-connectivity-and-access 
64 Platjoslas elektronisko sakaru tīkls, kas nodrošina datu pārraides ātrumu100 Mbiti/s, ir ļoti augstas veiktspējas tīkls jeb 
VHCN (Very high capacity network).  



  
  

“Pētījums Eiropas Savienības fondu 2021. -2027. gada plānošanas perioda ieguldījumu priekšnosacījumu izpildei”     (gala ziņojums)
  

   100 

 

Ieteikumi 

Savienojamības paziņojumā iekļauti trīs galvenie mērķi un katra mērķa sasniegšanai var tikt 
izmantotas savs finansējuma avots un dažādas tehnoloģijas, tādēļ katra mērķa ieviešana būtu 
izvērtējama atsevišķi, kā arī veidojami atsevišķi vai integrēti mērķu sasniegšanas scenāriji.  
 

 

 

7.2. Platjoslas sakaru tīklu attīstības scenāriji  

Rokasgrāmatā par ieguldījumiem ātrdarbīgu platjoslas sakaru tīklu attīstībā65 (Rokasgrāmata) 
aprakstīti četri platjoslas tīkla attīstības scenāriji. Papildus ņemta vērā EK publikācija par platjoslas 
attīstību lauku apvidos un attālinātās teritorijās66.  
 
Publiski pārvaldīta pašvaldības tīkla modelis (dēvēts arī par publisko projektēšanas-būvniecības 
ekspluatācijas modeli (DBO), lai gan var ietvert arī publiskās un privātās partnerības (PPP) elementus). 
Ja tiek īstenots publiski pārvaldīta pašvaldības tīkla modelis, publiskā iestāde izveido platjoslas tīklu 
pašvaldībā, apgabalā vai reģionā. Šā modeļa galvenā iezīme ir tā, ka publiskā iestāde vada un tieši 
kontrolē ierīkošanu. Šajā nolūkā parasti esošās struktūras ietvaros ir jāizveido jauns uzņēmums vai 
īpaša struktūrvienība. Šī struktūrvienība ierīko tīklu vai nu tieši, vai arī, rīkojot standarta iepirkumu, kurā 
piesaista tirgus dalībniekus (inženiertehnisko darbu un tīklu ierīkošanas uzņēmumus, ne telesakaru 
operatorus). 
 
Privāti pārvaldīta pašvaldības tīkla modelis (dēvēts arī par publisko ārpakalpojumu vai koncesijas 
modeli), īstenojot privāti pārvaldīta pašvaldības tīkla modeli, publiskā iestāde rīko iepirkumu un uztic 
pašvaldības, apgabala vai reģiona platjoslas tīkla izveidi un ekspluatāciju privātam uzņēmējam. 
Dažkārt šo modeli dēvē par publiskā ārpakalpojuma modeli vai koncesijas modeli. 
 
Kopienas platjoslas modelis - ieguldījumus platjoslas sakaru tīkla attīstībā privātas iniciatīvas 
ietvaros veic vietējie iedzīvotāji, īstenojot “augšupēju” pieeju. Šāds līdzdalības modelis parasti ļoti 
veiksmīgi piesaista projektiem potenciālos galalietotājus un veicina finansiāli ilgtspējīgu risinājumu 
izstrādi. Konkurences līmenis ir atkarīgs no projekta veida — bieži tiek īstenots atvērtā tīkla 
uzņēmējdarbības modelis. 
 
Operatora subsidēšanas modelis (dēvēts arī par deficīta finansēšanu vai privāto DBO). Ja tiek 
īstenots operatora subsidēšanas modelis, publiskā iestāde nolemj tieši neiesaistīties reģiona platjoslas 
pārklājuma nodrošināšanā un tikai piešķir subsīdijas vienam tirgus dalībniekam (parasti 
nozīmīgākajam telesakaru operatoram) tā infrastruktūras modernizācijai. Ar jaunas infrastruktūras 
būvniecību un pietiekama klientu skaita piesaistīšanu saistītos riskus uzņemas finansējuma saņēmēji.  
 
Platjoslas ierīkošanu var uzskatīt arī par vispārējas tautsaimnieciskas nozīmes pakalpojumu 
(VTNP). Šādam ieguldījumam ir jāsaņem EK apstiprinājums. Šis ir viens no vissarežģītākajiem rīcības 
variantiem, tomēr tā īstenošana nav neiespējama67.  
 
Citu valstu piemēri attiecībā uz platjoslas attīstību ir iekļauti ziņojuma pielikumā. Grieķijā un Austrijā 
tiek attīstīti PPP modeļi, Ungārijā ERAF finansējums tiek izmantots optiskā tīkla attīstībai, Igaunijā 

                                                
65 https://ec.europa.eu/newsroom/dae/document.cfm?doc_id=12891 
66 https://ec.europa.eu/digital-single-market/en/news/broadband-handbook-facing-challenges-broadband-deployment-rural-
and-remote-areas 
67 http://ec.europa.eu/competition/state_aid/cases/236358/236358_1183816_63_2.pdf 
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ERAF finansējums tiek izmantots vidējās jūdzes attīstībai, Lietuvā ELFLA līdzekļi tiek izmantoti 
interneta pieejamības lauksaimniekiem nodrošināšanai. 
 

 

Ieteikumi 

Izvērtējami visi attīstības scenāriji, izņemot kopienas platjoslas modelis, jo anketēšanas rezultātā 
pašvaldības nav norādījušas interesi attīstīt kopienas platjosla modeli.  
 
Tāpat nav izvērtējams vispārējas tautsaimniecības nozīmes pakalpojumu modelis, jo jau ir veiktas 
ievērojamas publiskā finansējuma investīcijas interneta pieejamības veicināšanā un šāda scenārija 
izveidei būtu nepieciešams ievērojams laiks, jāsaņem EK apstiprinājums, kā arī šis ir viens no 
vissarežģītākajiem rīcības variantiem. Papildus jāņem vērā, ka Latvijā lielākajā daļā teritorijas ir 
piekļuve internetam, kā arī lielā daļā Latvijas teritorijas tiek nodrošināta konkurence starp mobilo 
sakaru operatoriem, tādēļ būs grūti pierādīt valsts atbalstu visā valsts teritorijā. Kā piemērs tiek 
minēta Igaunija68, bet apstiprinājums ir iegūts 2010.gadā.  
 

 

 

7.3. Platjoslas sakaru tīklu attīstības finansēšanas modeļi  

 
Rokasgrāmatā par ieguldījumiem ātrdarbīgu platjoslas sakaru tīklu attīstībā69 (Rokasgrāmata) 
aprakstīti finansēšanas modeļi, ko platjoslas attīstībai var īstenot publiskā iestāde – parasti vienlaikus 
tiek izmantoti vairāki finansēšanas instrumenti, tas ir: 

• Finansējums no ienākumiem – pašfinansēšana (atkārtota ienākumu ieguldīšana, piemēram, 
no maksām par tīkla savienojumu, pakalpojumu un tīkla pakalpojumu sniedzējiem 
piemērotajām maksām, tumšās šķiedras iznomāšanas u.tml.); 

• Privātais kapitāls un finanšu tirgi – finanšu tirgū gūtais pašu kapitāls un aizņēmumi 
(korporatīvais finansējums), pašu kapitāls un aizņēmumi, ko kopuzņēmuma ietvaros iegulda 
partneri (projekta finansējums); 

• Valdības garantēti banku aizdevumi un obligācijas (garantijas); 

• Publiskais finansējums – aizdevumi ar atvieglotiem nosacījumiem, projekta obligācijas, 
dotācijas, suverēns finansējums; 

• Augšupējs kopienas finansējums – gūts no galalietotājiem, vietējām asociācijām.  

 

 

Ieteikumi 

Finansēšanas modelis būs atkarīgs no izvēlētā attīstības scenārija un projekta ietvaros izvērtējams 
tikai publiskais finansējums.  

 
 

                                                
68 https://ec.europa.eu/competition/state_aid/cases/236358/236358_1183816_63_2.pdf 
69 https://ec.europa.eu/newsroom/dae/document.cfm?doc_id=12891 
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7.4. Pašvaldību anketēšanas rezultāti par nepieciešamajiem atbalsta 
mehānismiem 

Projekta ietvaros nosūtītas anketas 119 pašvaldībām (110 novadiem un 9 republikas pilsētām), 
atbildes saņemtas no 103 respondentiem jeb 87%. Anketēšanas mērķis bija uzzināt pašvaldību 
viedokli par nepieciešamajiem atbalsta mehānismiem nodrošinot interneta pieejamību ES fondu 2021.-
2027.gada plānošanas periodā.  
 
Nepieciešamie atbalsta mehānismi  

“Vai ES fondu 2021.-2027. gada plānošanas periodā nepieciešams atbalsts interneta vidējās jūdzes 
savienojuma nodrošināšanai? Kāda veida atbalsts nepieciešams 2021.-2027. gada plānošanas 
periodā?” 

Visvairāk aptaujāto jeb 24 % atzīst nepieciešamību pēdējās jūdzes projektu atbalstam, kā arī 21% 
respondentu redz nepieciešamību atbalstīt vidējās jūdzes projektus. Pašvaldības atzīst vaučeru 
nepieciešamību pakalpojumu cenas subsidēšanai (21%) un infrastruktūras attīstībai (17%). 
 

Attēls 29. Darbības  interneta attīstībai 

 

Avots: PwC un CSECOE anketēšanas rezultāti 

“Vai ES fondu 2021.-2027. gada plānošanas periodā nepieciešams atbalsts interneta pēdējās jūdzes 
savienojuma nodrošināšanai? Kāda veida atbalsts nepieciešams 2021.-2027. gada plānošanas 
periodā?” 

66% aptaujāto pašvaldību par nozīmīgu uzskata pēdējās jūdzes attīstību ES fondu 2021.-2027. gada 
plānošanas periodā. Svarīgākie pasākumi – pēdējās jūdzes projekta īstenošanas turpināšana (29%),  
pakalpojuma cenas subsidēšana (27%), lielāka komersantu iesaiste (23%), bet maznozīmīgākā – 
dotāciju piešķiršana infrastruktūras attīstībai (19%). 
 
Visvairāk aptaujāto jeb 30 % atzīst nepieciešamību pēdējās jūdzes projektu atbalstam. Pašvaldības 
atzīst vaučeru nepieciešamību pakalpojumu cenas subsidēšanai (28%) un infrastruktūras attīstībai 
(19%). Liela daļa respondentu (23%) norāda uz nepieciešamību iesaistīt komersantus pēdējās jūdzes 
nodrošināšanā. 
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Attēls 30. Darbības “pēdējās jūdzes” attīstīšanai 

 

Avots: PwC un CSECOE anketēšanas rezultāti 

 

Ieteikumi 

Lielākā daļa respondentu jeb 71% atbalsta pēdējās jūdzes projektu īstenošanas turpināšanu, lielāku 
komersantu iesaisti un grantus infrastruktūras attīstībai. Tikai 27% respondentu atbalsta 
pakalpojumu cenas subsidēšanu, tādejādi būtu turpināmas investīcijas infrastruktūrā nevis 
pakalpojumu cenu subsidēšana. 

 
 

7.5. Normatīvais regulējums  

 
Normatīvais regulējums  

 
Platjoslas attīstību nosaka dažādi ES normatīvie akti, tai skaitā: 
 

• Eiropas Parlamenta un Padomes Direktīva 2002/21/EK (2002. gada 7. marts) par kopējiem 
reglamentējošiem noteikumiem attiecībā uz elektronisko komunikāciju tīkliem un 
pakalpojumiem (pamatdirektīva)70; 

• Eiropas Parlamenta un Padomes Direktīva 2002/19/EK (2002. gada 7. marts) par piekļuvi 
elektronisko komunikāciju tīkliem un ar tiem saistītām iekārtām un to savstarpēju savienojumu 
(piekļuves direktīva)71; 

• Komisijas Ieteikums (2007. gada 17. decembris) par attiecīgajiem produktu un pakalpojumu 
tirgiem elektronisko sakaru nozarē, kuros var būt nepieciešams ex ante regulējums saskaņā ar 
Direktīvu 2002/21/EK par kopējiem reglamentējošiem noteikumiem attiecībā uz elektronisko 
komunikāciju tīkliem un pakalpojumiem (izziņots ar dokumenta numuru K(2007) 5406)72; 

                                                
70 https://eur-lex.europa.eu/legal-content/LV/ALL/?uri=CELEX:32002L0021 
71 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX:32002L0019&qid=1602703860197 
72 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=uriserv:OJ.L_.2007.344.01.0065.01.LAV&toc=OJ:L:2007:344:TOC 
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• 2013/466/ES: Komisijas Ieteikums (2013. gada 11. septembris) par saskanīgiem 
nediskriminēšanas pienākumiem un izmaksu aprēķināšanas metodēm, lai veicinātu konkurenci 
un uzlabotu ieguldījumu vidi platjoslas pakalpojumu jomā73; 

• Ieteikums par saskanīgiem nediskriminēšanas pienākumiem74. 
 

Attīstot platjoslas projektus, izmantojot publisko finansējumu, svarīgi ņemt vērā valsts atbalsta 
jautājumus un saistošo normatīvo regulējumu, tai skaitā: 

• Komisijas Regulas (ES) Nr. 1407/2013  (2013. gada 18. decembris) par Līguma par Eiropas 
Savienības darbību 107. un 108. panta piemērošanu de minimis atbalstam75; 

• Komisijas Regula (ES) 2020/972  (2020.gada 2.jūlijs), ar ko groza Regulu (ES) Nr. 1407/2013 
attiecībā uz tās pagarināšanu un groza Regulu (ES) Nr. 651/2014 attiecībā uz tās pagarināšanu 
un attiecīgiem pielāgojumiem76; 

• Komisijas Regula (ES) Nr. 360/2012 (2012.gada 35.aprīlis) par Līguma par Eiropas Savienības 
darbību 107. un 108.panta piemērošanu de minimis atbalstam, ko piešķir uzņēmumiem, kuri 
sniedz pakalpojumus ar vispārēju tautsaimniecisku nozīmi77; 

• Komisijas Regula (ES) Nr. 651/2014  ar ko noteiktas atbalsta kategorijas atzīst par saderīgām 
ar iekšējo tirgu piemērojot Līguma 107. un 108. pantu78; 

• Komisijas komunikācija, ES pamatnostādnes valsts atbalsta noteikumu piemērošanai attiecībā 
uz platjoslas tīklu ātru izvēršanu, 2013/C 25/0179; 

• Komisijas paziņojums par Līguma par Eiropas Savienības darbību 107.panta 1.punktā minēto 
valsts atbalsta jēdzienu, 2016/C 262/0180; 

• Valsts atbalsts un ES fondi81, DG BUG pētījums, 2018.gada aprīlis, nosakot, ka ES tieši 
administrētais finansējums neveido valsts atbalstu; 

• Komisijas lēmumi attiecībā uz valsts atbalsta jautājumiem82; 

• Valsts atbalsta pieteikuma formas83. 
 

Valsts atbalsts 

Zemāk iekļauta informācija par valsts atbalsta nosacījumiem, izmantojot dažādu normatīvo 
regulējumu, pētījumus vai citus materiālus.  
 

 

Valsts atbalsta jēdziens84 (Līgums par Eiropas Savienības darbību) 

                                                
73 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX:32013H0466 
74 https://ec.europa.eu/digital-single-market/en/news/commission-recommendation-consistent-non-discrimination-
obligations-and-costing-methodologies 
75 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX%3A32013R1407 
76 https://eur-lex.europa.eu/legal-content/EN/TXT/?qid=1602704100093&uri=CELEX:32020R0972 
77 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX:32012R0360&qid=1602704113198 
78 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX:32014R0651&qid=1602704139143 
79 https://eur-lex.europa.eu/legal-content/GA/TXT/?uri=CELEX:52013XC0126(01) 
80 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX%3A52016XC0719%2805%29 
81 https://www.europarl.europa.eu/cmsdata/142819/Briefing_State%20Aid%20and%20EU%20funding_Final.pdf 
82 https://ec.europa.eu/competition/sectors/telecommunications/broadband_decisions.pdf 

83 https://ec.europa.eu/competition/state_aid/legislation/forms.htm 

 
84 https://eur-lex.europa.eu/legal-content/GA/TXT/?uri=CELEX:52013XC0126(01) 

 

https://ec.europa.eu/competition/state_aid/legislation/forms.html
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Lai pasākumu varētu uzskatīt par valsts atbalstu, ir jābūt izpildītiem šādiem kumulatīviem 
nosacījumiem:  
 
a) pasākums tiek īstenots no valsts līdzekļiem; 
b) tas rada ekonomiskas priekšrocības uzņēmumiem;  
c) priekšrocības ir selektīvas; 
d) rada vai draud radīt konkurences izkropļojumus; 
e) pasākums ietekmē tirdzniecību starp dalībvalstīm. 
 
ES tieši pārvaldītais finansējums un valsts atbalsta jēdziens85 (Regula 651/2014) 

(26) Savienības finansējums, kuru centralizēti pārvalda Savienības iestādes, aģentūras, 

kopuzņēmumi vai citas struktūras un kurš nav dalībvalstu tiešā vai netiešā kontrolē, nav 

uzskatāms par valsts atbalstu. Ja šāds Savienības finansējums tiek apvienots ar valsts 

atbalstu, tad, lai noteiktu, vai ir ievērotas paziņošanas robežvērtības un atbalsta maksimālā 

intensitāte, būtu jāņem vērā vienīgi valsts atbalsts, ja vien publiskā finansējuma kopsumma, kas 

piešķirta attiecībā uz vienām un tām pašām attiecināmajām izmaksām, nepārsniedz labvēlīgāko 

finansējuma likmi, kura noteikta piemērojamajos Savienības tiesību aktos. 
 
Valsts atbalsts un publiskās iestādes86 
 
Turpretī savienojumu nodrošināšana vienīgi publiskajām iestādēm nav saimnieciskā darbība, 
tāpēc tā dēvēto “slēgto tīklu” publiskā finansēšana nav valsts atbalsts87. 
 

 

Zemāk ir iekļauta informācija par katru no valsts atbalsta nosacījumiem saistībā ar valsts atbalsta 
jautājumiem un platjoslas internetu Komisijas paziņojums 2013/C 25/0188. 

Valsts līdzekļu izmantošana – dotācijas, nodokļu atlaides, aizdevumi, labums natūrā, ELFLA, ERAF. 

Uzņēmums – arī valsts uzņēmums vai ar valsts administrācijas starpniecību. Saimnieciskā darbībā, 
arī platjoslas tīkla infrastruktūras izbūve. Nav valsts atbalsts, ja nevienam nerada priekšrocības, bet, 
ja ļauj izmantot ieguldītājiem platjoslā vai operatoriem, tad visticamāk būs valsts atbalsts. 

Priekšrocības – valsts iestāde uzvarējušam pretendentam piešķirs subsīdijas. 

Selektivitāte – valsts pasākumi selektīvi, jo ir vērsti uz ieguldījumiem platjoslā. 

Konkurences kropļošana – atbalsts kropļo konkurenci. 

Ietekme uz tirdzniecību – var ietekmēt citu dalībvalstu pakalpojumu sniedzējus. 

 
Komisijas Regula (ES) Nr. 651/201489 ar ko noteiktas atbalsta kategorijas atzīst par saderīgām 
ar iekšējo tirgu piemērojot Līguma 107. un 108. pantu 
 

                                                
85 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX%3A32014R0651 
86 ES pamatnostādnes valsts atbalsta noteikumu piemērošanai attiecībā uz platjoslas tīklu ātru izvēršanu (OV C 25, 

26.1.2013., 1. lpp.), 11. punkts un 14. zemsvītras piezīme. 
 
87 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX%3A52016XC0719%2805%29#ntr319-
C_2016262LV.01000101-E0319 
88 https://eur-lex.europa.eu/legal-content/GA/TXT/?uri=CELEX:52013XC0126(01) 
89 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX%3A32014R0651 

https://eur-lex.europa.eu/legal-content/LV/AUTO/?uri=OJ:C:2013:025:TOC
https://eur-lex.europa.eu/legal-content/LV/AUTO/?uri=OJ:C:2013:025:TOC
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4. pants  

Paziņošanas robežvērtības 

1.   Šo regulu nepiemēro atbalstam, kurš pārsniedz šādas robežvērtības: 

a) reģionālais ieguldījumu atbalsts: “atbalsta koriģētā summa”, kas ieguldījumam, kura 
attiecināmās izmaksas ir EUR 100 miljoni, aprēķināta saskaņā ar 2. panta 20. punktā 
noteikto mehānismu; 

b) atbalsts platjoslas infrastruktūrai: kopējās izmaksas EUR 70 miljoni vienam projektam; 

13.pants  

Shēmas, kas paredzētas tūrisma darbībām, platjoslas infrastruktūrai vai lauksaimniecības 
produktu pārstrādei un tirdzniecībai, neuzskata par tādām, kuras paredzētas konkrētām 
saimnieciskās darbības nozarēm.  

14.pants - Reģionālais atbalsts platjoslas tīkla attīstīšanai atbilst šādiem nosacījumiem: 

a) atbalstu piešķir tikai apgabalos, kuros nav tādas pašas kategorijas (pamata platjoslas vai 
NGA) tīkla un kuros ir maz ticams, ka šāds tīkls varētu uz komerciāliem pamatiem tikt izveidots 
triju gadu laikā no lēmuma piešķirt atbalstu; un 

b) subsidētajam tīkla operatoram ir jāpiedāvā aktīva un pasīva vairumtirdzniecības līmeņa 
piekļuve saskaņā ar taisnīgiem un nediskriminējošiem nosacījumiem, kas attiecībā uz NGA tīkliem 
ietver fizisku atsaisti; un 

c) atbalstu piešķir, pamatojoties uz konkursa procedūru. 

52. pants 

Atbalsts platjoslas infrastruktūrai 

1.   Ieguldījumu atbalsts platjoslas tīkla attīstīšanai ir saderīgs ar iekšējo tirgu Līguma 107. panta 3. 
punkta nozīmē un ir atbrīvots no Līguma 108. panta 3. punktā noteiktās paziņošanas prasības, ja 
ir izpildīti šajā pantā un I nodaļā paredzētie nosacījumi. 

2.   Attiecināmās izmaksas ir šādas: 

a) ieguldījumu izmaksas platjoslas pasīvās infrastruktūras izvēršanai; 

b) ieguldījumu izmaksas ar platjoslu saistītiem inženiertehniskajiem darbiem; 

c) ieguldījumu izmaksas pamata platjoslas tīklu izvēršanai; un 

d) ieguldījumu izmaksas nākamās paaudzes piekļuves (“NGA”) tīklu izvēršanai. 

3.   Ieguldījumus veic tikai apgabalos, kuros nav tādas pašas kategorijas (pamata platjoslas vai 
NGA tīkla) infrastruktūras un kuros ir maz ticams, ka šāda infrastruktūra varētu uz komerciāliem 
pamatiem tikt izveidota triju gadu laikā no brīža, kad publicēta informācija par plānoto atbalsta 
pasākumu, ko turklāt pārbauda atklātā sabiedriskajā apspriešanā. 

4.   Atbalstu piešķir, pamatojoties uz atklātu, pārredzamu un nediskriminējošu konkursa procedūru, 
ievērojot tehnoloģiju neitralitātes principu. 

5.   Tīkla operators piedāvā plašāko iespējamo aktīvo un pasīvo vairumtirdzniecības līmeņa 
piekļuvi, ievērojot šīs regulas 2. panta 139. punktu, saskaņā ar taisnīgiem un nediskriminējošiem 
nosacījumiem, kas attiecībā uz NGA tīkliem ietver fizisku atsaisti. Šādu vairumtirdzniecības līmeņa 
piekļuvi nodrošina vismaz septiņus gadus, bet piekļuves tiesības kabeļu kanalizācijai un stabiem ir 
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beztermiņa. Attiecībā uz atbalstu kabeļu kanalizācijas izbūvei kabeļu kanalizācijai jābūt pietiekami 
ietilpīgai, lai tajā būtu vieta vairākiem kabeļu tīkliem un dažādām tīkla topoloģijām. 

6.   Vairumtirdzniecības līmeņa piekļuves cena pamatojas uz valsts regulatīvās iestādes 
noteiktajiem cenu principiem un uz salīdzinošajiem rādītājiem citos attiecīgās dalībvalsts vai 
Savienības apgabalos, kuros ir izteiktāka konkurence, ņemot vērā tīkla operatora saņemto 
atbalstu. Ar valsts regulatīvo iestādi apspriežas par piekļuves nosacījumiem, tostarp cenām, un 
par strīda gadījumiem starp piekļuves prasītājiem un subsidētās infrastruktūras operatoru. 

7.   Ja projektam piešķiramā atbalsta summa pārsniedz EUR 10 miljonus, dalībvalstis izveido 
uzraudzības un atgūšanas mehānismu. 

 
Galalietotāju subsidēšana – de minimis nosacījumi  

 
Pašvaldības var veicināt pieejamību piemēram, izmantojot MVU IKT inovācijas kuponus90, lai (daļēji) 
segtu vai nu galalietotāju izmaksas par platjoslas ierīču uzstādīšanu vai iegādi, vai arī ikmēneša 
abonentmaksu. Ja publiskā iestāde vēlas izmantot šo instrumentu, viņiem vispirms būtu jānoskaidro, 
vai viņi atbilst de minimis nosacījumam.  
 
Cits risinājums būtu piemērot MVU kuponiem grupu atbrīvojumu kā atbalstam, kas piešķirts MVU vai 
inovatīviem uzņēmumiem. Ja platjoslas projekts atbilst šim kritērijam, netiek piemērotas nekādas 
papildu prasības par valsts atbalstu. Ja atbalsts ir lielāks par de minimis projekta robežvērtību, t. i., 
EUR 200 000 vienam atbalsta saņēmējam, vai tam netiek piemērots grupu atbrīvojums, to varētu 
uzskatīt par valsts atbalstu, ja ir iesaistīts netiešais atbalsts. Netiešais atbalsts ir iespējams, jo summas, 
kas piešķirtas teritorijas mājsaimniecībām vai MVU. Papildu informācija par šādiem atbalsta veidiem 
publicēta EK plānā par IST kuponiem91 un bukletā par IST inovācijas kuponiem92. 

 

 

Ieteikumi 

Plānojot interneta pieejas attīstības scenārijus, ņemt vērā valsts atbalsta jautājumus, bet detalizētu 
izvērtējumu veikt izvēlētajam scenārijam.  

Valsts atbalsta jautājumi nav piemērojami investīcijām publiskajām iestādēm, bet, ja veiktās 
investīcijas var izmantot operatori, tad uz veiktajām investīcijām attiecas valsts atbalsta jautājumi. 

Valsts atbalsta jautājumi nav piemērojami ES tieši administrētajām investīcijām, piemēram, 
CEF2. Tajā pašā laikā jāņem vērā, kurš lemj par nacionālā līdzfinansējuma apjomu un lielumu, jā tā 
ir dalībvalsts, tad valsts atbalsta nosacījumi ir ievērojami. 

Regulas 651/2014 piemērošana neatbrīvo no valsts atbalsta programmas sagatavošanas un 
kopsavilkuma informācijai Eiropas Komisijai sagatavošanas un nosūtīšanas. Piemērojot regulu 
Nr.651/2014 dalībvalsts vienīgi ir atbrīvota no šīs programmas notificēšanas Eiropas Komisijai. 

Platjoslas attīstība piemērojot reģionālo atbalstu un ievērojot noteiktus nosacījumus, kā arī 
nodrošinot atbilstību visu Regulas 651/2014 14.panta nosacījumu izpildei.  

Saskaņā ar Finanšu ministrijas skaidrojumu, atbilstoši regulas Nr.651/2014 2.panta 27.punktā 
sniegtajai atbalstāmā apgabala definīcijai visa Latvijas teritorija ir uzskatāma par atbalstāmo 

                                                
90 http://ec.europa.eu/digital-agenda/en/ict-innovation-vouchers-scheme-regions. 
91 http://ec.europa.eu/digital-agenda/node/67716 
92 http://ec.europa.eu/digital-agenda/node/67113 
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apgabalu atbilstoši Līguma 107.panta a)apakšpunktam, attiecīgi, vai, ievērojot jau veiktās 
investīcijas platjoslās Latvijas teritorijā, uz Latviju ir iespējams attiecināt regulas Nr.651/2014 
14.panta 10.punkta a) apakšpunktu - atbalstu piešķir tikai apgabalos, kuros nav tādas pašas 
kategorijas (pamata platjoslas vai NGA) tīkla un kuros ir maz ticams, ka šāds tīkls varētu uz 
komerciāliem pamatiem tikt izveidots triju gadu laikā no lēmuma piešķirt atbalstu. Attiecībā uz 
pēdējo jūdzi regulas Nr.651/2014 14.panta piemērošana nav iespējama vispār, ievērojot to, ka 
regulas Nr.651/2014 14.panta 10.punkta apakšpunktu nosacījumiem visiem ir jāizpildās vienlaicīgi.  

Projekta ietvaros netiek izvērtēta iespēja noteikt interneta piekļuvi kā vispārēju tautsaimniecības 
nozīmes pakalpojumu, jo tas ir ļoti laikietilpīgs process un reti izmantots starp dalībvalstīm. 

 

7.6. Latvijas noteikto prioritāšu sasniegšanas iespējas 

Savienojamības paziņojuma stratēģiskie mērķi 2025. gadam var tikt sasniegti izmantojot dažādus 
plānotos pasākumus un finansējuma iespējas, tai skaitā: 

• NAP2027 noteiktos pasākumus platjoslas infrastruktūras attīstībai; 

• ES fondu 2021.-2027.gada plānošanas perioda Eiropas reģionālās attīstības fonda 
finansējumu (3.1. prioritātei - 32 907 750 EUR); 

• CEF2 finansējumu – 5G Baltijas jūras koridors; 

• Citus finansējuma avotus. 

Katram no finansējuma veidiem ir savi nosacījumi un finansējamās jomas prioritātes. Zemāk aprakstīti 
projektu ieviešanas veidi izmantojot dažādus finansēšanas avotus.  

7.6.1. Plānotie ieguldījumi savienojamībā NAP2027 un ES fondu 2021.-2027. 
gada plānošanas periodā Latvijā 

Latvijas Nacionālais attīstības plāns 2021.-2027. gadam ir dokuments, kas nosaka lielākos valsts 
budžeta, kā arī ES fondu līdzekļu ieguldījumus valsts attīstībā93. Tajā paredzēti 4 platjoslas 
infrastruktūras attīstībai atbilstoši digitalizācijas pasākumi, kuru atbildīgā ministrija ir Satiksmes 
ministrija. Pasākumiem kopējais paredzamais finansējums ir 32 375 000 EUR (ERAF un valsts 
budžeta līdzekļi). Pasākumiem norādītais NAP2027 uzdevums - Eiropas Savienības savienojamības 
mērķiem atbilstoša platjoslas elektronisko sakaru tīkla izveidošana, attīstot “vidējās jūdzes” un 
“pēdējās jūdzes” elektronisko sakaru tīklu infrastruktūru, un izveidojot platjoslas kartēšanu. 
Finansējums paredzēts šādiem pasākumiem: 

• Finansējuma avots – ERAF un KF: 
o Pasākums nr. 540: VIA Baltica - 5G pieejamība gar visiem galvenajiem sauszemes 

transporta ceļiem, paredzamais finansējums 5 000 000 EUR; 
o Pasākums nr. 543: Platjoslas infrastruktūras attīstība – pēdējās jūdzes pieslēgumu 

izveide, paredzamais finansējums 10 000 000 EUR; 
o Pasākums nr. 544: Nākamās paaudzes tīkla izveide lauku teritorijām, paredzamais 

finansējums 15 000 000 EUR; 
o Pasākums nr. 554: Datu pārraides pamattīkla atjaunošana un funkciju 

paplašināšana, nodrošinot vilcienu kustības vadību un citus dzelzceļa tehnoloģiskos 
procesus dzelzceļa stacijās, parkos, posmos un citos objektos 2 375 000 EUR. 

Eiropas Savienības struktūrfondu un Kohēzijas fonda 2021.–2027. gada plānošanas perioda darbības 
programmas projektā94 definētas risināmās problēmas, izaicinājumi turpmākajā plānošanas periodā, 

                                                
93 https://www.pkc.gov.lv/nap2027 
94 https://www.fm.gov.lv/files/finansuministrija/Darbibas%20programma_10082020.docx 
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piemēram, pieaugošā slodze mobilajiem un fiksētajiem tīkliem digitālās pārejas dēļ, tādēļ paredzams, 
ka augs prasības pēc ātras lielu datu daudzuma apmaiņas (nepieciešama 5G infrastruktūras attīstība, 
kas, savukārt, nav ekonomiski izdevīga lauku teritorijās un pilsētām pieguļošās teritorijās). 

Darbības programmas projekta prioritāte saskan ar Latvijas Nacionālā attīstības plāna 2021.-2027. 
gadam95 rīcības virziena “Tehnoloģiskā vide un pakalpojumi” mērķi – “Eiropas  Savienības  
savienojamības  mērķiem  atbilstoša  platjoslas elektronisko sakaru infrastruktūra”. Saskaņā ar 
Darbības programmas projektu saistībā ar digitālo pāreju ekonomikā pieaugs slodze mobilajiem un 
fiksētajiem tīkliem, kā arī būtiski pieaugs prasības pēc ātras lielu datu daudzuma apmaiņas, kas prasīs 
5G infrastruktūras attīstību. Lauku teritorijās un pilsētām pieguļošās teritorijās nav ekonomiski izdevīgi 
attīstīt 5G tīklus un nodrošināt abonentlīniju pieslēgumus. Nepārtraukts un viendabīgs pārrobežu 5G 
pārklājums ir būtisks viedā transporta un viedo satiksmes vadības sistēmu attīstībai gar TEN-T 
autoceļiem un dzelzceļiem, tomēr ne visur gar minētajiem ceļiem un dzelzceļiem ir pieejamas 
piemērotas elektroapgādes infrastruktūra 5G vajadzībām. 

Darbības Programmas projektā 3.1.1. SAM “Uzlabot digitālo savienojamību” ietvaros paredzēti 
pasākumi, kas turpinās attīstīt augstas veiktspējas elektronisko sakaru tīklus, veicinot 5G pieejamību, 
nodrošinot pasīvo elektronisko sakaru tīklu infrastruktūru gar TEN-T autoceļiem un dzelzceļiem. 3.1.1. 
SAM ietvaros plānots modernizēt vai izveidot jaunu, Savienojamības paziņojumam atbilstošu, 
elektronisko sakaru tīklu infrastruktūru atbalstāmajās teritorijās. 5G izvēršanai piemērotas pasīvās 
infrastruktūras pieejamības gar TEN-T tīkla sauszemes transporta ceļiem nodrošināšana; Elektronisko 
sakaru tīklu pasīvās infrastruktūras izveide, kā arī nodrošināšana ar nepieciešamo elektroapgādi 
infrastruktūru 5G izvēršanai gar transporta koridoriem, kur šāda infrastruktūra nav pieejama. Ļoti 
augstas veiktspējas tīklu infrastruktūras (tai skaitā atvilces maršrutēšanas tīklu) attīstība 
Savienojamības paziņojumam atbilstošu pēdējās jūdzes pieslēgumu nodrošināšanai. 

Noteikti obligātie uzraudzības rādītāji 3.1. prioritātes “Digitālā savienojamība” (3.1.1. SAM “Uzlabot 
digitālo savienotību”) projektam – 2 iznākuma un 2 rezultātu rādītāji. Iznākuma rezultāti ir sekojoši: 

• RCO 41 - Papildu mājsaimniecības ar piekļuvi ļoti augstas jaudas platjoslai – mājsaimniecību 
skaits; 

• RCO 42 - Papildu uzņēmumi ar piekļuvi ļoti lielas jaudas platjoslas pakalpojumiem – 
uzņēmumu skaits. 

Savukārt rezultātu rādītāji izteikti kā: 

• RCR 53 - Mājsaimniecības, kuras abonē platjoslas pieslēgumus ļoti lielas jaudas tīklam – 
mājsaimniecību skaits; 

• RCR 54 - Uzņēmumi, kas abonē platjoslas pieslēgumus ļoti lielas ietilpības tīklam – uzņēmumu 
skaits. 

3.1.1. SAM galvenās mērķgrupas - elektronisko sakaru pakalpojumu, IS un elektronisko pakalpojumu 
lietotāji – iedzīvotāji (mājsaimniecības), komersanti, iestādes un sociālekonomiskie virzītājspēki 
(piemēram, skolām, bibliotēkas, pētniecības centri, biznesa centri, dzelzceļa stacijas, ostas, lidostas, 
ārstu prakses, slimnīcas, stadioni, galvenie sabiedrisko pakalpojumu sniedzēji, kā arī uzņēmumi, kas 
intensīvi izmanto digitālos resursus).  

5.pielikumā iekļauta sasaiste starp atsevišķiem valsts atbalsta jautājumiem un plānotajiem attīstības 
scenārijiem, kas iekļauti ziņojuma 6.sadaļā.  

 

                                                
95 https://www.pkc.gov.lv/sites/default/files/inline-files/NAP2027_apstiprin%C4%81ts%20Saeim%C4%81_1.pdf 
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Ieteikumi 

Analizējot plānotos NAP2027 pasākumus un ES fondu 2021.-2027.gada plānošanas perioda 
darbības programmas projektu, ņemt vērā pasākuma ieviešanas mērķi saistībā ar Savienojamības 
paziņojumā iekļautajiem mērķiem, vai pasākums atbalstu vienu vai vairākus no plānotajiem 
mērķiem, piemēram, 5G attīstība, interneta pieejamība mājsaimniecībām, interneta pieejamība 
sociālekonomiskajiem virzītājspēkiem. Pamatojoties uz izvirzītajiem mērķiem, noteikt iznākuma un 
rezultātu rādītājus, jo Darbības Programmas rādītāju projekts ietver tikai vienu aspektu no 
Savienojamības paziņojumā iekļautajiem mērķiem, interneta pieejamība mājsaimniecībām. 

Rezultātu un iznākuma rādītāji attiecas tikai uz piekļuvi ļoti augstas jaudas platjoslai, tādejādi netiek 
mērīts investīciju rezultāts investējot mobilajos sakaru pakalpojumos, jo investīcijas mobilajos 
sakaru pakalpojumos nevar nodrošināt ļoti augstas jaudas platjoslu, izņemot 5G. 

Iznākuma un rezultātu rādītāji neietver mērījumus attiecībā uz izmaiņām pieslēgumu skaitā ļoti 
augstas platjoslai sociālekonomiskajiem virzītājspēkiem. 

Pasākumus ir plānots izmantot ar valsts līdzekļiem, tādēļ uz tiem attiecas valsts atbalsta 
nosacījumi. Izņēmums ir investīcijas savienojumos publiskajām iestādēm96, kā arī reģionālais 
atbalsts pie noteiktiem nosacījumiem (regulas Nr. 651/2014 14.pants). Saskaņā ar Finanšu 
ministrijas Komercdarbības atbalsta kontroles departamenta sniegto skaidrojumu, attiecībā uz 
pēdējo jūdzi regulas Nr.651/2014 14.panta piemērošana nav iespējama vispār, ievērojot to, ka 
regulas Nr.651/2014 14.panta 10.punkta apakšpunktu nosacījumiem visiem ir jāizpildās vienlaicīgi. 

 
 

7.6.2. CEF2 plānotais finansējums  

Papildus ERAF, KF un nacionālajam finansējumam svarīgs finansējuma avots ir CEF2. Priekšlikumā 
Eiropas Parlamenta un Padomes Regulai, ar ko izveido Eiropas infrastruktūras savienošanas 
instrumentu un atceļ Regulu (ES) Nr. 1316/2013 un (ES) Nr. 283/2014 (COM/2018/438 final)97 minēts, 
ka programmas konkrētais mērķis digitālajā nozarē ir veicināt ļoti augstas veiktspējas tīklu un 5G 
sistēmu izvēršanu, lai ES teritorijās palielinātu digitālo pamattīklu noturību un veiktspēju, savienojot tos 
ar kaimiņteritorijām, kā arī lai veicinātu transporta un enerģētikas tīklu digitalizāciju. 

Baltijas jūras 5G koridors 

CEF2 regulas priekšlikuma Pielikuma 5. daļā kā indikatīvs 5G koridors, kas tiesīgs saņemt 
finansējumu, minēts posms Tallina – Kauņa (Baltijas jūras koridors). Informācija par CEF2 finansējuma 
piešķiršanas prioritātēm iekļauta ziņojuma pielikumā. 

CEF2 finansējums viedām pašvaldībām 

                                                
96 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX%3A52016XC0719%2805%29#ntr319-
C_2016262LV.01000101-E0319 
97 https://eur-lex.europa.eu/legal-content/LV/TXT/?uri=CELEX:52018PC0438 
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CEF2 darba programmas projektā ir iekļauts atbalsta mehānisms 5G nodrošināšanai 
sociālekonomiskajiem virzītājspēkiem viedās pašvaldībās (granta finansējums 60 000 – 200 000 
EUR). 

 

Ieteikumi 

Plānojot finansējuma avotu dažādu Savienojamības paziņojumā iekļauto mērķu sasniegšanai, ņemt 
vērā CEF2 finansējuma iespējas 5G Baltijas jūras koridora attīstībai, tādejādi neplānojot cita 
veida infrastruktūru un investīcijas 5G Via Baltica un 5G Rail Baltica koridoros.  

Platjoslas kompetences centram veicināt pašvaldību pieteikšanos CEF2 finansējumam attiecībā uz 
5G ieviešanu, lai veicinātu sociālekonomisko virzītājspēku pieejamību ātram internetam. 

ES tieši administrētajam finansējumam nav piemērojami valsts atbalsta nosacījumi, ja finanšu 
līdzekļus tiešā veidā piešķir tieši administrēta EK aģentūra un valsts iestādēm nebūs nekādas 
rīcības pār šo līdzekļu piešķīrumu, tie nebūs uzskatāmi  par valsts līdzekļiem un dalībvalsts līmenī 
komercdarbības atbalsta kontroles normas netiks piemērotas. Saskaņā ar Finanšu ministrijas 
Komercdarbības atbalsta kontroles departamenta skaidrojumu, ja par ES tieši administrētā 
finansējuma nacionālā līdzfinansējuma daļu lemj pati dalībvalsts, komercdarbības atbalsta kontroles 
normas ir ievērojamas.    
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1.Pielikums – Pašvaldību aptaujā 
norādītie dati 

1.1. Nepieciešamās izmaiņas platjoslas finansēšanā 

“Lūdzu, norādiet kas Jūsuprāt būtu jāmaina, lai uzlabotu interneta pieejamību un izmantošanu, 
piemēram, attiecībā uz finansējumu, valsts atbalsta pasākumiem, komersantu darbības veicināšanu 
un citiem.” 

Tabulā zemāk iekļauta informācija no pašvaldību anketēšanas rezultātiem par nepieciešamajām 
izmaiņām platjoslas finansēšanā. 

Tabula 13. Nepieciešamās izmaiņas platjoslas finansēšanā pašvaldību skatījumā 

Intervences joma Apraksts 

Finansējums 
pakalpojuma 
sniedzējiem, valsts 
atbalsts 

Nepieciešams valsts atbalsts pakalpojuma sniedzējiem, lai motivētu tos 
uzlabot interneta pieejamību lauku apvidos. 
Komersantu piesaiste un valsts subsidēšana jūdzes nomai. 
Subsidēt interneta izveides projektus teritorijās, kur nav optiskā interneta 
pieejamība. 
Jaunizbūvētais optiskais tīkls nav pieejams, jo operatori argumentē tā 
neizmantošanu saistībā ar augstām nomas maksām. 
Valsts atbalsts Pēdējās jūdzes ierīkošanai 
Valsts atbalsta pasākumi vietās, kur komersantiem neatmaksājas uzlabot 
interneta ātrumu 
Finansēt operatoriem neizdevīgus pieslēgumus, kuros ir mazs skaits ar gala 
lietotājiem. 
Valstij būtu jāveic reālās situācijas izpēte (reāli esošo interneta kabeļu 
izvietojums pret mājsaimniecībām/ēkām) un jāorganizē vai jāatbalsta tīkla 
pievilkšana uz mazāk apdzīvotiem rajoniem. Sakarā ar ārkārtas situāciju 
jāapzina tās mājsaimniecības, kuriem zemo ienākumu dēļ bija problēmas ar 
attālinātu mācīšanos vai strādāšanu no mājām stabila interneta pieslēguma 
neesamības dēļ. 
Ir daudz gadījumi, kad komersants negrib nodrošināt stabilu interneta 
pieslēgumu, aizbildinoties ar to izmaksām - šis varbūt būtu tas gadījums, kad 
tiktu piešķirts vismaz daļējs finansējums savienojuma izveidei.  
Likumā derētu ierakstīt to, ka, ja tiek remontēts ceļš, ietves, kanalizācijas, 
siltuma un ūdens vadu sistēmas (būtībā jebkurš remontdarbs, kas saistās ar 
pilsētas vai valsts ceļu un citu zonu uzrakšanu), tad jāiegulda vairākas sakaru 
kanalizācijas caurules, ko varētu izmantot gan pašvaldība, gan komersanti, 
tā ātrāk, ērtāk un lētāk attīstot optiskos tīklus. 
Valsts atbalsts pakalpojumu sniegšanai, valsts atbalsts mobilo sakaru 
operatoriem - jaunu mobilo sakaru torņu celšanai (mobilais internets) vietās, 
kas "nenes peļņu" 
Atbalsta pasākumi / subsīdijas "pēdējās jūdzes" optiskajiem pieslēgumiem 
Valsts atbalsts varētu tikt virzīts uz publiskās un privātās datu pārraides 
infrastruktūras, tai skaitā optisko datu tīklu, kopīgu izmantošanu (nedublējot 
maģistrālo infrastruktūru - optikas kabeļi, datu pieslēguma punkti). 
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Intervences joma Apraksts 

Pēdējās jūdzes 
izbūve 

LVRTC platjoslas projektā izbūvēt pēdējo jūdzi 
Apgūt valstī izveidotos optiskos tīklus, jo tie pašlaik vairumā gadījumu pat 
nepiedāvā pakalpojumu. 
Novadā ir izbūvēti vairāki pieslēgumi optiskajam internetam, bet 
pakalpojumu sniedzēji tos neizmanto un klienti tiem vienkārši netiek klāt 
Ir izbūvēts platjoslas internets, kas praktiski nav pieejams, jo projektā 
praktiski nebija risināti pieslēgšanās jautājumi un rezultātā platjosla praktiski 
netiek izmantota, jo nav intereses veikt ieguldījumus ne pakalpojumu 
sniedzējiem, ne patērētājiem. 
Paplašināt sadarbību pašvaldības iestādēm un valsts iestādēm piederošiem 
IT infrastruktūras īpašniekiem/turētājiem. Bez nepieciešamības iesaistīt 
trešās personas.  Piemēram, Pašvaldība nevar izmantot LVTRC reģionālās 
optikas pieslēgumus, bez trešās personas.  Mūsu pašvaldībā būtu izdevīgi 
savienot attālinātās iestādes ar mūsu centrālo pieslēgumu, tādējādi 
nodrošinot drošu, šifrētu iekšējo tīklu ar lielu kapacitāti. Bet tā kā trešajām 
personām nešķiet pievilcīgs vai ekonomiski izdevīgs LVTRC 
piedāvājums/iespēja, mēs nevaram izmantot valsts piedāvātos maģistrālos 
"ceļus", kas jau ir izbūvēti. 
LVRTC projektā izmaksas jārēķina no pēdējās jūdzes, nevis no maģistrālās 
jūdzes novada centrā. Jāveic atbalsta pasākumi vietējiem interneta 
pakalpojumu sniedzējiem savas infrastruktūras izbūvei līdz klientam - tās var 
būt atlaides vai mazi izbūves projekti, kur komersanti var pieteikties ar 
saviem infrastruktūras plāniem, ko tad projekts 80% segtu. 

Pakalpojumu cena Samazināt cenas LVRTC pakalpojumiem, lai būtu pieejams optiskais 
pieslēgums pagastiem, jo šobrīd šis pakalpojums nav ekonomiski izdevīgs 
Būtu nepieciešams papildus finansējums interneta pieslēgumu ierīkošanai 
un pieejamības nodrošināšanai par adekvātu cenu. 
Jāpiedāvā pakalpojuma pievilcīga cena. 
Interneta pieslēgumiem jābūt pieejamākām cenām 
Cenu politika attiecībā pret reālo datu pārraides ātrumu. 
Pieeja LVRTC izbūvētajai infrastruktūrai lauku reģionos - izmaksu dēļ šobrīd 
komersantiem nav intereses. 
Samazināt jūdzes nomas maksu 
Jāmaina vidējās jūdzes LVTRC optikas izmantošanas nosacījumi un 
jāsamazina izmaksas uz to. 

Finansējums 
novadiem 

Nepieciešams finansējums novadu iekšējiem tīkliem, to attīstībai, lai novads 
savām struktūrvienībām varētu izveidot vienotu iekšējo tīklu. 
Attālos rajonos, kur maz klientu, ļaut pēdējo jūdzi realizēt pašvaldībām. 
Valsts vispār nefinansē IT resursu attīstību pašvaldībās 
Vairākām novada pagastu iestādēm būtu nepieciešams uzlabot interneta 
savienojuma ātrumu, atbalsts galvenokārt saistīts ar finansējumu un atbalsta 
pasākumiem. 
Atļaut Pašvaldībai bezmaksas izmantot LVRTC projektā "Elektroniskās 
sakaru infrastruktūras pieejamības uzlabošana lauku teritorijās"  izveidoto 
optisko tīklu. 

Mobilās 
tehnoloģijas 

Perspektīvā būtu nepieciešams attīstīt un lūkoties uz mobilo tehnoloģiju pusi. 
Mobilie savienojumi kļūst lētāki, pieejamāki un galvenokārt ātrāki. Tā ir joma, 
kas būtu atbalstāma 
paplašināt kanālu plūsmu 4G mobilajam tīklam un uzlabot 4G tīkla 
pārklājumu vai izveidot 5G mobilo tīklu. 
Nepieciešams uzlabot mobilā tīkla pārklājumu 
Vajadzētu palielināt mobilo torņu signāla jaudu un izlīdzināt pārklājumu. 
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Intervences joma Apraksts 

Teritorijas Interneta infrastruktūra jābūvē pierobežas teritorijās un laukos kopumā, 
diemžēl ārpus ciematu centriem nav pieejams stacionārais internets un ir 
vāja pieejamība mobilajam internetam. Bez interneta mūsdienās nav 
iespējama uzņēmējdarbība, līdz ar to arī apdzīvotība laukos. 
Nepieciešamas valsts investīcijas lauku teritorijās, kur tās vēl nav piešķirtas. 

Izglītības iestādes Izglītības iestādēm, kur iespējams, jāvar pieslēgties pie LVRTC optiskā tīkla 
un interneta, par mazu abonēšanas maksu. 
Valsts centralizēti projekti un rezultātu rādītāji izglītības iestādēm. 
Izveidot valsts dotāciju programmu valsts izglītības iestādēm, kas segtu 
daļēju pēdējās jūdzes izmantošanas izmaksas. 

Avots: PwC un CSE COE aptaujas rezultāti 

 

1.2. Nepieciešamās izmaiņas “vidējās jūdzes” un “pēdējās jūdzes” attīstībā  

“Kas, Jūsuprāt, Latvijā būtu jāmaina attiecībā uz interneta savienojumu pieejamību, “vidējās jūdzes” un 
“pēdējās jūdzes” nodrošināšanu?” 

Pašvaldībām vaicāts par iespējamām pārmaiņām, lai veicinātu iedzīvotāju, pašvaldību un Pašvaldības 
norādījušas, kas būtu jāmaina attiecībā uz “pēdējās jūdzes” un “vidējās jūdzes” infrastruktūras 
īstenošanu. Tabulā zemāk iekļauta informācija no pašvaldību anketēšanas rezultātiem. 

Tabula 14. Nepieciešamās izmaiņas attiecībā uz “vidējās jūdzes” un “pēdējās jūdzes” infrastruktūru 

Intervences joma Apraksts 

“Vidējā jūdze” Jāsamazina vidējās jūdzes tīkla nomas maksa 
Nomas maksas samazināšana 
Vidējās jūdzes pieejamība - neadekvāta cena. Komersants nevar izmantot 
vidējo jūdzi dēļ pakalpojuma pašizmaksas (sevišķi vietās ar potenciāli nelielu 
klientu skaitu) 
Vidējās jūdzes nodrošināt ar garantētu un stabilo internēta ātrumu kanālu 
Valsts dotācija LVRTC projekta turpinājumam 
Jāturpina izbūvēt un attīstīt optiskos tīklus, apgūstot Eiropas un citus fondus, 
lai pēc iespējas vairāk gala patērētājiem būtu pieejams stabils un ātrs 
interneta pieslēgums 
Jāmazina izmaksas un jārada piekļuves iespējas 
Jāpārskata nomas politika LVRTC izveidotajiem "vidējās jūdzes" tīklam, lai 
tā kļūtu pievilcīga komersantiem. Piemēram: noslēdzot līgumu uz trim 
gadiem, pirmais par brīvu. Bet arī tajos pēdējos divos gados maksai 
nevajadzētu būt tādai, kas atbaida komersantus, kas vēlētos sniegt 
pakalpojumus attālākos ciematos, kur mobilo sakaru operatori tāpat būs 
konkurenti. 
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Intervences joma Apraksts 

“Pēdējā jūdze” Pēdējo jūdzi izbūvēt LVRTC piesaistot struktūrfondu līdzekļus 
Projektā vajadzēja jau ievietot punktus par pēdējās jūdzes izveidi 
Pēdējā jūdze bija jārealizē uzreiz kopā ar vidējo jūdzi vismaz galvenajiem 
objektiem attiecīgajā teritorijā - pašvaldība, medicīna, glābšanas dienesti, 
policija u.c. 
Dot iespēju LRTVC sniegt operatora pakalpojumus valsts pārvaldes 
iestādēm pēdējās jūdzes nodrošināšanai, ja tas palīdzētu samazināt 
pakalpojuma izmaksas salīdzinājumā ar esošo nolikumu 
Jāuzlabo infrastruktūra un pieejamība optiskajiem kabeļtīkliem 
Pēdējās jūdzes nodrošināt ar garantētu un stabilo internēta ātrumu kanālu 
Jāsadarbojas ar interneta pakalpojumu sniedzējiem par iespēju izmantot šos 
pieslēgumus 
Mobilajam vai platjoslas internetam (vismaz 30 Mb/s) jābūt pieejamam visā 
Latvijas teritorijā par atbilstošu abonementa maksu 
Jārada lielāka konkurence optisko un fiksēto interneta pieslēgumu tirgū 
Pierīgas un tālākos novados. Pašreiz vēsturiski tas operators, kurš pirmais ir 
attīstījis savu optisko infrastruktūru noteiktā pilsētā vai apdzīvotā vietā, tur 
dominē un rada monopolu gadiem. Kādam citam operatoram pēc tam ienākt, 
nezinot vai izdosies piesaistīt atbilstošu daudzumu klientus, ir ļoti grūti un 
parasti tas nenotiek 
Pieejamāka informācija gan gala klientiem, gan interneta pakalpojumu 
sniedzējiem kā nodrošināt pieslēgumu 
Skaidri definēti komersanti, pie kā vērsties, lai iegūtu šo pēdējo jūdzi. 

Valsts atbalsts Nepieciešams veicināt komersantus nodrošināt “pēdējo jūdzi” 
Jāveicina mazo operatoru piesaisti, reģionos pārsvarā nav ekonomiski 
izdevīgi veidot pēdējās jūdzes pieslēgumus, ņemot vērā mobilo pieslēgumu 
izmaksas (domāts tālākos reģionos, piemēram, virs 10 km attālumā no 
pilsētām). Bet mobilie pieslēgumi mēdz būt nestabili un pie lielāka klientu 
skaita nenodrošina pietiekamu interneta ātrumu 
Valstij jāstimulē operatorus piedāvāt šo pakalpojumu arī laukos par saprātīgu 
cenu 
Nepieciešamas subsīdijas pakalpojumu ierīkošanai 
Lielāka uzņēmēju interese par pēdējās jūdzes nodrošināšanu 
Reālāk formulēt pieejamo valsts atbalstu. 
Tam jābūt ilgtermiņa pasākumam, ko nodrošina stabils sadarbības partneris 
Vietās, kur tas nav izdevīgi komersantam - dotēt. Diemžēl, bet novadā ir ļoti 
daudz vietu, kur iedzīvotājiem nav pieejams ne tikai nekāds interneta 
savienojums, bet arī nekādi sakari - ne mobilie, ne fiksētie. 

Finansējums un 
izmaksas 

Pēc iespējas mazākas cenas gala lietotājiem, fiksējot tarifus ar 
normatīvajiem aktiem 
Jānodrošina pilns pakalpojuma veids par adekvātu cenu 
Vidējai jūdzei pārāk augstas izmaksas 
Piesaistot privātos līdzekļus centralizēti attīstīt vēlamo nodrošinājumu 
Vajadzētu piešķirt papildus finansējumu šī projekta pieejamībai, jo šim 
pakalpojumam nav pietiekami gala patērētāji tikai tāpēc, ka platjoslas 
infrastruktūra nav attīstīta mazākās pašvaldībās, līdz ar to pakalpojums 
sanāk neadekvāti dārgs 
Cenu politika komersantiem – vairāk par 20€ par kilometru komersantam nav 
interesanta summa sadarbībai, ja pēdējās jūdzes vada galā būs viena vai 
divas mājsaimniecības. 
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Intervences joma Apraksts 

Pašvaldību loma Jāņem piemērs no igauņiem un lietuviešiem: izglītības iestādēm un 
pašvaldības iestādēm jāļauj izmantot jūdzes un LVRTC internetu bez 
komersantu iesaistīšanas 
Pašvaldībām jāļauj nodrošināt “pēdējās jūdzes” pasākumu vai arī jārod veids 
kā to finansiāli izdevīgi subsidēt gala lietotājam, kur ir mazs pieprasījums un 
komersants nav ieinteresēts tur startēt 
Vairāk informēt mazās pašvaldības, paskaidrojot reālos ieguvumus. 
Point2point savienojums starp pašvaldību pilsētām (ATR sakarā) iestādēm 
neizmantojot komersantu pakalpojumus. 

Uzņēmēju loma Izvērtēt potenciālos ražotājus un viņu attīstības virzienus, būvēt sakaru tīklus 
atbilstoši vajadzībām 
Komersantiem ir jānāk ar piedāvājumu uz ātru un stabilu internetu, ko 
nenodrošina mobilie operatori, kā arī ir jāmaina cenu politika. 

Gala lietotājs Veikt tīkla infrastruktūras izpēti no lietotāja puses. 
Jāveic plaša iedzīvotāju aptauja par vēlamo interneta ātrumu un gatavību par 
to maksāt. 
Jāizveido optisko datu pārraides tīklu infrastruktūra, kas būtu ierīkota tur, kur 
ir reāla vajadzība, nevis kā līdz šim – “tur, kur ir “baltie plankumi”” 
un nav reālu patērētāju. 
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2.Pielikums – CEF2 finansējuma 
piešķiršanas noteikumi  

CEF2 finansējuma piešķiršanas noteikumi 
Finansējuma prioritātes tiek noteiktas, ņemot vērā dažādus kritērijus: 

• darbībām, kuras veicina pieeju ļoti augstas veiktspējas tīkliem, kas spēj nodrošināt gigabitu 
savienotību sociālekonomiskajiem virzītājspēkiem, piešķir prioritāti, ņemot vērā 
sociālekonomisko virzītājspēku funkciju, uz šādas savienotības pamata pieejamo digitālo 
pakalpojumu un lietojumprogrammu nozīmīgumu un potenciālos sociālekonomiskos 
ieguvumus iedzīvotājiem, uzņēmumiem un vietējām kopienām, tostarp iespējamo pozitīvo 
netiešo ietekmi savienotības ziņā; 

• darbības, kuras veicina ļoti augstas kvalitātes vietējo bezvadu savienotību vietējās 
kopienās; 

• attiecībā uz darbībām, kas veicina 5G sistēmu izvēršanu, prioritāti piešķir 5G koridoru 
izvēršanai sauszemes transporta maģistrālēs, tostarp Eiropas transporta tīklos. Ņem vērā 
arī to, ciktāl darbība veicina pārklājuma nodrošināšanu lielākajās transporta maģistrālēs, ļaujot 
nepārtraukti nodrošināt sinerģijas digitālos pakalpojumus, vienlaikus maksimāli palielinot 
potenciālo pozitīvo netiešo ietekmi uz teritorijām un iedzīvotājiem projekta izvēršanas teritorijas 
apkaimē; 

• projektiem, kuru mērķis ir izvērst pārrobežu pamattīklus, ar kuriem Savienību savieno ar 
trešajām valstīm un stiprina savienojumu Savienības teritorijā, tostarp zemūdens kabeļi, piešķir 
prioritāti atkarībā no tā, cik būtiski tie veicina elektronisko sakaru tīklu noturības un veiktspējas 
palielināšanu Savienības teritorijā; 

• attiecībā uz ļoti augstas veiktspējas tīklu pārklājumu prioritāti piešķir darbībām, kas veicina 
teritoriju un iedzīvotāju pārklājumu, apgriezti proporcionāli dotācijas atbalstam, kas būtu 
vajadzīgs, lai projektu varētu īstenot, salīdzinājumā ar piemērojamo maksimālo līdzfinansējuma 
likmi. Ņem vērā arī to, ciktāl darbība veicina teritorijas un iedzīvotāju vispārēja pārklājuma 
nodrošināšanu konkrētā projekta izvēršanas teritorijā, vienlaikus maksimāli palielinot 
potenciālo pozitīvo netiešo ietekmi uz teritorijām un iedzīvotājiem projekta izvēršanas teritorijas 
apkaimē; 

• attiecībā uz projektiem, ar kuriem izvērš operatīvās digitālās platformas, prioritāti piešķir 
darbībām, pamatojoties uz mūsdienu tehnoloģijām un ņemot vērā tādus aspektus kā 
sadarbspēju, kiberdrošību, datu privātumu un atkārtotu lietošanu; 

• to, cik lielā mērā izvērstā tehnoloģija ir konkrētajam projektam vispiemērotākā, vienlaikus 
piedāvājot vislabāko līdzsvaru starp progresīvākajām tehnoloģijām datu plūsmas kapacitātes, 
pārraides drošības un tīkla noturības un izmaksu efektivitātes ziņā. 

Digitālajā nozarē atbalstāmas tādas darbības kā: 

• darbības, ar kurām atbalsta sociālekonomisko virzītājspēku gigabitu savienotību; 

• darbības, ar kurām atbalsta tādu īpaši augstas kvalitātes vietējas bezvadu savienotības 
sniegšanu vietējās kopienās, kura tiek nodrošināta bez maksas un bez diskriminējošiem 
nosacījumiem; 

• darbības, ar kurām atbalsta nepārtrauktu 5G sistēmu pārklājumu visās sauszemes 
transporta maģistrālēs, tostarp Eiropas transporta tīklos; 

• darbības pamattīklu izvēršanas atbalstam, tostarp ar zemūdens kabeļiem, dalībvalstīs un starp 
Savienību un trešām valstīm; 

• darbības, ar kurām atbalsta Eiropas mājsaimniecību piekļuvi ļoti augstas veiktspējas tīkliem; 



  
  

“Pētījums Eiropas Savienības fondu 2021. -2027. gada plānošanas perioda ieguldījumu priekšnosacījumu izpildei”     (gala ziņojums)
  

   118 

• darbības, ar kurām īsteno digitālās savienotības infrastruktūras prasības saistībā ar pārrobežu 
projektiem transporta vai enerģētikas jomā, un/vai darbības, ar kurām atbalsta operatīvās 
digitālās platformas, kas ir tieši saistītas ar transporta infrastruktūrām vai 
energoinfrastruktūrām. 

Dotācijas piešķir, ņemot vērā dažādus elementus: 

• ekonomiskā, sociālā un vidiskā ietekme (ieguvumi un izmaksas); 

• inovācijas, drošības, sadarbspējas un pieejamības aspekti; 

• pārrobežu dimensija; 

• sinerģija starp transporta, enerģētikas un digitālo nozari; 

• projektu izstrādes darbības gatavība; 

• ierosinātā īstenošanas plāna pamatojums; 

• Savienības finansiālā atbalsta katalītiskā ietekme uz ieguldījumu; 

• vajadzība pārvarēt finansiālus šķēršļus, piemēram, nepietiekamu komerciālo dzīvotspēju vai 
tirgus finansējuma trūkumu; 

• saskanība ar Savienības un valstu enerģētikas un klimata jomas plāniem. 

Pētījumiem Savienības finansiālā atbalsta summa nepārsniedz 50% no kopējām attiecināmajām 
izmaksām. Pētījumiem, kas finansēti ar summām, kas pārvietotas no Kohēzijas fonda, maksimālā 
līdzfinansējuma likme ir likme, ko piemēro Kohēzijas fondam (var palielināt līdz ne vairāk kā 85% 
darbībām, kas saistītas ar pārrobežu savienojumiem, ir pierādīta īpaši augsta integrācijas pakāpe 
darbības plānošanā un īstenošanā, izveidots atsevišķs projekta uzņēmums, kopīga pārvaldības 
struktūra un pastāv divpusējs tiesiskais regulējums vai pieņemts īstenošanas akts). 

Digitālajā nozarē piemēro šādas maksimālās līdzfinansējuma likmes: darbiem, kas saistīti ar nozares 
konkrētajiem mērķiem, Savienības finansiālā atbalsta summa nepārsniedz 30% no kopējām 
attiecināmajām izmaksām. Līdzfinansējuma likmes var palielināt līdz 50% darbībām ar izteiktu 
pārrobežu dimensiju, piemēram, nepārtrauktam 5G sistēmu pārklājumam lielākajās transporta 
maģistrālēs vai pamattīklu izvēršanai starp dalībvalstīm un starp Savienību un trešajām valstīm un līdz 
75% darbībām, ar kurām īsteno sociālekonomisko virzītājspēku gigabitu savienotību. Darbības vietējas 
bezvadu savienotības nodrošināšanas jomā vietējās kopienās finansē ar Savienības finansiālo 
atbalstu, sedzot līdz 100% no attiecināmajām izmaksām, neskarot līdzfinansējuma principu.  

Dotācijas var kombinēt ar finansējumu no Eiropas Investīciju bankas vai valsts attīstību veicinošām 
bankām, kā arī citām attīstības un publiskām finanšu sektora iestādēm, privātā sektora finanšu 
iestādēm un investoriem, tai skaitā publiskām un privātām partnerībām. Darbība var saņemt 
finansējumu arī no citām Eiropas Savienības programmām, tostarp ar dalītās pārvaldības principiem, 
ja finansējums neattiecas uz tām pašām izmaksām. 
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3.Pielikums – Platjoslas attīstība - 
citu valstu piemēri  

Publiskā un privātā partnerība – Grieķija  
Grieķijā “baltajos” lauku apvidos platjoslas tīklājs ieviests, izmantojot publisko un privāto partnerību98, 
kā arī kombinējot Eiropas Investīciju bankas un JESSICA iniciatīvas līdzekļus. Projekta ietvaros 
paredzēts projektēt, finansēt, būvēt, uzturēt un ekspluatēt platjoslas infrastruktūru, kas nodrošinās 
platjoslas pakalpojumus lauku apmetnēm, kur nav platjoslas pamata infrastruktūras vai ir maz ticams, 
ka tuvākajā nākotnē tā tiks attīstīta. 
Privātie partneri izvēlēti 3 lotēm – pirmajai un trešajai privātais partneris ir “OTE S.A.”, bet otrajai lotei 
“HELLAS ONLINE – INTRAKAT - INTRACOM HOLDINGS”. Kopējās projekta izmaksas sasniegušas 
265 milj. EUR, ko veido Eiropas Savienības granti 160,1 milj. EUR apmērā, kā arī kapitāla un 
komercbanku ieguldījumi 104,7 milj. EUR apmērā, iesaistīta arī Grieķijas Nacionālā banka.  
 
Publiskā un privātā partnerība – Austrija 
NöGIG projekta 2. posma99 mērķis ir veicināt privātā kapitāla tirgus ienākšanu projektā, pamatojoties 
uz 3LOM (trīsslāņu atklātais modelis). Tādējādi tiks nodrošināta Lejasaustrijas uzņēmējdarbības vietas 
ilgtermiņa dzīvotspēja, nodrošinot atklātu, nediskriminējošu piekļuvi tīklam mazāk nodrošinātajos 
Lejasaustrijas lauku apvidos un konkurenci aktīvā tīkla un pakalpojumu sniedzēju līmenī.  
Saskaņā ar finanšu modeli Lejasaustrijai un ieguldītājiem ir pieejams kopīgs finansējums, vienlaikus 
nodrošinot visu atvērto un publisko tīklu svarīgo parametru izpildi. Tas ietver koncentrēšanos uz lauku 
teritorijām, izvēršanu tikai tad, ja ir saņemts konkrēts pieprasījums (vismaz 40%) un citiem principiem. 
nöGIG izstrādāja finanšu struktūru, kas rada ieguvums Lejasaustrijas valdībai un katram investoram.  
Ieguldījumu modelis ir PPP modelis, kurā privātais ieguldītājs finansē papildu 100 000 savienojumu 
izvēršanu lauku apvidos, ko atbalsta publiskais partneris pieprasījuma apkopošanas, apstiprināšanas 
procedūru un publiskā atbalsta ietvaros. Uzņēmējdarbības modelis ir 3LOM (trīsslāņu atklātais 
modelis), jo tas nodrošina skaidru fizisko, aktīvo un pakalpojumu sniedzēju lomu nošķiršanu, kā 
rezultātā rodas ilgtspējīgi platjoslas risinājumi. NRA (RTR GmbH) jau no paša sākuma ir iesaistīta 
standarta piedāvājuma (tumšās šķiedras) pārskatīšanā un revīzijā un regulāri informē par projekta 
gaitu. Laikposmā no 2015. līdz 2019. gadam Lejasaustrija finansēja projekta izmēģinājuma posma 
izveidi un īstenošanu. Turpmāku izvēršanu (2019. –2022. gads) tirgus ieguldītāji finansēs PPP projekta 
ietvaros. ES finansējums projekta īstenošanai nav piesaistīts. 
 
Kombinēts finansējums – Ungārija  
2015.-2018. gadā Ungārijā darbojās nacionālā Ātrdarbīgā interneta programma, lai sasniegtu Eiropas 
Digitālās programmas mērķus, tas ir, nodrošināt 30 Mbps savienojumu mājsaimniecībām, bet 
publiskajām institūcijām – 100 Mbps savienojumu100. Projekta mērķis ir apgādāt mazāk attīstītos 
reģionos teritorijas ar NGA tīkliem, to ieviešanai nodrošinot valsts atbalstu. Plānots izveidot augstas 
veiktspējas tīklu, kas atbilstu pieaugošajām izmantošanas un platjoslas prasībām un kas var atvieglot 
digitālo pakalpojumu izplatīšanu starp privātpersonām, uzņēmumiem un publiskām iestādēm 
(sociālekonomiskajiem dzinējspēkiem). Konkursa noslēgumā 80% projektu bija saistīti ar optisko 
šķiedru tehnoloģijām. 
 
Programmai paredzētais finansējums veidots no: ERAF granta 187 miljonu EUR apmērā, Ungārijas 
Attīstības bankas aizdevuma 16 miljonu EUR apmērā, nacionālā finansējuma 18 miljoniem EUR 
(Budapeštas reģionam), kā arī operatoru privātajām investīcijām. 

                                                
98 https://www.fi-compass.eu/sites/default/files/publications/Nikos_Mantzoufas_Broadband%20network.pdf 
99 https://ec.europa.eu/digital-single-market/en/content/nogig-phase-2 
100 https://op.europa.eu/en/publication-detail/-/publication/8947e9db-4eda-11ea-aece-01aa75ed71a1/language-en 
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Jāņem vērā, ka programma aptver visu valsti ar NGA, nodrošinot valsts atbalstu ekonomiski mazāk 
pievilcīgajiem, galvenokārt lauku reģioniem. Pakalpojumu sniedzēji izveidos aptuveni 400 000 
savienojumu.101  
 
Kombinēts finansējums – Igaunija  
Kopš 2009. gada Igaunijā ieviesta EstWin (Igaunijas Platjoslas infrastruktūras tīkls) programma102, ko 
izveidoja Igaunijas Platjoslas attīstības fonds (ELASA) sadarbībā ar Ekonomikas un komunikāciju 
ministriju un Igaunijas IKT asociāciju (ITL). Programmas ietvaros attīstīts vidējās jūdzes tīkls, stimulējot 
telekomunikāciju operatorus attīstīt pēdējās jūdzes savienojumus ar galalietotājiem, piemēram, 
mājsaimniecībām. Projekts īstenots lauku un maz apdzīvotās teritorijās – Tallina un citu pilsētu 
teritorijas nav aptvertas -, nodrošinot ātrdarbīgu (100 Mbps) savienojumu mājsaimniecībām, 
uzņēmumiem, publiskajām iestādēm.  
Projektu finansēja no Eiropas struktūrfondu līdzekļiem (85%), kā arī ELASA aizņēmumiem (15%). 
Kopējais finansējums: 70 598 668 EUR, piesaistītais finansējums: 60 839 762 EUR, ELASA 
finansējums: 9 759 047 EUR103. 

Ir izmantots privātais fonds, īpaša vienība, kas izraudzīta tikai šim projektam - būvēt un uzturēt vidējo 
jūdzi tīklu tirgus nepilnību teritorijās104. Igaunijas Platjoslas attīstības fonds dibināts Ekonomikas un 
komunikāciju ministrijas un Igaunijas Informācijas tehnoloģiju un telekomunikāciju asociācijas (ITL) 
iniciatīvas ietvaros. Sākotnējo kartēšanu veica ITL dalībnieki, lai definētu projekta darbības jomu. 
Ministrija un regulators palīdzēja noteikt tirgus nepilnību jomas un izveidot iespējamo finansēšanas 
shēmu. Projekts (visos posmos) ir finansēts no Eiropas Savienības struktūrfondiem un fonda 
ņemtajiem aizdevumiem. 

ELFLA finansējums – Lietuva 
PE “Plačiajuostis internetas” laika posmā no 2016. līdz 2018. gadam īstenoja projektu “Atbalsts 
platjoslas infrastruktūrai (II posms)” (PRIP-2)105. PRIP-2 mērķis bija izbūvēt aptuveni 342,6 kilometru 
optiskās šķiedras līnijas un savienot esošās infrastruktūras ne mazāk kā 400 lauksaimniecības nozares 
objektus. Pēc PRIP-2 platjoslas infrastruktūras izveides operatoriem, kuri var pieslēgt savu 
infrastruktūru (t. i., tīkla segmenta “pēdējo jūdzi”) un nodrošināt jaunas paaudzes piekļuves 
pakalpojumus galalietotājiem, tiek nodrošināta brīva vairumtirdzniecības piekļuve.  
 
Attīstību koordinē valsts vairumtirdzniecības operators. Projekts galvenokārt tika finansēts no ELFLA 
līdzekļiem. Infrastruktūra ir uzbūvēta vietās, kur tā nepastāv, un tuvākajā laikā nav citu iesaistīto pušu 
plānu to veidot. Valsts uzņēmums “Plačiajuostis internetas” nodrošina platjoslas vairumtirdzniecības 
pakalpojumus tīkla operatoriem, kas lietotājiem sniedz platjoslas pakalpojumus. PE "Plačiajuostis 
internetas" nesniedz pakalpojumus galalietotājiem. Pakalpojumus nodrošina likmes, ko nosaka 
satiksmes un sakaru ministra rīkojums. PE "Plačiajuostis internetas" ir bezpeļņas uzņēmums. 
 

                                                
101 https://ec.europa.eu/digital-single-market/en/country-information-hungary 
102 https://op.europa.eu/en/publication-detail/-/publication/8947e9db-4eda-11ea-aece-01aa75ed71a1/language-en 
103 https://www.elasa.ee/estwin-arvudes/ 
104 https://ec.europa.eu/digital-single-market/en/content/estwin-ii-estonian-wideband-infrastructure-network-estonia 
105 https://ec.europa.eu/digital-single-market/en/content/support-broadband-infrastructure-stage-ii-prip2-lithuania 
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4.pielikums – Kartogrāfiskā materiāla paraugi 

Attēls 31. Autoceļi un mobilā tīkla pārklājums 

 
Avots: PwC un CSE COE pētījums.  
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Attēls 32. LVRTC optikas tīkls un pieslēguma punkti 

 
Avots: PwC un CSE COE pētījums.  
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Attēls 33. Ārstniecības iestādes (Slimnīcas) 

 
Avots: PwC un CSE COE pētījums. 
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Attēls 34. Izglītības iestādes (skolas, koledžas, universitātes) 

 
Avots: PwC un CSE COE pētījums.  
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Attēls 35. Kultūras objekti 

 
Avots: PwC un CSE COE pētījums. 
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5. pielikums – Paziņojums par valsts 
atbalstu  

Pamatveidlapa  
 

Iekļauti ziņojuma 6.sadaļā pie katra no scenāriju aprakstiem 

 
 
1.1. Lūdzu, paskaidrojiet nepieciešamību pēc valsts iejaukšanās. Lūdzu, ņemiet vērā, ka atbalstam 

jābūt vērstam uz tādas situācijas risināšanu, kurā atbalsts var sniegt būtisku uzlabojumu, ko 
tirgus pats nespētu nodrošināt, novēršot precīzi definētu tirgus nepilnību.  
 

Skatīt 6.9 sadaļu, kā arī katra scenārija aprakstu  

 

1.2. Piemērots instruments 6.1. punktā norādītā kopīgu interešu mērķa sasniegšanai. Lūdzu, 
ņemiet vērā, ka atbalsts netiks uzskatīts par saderīgu, ja mazāk kropļojoši pasākumi ļautu 
sasniegt to pašu pozitīvo rezultātu. 

        Skatīt 6.9 sadaļu, kā arī katra scenārija aprakstu  

1.3. Lūdzu, norādiet, kāpēc piešķirtais atbalsts ir samērīgs, ciktāl tas atbilst minimumam, kas 
nepieciešams pamudināšanai uz attiecīgajiem ieguldījumiem vai darbībām. 
 

Skatīt 6.10 sadaļu, kā arī katra scenārija aprakstu 

 

1.4. Lūdzu, norādiet atbalsta iespējamo negatīvo ietekmi uz konkurenci un tirdzniecību un 
konkretizējiet, kādā mērā pozitīvā ietekme atsver to. 
 

Skatīt 6.10 sadaļu, kā arī katra scenārija aprakstu 

 
 
III 5. daļa. Papildinformācijas lapa par valsts atbalstu platjoslas tīkliem 
 

1. Paziņotā atbalsta pasākuma iezīmes 

1.1. Lūdzu, norādiet valsts iejaukšanās loģisko pamatu un izskaidrojiet paredzamos 
ieguvumus no atbalsta pasākuma (piemēram, saimnieciskos un sociālos ieguvumus, lielāku 
platjoslas pārklājumu un interneta izplatības pakāpi utt.). 
 

Skatīt 6.10 sadaļu, kā arī katra scenārija aprakstu 

 

2. Atbalsta pasākuma process un piešķiršana 
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Kartēšana, pārklājuma analīze  

2.1. Kāda ir atbalsta darbības joma teritoriālā pārklājuma ziņā? 

Skatīt katra scenārija aprakstu 6. sadaļā 

 

2.2. Lūdzu, sniedziet informāciju (norādot datumu) un iesniedziet rezultātus, kuri izriet no detalizētās 
kartēšanas un pārklājuma analīzes, kas veiktas, lai skaidri noteiktu mērķteritorijas:  

Skatīt 6. sadaļu  

Konkursa atlases procedūra 

2.3. Lūdzu, sniedziet informāciju par to, kā izvēlēsies ekonomiski visizdevīgāko piedāvājumu (tostarp 
par atbalsta piešķiršanas kritērijiem un katram izvēlētajam kritērijam piešķirto relatīvo nozīmi), 
ņemot vērā kvalitatīvos kritērijus (piemēram, pārklājumu, tehnoloģiskās pieejas ilgtspēju vai 
risinājuma ietekmi uz konkurenci) un cenu: 

Skatīt 6. sadaļu – katra scenārija aprakstu  

 

2.4. Vai pastāv kādas minimālās servisa prasības, kurām subsidētajam tīklam ir jāatbilst (tādas kā 
minimālais joslas platums, pakalpojumu nepārtrauktība, minimālais ģeogrāfiskais pārklājums 
utt.)?  

 Jā     Nē 

2.5. Vai atbalsta pasākums ir tehnoloģiski neitrāls? 

 Jā     Nē 

2.6. Lūdzu, iesniedziet karti, kurā attiecīgajā valstī vai reģionā ir attēlotas esošās infrastruktūras, 
tostarp arī jebkādas jaunas infrastruktūras, ko komercoperatori plāno izbūvēt tuvākajā nākotnē, 
tas ir, triju gadu laikposmā: 

Skatīt kartes 6. sadaļā un pielikumos 

 

2.7. Lūdzu, paskaidrojiet, kāda veida “vairumtirdzniecības līmeņa piekļuves” saistības tiks 
piemērotas subsidētajam tīklam (tostarp piekļuve pasīvajai un aktīvajai infrastruktūrai, tiesības 
izmantot kabeļu kanalizāciju un stabus, tumšo optisko šķiedru un āra sadales skapjus), un cik 
ilgi piekļuves saistības būs spēkā: 

Skatīt scenāriju aprakstus 6.10 sadaļu 

 

Vairumtirdzniecības līmeņa piekļuves cenas 

2.8. Lūdzu, paskaidrojiet, kā tiks noteiktas piekļuves etaloncenas: 

Skatīt 6.10 sadaļu  

Atgūšanas un uzraudzības mehānisms 
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2.9. Lūdzu, paskaidrojiet, kā tiks organizēta atbalsta pasākuma uzraudzība:  

– kura valsts iestāde uzņemsies uzraudzību? Satiksmes ministrijas Sakaru 
departaments 

– kādi pasākuma aspekti tiks pakļauti uzraudzībai? Projekta ieviešanas uzraudzība, 
skatīt 6.10 sadaļu 

– kādi darbības kritēriji tiks analizēti? Darbības Programmas rādītāji, skatīt 5.sadaļu 
attiecībā uz rādītāju definēšanu un 6.sadaļu attiecībā uz konkrētām rādītāju vērtībām 

– kāds būs uzraudzības grafiks? Saskaņā ar projekta ieviešanas grafiku, skatīt 6.10 
sadaļu 

Valsts regulatīvā iestāde 

2.10. Lūdzu, aprakstiet valsts regulatīvās iestādes nozīmi, jo īpaši attiecībā uz mērķteritoriju 
noteikšanu, vairumtirdzniecības līmeņa piekļuves cenu, tostarp etaloncenas noteikšanu, strīdu 
risināšanu utt: 

Satiksmes ministrijas Sakaru departaments, SPRK 

 

3. Saderības kritēriji 

Lūdzu, paskaidrojiet, kā paziņotais atbalsta pasākums atbilst nosacījumiem, kas norādīti 
Pamatnostādņu par platjoslas tīkliem 2.5. iedaļā. 

Skatīt ziņojuma 7. sadaļu 

Vispārējas nozīmes mērķis 

a) Vai atbalsta pasākuma mērķis ir sasniegt skaidri definētus vispārējas nozīmes mērķus? 

 Jā     Nē 

b) Ja atbilde a) apakšpunktā ir “jā”, lūdzu, sniedziet aprakstu par vispārējas nozīmes 
mērķiem, kuri sasniedzami ar atbalsta pasākuma palīdzību: 

Skatīt scenāriju aprakstus 6. sadaļā 

 

Tirgus nepilnība 

c) Vai atbalsta pasākums skar tirgus nepilnību vai būtisku nevienlīdzību, kas kavē platjoslas 
tīklu pakalpojumu pieejamību?  

 Jā     Nē 

d) Ja atbilde c) apakšpunktā ir “jā”, lūdzu, aprakstiet šo tirgus nepilnību un sniedziet vispārīgu 
pārskatu par platjoslas tīklu tirgu attiecīgajā valstī vai reģionā un par atbalsta pasākuma 
mērķteritorijām.  

Skatīt scenāriju aprakstus 6. sadaļā un ziņojuma pielikumus 

 

Šajā pārskatā būtu jāietver informācija par platjoslas tīkla pārklājuma esošo līmeni, interneta izplatības 
pakāpi (pieslēgto mājsaimniecību un uzņēmumu skaitu), pakalpojumu pieejamības sadalījumu pa 
tehnoloģijām, galvenajām tendencēm (valsts vai reģionālajā) platjoslas tīklu tirgū, pilsētu/lauku 
atšķirības platjoslas tīklu pārklājuma ziņā, mazumtirdzniecības cenu salīdzinājumu ar cenām, kas tiek 
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pieprasītas par tiem pašiem pakalpojumiem, kuri tiek sniegti valsts konkurētspējīgākās, bet citādi 
salīdzināmās teritorijās vai reģionos, pieejamajiem tehnoloģiskajiem risinājumiem platjoslas tīklu 
attīstībai un savienojamības pakalpojumu sniegšanai, konkurences situāciju elektroniskās komunikācijas 
tirgos (tirgu struktūru un dinamiku), pārskatu par valsts tiesisko regulējumu un par esošajām 
regulatīvajām saistībām attiecībā uz elektronisko komunikāciju operatoriem: 

Piemērots instruments 

e) Lūdzu, pierādiet atbalsta pasākuma piemērotību:  

Skatīt scenāriju aprakstus 6. sadaļā un ziņojuma pielikumus 

 

f) Vai jau ir bijuši ieviesti jebkādi citi alternatīvi (mazāk kropļojoši) instrumenti, lai veicinātu 
platjoslas pakalpojumu sniegšanu un novērstu platjoslas tīklu savienojamības neesību, 
tostarp ex ante regulējums vai pieprasījuma stimulēšana? 

 Jā     Nē 

g) Ja atbilde f) apakšpunktā ir “jā”, lūdzu, aprakstiet šīs iniciatīvas un paskaidrojiet, kāpēc tās 
tika uzskatītas par nepietiekamām, lai sasniegtu vēlamos platjoslas tīklu attīstības mērķus:  

 .........................................................................................................................  

 .........................................................................................................................  

h) Vai esošie tīklu operatori pēdējos trīs gados ir veikuši jebkādus privātus ieguldījumus 
mērķteritorijās? 

 Jā     Nē 

i)   Ja atbilde h) apakšpunktā ir “jā”, lūdzu, aprakstiet šos ieguldījumus un paskaidrojiet, 
kāpēc ar esošo platjoslas tīklu infrastruktūru nepietiek, lai apmierinātu iedzīvotāju un 
uzņēmumu vajadzības, un kāpēc ir nepieciešams valsts atbalsts: 

 .........................................................................................................................  

 .........................................................................................................................  

Stimulējošā ietekme  

j)   Lūdzu, aprakstiet atbalsta pasākuma paredzamo pozitīvo ietekmi: 

Skatīt scenāriju aprakstus 6. sadaļā un ziņojuma pielikumus 

Krass uzlabojums 

k) Vai atbalsta pasākums nodrošinās krasu uzlabojumu platjoslas tīklu pieejamības ziņā?  

 Jā     Nē 

l)   Ja atbilde k) apakšpunktā ir “jā”, lūdzu, pierādiet to, veicot esošā un plānotā tīkla 
izvērsuma salīdzināšanu (tas ir, pirms un pēc plānotās iejaukšanās). Jo īpaši, lūdzu, sīki 
aprakstiet, vai un kādā mērā tiks veikti nozīmīgi jauni ieguldījumi platjoslas tīklos un kādas 
jaunas iespējas tiks ieviestas tirgū platjoslas tīklu pakalpojumu pieejamības un kvalitātes 
ziņā:  
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Skatīt scenāriju aprakstus 6. sadaļā un ziņojuma pielikumus 

m) Lūdzu, izskaidrojiet plānotās izmaiņas atbalsta saņēmēja(-u) rīcībā: 

Skatīt scenāriju aprakstus 6. sadaļā un ziņojuma pielikumus 

n) Lūdzu, pierādiet, ka bez valsts atbalsta tajā pašā laikposmā un/vai ar tiem pašiem 
nosacījumiem nebūtu iespējams veikt līdzīgu ieguldījumu platjoslas tīklos:  

 Skatīt scenāriju aprakstus 6. sadaļā un ziņojuma pielikumus 

Samērīgums 

o) Lūdzu, paskaidrojiet, kā tiek nodrošināts, ka atbalsta pasākuma apjoms aprobežojas ar 
nepieciešamo minimumu:  

Skatīt scenāriju aprakstus 6. sadaļā un ziņojuma pielikumus 

 

 

Konkurences izkropļojumi un ietekme uz tirdzniecību 

p) Lūdzu, paskaidrojiet, kāda varētu būt atbalsta pasākuma negatīvā ietekme uz konkurenci 
un tirdzniecību (piemēram, iespēja izraisīt privāto ieguldījumu izstumšanu vai dominējošā 
stāvokļa nostiprināšanos) un kādi pasākuma elementi106 varētu šos riskus samazināt:  

Skatīt scenāriju aprakstus 6. sadaļā un ziņojuma pielikumus 

  

                                                
106  Piemēram, izvēlētais ieguldījumu un uzņēmējdarbības modelis, ģeogrāfiskās iejaukšanās teritoriju lielums un 
iezīmes vai projekta izmaksu kontroles pasākumi. 



  
  

“Pētījums Eiropas Savienības fondu 2021. -2027. gada plānošanas perioda ieguldījumu priekšnosacījumu izpildei”     (gala ziņojums)
  

   131 

6. pielikums – Ciemu saraksts 
potenciālās baltās teritorijās 

Pielikumā sniegts saraksts ar to ciemu nosaukumiem, kas atrodas baltajās teritorijās (kur netiek nodrošināta 

piekļuve internetam ar ātrumu vismaz 30Mbps). 

Tabula 15. Ciemu saraksts, kas atrodas baltajās teritorijās 

 

Nosaukums Veids 
Datu 
avots 

Ābeles mazciems VDB 

Aistere mazciems VDB 

Aisteres muiža mazciems VDB 

Aizdumble skrajciems VDB 

Aizdzire mazciems VDB 

Aizkalnieši skrajciems VDB 

Aizkuja skrajciems VDB 

Aizpūre skrajciems VDB 

Aizpurieši  skrajciems VDB 

Aizpūrīši skrajciems VDB 

Aizstrautnieki vidējciems VDB 

Aizvīķi aprūpes ciems VDB 

Akaši skrajciems VDB 

Akremi skrajciems VDB 

Alejas mazciems VDB 

Aļņi ciems OSM 

Alodzene [uo] mazciems VDB 

Ančipova skrajciems VDB 

Ančkini skrajciems VDB 

Andri skrajciems VDB 

Aniņi skrajciems VDB 

Annasciems skrajciems VDB 

Antani mazciems VDB 

Antāni skrajciems VDB 

Apaļi mazciems VDB 

Apšenieki skrajciems VDB 

Arkani skrajciems VDB 

Astenci skrajciems VDB 

Augšciems skrajciems VDB 

Augškalne skrajciems VDB 

Auliciems mazciems VDB 

Ausātas mazciems VDB 

Auška mazciems VDB 

Auzāji skrajciems VDB 

Nosaukums Veids 
Datu 
avots 

Avotkalns mazciems VDB 

Babri skrajciems VDB 

Babri skrajciems VDB 

Babrova skrajciems VDB 

Badnova skrajciems VDB 

Baibas skrajciems VDB 

Bajāri skrajciems VDB 

Bajs mazciems VDB 

Balaški skrajciems VDB 

Baldonas [uo] mazciems VDB 

Baltica skrajciems VDB 

Baltica skrajciems VDB 

Baltie Bērzi  skrajciems VDB 

Bandenieki mazciems VDB 

Bauri mazciems VDB 

Bazāni mazciems VDB 

Beirupūrs skrajciems VDB 

Beļava ciems OSM 

Beļejova skrajciems VDB 

Bernāni mazciems VDB 

Berzbeke ciems OSM 

Beržine skrajciems VDB 

Bērziņi 
vasarnīcu 
ciems VDB 

Bērzkalni skrajciems VDB 

Bērzupe vidējciems VDB 

Biksēja skrajciems VDB 

Biksi skrajciems VDB 

Bileiķi skrajciems VDB 

Biņova skrajciems VDB 

Birzuļi skrajciems VDB 

Bitāni mazciems VDB 

Bitēni mazciems VDB 

Blankenfelde mazciems VDB 

Blaževiči skrajciems VDB 
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Nosaukums Veids 
Datu 
avots 

Blāzma mazciems VDB 

Blekteskalns mazciems VDB 

Bloki [o] skrajciems VDB 

Bodrovka skrajciems VDB 

Bogomoli skrajciems VDB 

Bojāru Eriņi  skrajciems VDB 

Bokoni skrajciems VDB 

Boncāni [o] skrajciems VDB 

Bondari [o] skrajciems VDB 

Borovije skrajciems VDB 

Borovka skrajciems VDB 

Borski [o] skrajciems VDB 

Bramaniški skrajciems VDB 

Branti mazciems VDB 

Briedinieki skrajciems VDB 

Brigi vidējciems VDB 

Bringas skrajciems VDB 

Briškas skrajciems VDB 

Brīžova skrajciems VDB 

Brokas [uo] skrajciems VDB 

Brūveri mazciems VDB 

Bučāni skrajciems VDB 

Bučkas skrajciems VDB 

Budiški skrajciems VDB 

Buka mazciems VDB 

Buļļi skrajciems VDB 

Bunčova skrajciems VDB 

Burduški skrajciems VDB 

Burtnieki mazciems VDB 

Butāni mazciems VDB 

Čači skrajciems VDB 

Čapkova mazciems VDB 

Catlakši skrajciems VDB 

Catlakši skrajciems VDB 

Caurvēderi mazciems VDB 

Celminīki skrajciems VDB 

Celtnieks 
vasarnīcu 
ciems VDB 

Cempi vidējciems VDB 

Cērteles mazciems VDB 

Cibuļski skrajciems VDB 

Ciematnieki skrajciems VDB 

Cirakalns mazciems VDB 

Cirkale skrajciems VDB 

Cisovka skrajciems VDB 

Čižiki skrajciems VDB 

Nosaukums Veids 
Datu 
avots 

Dabari mazciems VDB 

Daibe mazciems VDB 

Darvasbrenči mazciems VDB 

Dārziņi 
vasarnīcu 
ciems VDB 

Daugavas stacija mazciems VDB 

Daugavieši  skrajciems VDB 

Degļova mazciems VDB 

Degumi mazciems VDB 

Deiki-Brenči skrajciems VDB 

Dekšāres ciems OSM 

Dekšores [uo]  vidējciems VDB 

Desetnīki skrajciems VDB 

Dieviņi skrajciems VDB 

Dīķeri mazciems VDB 

Dimperi skrajciems VDB 

Dirši skrajciems VDB 

Dirvoniški [uo] skrajciems VDB 

Domoriški skrajciems VDB 

Dorupe [uo] vidējciems VDB 

Dorvas Cepļi [o] skrajciems VDB 

Dovale [o] skrajciems VDB 

Draudavas skrajciems VDB 

Drebeinīki (arī) skrajciems VDB 

Drinki skrajciems VDB 

Dubeņmuiža mazciems VDB 

Dūberiucis skrajciems VDB 

Dubrovka skrajciems VDB 

Dubulti vidējciems VDB 

Dudari skrajciems VDB 

Dūķernieki mazciems VDB 

Dundas skrajciems VDB 

Dunski skrajciems VDB 

Dupļi mazciems VDB 

Dvorišči [o] (tagad) skrajciems VDB 

Dzalbi skrajciems VDB 

Dzeguzēni vidējciems VDB 

Dzelzupe skrajciems VDB 

Dzeņi 
vasarnīcu 
ciems VDB 

Dzeņkalns  mazciems VDB 

Dzērves skrajciems VDB 

Dziervīne skrajciems VDB 

Dzirnieki vidējciems VDB 

Eisaki skrajciems VDB 

Elerne mazciems VDB 



  
  

“Pētījums Eiropas Savienības fondu 2021. -2027. gada plānošanas perioda ieguldījumu priekšnosacījumu izpildei”     (gala ziņojums)
  

   133 

Nosaukums Veids 
Datu 
avots 

Elkšķene skrajciems VDB 

Erverti mazciems VDB 

Ezēni mazciems VDB 

Ezeriņi 
vasarnīcu 
ciems VDB 

Ezersala mazciems VDB 

Ezīšava mazciems VDB 

Fedorki [o] skrajciems VDB 

Fiļki skrajciems VDB 

Foļvaroka skrajciems VDB 

Frački skrajciems VDB 

Franapole [o] skrajciems VDB 

Gabri skrajciems VDB 

Gaiļi skrajciems VDB 

Gaiņi skrajciems VDB 

Gajs skrajciems VDB 

Galāti mazciems VDB 

Galiņi 
vasarnīcu 
ciems VDB 

Garaņi skrajciems VDB 

Garanu Škauna skrajciems VDB 

Garstierdele skrajciems VDB 

Garvacainīki  skrajciems VDB 

Gārzde skrajciems VDB 

Gaspari skrajciems VDB 

Gaujaslāči 
vasarnīcu 
ciems VDB 

Gavari skrajciems VDB 

Ginovka skrajciems VDB 

Glaudāni skrajciems VDB 

Gļinaruča skrajciems VDB 

Gorbunovka mazciems VDB 

Gračuļi skrajciems VDB 

Graiži skrajciems VDB 

Grāveļi skrajciems VDB 

Grendze skrajciems VDB 

Gribuļi skrajciems VDB 

Griepciems mazciems VDB 

Grimnauži mazciems VDB 

Grišina mazciems VDB 

Grižanki skrajciems VDB 

Gropiņi [uo] mazciems VDB 

Grundas mazciems VDB 

Grustāni skrajciems VDB 

Gruzdinauka skrajciems VDB 

Gubina skrajciems VDB 

Nosaukums Veids 
Datu 
avots 

Guriliški skrajciems VDB 

Guta skrajciems VDB 

Guzas skrajciems VDB 

Hmilovka skrajciems VDB 

Idzipole [o] skrajciems VDB 

Iesalkāja mazciems VDB 

Igaunīši skrajciems VDB 

Ignatoviči [o] skrajciems VDB 

Ikaunieki skrajciems VDB 

Ikaunīki skrajciems VDB 

Ilga mazciems VDB 

Iliņi mazciems VDB 

Iļvezi skrajciems VDB 

Ilza skrajciems VDB 

Ilziņi mazciems VDB 

Indāni skrajciems VDB 

Indričāni skrajciems VDB 

Irbenieki skrajciems VDB 

Irbessala skrajciems VDB 

Isajevka skrajciems VDB 

Ivoni (kļūdaini) skrajciems VDB 

Jakuči skrajciems VDB 

Jakulinski skrajciems VDB 

Janīši skrajciems VDB 

Janovole skrajciems VDB 

Jaseņeci mazciems VDB 

Jātele mazciems VDB 

Jaudzemi skrajciems VDB 

Jaunā Zeļonovka skrajciems VDB 

Jaunaduliena mazciems VDB 

Jaunaiskrūgs skrajciems VDB 

Jaunāmuiža mazciems VDB 
Jaunburtnieku 
pamatskola mazciems VDB 

Jaungaiļi skrajciems VDB 

Jaunmeži mazciems VDB 

Jaunpatkule mazciems VDB 

Jaunpļavas skrajciems VDB 

Jaunsaimnieki 2  mazciems VDB 

Jaunvāle mazciems VDB 

Jaunvarieba mazciems VDB 

Jaunzeļči skrajciems VDB 

Jaunzemi skrajciems VDB 

Jaunžogoti skrajciems VDB 

Jokums [uo] mazciems VDB 

Jonāni [uo] skrajciems VDB 
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Nosaukums Veids 
Datu 
avots 

Jonički [o] skrajciems VDB 

Juneļi 
vasarnīcu 
ciems VDB 

Jurenski skrajciems VDB 

Jurģi vidējciems VDB 

Justinova skrajciems VDB 

Kadilas mazciems VDB 

Kaģumciems mazciems VDB 

Kaijas 
vasarnīcu 
ciems VDB 

Kaijciems vidējciems VDB 

Kaive ciems OSM 

Kaķīši mazciems VDB 

Kāķīši mazciems VDB 

Kaļkes (neprecīzi) skrajciems VDB 

Kalnapededze skrajciems VDB 

Kalnciema masīvs mazciems VDB 

Kalngali mazciems VDB 

Kalnieši skrajciems VDB 

Kalniški skrajciems VDB 

Kalniški skrajciems VDB 

Kalpinka skrajciems VDB 

Kaļvi mazciems VDB 

Kāņciems skrajciems VDB 

Kapteines skrajciems VDB 

Kapteiņi skrajciems VDB 

Karališkas skrajciems VDB 

Kārkli mazciems VDB 

Kārklumuiža mazciems VDB 

Karva mazciems VDB 

Kārzdaba mazciems VDB 

Kategrade mazciems VDB 

Katlēri mazciems VDB 

Katrīna mazciems VDB 

Kazaki skrajciems VDB 

Kazsalīši skrajciems VDB 

Kebži skrajciems VDB 

Keiļi skrajciems VDB 

Ķeiži mazciems VDB 

Ķieģeļceplis mazciems VDB 

Ķipļuki (neprecīzi) skrajciems VDB 

Kirkiliški skrajciems VDB 

Kirups skrajciems VDB 

Kiureņi skrajciems VDB 

Kiuti skrajciems VDB 

Ķivīļi skrajciems VDB 

Nosaukums Veids 
Datu 
avots 

Klementine skrajciems VDB 

Klešņiki skrajciems VDB 

Kliņģerīši skrajciems VDB 

Kliši skrajciems VDB 

Kloviņi [uo] skrajciems VDB 

Kņāvi mazciems VDB 

Kočkares [o] mazciems VDB 

Koktagols skrajciems VDB 

Kolna Pūrs skrajciems VDB 

Kondaunīki [o] skrajciems VDB 

Konogoļci skrajciems VDB 

Konovalova skrajciems VDB 

Koškina [o] skrajciems VDB 

Kovaļovka skrajciems VDB 

Kozindi [o] skrajciems VDB 

Kozlova skrajciems VDB 

Kožurki [o] mazciems VDB 

Kriepaste mazciems VDB 

Krievbūdas skrajciems VDB 

Krievciems skrajciems VDB 

Krikši skrajciems VDB 

Kristužāni skrajciems VDB 

Krivanda mazciems VDB 

Krīveņi skrajciems VDB 

Krīviņi skrajciems VDB 

Krīvu Sloboda skrajciems VDB 

Križovka skrajciems VDB 

Križuta skrajciems VDB 

Krote vidējciems VDB 

Krumpāni skrajciems VDB 

Krūzes skrajciems VDB 

Kubuļniški skrajciems VDB 

Kūdums vidējciems VDB 

Kujerci skrajciems VDB 

Kulakova skrajciems VDB 

Kulakova skrajciems VDB 

Kumpoti [o] skrajciems VDB 

Kunģēļi skrajciems VDB 

Kungudruvas skrajciems VDB 

Kurjanova skrajciems VDB 

Kurloviči [o] skrajciems VDB 

Kursieši mazciems VDB 

Lāčudārzs skrajciems VDB 

Ladusi skrajciems VDB 

Laime 
vasarnīcu 
ciems VDB 
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Nosaukums Veids 
Datu 
avots 

Lakšciems mazciems VDB 

Lampuži skrajciems VDB 

Lapsas mazciems VDB 

Laši vidējciems VDB 

Latvasas skrajciems VDB 

Latvīšu Sloboda skrajciems VDB 

Lauči skrajciems VDB 

Lauka Ļāperi skrajciems VDB 

Lauva mazciems VDB 

Leiši mazciems VDB 

Lejas mazciems VDB 

Lejaskrogs mazciems VDB 

Lejasozoli mazciems VDB 

Letnijkuts skrajciems VDB 

Lībieši mazciems VDB 

Līči mazciems VDB 

Līciems mazciems VDB 

Lielauce vidējciems VDB 

Lielie Lītaunīki skrajciems VDB 

Lielmaņi mazciems VDB 

Lielsesava mazciems VDB 

Lielstāpeles mazciems VDB 

Lielvircava ciems OSM 

Liepnieki mazciems VDB 

Līgciems mazciems VDB 

Līgotnes 
vasarnīcu 
ciems VDB 

Līgotnes 1 
vasarnīcu 
ciems VDB 

Linaites Pūrs skrajciems VDB 

Lineja skrajciems VDB 

Liučāni skrajciems VDB 

Līves mazciems VDB 

Livzinīki (kļūdaini) skrajciems VDB 

Ločukolni mazciems VDB 

Lode [uo] vidējciems VDB 

Lopsti skrajciems VDB 

Lotuši [o] skrajciems VDB 

Lozdas [o] skrajciems VDB 

Lozdi [o] skrajciems VDB 

Lozdova skrajciems VDB 

Lubaņecs skrajciems VDB 

Ludvikova skrajciems VDB 

Lūkalni skrajciems VDB 

Lukjanska skrajciems VDB 

Lukne skrajciems VDB 

Nosaukums Veids 
Datu 
avots 

Ļuļiški skrajciems VDB 

Lūza mazciems VDB 

Maisi mazciems VDB 

Maksini skrajciems VDB 

Maltas Trūpi vidējciems VDB 

Mamonova skrajciems VDB 

Margitava mazciems VDB 

Marianpole [o] skrajciems VDB 

Mārkalne vidējciems VDB 

Maslova skrajciems VDB 

Māteri skrajciems VDB 

Mazbērstele vidējciems VDB 

Mazdāma skrajciems VDB 

Mazdzērve mazciems VDB 

Mazie Lītaunīki skrajciems VDB 

Mazlauki vidējciems VDB 

Mazrūmene mazciems VDB 

Mazslate mazciems VDB 

Medīlas mazciems VDB 

Medņi vidējciems VDB 

Medņu Rubeņi mazciems VDB 

Mehanizators 
vasarnīcu 
ciems VDB 

Meikaļi skrajciems VDB 

Melderes mazciems VDB 

Melnezers 
vasarnīcu 
ciems VDB 

Meža Mackeviči skrajciems VDB 

Meža Škapari skrajciems VDB 

Mežagols [o] skrajciems VDB 

Mežaraupi mazciems VDB 

Mežarejas skrajciems VDB 

Mezīši mazciems VDB 

Mīlakšas ciems OSM 

Ozoli ciems OSM 

Ozolmuiža ciems OSM 

Pedele ciems OSM 

Pidriķis ciems OSM 

Rauda ciems OSM 

Rinda ciems OSM 

Rozes ciems OSM 

Rubeņi ciems OSM 

Saraiķi ciems OSM 

Sesile ciems OSM 

Silnieki ciems OSM 

Štikāni ciems OSM 
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Nosaukums Veids 
Datu 
avots 

Tiegaži ciems OSM 

Tilti ciems OSM 

Vākšēni ciems OSM 

Varnaviči ciems OSM 

Vecumi ciems OSM 

Virķēni ciems OSM 

Ziemupe ciems OSM 

Zvirgzde ciems OSM 
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7. pielikums – Fiksētie pieslēgumi 

Pielikums pieejams kā Excel fails “7. pielikums Fiksetie pieslegumi.xlsx” (Nav pieejams, klasificēts kā 

komercnoslēpums).  
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8. pielikums – Mobilās bāzes stacijas 

Pielikums pieejams kā Excel fails “8. pielikums Mobilas bazes stacijas.xlsx” (Nav pieejams, klasificēts kā 

komercnoslēpums). 
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9. pielikums – VHCN attīstības plāni 

Pielikums pieejams kā Excel fails “9. pielikums VHCN plani tet.xlsx”. (Nav pieejams, klasificēts kā 

komercnoslēpums).  
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10. pielikums – Statistikas datu 
savietojamība pēc administratīvi 
teritoriālās reformas 

Tabula 16. Statistikas datu savietojamības tabula 

 

119 Novadi un pilsētas 
(līdz 30/06/2021) 

42 Novadi un 
valstspilsētas  
(pēc 30/06/2021) 

Ādažu novads Ādažu novads 

Carnikavas novads Ādažu novads 

Aizkraukles novads Aizkraukles novads 

Jaunjelgavas novads Aizkraukles novads 

Kokneses novads Aizkraukles novads 

Neretas novads Aizkraukles novads 

Pļaviņu novads Aizkraukles novads 

Skrīveru novads Aizkraukles novads 

Alūksnes novads Alūksnes novads 

Daugavpils novads Augšdaugavas novads 

Ilūkstes novads Augšdaugavas novads 

Baltinavas novads Balvu novads 

Balvu novads Balvu novads 

Rugāju novads Balvu novads 

Viļakas novads Balvu novads 

Bauskas novads Bauskas novads 

Iecavas novads Bauskas novads 

Rundāles novads Bauskas novads 

Vecumnieku novads Bauskas novads 

Amatas novads Cēsu novads 

Cēsu novads Cēsu novads 

Jaunpiebalgas novads Cēsu novads 

Līgatnes novads Cēsu novads 

Pārgaujas novads Cēsu novads 

Priekuļu novads Cēsu novads 

119 Novadi un pilsētas 
(līdz 30/06/2021) 

42 Novadi un 
valstspilsētas  
(pēc 30/06/2021) 

Vecpiebalgas novads Cēsu novads 

Daugavpils Daugavpils 

Aizputes novads Dienvidkurzemes novads 

Durbes novads Dienvidkurzemes novads 

Grobiņas novads Dienvidkurzemes novads 

Nīcas novads Dienvidkurzemes novads 

Pāvilostas novads Dienvidkurzemes novads 

Priekules novads Dienvidkurzemes novads 

Rucavas novads Dienvidkurzemes novads 

Vaiņodes novads Dienvidkurzemes novads 

Auces novads Dobeles novads 

Dobeles novads Dobeles novads 

Tērvetes novads Dobeles novads 

Gulbenes novads Gulbenes novads 

Aknīstes novads Jēkabpils novads 

Jēkabpils Jēkabpils novads 

Jēkabpils novads Jēkabpils novads 

Krustpils novads Jēkabpils novads 

Salas novads Jēkabpils novads 

Viesītes novads Jēkabpils novads 

Jelgava Jelgava 

Jelgavas novads Jelgavas novads 

Ozolnieku novads Jelgavas novads 

Jūrmala Jūrmala 

Baldones novads Ķekavas novads 
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119 Novadi un pilsētas 
(līdz 30/06/2021) 

42 Novadi un 
valstspilsētas  
(pēc 30/06/2021) 

Ķekavas novads Ķekavas novads 

Aglonas novads Krāslavas novads 

Dagdas novads Krāslavas novads 

Krāslavas novads Krāslavas novads 

Alsungas novads Kuldīgas novads 

Kuldīgas novads Kuldīgas novads 

Skrundas novads Kuldīgas novads 

Liepāja Liepāja 

Alojas novads Limbažu novads 

Limbažu novads Limbažu novads 

Salacgrīvas novads Limbažu novads 

Līvānu novads Līvānu novads 

Ciblas novads Ludzas novads 

Kārsavas novads Ludzas novads 

Ludzas novads Ludzas novads 

Zilupes novads Ludzas novads 

Cesvaines novads Madonas novads 

Ērgļu novads Madonas novads 

Lubānas novads Madonas novads 

Madonas novads Madonas novads 

Babītes novads Mārupes novads 

Mārupes novads Mārupes novads 

Ikšķiles novads Ogres novads 

Ķeguma novads Ogres novads 

Lielvārdes novads Ogres novads 

Ogres novads Ogres novads 

Olaines novads Olaines novads 

Aglonas pagasts Preiļu novads 

Preiļu novads Preiļu novads 

Riebiņu novads Preiļu novads 

Vārkavas novads Preiļu novads 

Rēzekne Rēzekne 

Rēzeknes novads Rēzeknes novads 

119 Novadi un pilsētas 
(līdz 30/06/2021) 

42 Novadi un 
valstspilsētas  
(pēc 30/06/2021) 

Varakļānu novads Rēzeknes novads 

Viļānu novads Rēzeknes novads 

Rīga Rīga 

Garkalnes novads Ropažu novads 

Ropažu novads Ropažu novads 

Stopiņu novads Ropažu novads 

Vangažu pilsēta Ropažu novads 

Salaspils novads Salaspils novads 

Brocēnu novads Saldus novads 

Saldus novads Saldus novads 

Saulkrastu novads Saulkrastu novads 

Sējas novads Saulkrastu novads 

Skultes pagasts Saulkrastu novads 

Inčukalna pagasts Siguldas novads 

Krimuldas novads Siguldas novads 

Mālpils novads Siguldas novads 

Siguldas novads Siguldas novads 

Apes novads Smiltenes novads 

Raunas novads Smiltenes novads 

Smiltenes novads Smiltenes novads 

Dundagas novads Talsu novads 

Mērsraga novads Talsu novads 

Rojas novads Talsu novads 

Talsu novads Talsu novads 

Engures novads Tukuma novads 

Jaunpils novads Tukuma novads 

Kandavas novads Tukuma novads 

Tukuma novads Tukuma novads 

Valkas novads Valkas novads 

Beverīnas novads Valmieras novads 

Burtnieku novads Valmieras novads 

Kocēnu novads Valmieras novads 

Mazsalacas novads Valmieras novads 
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119 Novadi un pilsētas 
(līdz 30/06/2021) 

42 Novadi un 
valstspilsētas  
(pēc 30/06/2021) 

Naukšēnu novads Valmieras novads 

Rūjienas novads Valmieras novads 

Strenču novads Valmieras novads 

119 Novadi un pilsētas 
(līdz 30/06/2021) 

42 Novadi un 
valstspilsētas  
(pēc 30/06/2021) 

Valmiera Valmieras novads 

Ventspils Ventspils 

Ventspils novads Ventspils novads 
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11. pielikums – Investīciju atdeves 
aprēķini scenārijam Nr.1 

Pielikums pieejams kā Excel fails “11_pielikums_kalkulalors_1scen.xlsx” 
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12. pielikums – Investīciju atdeves 
aprēķini scenārijam Nr.2 

Pielikums pieejams kā Excel fails “12_pielikums_kalkulalors_2scen.xlsx” 

 



  
  

“Pētījums Eiropas Savienības fondu 2021. -2027. gada plānošanas perioda ieguldījumu priekšnosacījumu izpildei”     (gala ziņojums)
  

   145 

13. pielikums – Investīciju atdeves 
aprēķini scenārijam Nr.3 

Pielikums pieejams kā Excel fails “13_pielikums_kalkulalors_3scen.xlsx” 
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14. pielikums – Investīciju atdeves 
aprēķini scenārijam Nr.4 

Pielikums pieejams kā Excel fails “14_pielikums_kalkulalors_4scen.xlsx” 
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15. pielikums – Investīciju atdeves 
aprēķini scenārijam Nr.5 

Pielikums pieejams kā Excel fails “15_pielikums_kalkulalors_5scen.xlsx” 
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16. pielikums – Investīciju atdeves 
aprēķini scenārijam Nr.6 

Pielikums pieejams kā Excel fails “16_pielikums_kalkulalors_6scen.xlsx” 
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17. pielikums – Veikto interviju 
pārskats 

Tikšanās ar Bite grupas (Bite, Latnet Unistar) pārstāvjiem 10.09.2020 
 
Norāda, ka pirms noteikt pētījumā iegūstamo datu kopas gan par esošajiem interneta pieslēgumiem 
un mobilajiem torņiem, gan arī par nākotnes plāniem, bija jākonsultējas ar 4 nozares asociācijām, lai 
nodrošinātu to biedru atbalstu pētījumam. 
 
Attiecībā uz nākotnes VHCN plāniem Bite norāda, ka uzņēmuma mobilie torņi nav pieslēgti optikai un 
vēlās tam atbalstu. Ilgākā perspektīvā visi attīstības plāni saistīti ar 5G, kas ir pilnīgi neskaidri, jo nav 
nodefinēti spēles noteikumi, īpaši attiecībā uz Bite un Tele2 kopuzņēmuma plāniem. Attiecībā uz 
nākotnes VHCN plāniem Latnet/Unistar norāda, ka tie ir oportūniski, kur parādās jauns bizness, tāpēc 
neprognozējami. 
 
Bite uzsver resursu koplietošanas nozīmi un redz vairākas iespējas: 

• kopējs tornis; kopējs optiskais pieslēgums; 

• kopēji raidītāji, kopējs frekvenču diapazons. 

Norāda uz Centuria projektu kopā ar Tele2, kas cīnās ar administratīviem šķēršļiem. Bite neatbalsta 
vaučeru modeli. 
 
Tikšanās ar tet pārstāvjiem 10.09.2020 (Valdes loceklis Uldis Tatarčuks u.c.) 
 
Norāda, ka tet plāni ir pieslēgt pēc iespējas vairāk mājsaimniecību optiskajam tīklam, izbūvējot pēdējo 
jūdzi, kur ir potenciāls. Vidējā jūdze valstī esot izbūvēta pietiekamā apjomā, un tikai 20 no izbūvētajiem 
200 pieslēgumiem tiek izmantoti, pie tam pēdējā jūdze tur lielākoties DSL vektorings (tuvumā 80Mbps, 
max 1.3 km 20Mbps).  
 
Tet norāda, ka nepietiek ar garantēto ātrumu 30Mbps, konkursos jāpieprasa garantētais ātrums vismaz 
100Mbps, lai būtu iespējama vairāku mājsaimniecības locekļu attālināta strādāšana vienlaicīgi. 
Norāda, ka attālinātā strādāšana paliks arī pēc pandēmijas beigām, jo uzņēmumi atsakās no biroju 
telpām. 
 
Tet norāda, ka vidējās izmaksas optiskā tīkla izbūvei mājsaimniecībai baltajās teritorijās ir apmēram 3 
000 EUR. Lai gan parastais vērtējums optiskā tīkla izmantošanas ilgumam ir 25 gadi, Tet reāli to vērtē 
kā 40 gadus. 
 
Norāda, ka bieži nepieciešams iedzīvotāju līdzfinansējums, ar līdzfinansējumu 150-300EUR no 
mājsaimniecības tet gadā izbūvē pieslēgumus apm. 30 ielās. Norāda uz sarežģīto un ilgo optisko tīklu 
izbūves projektu projektēšanu uz saskaņošanu: Būvniecības IS  strādā slikti, skaņošana ļoti ilgi, pati 
projektēšana var aizņemt 9 mēnešus un process būtu jāvienkāršo. Sarežģīta saskaņošana ar Rīgas 
gaisma un Rīgas namu pārvaldnieku, kā arī ar apsaimniekošanas biedrībām (piekrīt <50%: nekas 
nesanāk). Iedzīvotājs var nepiekrist izvilkt optiku zem savas zemes (tas notiek bez grāvju rakšanas), 
vajadzētu, ka nevar aizliegt. Atzīmē pozitīvu sadarbību ar Valsts ceļiem. 
 
Norāda, ka Rail Baltic neparedzēja ielikt infrastruktūru - ieguldīt kabeli. Tet savu optisko infrastruktūru 
izīrē konkurentiem par 5.5 EUR mēnesī no klienta.  
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Atkārtota tikšanās ar tet pārstāvjiem 16.09.2020 (Valdes loceklis Uldis Tatarčuks u.c.) 
 
Atkārtoti norāda uz zemas kvalitātes Būvniecības IS: slikti sūta ziņojumus, netiek ieviesti izmaiņu 
pieprasījumu, rezultātā tet izmanto savu JIRA sistēmu funkcijā, kuras bija jānodrošina Būvniecības IS. 
Ierosina izmainīt regulējumu, lai samazinātu optisko kabeļu izvietošanas dziļumu un noteiktu, ka, 
izbūvējot jebkuru infrastruktūru, jāliek kanāli kabeļiem; vēlāk iegūt saskaņojumu kabeļu izbūvei ļoti 
sarežģīti. 
 
39 objektos tet līgumi ar LVRTC. Ja būtu labāka cena, izmantotu varbūt 49 punktus. Tikai vienā objektā 
izbūvēts optiskais kabelis līdz klientam, jo mazs potenciālo klientu skaits. Tet uztur 700-800 vidējās 
jūdzes pieejas punktus.  
 
Norāda, ka nelegālā kabeļu izvilkšana pa gaisu pilsētās kropļo tirgu, jo to izmaksas apm. 5x mazākas. 
Norāda, ka, ja 50% varētu finansēt kāds cits, optiskajiem pieslēgumiem būtu ļoti liels pieprasījums. Kā 
negatīvu tendenci min, ka pašvaldības sāk prasīt naudu par tīkla ievilkšanu savās zemēs. Valsts 
atbalstam iesaka šādus modeļus: 

• Pašvaldības izbūvē pēdējo jūdzi (tā dara Vācijā un arī Latvijā (Ādaži, Mārupe, Cēsis)) 

• Konkurss konkrētā teritorijā - kurš vairāk pieslēgs mājsaimniecības pēdējai jūdzei 

o liekas labāks 

o jānosaka garantētais ātrums 

Norāda, ka 96% tele2 bāzes staciju pieslēgtas tet optikai. 
 
Tikšanās ar tet pārstāvjiem 10.09.2020 (Valdes priekšsēdētājs Beļskis u.c.) 
 
Norāda, ka visas baltās teritorijas pašreizējā vidējās jūdzes izbūves projektā nevar sasniegt. ERAF 1. 
kārtā izbūvēti 177 vidējās jūdzes pieslēguma punkti, 2. kārtā – 224. Komersantiem atbalstāmajās 
teritorijās tiek piedāvātas vidējā jūdzes pieslēguma īres atlaides, lai stimulētu izmantošanu. Norāda, 
ka būtu nepieciešams mehānisms, lai teritoriju iekšienē, kas skaitās pelēkas, varētu noteikt baltas 
apakšteritorijas, kur varētu būt pieejams valsts atbalsts vidējās jūdzes izbūvei. 
 
LVRTC iesaka subsidēt vidējās jūdzes izbūvi līdz esošiem torņiem pelēkajā zonā. 
Iesaka arī jaunu subsīdiju programmu gala operatoram: 

• infrastruktūras izbūvei līdz gala lietotājam; 

• nauda uzsākt biznesu 

• pienākums nodrošināt pakalpojumu vismaz 3-5 gadus 

Norāda, ka LVRTC 1km optiskā tīkla izbūve maksā 40 000EUR, mobilā torņa izbūvi vērtē ap 250 000 
-300 000EUR. Baltajās teritorijās nepieciešams valsts atbalsts, kas fokusēts uz izbūvētās vidējās 
jūdzes izmantošanu. Kā negatīvu piemēru min 500 000EUR atbalstu bibliotēkām, kura rezultātā 100 
bibliotēkas neizmanto pieslēgto platjoslu.  
 
Tikšanās ar AST (Sadales tīkli) pārstāvjiem 17.09.2020 
 
Norāda, ka plaši ievieš attālināmi nolasāmos skaitītājus, kur datu pārraide sākumā pa elektrības 
vadiem (PLC tehnoloģija), pēc koncentratora transformatoru apakšstacijā GSM tīkls. Šis risinājums 
pārāk lēns, lai būtu alternatīvs interneta pieslēgums. AST uztur 95000 km elektrolīnijas. 
Augstsprieguma tīkli izvieto arī optiskos kabeļus (OPGW). 
 
AST izvērtējis, ja, izbūvējot jaunas elektrolīnijas, izvietotu arī optiskos kabeļus, materiāliem būtu +20%, 
pārējais - nav papildus izmaksu. AST gadā  liek kabeļus 1700km garumā līdz patērētājam (vidējā jūdze 
līdz zemes gabala robežai 04kV). Varētu ļaut pieslēgties izbūvētajam optiskajam tīklam tikai tie +20% 
kaut kur jāiegrāmato. tet varētu nākt un tirgot to infrastruktūru, nodrošinot mājsaimniecību 
pieslēgumus. 
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Alternatīvi varētu nodrošināt optika līdz mobilajām bāzes stacijām un tās izvietot uz elektropārvades 
līniju stabiem (5G bāzes stacija - 30litru tilpums). Tam vajag valstisko redzējumu. 
 
Tikšanās ar LMT tehniskā direktora vietnieku Viesturu Beināru 18.09.2020 
 
Redzējums par platjoslas attīstību:  

• uz ciematiem vilks optiku: 

• pārējā teritorija 5G 650-800MHz diapazonā 

o +20% ātrums salīdzinot ar 4G 

o garantētais ātrums nebūs 

o 15-20km2 teritorijā 1Gbps ātrums (100mbps 10 lietotājiem) 

• pilsētas, a klases trases – 5G 3.5GHz diapazonā, šūnas rādiuss R=700m 

• 5G 26GHz diapazonā - telpām 

Izvēršot 5G nepieciešama torņu kopīga iznmantošana, bet to sarežģī, ka LMT torņus iegādājas, bet 
bite un tele2 – nomā. Atbalstāms būtu scenārijs, ka ir kāds, kas būvē torņus, piemēram LVRTC. Tā 
notiek Lietuvā gan attiecībā uz optiku, gan arī mobilā tīkla izbūvi. Tele2 izmanto Latvenergo tīklu. 
Vērojama tendence, ka mobilie operatori izēd vietējos operatorus, piemēram ar televīziju. 
 
Uzsver, ka iepirkumos konkursos filigrāni jānodefinē ātruma mērīšana: 

• garantēts vidējais ātrums; 

• zem sarkanās līnijas diennakts laikā noteikts %. 

Norāda, ka tet optika ir dārga. Kā labāko scenāriju redz, ka 5G tīklus izvērstu, vienlaicīgi nodrošinot 
gan kopēju pieejamību, gan arī pieejamību operatīvajiem valsts dienestiem, garantējot noteiktu QOS, 
ko nodrošina 5G tehnoloģija. LMT šobrīd vajag 180 torņus,  gadā izbūvē 5. 150 torņus vajag pieslēgt 
optiskajam tīklam. Torņa izbūves izmaksas 100 000 EUR. 
 
Problēmas torņu izbūvē: 

• grūti atrast vietu 

• esošā būvniecības likumdošana laba tiem, kas grib būvniecību nobloķēt 

• pašvaldību noteiktā nomas maksa neadekvāta, jo baidās, ka būs par pārāk mazu cenu 

iznomāta: tāpēc eksperti, izsole 

• būtu jāprasa, ka jebkura publiska ēkā jābūt pārklājumam no 2 operatoriem, 

• uzceļ māju ar stikliem, kas nelaiž cauri 

• pašvaldību nesadarbošanās (Ķekava, Baloži, Garkalne (tagad labāk) 

LMT neatbalsta vaučeru risinājumu. Norāda, ka nav skaidrs, kas izvērsīs 5G ap autoceļiem - 5G tīkla 
operatori vai pati autoindustrija. VR/AR aplikācijām vajag vismaz 100Mbps ātrumu. LMT ievelk optiku 
šur tur (aizvietojot radioereleju līnijas, kur slikts pārklājums), bet ar optiku neiet uz dzīvokļiem. Norāda, 
ka tet uzskata skolas par saviem klientiem. Jūrmalā ir sava optika, bet nevar to iznomāt, var tikai skolām 
etc. 
 
Ādaži: nav ielikti gofri, kur ievilkt kabeļus, Sadales tīkli tos neliek. Kabeļu izvilkšana kanalizācijas 
sistēmā nav saprātīga biežo avāriju dēļ. RB Rail nesadarbojas ar mobilajiem operatoriem, varbūt 
LVRTC to var. Arī Via Baltica LVRTC var būvēt optiku, jūrmalas šoseja kā pilotprojekts.  
 
Norāda, ka pašvaldības komercsabiedrība varētu nodrošināt ielu apgaismojumu + internetu. 
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18. pielikums – 5.2 un 6. sadaļas 
tulkojums angļu valodā 

5.2. Analysis results 

5.2.1. Fixed broadband connections 

Within the scope of the research, data was received from merchants on the locations (addresses) of 
fixed broadband connections. Using this information in CSV data format, a GIS database layer 
was prepared in ESRI Shape data format (using Layer → Add layer → Add Delimited Text layer and 
respective Layer → Save As functionalities). Using these connection point data, the number of such 
connection points in each Central Statistical Bureau (CSB) 1x1km grid cell was calculated with GIS 
analysis tools (Vector → Analysis Tools → Count points in polygon functionality was used). The 
obtained results can be seen in the figure below. 
 

Figure 1. Number of fixed communication connections in each 1x1km grid cell 

 

Source: Research done by PwC and CSE COE. 
 

The data show that fixed communication connections can be found in 6130 CSB 1x1 km grid cells, 
which can be interpreted as an area of 6130 km2 or 9.34% of the entire territory of Latvia107. The 
declared places of residence in this territory are 1.64 million or 84.1%. The highest concentration of 
connections is observed in cities of national importance and the largest settlements. 

 

                                                
107 Calculations have been made considering that the entire CSB 1x1km grid for the territory of Latvia contains 65647 cells.  
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5.2.2 Fixed broadband connections with access to optics 

From the data received from merchants, it was possible to select those fixed communication 
connections that have access to broadband optics, providing an access speed of at least 100 
Mbps. Points were selected for which the value of the attribute PIEEJ_PLAT is 1 and using GIS 
analysis tools, the number of such connections in each CSB 1x1km grid cell was calculated (Vector → 
Analysis Tools → Count points in polygon functionality was used). The obtained results can be seen 
in the figure below. 

Figure 236. Number of fixed communication connections with access to optics in each 1x1km grid cell

 

Source: Research done by PwC and CSE COE. 

 

The data show that fixed communication connections with access to optics can be found in 1052 CSB 
1x1 km grid cells, which can be interpreted as an area of 1052 km2 or 1.60% of the entire territory of 
Latvia108. The declared places of residence in this territory are 1.35 million109 or 70.1%. Concentration 
in cities and major settlements of national importance is significantly higher than for fixed connections 
in general. 

5.2.3 Theoretical coverage of mobile communications 

Within the scope of the research, a data layer with theoretical mobile coverage was analytically 
created in the GIS database. In the mobile coverage, the access speed is estimated at 30 - 100 
Mbps. Calculations were performed using Q-GIS110 analysis tools. The data layer was obtained using 
mobile operator’s base station location data for 3341 mobile communication towers (received on 
21/09/2020 from VAS ES). 

In the calculation methodology, it was assumed that each base station of one operator has coverage 
with at least one nearest base station of the same operator (thus a continuous coverage area of one 

                                                
108 Calculations have been made considering that the entire CSB 1x1km grid for the territory of Latvia contains 65647 cells.  
109 The calculations use CSB data on the number of inhabitants in the 1x1km grid in 2019. 
110 Open source GIS application: Available: https://qgis.org/en/site/. 

https://qgis.org/en/site/
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operator is formed). The GIS analysis tools were used to determine the other base station closest to 
each operator's base station and the distance to it (Vector → Analysis Tools → Distance Matrix 
functionality was used to find one nearest point). The coverage between these two base stations was 
assumed to be at least 1/3 of the calculated distance to the nearest base station. 

For each tower of one operator, only a coverage sector with a radius of 2/3 of the calculated distance 
to the nearest base station is created (Vector → Geoprocessing Tools → Variable distance buffer 
functionality is used, keeping the sector radius value for each tower in a separate attribute). It was 
assumed that the radius of the sector was not less than 4 km. Coverage area was created by combining 
all single operator coverage sectors in a common single operator (Vector→ Geoprocessing Tools → 
Dissolve functionality with the parameter “Dissolve all” was used). 

The above steps were performed with the data of each mobile operator. As a result, the coverage data 
of all three mobile operators were collected (Vector → Geoprocessing Tools → Union functionality was 
used twice, combining two data sets each time). One common area was created from the combined 
coverage areas of all operators (Vector → Geoprocessing Tools → Dissolve functionality with the 
parameter “Dissolve all” was used). The obtained results can be seen in the figure below. 

Figure 3. Theoretical mobile network coverage 

 

Source: Research done by PwC and CSE COE. 

The data show that the theoretical coverage of the mobile communication network covers 59087 CSB 
1x1 km grid cells, which can be interpreted as an area of 59087 km2 or 90.0% of the entire territory of 
Latvia111. The declared places of residence in this territory are 1.86 million112 or 97.7%. 
 
 

                                                
111 Calculations have been made considering that the entire CSB 1x1km grid for the territory of Latvia contains 65647 cells. 
112 The calculations use CSB data on the number of inhabitants in the 1x1km grid in 2019. 
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5.2.4 White areas (no network with access speed of at least 30 Mbps) 

During the project white areas were analytically identified where broadband service with an 
access speed of at least 30 Mbps is not currently available. To identify such areas, areas with no 
mobile coverage (from any mobile operator) were researched, that have no fixed broadband 
connection points. For this purpose, the previously created GIS data layers with theoretical mobile 
coverage and fixed connection points were used. Fixed communication connection points that were 
outside the theoretical coverage of mobile communication were identified (Vector → Research Tools 
→ Select by Location functionality was used with the specification of selecting intersects, overlaps, 
and crosses as geometric search parameters). No such connections were found. Thus, the white 
areas were determined by excluding the theoretical mobile coverage from the territory of Latvia 
(Vector → Geoprocessing Tools → Difference functionality was used). Areas less than 20 ha that 
have no declared places of residence were manually removed from the initial GIS analysis. A total of 
172 sites were identified using this methodology. Ministry of Transport has requested CSB to prepare 
the information about the declared places of residence (or population) on the population in 2019 in a 
100x100 m grid. The obtained potential white areas can be seen in Figure 4. 

Figure 4. Map with white areas 

 

Source: Research done by PwC and CSE COE. 

The data show that the white territories identified occupy an area of 10,106 km2 or 15.65% of the entire 
territory of Latvia113. 43.3 thousand inhabitants have been declared their places of residence in these 
territories. Also, 5 educational institutions (schools) and 32 cultural objects (libraries) have been 
identified in these territories. 

The list of villages was obtained with GIS analysis tools, finding populated places (villages) from the 
Latvian Geospatial Information Agency (LGIA) Place Names Database114 (VDB data used only for 
existing villages) and Open Street Map (OSM) data on populated places in Latvia (villages). The list 

                                                
113 The total area of Latvia in 2015 from the CSB statistical table ISG040 was used in the calculations. Available: 
https://data1.csb.gov.lv/pxweb/lv/iedz/iedz__iedzskaits__ikgad/ISG040.px  
114 Available: https://vietvardi.lgia.gov.lv/  

https://data1.csb.gov.lv/pxweb/lv/iedz/iedz__iedzskaits__ikgad/ISG040.px
https://vietvardi.lgia.gov.lv/
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consists of populated places (villages) located in the white areas. It should be noted that there are 
several white territories where there are no villages, but they are inhabited according to the CSB data. 
There are single homesteads. The list of villages in the white territories is given in Annex 6. 

5.2.5 New mobile towers in the white areas 

Within the scope of the project a layer of GIS database was created with new mobile towers in 
potential white areas (no network connection with an access speed of at least 30 Mbps). The 
data layer was created with GIS analysis tools and saved in the ESRI Shape data format. The coverage 
of the new mobile towers was assumed to be on average a circle with a radius of 4 km. The possible 
location of the new mobile towers was determined manually by analyzing the data prepared by the 
CSB on the population of 2019 in 100x100 m grid cells so that the new mobile communication towers 
would cover as many people as possible. A total of 200 mobile towers were created in this data layer. 
The coverage sector for each tower was created using GIS analysis tools (Vector → Geoprocessing 
Tools → Fixed distance buffer functionality was used). The location of the new mobile towers 
determined can be seen in Figure 5. 

Figure 5. New mobile towers in the white areas 

 

Source: Research done by PwC and CSE COE. 

GIS analysis tools identified that with such 200 new mobile towers it is possible to provide additional 
mobile communications to 29.2 thousand inhabitants of a total of 43.3 thousand inhabitants who have 
been declared to live in potentially white areas (no network with an access speed of at least 30 Mbps). 

5.2.6 VHCN white areas (no network with access speed of at least 100 
Mbps) 

During the research white areas were analytically identified where broadband service with an 
access speed of at least 100 Mbps is currently not available (VHCN white areas). It was assumed 
that such symmetric access speeds could currently only be provided by fixed access points with access 
to broadband optics. To identify such white areas, areas without fixed access points with access to 
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broadband optics were searched for. For these calculations, the CSB 1x1 km grid cell data layer was 
used - grid cells with OPTI attribute values <1 was searched, i.e. cells without optical connections. The 
obtained white areas can be seen in Figure 6. 

Figure 6. VHCN White Territories 

 

Source: Research done by PwC and CSE COE. 

The data show that the identified VHCN white areas consisting of the entire territory of Latvia, except 
those territories in which there is access to broadband optics, cover 64595 CSB 1x1 km grid cells or 
98.4% of the entire territory of Latvia115. There are 577.95 thousand or 30.3% of the declared places 
of residence in this territory. 

5.2.7 Socio-economic drivers 

Within the scope of the project data on socio-economic drivers was identified in the following three 
groups: medical institutions, educational institutions and cultural institutions. 

Medical institutions 

The Open Street Map data was used on medical institutions that perform the functions of hospitals 
(see section 5.1 GIS database, data layer “Health care institutions”). A total of 54 institutions were 
retrieved (see Figure 7). 

                                                
115 Calculations have been made considering that the entire CSB 1x1km grid for the territory of Latvia contains 65647 cells. 
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Figure 7. Health care institutions 

 

Source: Research done by PwC and CSE COE. 

46.3% or 25 medical institutions already have access to Tet high-speed internet connection. This 
assessment was applied to those institutions for which according to the GIS data the distance to the 
nearest Tet optical connection point is less than 100 m, which would be considered as an output data 
error. 29 medical institutions do not currently have access to the VHCN network, and the establishment 
of an optical connection would be one of the solutions (in only one case the nearest optical access 
point is further than 3 km). The total length of the possible optical network from the nearest available 
optical connection point to the medical institutions is 25.8 km (distance along the straight line obtained 
with GIS analysis tools, multiplied by 1.3 to simulate the bending of the connection). 

Educational institutions 

Open Street Map data was used on educational institutions (see section 5.1 GIS database, data layer 
“Educational institutions”). A total of 902 institutions were retrieved (see Figure 8). 
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Figure 8. Educational institutions 

 

Source: Research done by PwC and CSE COE. 

Currently, high-speed optical Internet is available in 457 educational institutions or 50.6% of the 
examined educational institutions. In 97% of cases, it is a Tet optical connection. This assessment was 
applied to educational institutions for which according to GIS data the distance to the nearest optical 
connection point is less than 100 m, which would be considered an error in the output data. 445 
educational institutions do not currently have access to the VHCN network, and the 
establishment of an optical connection would be one of the solutions (in 103 cases the nearest optical 
access point is further than 3 km). 

The total length of the possible optical network from the nearest available optical connection point to 
342 educational institutions is 166.7 km (distance per straight line obtained with GIS analysis tools, 
multiplied by 1.3 to simulate the bending of the connection). For the remaining 103 educational 
institutions, the total length of the possible optical network is 1087.7 km, and they should look for 
alternative connection solutions. 

Cultural institutions 

The data on cultural objects available on the Open Data Portal was used (see section 5.1 GIS 
database, data layer “Cultural Institutions”). A total of 1754 different objects were retrieved (see Figure 
9). 
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Figure 9. Cultural objects 

 

Source: Research done by PwC and CSE COE. 

Currently 748 cultural objects or 42.6% of the researched objects have an optical Internet connection. 
In 74.1% of the cases, this can be provided by Tet. This assessment was applied to cultural objects for 
which according to GIS data the distance to the nearest optical connection point is less than 100 m, 
which would be considered an error in the output data. 1006 cultural objects do not currently have 
access to the VHCN network, and the establishment of an optical connection would be one of the 
solutions (in 439 cases the nearest optical access point is further than 3 km). 

The total length of the possible optical network from the nearest available optical connection point to 
657 cultural objects is 398.3 km (distance along the straight line obtained with GIS analysis tools, 
multiplied by 1.3 to simulate the curvature of the connection). For the remaining 439 cultural sites, the 
total distance of the possible optical network is 4784.3 km, and they should look for alternative 
connection solutions. 

5.2.8 Methodology for calculating outcome indicators for comparison of 
future development scenarios 

 
When planning the future development of a broadband network, various development scenarios can 
be identified that will result in the achievement of the project objectives. The indicators to be considered 
when assessing different development scenarios, as well as the methodology for determining the 
values of the indicators, are listed below. Each of the scenarios will have its own achievable values of 
outcome indicators in 2027. A connection with a speed of at least 100 Mbps is considered very high-
performance broadband. 
 
RCO 41 - Additional households with access to very high-performance broadband – a number of 
the households. The values are obtained as the difference between the current value (number of 
households in 2019) and the value of the indicator after the implementation of the scenario (number 
of households in 2027). For the calculations of the indicator RCO 41 on the current situation, the CSB 
data “Number of permanent residents, gender and age in 1 × 1 km grid cells” available on the Open 
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Data Portal have been used. Only data on the population in 2019 in CSV data format were used. The 
map was obtained by connecting the relevant data table to the 1x1 km grid GIS data layer. 
 
ROC 42 - Additional enterprises with access to very high-performance broadband services – a 
number of the enterprises. The values are obtained as the difference between the current value 
(latest CSB data) and the value of the indicator after the execution of the scenario (number of 
enterprises in 2027). 
For the calculation of the indicator ROC 42 on the current situation, the CSB database table SRG010 
“Economically active enterprises in statistical regions, cities, and counties of the Republic116” has 
been used. Data on economically active enterprises in the cities and counties of the Republic in 2018 
were used (the latest available data). According to these data, in 2018 there were a total of 185,006 
economically active companies in Latvia. Internet access for enterprises is calculated using the 
company's registered office. 
 
RCR 53 - Households subscribing to broadband connections to a very high-performance 
network – a number of the households. Values are obtained after the execution of the scenario 
(number of households in 2027). 
 
RCR 54 - Enterprises subscribing to broadband connections to a very high-performance network 
– a number of the enterprises. Values are obtained after the execution of the scenario (number of 
enterprises in 2027). 
 
To calculate the number of households, the CSB database table ISG060 “Total number of private 
households and average household size in statistical regions, cities, counties, rural areas and cities” 
117 was used. Data on the average household size in Latvia in 2020 were used. According to this 
table, the average household size is 2.28 persons. 
 
Therefore, the following formula was used for the calculations: 
 
SK = IEDZ / 2.28,  

where 
SK – the number of the households in 2019 and 2027,  
IEDZ – population in 2019 and 2027. 
 
 
According to the European Interoperability Framework, one of the objectives is to provide high-
performance broadband services for socio-economic drivers, which should be identified as a separate 
objective to be achieved and linked to the already defined outcome indicators ROC 42 and RCR 54. It 
is assumed that one socio-economic driver is one enterprise. 
 
In the case of socio-economic drivers, the values of ROC 42 and RCR 54 are set as target values, 
which are obtained by adding the number of health care institutions, educational institutions, and 
cultural objects indicated in Section 5.2.7 for which connections to the VHCN network are planned. 
 

5.2.9 Methodology for population forecast for 2027 

To determine the values of the planned outcome indicators concerning households in 2027, information 
on population projections in 2027 is included below. We will apply this methodology to all future 
development scenarios. 

                                                
116 Available: https://data.csb.gov.lv/pxweb/lv/uzn/uzn__01_skaits/SRG010.px  
117 Available: https://data.csb.gov.lv/pxweb/lv/iedz/iedz__iedzskaits__ikgad/ISG060.px  

 

https://data.csb.gov.lv/pxweb/lv/uzn/uzn__01_skaits/SRG010.px
https://data.csb.gov.lv/pxweb/lv/iedz/iedz__iedzskaits__ikgad/ISG060.px
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Forecast data are obtained from the CSB database table ISG020 “Population number and its change 
by statistical region, city, town, 21 development centres and county”118. Data on the number of 
inhabitants at the beginning of the year and changes in the number of inhabitants in the cities and 
counties in the period from 2010 to 2019 were used. To obtain a forecast for 2027, the dynamics of 
population changes in the last 10 years, and in the last 5 years were analyzed. Therefore, the dynamics 
(changes) of population were analyzed during this period. For the future forecast of population 
dynamics, the average value was calculated of change dynamics from the last 5 years and the value 
of the last year to consider both the long-term trend (5 years) and the latest changes (2019 data). Using 
the value of this population change dynamics, forecasts were calculated for population change from 
2020 to 2026 for each city and county. Using data on the population in 2019 and on changes in each 
subsequent year, a forecast was calculated for the population in 2027. Performing such calculations, 
the obtained forecast for the population of Latvia for 2027 was 1.86 million. 
 
In the next step, the population forecast data by cities and counties were transferred to the 1x1km grid. 
Therefore, calculations were performed with GIS analysis tools. Using the 1x1 km population grid data 
layer and the administrative boundary data layer and applying the Vector → GeoProcessing Tools → 
Union functionality, the composition of both data layers was obtained by determining the proportion of 
each 1x1 km population grid cell in the total area of the counties. Using this proportion value for each 
cell, the theoretically possible number of inhabitants of a county or city in a particular 1x1km grid cell 
was calculated. 
 
The following formula was used for the calculations: 
 

 SKi= 
SKnov x PLATi 

PLATnov 
, where  
SKi – population in the 1x1 km part of the grid cell located in the county (city), 
PLATi – area of the 1x1 km part of the grid cell located in the region (city), 
SKnov – total number of inhabitants in the county (city of the republic), 
PLATnov - the total area of the county (city). 
 

By summing the population in each 1x1 km grid cell, the GIS database data layer was obtained: 
“Population in 1x1km grid cells in 2027”. 

5.2.10 Methodology for estimating the number of enterprises now and in 
2027 

To determine the values of the planned outcome indicators concerning enterprises in 2027, information 
on the number of enterprises forecasts for 2027 is included below. We will apply this methodology to 
all future development scenarios. 

For the calculations of the indicator ROC 42 on the current situation, the CSB database table SRG010 
“Economically active enterprises in statistical regions, cities under state jurisdiction and counties”119 
has been used. Data on economically active enterprises in the cities and counties in 2018 were used 
(the latest available data). According to these data, in 2018 there were 185,006 economically active 
companies in Latvia. 

For the calculations of the indicator ROC 42 on the situation in 2027, it was assumed that the number 
of companies could have increased by 10%. 

                                                
118 Available: http://data1.csb.gov.lv/pxweb/lv/iedz/iedz__iedzskaits__ikgad/ISG020.px  
119 Available: https://data.csb.gov.lv/pxweb/lv/uzn/uzn__01_skaits/SRG010.px  

http://data1.csb.gov.lv/pxweb/lv/iedz/iedz__iedzskaits__ikgad/ISG020.px
https://data.csb.gov.lv/pxweb/lv/uzn/uzn__01_skaits/SRG010.px
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In the next step, the data on the number of companies by cities and counties was transferred to the 
1x1km grid. The following four layers of GIS data are used for this purpose: 

1) administrative boundaries, 

2) CORINE Land Cover, 

3) main roads and 

4) 1x1km grid data for the whole territory of Latvia. 

The calculations assumed that economically active companies were located in urban areas, agricultural 
land, or forest land 1 km from the main roads. 

Using GIS data analysis tools (Vector → Geoprocessing Tools → Fixed distance buffer functionality), 
a 1 km buffer zone was created around the main roads of Latvia. This buffer zone is used to identify 
those 1x1 km grid cells that are in this buffer zone (in whole or partially). 

Using the CORINE Land Cover data layer, the administrative boundary data layer, and the 1x1km grid 
data layer and applying the Vector → GeoProcessing Tools → Union functionality, the composition of 
all three data layers was obtained, thus determining: 

1) land cover distribution in each 1x1km grid cell, 

2) the distribution of land cover in the territory of the county (city). 

The first level classification of the CORINE Land Cover database was used for the distribution of land 
cover: 

1) urban territory, 

2) agricultural land, 

3) forest lands, 

4) wetlands, 

5) the water bodies. 

Areas with land cover class “4 - wetlands” and “5 - water bodies” were excluded from further 
calculations. In turn, the following coefficients were applied to the remaining land cover classes in order 
to model a different probability of the company's location in each of the classes: 

1) urban area - coefficient 0.75 (highest probability), 

2) agricultural land - coefficient 0.15 (assumption that the probability is 5 times lower than in urban 
areas), 

3) forest lands - coefficient 0.10 (the sum of all coefficients must be 1.0). 

 

Calculations were performed only for 1x1km grid cells located in the 1 km buffer zone around the main 
roads (see Figure 10). 
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Figure 10. Land cover 1 km around the main roads 

 
Source: Research done by PwC and CSE COE. 

 
The following formula was used to determine the number of enterprises in the part of the grid cell 
located in land cover class 1 (urban area): 

SK1= 
koef1 x SKnov x PLAT1 

PLATnov 
 
, where  
koef1 – 1st land cover class coefficient, 
SK1 – number of enterprises in the part of the 1x1km grid cell located in the region (city) in the 1st cover 
class, 
PLAT1 – area for that part of the 1x1km grid cell located in the region (city) in the 1st land cover class, 
SKnov – the total number of enterprises in the county (city), 
PLATnov - the total area of the county (city) in the 1 km buffer zone around the main roads. 
 
The following formula was used to determine the number of enterprises in the part of the grid cell 
located in land cover class 2 (agricultural land): 

SK2= 
Koef2 x SKnov x PLAT2 

PLATnov 
, where 
 
koef2 – 2nd land cover class coefficient, 
SK2 – number of enterprises in the part of the 1x1km grid cell located in the region (city) in the 2nd cover 
class, 
PLAT2 – area for the part of 1x1km grid cell located in the region (city) in the 2nd land cover class, 
SKnov – total number of enterprises in the region (city), 
PLATnov - the total area of the county (city) in the 1 km buffer zone around the main roads. 
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The following formula was used to determine the number of enterprises in the part of the grid cell 
located in the land cover class 3 (forest land): 

SK3= 
Koef3 x SKnov x PLAT3 

PLATnov 
 
, where  
koef3 – 3rd land cover class coefficient, 
SK3 – number of enterprises in the part of the 1x1km grid cell located in the region (city) in the 3rd land 
cover class, 
PLAT3 – area for the part of 1x1km grid cell located in the region (city) in the 3rd land cover class, 
SKnov – total number of enterprises in the region (city), 
PLATnov – the total area of the county (city) in the 1 km buffer zone around the main roads. 
 
To determine the number of enterprises in the part of the grid cell located in the county (city), the 
following formula was used:  

SK = SK1 + SK2 + SK3. 
 
The GIS database data layer “Number of enterprises in 1x1km grid cells in 2018” is obtained by 
summarizing the number of enterprises in each 1x1km grid cell. 
 

5.2.11 Areas affected by future development scenarios 

A separate 1x1km grid data layer was created for each of the possible future development scenarios 
to mark those 1x1km grid cells where the VHCN network is or is planned to be available. For this 
purpose, a special GIS data layer has been created for the 1x1km grid for the entire territory of Latvia 
Grid_lv_1k_teritorijas with special attributes for each cell: 
 
FIKS – number of fixed connections in the grid cell. 
MOBI – indication if the mobile connection is available in the grid cell in 2020 (0 - no, 1 - yes). 
OPTI – the number of fixed connections in the grid cell with access to the optics. 
NEW_CELL – indication if the mobile connection is planned in the grid cell in 2027 for new territories 
where there is no mobile connection in 2020 (0 - no, 1 - yes). This only applies to the 200 new mobile 
towers planned in Scenario 1. 
 
SOCEK1 – indication if the fixed connection with access to optics for socio-economic drivers is planned 
in the grid cell in 2027 (0 - no, 1 - yes). This only applies to Scenario 2. 
VIA_B – indication if the rid cell is located in the Via Baltica 4 km corridor (0 - no, 1 - yes). 
RAIL_B – indication if the grid cell is located in the Rail Baltica 4km corridor (0 - no, 1 - yes).  
 
The study assumes that VHCN with an access speed of at least 100Mbps, availability in 2020 is only 
in those areas where fixed broadband connections with access to optics can be found. Therefore, 
“VHCN white areas” are defined as areas without fixed connections with access to optics. 
 
For each scenario, the planned availability areas of the VHCN have been used as a filter to select 
those 1x1km grid cells that need to be aggregated by residents or companies in order to obtain the 
values of respective RCO 41 or ROC 42 indicators for the whole territory of Latvia. The same selected 
areas also apply to the calculation of RCR 53 and RCR 54. The affected areas of each scenario are 
given in the description of the respective scenario. 
 



  
  

“Pētījums Eiropas Savienības fondu 2021. -2027. gada plānošanas perioda ieguldījumu priekšnosacījumu izpildei”     (gala ziņojums)
  

   166 

5.2.12 Calculations on the county level 

Calculations for various development scenarios have been made not only for the territory of Latvia, but 
also by looking at the data by the new 42 administrative territories (counties and cities)120 (see the 
figure below). 

Figure 1137. Administrative territories after June 30, 2021 

 

Source: Research done by PwC and CSE COE. 

A conversion table has been used to recalculate the existing statistical data to the new administrative 
territories (see Appendix No.10). 

Considering the information characterizing the local government (number of inhabitants and its 
projected dynamics, number of enterprises, number of socio-economic drivers), local governments can 
be prioritized according to a conditional rank. The ranking calculation is made by rating the mentioned 
factors against their maximum values and then summing them by weighting factor. Table 1 shows the 
obtained ranking of national territories. 

Table 1. Local government conditional ranking 

Counties and 
cities (after 
30/06/2021) 

Population 
in 2027 

(forecast) 

Population 
changes (%) 

Number of 
economically 

active 
enterprises 

Number of 
health care 
institutions 

Number of 
educational 
institutions 

Number of 
cultural 

institutions 
Rank 

Ādaži 
municipality 

25287 26.2% 1783 1 5 7 28.90 

Aizkraukle 
municipality 

28324 -5.1% 2235 0 13 48 24.97 

                                                
120 https://likumi.lv/ta/id/315654-administrativo-teritoriju-un-apdzivoto-vietu-likums 
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Counties and 
cities (after 
30/06/2021) 

Population 
in 2027 

(forecast) 

Population 
changes (%) 

Number of 
economically 

active 
enterprises 

Number of 
health care 
institutions 

Number of 
educational 
institutions 

Number of 
cultural 

institutions 
Rank 

Alūksne 
municipality 

13801 -5.3% 1296 1 6 32 19.18 

Augšdaugava 
municipality 

28850 -13.6% 1790 0 10 50 19.86 

Balvi 
municipality 

16319 -19.5% 1839 1 16 43 20.40 

Bauska 
municipality 

38009 -10.7% 2946 1 27 64 40.58 

Cēsis 
municipality 

44772 6.6% 4277 1 40 60 55.34 

Daugavpils 75073 -2.0% 5012 3 26 40 56.27 

Dienvidkurzeme 
municipality 

37401 2.9% 3435 1 11 59 40.02 

Dobele 
municipality 

27387 -7.2% 2132 1 20 43 30.25 

Gulbene 
municipality 

18850 -7.7% 1623 0 15 30 16.40 

Jēkabpils 
municipality 

40410 -4.6% 3376 1 20 55 38.89 

Jelgava 63990 15.0% 4103 2 20 27 49.92 

Jelgava 
municipality 

29684 -7.2% 2276 0 21 48 27.26 

Jūrmala 52748 11.4% 4071 1 20 27 40.61 

Ķekava 
municipality 

31071 9.5% 2643 0 11 15 21.67 

Krāslava 
municipality 

20323 -19.2% 1817 2 19 44 28.24 

Kuldīga 
municipality 

25830 -10.0% 2998 1 8 44 25.16 

Liepāja 62702 -6.3% 5717 2 22 30 42.35 

Limbaži 
municipality 

33022 15.1% 2805 2 12 45 46.15 

Līvāni 
municipality 

10775 -0.1% 1002 0 2 17 9.02 

Ludza 
municipality 

20351 -13.9% 1629 2 12 48 29.32 

Madona 
municipality 

24536 -18.3% 2932 1 23 56 30.37 

Mārupe 
municipality 

46896 36.5% 3747 0 9 10 36.62 

Ogre 
municipality 

62181 7.7% 4918 1 24 50 50.16 
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Counties and 
cities (after 
30/06/2021) 

Population 
in 2027 

(forecast) 

Population 
changes (%) 

Number of 
economically 

active 
enterprises 

Number of 
health care 
institutions 

Number of 
educational 
institutions 

Number of 
cultural 

institutions 
Rank 

Olaine 
municipality 

22115 14.2% 1207 0 5 7 16.22 

Preiļi 
municipality 

14044 -12.4% 1819 0 2 36 10.38 

Rēzekne 27890 5.9% 1976 1 10 24 26.77 

Rēzekne 
municipality 

30442 -14.5% 2507 1 7 62 28.70 

Rīga 583605 -6.5% 77053 18 262 232 446.76 

Ropaži 
municipality 

46597 45.7% 2870 0 15 20 45.80 

Salaspils 
municipality 

24713 2.3% 1708 0 9 8 13.06 

Saldus 
municipality 

24820 -11.1% 2757 0 18 46 23.11 

Saulkrasti 
municipality 

3868 -54.3% 788 1 5 14 -13.74 

Sigulda 
municipality 

27660 -7.4% 2672 1 16 29 24.65 

Smiltene 
municipality 

19374 4.0% 1767 1 12 35 28.50 

Talsi 
municipality 

34899 -4.3% 3067 1 24 61 41.23 

Tukums 
municipality 

43708 -3.3% 3641 0 38 59 42.97 

Valka 
municipality 

8013 1.3% 611 1 4 14 14.24 

Valmiera 
municipality 

47269 -9.6% 4839 2 33 71 54.66 

Ventspils 30603 -10.0% 2435 2 21 21 28.52 

Ventspils 
municipality 

11488 -0.3% 887 0 9 23 13.55 

Maximum 
value 

583605  77053 18 262 232  

Weighting 
factor 

1.00 0.50 0.75 1.00 1.00 0.75  

Source: Research done by PwC and CSE COE. 

The established ranking can be used to identify areas where priority should be given to improving the 
availability of the Internet from the state resources for the implementation scenarios. 
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6. Approach scenarios for 
determining public intervention 
in the deployment of VHCN 
networks and the necessary 
investments 

The research aims to prepare a description of approach scenarios based on the collected data 
and cartographic material, that includes setting out the principles for public intervention in the 
deployment of VHCN networks to facilitate the objectives set in the European Interoperability 
Framework, considering the availability of fixed and mobile communication technologies, 
development trends, population density, as well as the broadband infrastructure created for the 
implementation of the state financial aid program No.SA.33324 “Next Generation Networks in 
Rural Areas” (hereinafter - VAP No.SA.33324). 

Approach scenarios: 

-  Ensuring the best use of state financial aid funding for the deployment of VHCN 
infrastructure to provide the highest return in terms of the number of households and / or socio-
economic drivers; 

-  Optimal use of state aid funding for the deployment of VHCN infrastructure to ensure 
coverage as much as possible in areas where the optical network infrastructure is not provided 
within the framework of VAP No. SA.33324. 

Based on the established of the approach scenarios, the lack of investment mist be assessed in 
specific areas / facilities to provide access to very high performance (VHCN) networks 

 

6.1 Baseline situation for determining public intervention in the 
deployment of VHCN networks 

The analysis performed is significant for the shortcomings of the Latvian VHCN broadband market, 
as well as significant inequalities, that delays availability of wide network services. This section 
includes information on market deficiencies, an overview of broadband network availability and target 
areas for support measures. 

Current level of broadband network coverage in urban and rural areas 

According to the study, broadband fixed VHCN services with data download speed of at least 30 Mbps 
are available in about 9.34% of the country's territory, however in these territories lives 84.1% of the 
country's population. 

VHCN networks with a speed of at least 100Mbps are available only in about 1.6% of the country's 
territory (large cities and populated places) for 70.1% of the population. 
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As these relatively small areas where VHCN services are available are urban and large populated, 
there are very large urban/rural differences in broadband network coverage in the country. This 
situation is unsatisfactory and needs to be improved, although it is objectively related to the low average 
population density in the country, the historically high population concentration in the capital Riga and 
regional centers, as well as active migration from rural areas to these centers or abroad. 

In order to address the market deficiency associated with low population density in a large part of the 
country, which does not allow for a sufficiently rapid return on investment in VHCN broadband 
networks, public support is needed for the deployment of such broadband networks in areas where 
they are not available. 

The data of the research and the performed analysis show that mobile networks are available in about 
90% of the country's territories and about 97.7% of the country's population live there. The practical 
performance of the mobile network can be assessed based on regular measurements performed by 
Public Utilities Commission (PUC). According to PUC measurements in 2019, the average values of 
connection speed in 95% of measurements in 4G data transmission technology in Latvia in 2019 were 
36.6 Mbps for download and 19.15 Mbps for upload. Thus, it can be considered that the country has 
good mobile Internet coverage with an average speed of around 30 Mbps. At the same time, however, 
it should be noted that download speeds above 30 Mbps have been only 64% of measurements taken 
in various parts of the country. PUC notes that although the availability of the service in the country is 
generally good, in some measurements upload speed values of even lower than 256 Kbps have been 
observed, and the availability of the service in such areas may be significantly impaired. 

To address the market deficiency related to the absence or very low population density in a small part 
of the country where mobile operators are not interested in offering their services, public support is 
needed for the deployment of core or VHCN broadband networks in these areas. 

Breakdown of broadband availability by technology 

In the field of fixed broadband services, Latvia has a large share of VHCN connections - 80% of 
connections provide speeds above 30Mbps and 70% have optical VHCN connections that provide 
symmetrical download and upload speeds above 100Mbps. VHCN networks providing services 
between 30 and 100 Mbps currently use a variety of wired (telephone cables (DSL, VDSL), coaxial 
cables (DOCSIS), Ethernet networks) and radio technologies, which are gradually being replaced by 
optics, thus replaced to VHCN. 

Mobile broadband services are provided practically everywhere in the country using 4G technologies. 

The main trends in the broadband network market 

The main trend in the fixed broadband market is the increasing availability of VHCN optical networks, 
which provide symmetrical speed from 100Mbps up to 1 Gbps (depending on the customer's needs). 

There is a lack of investment by operators to deploy VHCN networks to meet EU gigabit connectivity 
targets, as these networks are deployed in densely populated areas and further investments need to 
be made in areas where they are not expected to pay off quickly. This would require state support. 

Concerning the mobile broadband market, it can be noted that the transition to 4G networks has been 
practically complete (from all 3 mobile operators only 10 out of 3,000 base stations do not provide 4G). 
Thus, about 90% of the country's territory has access to a 4G mobile network with a theoretical 
download speed of up to 100Mbps (if the nearest base station is used by a small number of 
subscribers). As already mentioned, download speeds above 30Mbps have been only 64% of 
measurements in different parts of the country at different times. 

Retail prices for broadband services 

As all 3 national mobile operators offer their services throughout the country, their prices are the same 
everywhere. The competition between operators provides affordable prices for end-users, starting from 
about 10 EUR per month and including Internet access with an average speed of around 30Mbps. 
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Retail prices for fixed broadband services in different places in the country are also very similar, as the 
largest service provider Tet offers its services at the same prices throughout the country and other 
market players must compete with similar prices. These prices start from about 15 EUR per month for 
a service with a symmetrical speed of 100Mbps. It should be noted here that fixed broadband services 
with speeds above 100Mbps are actually only available in cities and larger settlements. 

However, the installation of new optical network connections in small inhabited places for individual 
customers far from the Middle mile network connection points requires large investments. In order to 
do so, service providers often require customer participation, so the cost of effective VHCN broadband 
services in small inhabited places can be high and often unavailable. 

In general, the market deficiency in the country is not related to different retail prices of broadband 
services in areas with different competitiveness, but to the available technological solutions and 
infrastructure for the development of broadband networks and the provision of connectivity services. 

There is a lack of investment by operators to be able to continue to provide VHCN networks to a 
growing part of the population in less populated areas at the same prices as in more densely populated 
areas. This would require state support. 

Available technological solutions for broadband network development 

An important future technological solution for the development of broadband VHCN networks and the 
provision of connectivity services in the country should be considered the deployment of optical 
networks that provide symmetrical speeds from 100Mbps, with the possibility to upgrade them to 
1Gbps. 

In the nearest future, the construction of 5G mobile networks can be considered as another 
technological solution for VHCN networks. However, providing guaranteed speeds in mobile networks, 
including 5G networks where users use the same frequency band within a network cell, will require a 
dense deployment of many base stations. 

As mobile networks cover about 90% of the territory in the country, this coverage needs to be improved. 
An appropriate technological solution for this purpose is the deployment of 4G networks (or 5G 
networks in the low-frequency band) to ensure the availability of mobile broadband services throughout 
the country. 

To improve the availability of broadband services in the country, it is important to use the Middle mile 
network and connection points that were built in the project "Next Generation Electronic 
Communications Network Development in Rural Areas" (177 access points were built and 1813km of 
optical cable was invested) and is currently being built within the project “Improving the availability of 
electronic communications infrastructure in rural areas” (it is planned to build at least 220 access 
points). According to the information received during the research, only about 2,000 km of the built 
optical network of about 4,000 km are currently used and only 43 of the built 401 network access points 
are used to provide services. 

Additional state support is needed to address market deficiencies (lack of investment to build the Last 
mile to the end-user, lack of local businesses) that do not make sufficient use of the national Middle 
mile network. 

Competition situation in electronic communications markets 

In the field of fixed broadband services, the market is concentrated with 4-5 largest players (Tet, 
Baltcom, Balticom, Dautkom), because small companies do not have enough investment to build 
optical networks. 

State financial aid for infrastructure construction would revitalize competition in the market for fixed 
VHCN services. 

In the mobile 4G broadband sector, there is healthy competition in the country. However, operators 
have built their own independent technical infrastructures. Partial infrastructure sharing would have 
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saved investment capital for the deployment of 5G networks and possibly helped to ensure lower 
service prices for end-users. 

Concerning the construction of 5G networks, the construction of a common technical infrastructure 
would benefit both the operators themselves, customers, and the state as a whole, so this market 
should be regulated by defining the rules of the game, requiring all operators to cooperate, regardless 
of ownership. 

One of the solutions could be the public support for the construction of a common 5G technical 
infrastructure (optical networks and towers, in some cases, even shared 5G base stations), which 
would allow the rapid availability of 5G VHCN networks, reduce costs, ensure affordable prices and 
allow operators to compete by offering different services through a common infrastructure. 

Expected economic and social benefits of the support measures 

The implementation of the planned state support measures would create a broadband network 
infrastructure that ensures the availability of VHCN networks to end-users - socio-economic drivers, 
businesses, and citizens. New interactive communication options (including video conferencing) would 
be a social benefit. 

Improving the availability of the Internet in certain areas with the help of state support will enable 
companies to offer new innovative services, promote remote work opportunities, as well as promote 
the development of the area by choosing to live in these areas. 

The availability of high-speed networks will enable citizens to use online services and receive services 
from state and municipal institutions, as well as to learn remotely. 

Improving the availability of the Internet for socio-economic drivers will help to provide better services 
to citizens, such as education, health cultures, and economic growth. 

Support measures would also provide infrastructure for the establishment of mobile networks in areas 
where their coverage is currently insufficient. This would ensure mobile communications and internet 
access, providing the above benefits at least to a limited extent. 

EU funded projects for internet access 

A publicly managed network model has been implemented in Latvia by the support of the EU funds121. 
Latvia State Radio and Television Centre SJSC (LVRTC) made investments in Middle mile 
infrastructure, managed and directly controlled the development. LVRTC ensures the availability of the 
established Middle mile infrastructure to the providers of Internet access services. The biggest 
challenge for the current system is the low usage of the established Middle mile infrastructure. Use fee 
12 EUR / km, as well as various discounts, are applied. In many cases, the established infrastructure 
is not connected to mobile towers (according to the information obtained during the interviews, more 
efficient compatibility with mobile towers is ensured within the framework of the 2nd phase of the 
project). 

 

 

 

                                                
121 Available: https://likumi.lv/ta/id/278331-darbibas-programmas-izaugsme-un-nodarbinatiba-2-1-1-specifiska-atbalsta-
merka-uzlabot-elektroniskas-sakaru-infrastrukturas  

https://likumi.lv/ta/id/278331-darbibas-programmas-izaugsme-un-nodarbinatiba-2-1-1-specifiska-atbalsta-merka-uzlabot-elektroniskas-sakaru-infrastrukturas
https://likumi.lv/ta/id/278331-darbibas-programmas-izaugsme-un-nodarbinatiba-2-1-1-specifiska-atbalsta-merka-uzlabot-elektroniskas-sakaru-infrastrukturas
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6.2 Overview of the proposed approach scenarios for 
determining public intervention in the deployment of VHCN 
networks 

Within the framework of the research, one approach scenario has been developed for the deployment 
of NG broadband networks in white areas where there is no network with an access speed of at least 
30 Mbps, three scenarios for the deployment of NG broadband networks in VHCN white areas without 
a network with an access speed of at least 100 Mbps, and 2 scenarios for 5G Internet access to 
transport corridors. This section describes the access models used, as well as an overview of the 
expected performance indicators. 

The developed approach scenarios are described in detail in the following sections of the report, 
including the results of the necessary investment calculations. Full investment calculations for all 
developed approach scenarios are provided in Annexes 11-16. 

The calculations of the required investments made within the project are based on many assumptions, 
which may change, as they are related to the further development of technology and the approach of 
operator services and market development. For example, the necessary infrastructure costs, which 
may change as technology advances, the new mobile towers required, which may change depending 
on the mobile operator's network development strategies, and the revenue from services, which may 
vary depending on the mobile operator's service delivery strategy. Also, for example, annual 
maintenance costs of 1% or 3% per year of the investments made are the assessment of the project 
experts. 

Therefore, the estimates included in the report are to be considered as indicative only and may vary 
significantly depending on the strategies chosen by market participants in further developing the 
availability of Internet services. 

The included estimates should be used as cost categories that should be analyzed before a decision 
is made, by reviewing the assumptions at that point and recalculating using the methodology described 
in the report. 

Scenarios for investments to ensure the availability of Internet services 

Scenario development is based on the development models set out in the Guide to High-Speed 
Broadband Investment (Handbook)122; interviews with major Internet access service providers, such 
as Tet, LMT, TELE2; industry associations, such as the Latvian Internet Association and the Middle 
mile infrastructure provider LVRTC. 

According to the Handbook, there are the following models for creating Internet access: 

➢ Publicly managed network model. The public authority manages and directly controls the 
installation of the network. 

➢ Privately managed network model. The public authority procures and entrusts the 
establishment and operation of the network to a private operator. 

➢ Community network model. In the case of the Community network model, local people invest 
in the development of the network through a private initiative. 

➢ Operator subsidy network model. The public authority decides not to be directly involved in 
the provision of network coverage and only grants subsidies to one operator for the 
modernization of its infrastructure. 

                                                
122 Available: https://ec.europa.eu/newsroom/dae/document.cfm?doc_id=12891  

https://ec.europa.eu/newsroom/dae/document.cfm?doc_id=12891
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Different scenarios can be used to plan future initiatives, combining the existing publicly managed 
network model with other models, but with a clear indication of the owners and operators of the 
infrastructure set up and whether the investment is made in the Middle or Last mile. 

Various development scenarios are presented below, taking into account the development principles 
described in the Handbook, except for the community network model, which does not assess the 
development of the community broadband model given the low purchasing power of the population 
and the project's goal of low internet density. 

The proposed scenarios aim to improve internet accessibility in white areas. The availability of the 
Internet can be ensured by using the services of mobile operators (mobile Internet) or an optical cable 
connection, therefore, for each of the proposed scenarios, the type of Internet availability will be 
indicated. When analyzing the scenarios, it should be taken into account that the availability and quality 
of mobile Internet depends on the number of concurrent users and, if a guaranteed speed is provided 
for the provision of nationally important functions, such as State Fire and Rescue Service of the 
Republic of Latvia (SFRS), a virtual subnet must be created in the network. The project does not 
analyze the creation of such a subnetwork. The scenarios define a methodology for determining the 
guaranteed Internet access speed, including a minimum share of a certain speed availability during the 
day, which may be less than 100%. 

Investments can be made in the average mile and the last mile, so each type of scenario indicates the 
type of investment. In parallel with the development of Internet accessibility in the white territories, the 
development of 5G corridors - Rail Baltica (railway) and Via Baltica (motorway) - has been analyzed. 

When planning investments for Internet access, various additional measures should be implemented 
to ensure the highest possible return on the investments made and the efficient use of public funding: 

➢ When state or municipal capital companies upgrade or build new public infrastructure (road 
lighting, water mains, gas pipelines, power grids, streets and roads, or overhaul), it should be 
combined with the development of optical network infrastructure through joint investment 
projects to reduce necessary costs. 

➢ Reduce the administrative burden for the installation of optical network infrastructure by 
facilitating and accelerating the preparation of the necessary documentation. 

 

Scenario performance indicators 

The performance indicators of the scenarios have been determined considering the indicators specified 
in the draft regulations of the planned investment financing - EU funds for the period 2021 - 2027, which 
apply to households and enterprises. Performance indicators were calculated using the methodology 
described in Section 5.2. An overview of the calculated performance indicators for all scenarios is given 
in Table 2. 
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Table 2. Summary of performance indicators for each scenario 

  RCO 41 RCO 42 RCR 53 RCR 54 

Scen
arios 

Description of the area 
where VHCN is available in 
2020 and planned for 2027  

Additional 
households with 
access to very 
high-
performance 
broadband - 
number of 
households 

Additional 
companies 
with access to 
very high-
performance 
broadband - 
number of 
companies 

Households 
subscribing to 
broadband 
connections to a 
very high-
performance 
network - 
number of 
households 

Companies 
subscribing to 
broadband 
connections on 
a very high-
performance 
network - 
number of 
companies 

  (thousands) (thousands) (thousands) (thousands) 

1 Mobile communications and 
fixed broadband connections 
in 2020 + 
new towers in the white areas 
(at least 30Mbps) in 2027 

8.6 
(2020 – 839.0 
2027 – 847.6) 

0.8 
(2020 – 177.3 
2027 – 178.1) 

4.3 
(2020 – 419.5 
2027 – 423.8) 

0.4 
(2020 – 88.7 
2027 – 89.1) 

2 Optical connections in 2020 + 
optical connections socio-
economic drivers in 2027 + 
households and businesses 1 
km around socio-economic 
drivers in 2027 

128.4 
(2020 – 591.9 
2027 – 720.3) 

50.6 
(2020 – 96.4 

2027 – 147.0) 

64.2 
(2020 – 296.0 
2027 – 360.2) 

25.3 
(2020 – 48.2 
2027 – 73.5) 

3 Optical connections in 2020 + 
improved mobile 
communications in 2020 from 
4G to 5G + 
part of fixed connections (who 
will have access to optics in 
2027) 

251.1 
(2020 – 591.9 
2027 – 843.0) 

89.8 
(2020 – 96.4 

2027 – 186.2) 

125.5 
(2020 – 296.0 
2027 – 421.5) 

44.9 
(2020 – 48.2 
2027 – 93.1) 

4 Optical connections in 2020 + 
all fixed connections (who will 
have access to optical in 
2027) 

130.9 
(2020 – 591.9 
2027 – 722.8) 

45.0 
(2020 – 96.4 

2027 – 141.4) 

65.4 
(2020 – 296.0 
2027 – 361.4) 

22.5 
(2020 – 48.2 

2027 – 70.7). 

5 Optical connections in 2020 in 
the Via Baltica 4km corridor + 
5G network in the entire Via 
Baltica corridor 

17.6 
(2020 – 0.0 

2027 – 17.6) 

7.1 
(2020 – 0.0 
2027 – 7.1) 

8.8 
(2020 – 0.0 
2027 – 8.8) 

3.5 
(2020 – 0.0 
2027 – 3.5) 

6 Optical connections in 2020 in 
the Rail Baltica 4km corridor + 
5G network in the entire Rail 
Baltica corridor 

16.8 
(2020 – 0.0 

2027 – 16.8) 

7.3 
(2020 – 0.0 
2027 – 7.3) 

8.4 
(2020 – 0.0 
2027 – 8.4) 

3.7 
(2020 – 0.0 
2027 – 3.7) 

Source: Research done by PwC and CSE COE. 

 

In 2019, 99% of companies and 85.4% of households had access to the Internet. (Source: CSB, 2020 
https://www.csb.gov.lv/en/press_release/2832 . At the same time, the European Commission's working 
paper SWD (2020) 111 final "Digital Economy and Society Index (DESI) 2020"123 states that: 

1) for fixed broadband, the total utilization rate in Latvia is 64% and 

2) for broadband up to 100Mbps, the utilization rate is only 38% (without separating fixed access 
from a mobile). 

The performance indicators for the calculation of RCR 53 and RCR 54, therefore, assume that in 2027, 
access to very high-performance broadband services will be used by 50% of households and 
businesses that will have access to such services. 

                                                
123 Available: https://ec.europa.eu/transparency/regdoc/rep/10102/2020/EN/SWD-2020-111-F1-EN-MAIN-PART-5.PDF  

https://www.csb.gov.lv/en/press_release/2832
https://ec.europa.eu/transparency/regdoc/rep/10102/2020/EN/SWD-2020-111-F1-EN-MAIN-PART-5.PDF
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6.3 Scenario 1 - Publicly managed network model - Middle mile 

Scenario 1 aims to create an infrastructure for the provision of Internet access services in areas where 
there is currently no network with an access speed of at least 30 Mbps. 

In the case of Scenario 1, it is assumed that the availability of VHCN with an access speed of at least 
30Mbps in 2020 is in areas where there is access to broadband optics (data layer Grid_lv_1k_territory 
attribute OPTI> 0) and where mobile communications are available (data layer Grid_lv_1k_territory 
attribute MOBI = 1). In 2027, the availability of VHCN with an access speed of at least 30Mbps is also 
planned in the white areas, where new mobile communication towers will be built (see the figure below). 

Figure 12. Areas affected by Scenario 1 

 

 
Source: Research done by PwC and CSE COE. 

Table 3. Description of the scenario 1 

Parameters Description 

Description of the planned 
investment 

Investments in connecting the existing middle mile infrastructure with the 
towers of mobile communication companies, as well as the construction of 
new mobile communication towers at the existing middle mile 
infrastructure. 

Mobile communication towers are connected to the LVRTC middle mile 
network - optics. The project should also finance the construction of an 
optical network from the existing LVRTC middle mile network to the newly 
built mobile tower. It is assumed that an average of 9 km of optics must be 
extended to each newly built mobile tower or 1,800 km of optics to 200 
towers. 

It is recommended that base stations be located as close as possible 
to socio-economic drivers or roads in order to provide the best 
possible internet connection for socio-economic drivers and to 
support autonomous transport management as much as possible. 
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Parameters Description 

The exact location of the base stations will be determined after the 
approval of the total investment. 

Investment target area Middle mile 

Owner of investments made State or state capital company 

Project implementer Public authority, for example LSRTC. 

Methodology for determining 
the values of outcome 
indicators 

The methodology for determining the values of outcome indicators is 
described in Section 5 of the report. 

Outcome indicators 
Below are the project outcome indicators. The methodology for calculating 
the values of the indicators is included in section 5.2 of the report. 

Code Description Value (thous.) 

RCO 41 
Additional households with broadband 
access - number of households 

8.6 

RCO 42 
Additional companies with access to 
broadband services - number of 
companies 

0.8 

RCR 53 
Households subscribing to broadband 
connections - number of households 

4.3 

RCR 54 
Companies subscribing to broadband 
connections - number of companies 

0.4 
 

Involvement of local 
governments 

Municipalities provide the necessary support for the establishment of an 
optical network, land and permits for the construction of communication 
towers for new mobile operators. 

Assumptions and limitations The calculations assume that 5G mobile Internet services would be 
provided in the 650-800 Mhz frequency range. 

Investments are planned only for the construction of new mobile 
communication towers. 200 new mobile towers are needed. 

Base stations shall be located in the white areas of the VHCN, but if 
necessary, in order to reduce project costs, base stations shall be located 
outside the white areas but provided that Internet access to the white 
areas is provided. 

The built base stations can be used for 4G and 5G networks 

The required investment for the construction of one new mobile 
communication tower is approximately 100,000 EUR 

According to the project experts, the average maintenance costs can be 
3% per year of the investments made (there may be different maintenance 
costs for the optical network and the mobile communication tower). 
Maintenance costs are borne by mobile operators as they will use the 
newly built mobile towers 

The duration of use of the investment is 20 years. 

The construction cost of the optical network is 30 EUR / m or 30,000 EUR 
per km. 

Revenue is calculated per capita and not per household, as it is assumed 
that each resident has their own mobile phone. It is assumed that the fee 
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Parameters Description 

for mobile services is 10 EUR per month, as well as the mobile operator, 
has the opportunity to expand the range of services provided. Revenues 
are distributed equally to all mobile towers, as the number of customers 
per tower is unknown, as well as how many and which mobile operators 
would provide services. 

Scenario analysis does not include a description of the situation and 
financial calculations in cases when LVRTC optics are attracted to existing 
mobile towers, because no information is available on which mobile 
towers would require such an investment. In total, there are 3,341 mobile 
towers in Latvia. According to the information provided in the interviews, 
connection to the optical network may be required ¼ from all towers or 
about 660 towers. Connection costs can only be calculated if the exact 
towers and their distance to the optics are known. 

Financial return  Summary of return on investment calculations: 

Value Indicator description  

€400,920.00 Total revenue per year, EUR 

€4,996,349.37 (1) Total revenue over 20 years, EUR (Net 
Present Value with 5% discount rate)   

€88,000,000.00 (2) Total investment, EUR 
  

€2,640,000.00 Maintenance costs, EUR / year (3% of 
investments) 

€32,900,235.30 (3) Total maintenance costs over 20 years, 
EUR (Net Present Value with 5% discount 
rate) 

-€115,903,885.93 (4) Calculation of return on investment for 20 
years: (4) = (1) - (2) - (3) 

Detailed calculations are provided in Appendix No.11 

 

Technical solution 

Within the scope of the research, a new infrastructure is being built, supplementing the existing middle 
mile optical network. The investment is made by a public body and the infrastructure created is owned 
by a public body. The following additional investments can be made (both types of investments or only 
one type of investment): 

➢ New optical lines (middle mile) have been laid from the existing main optical network to the 
towers of mobile communication companies in the white territories. The new optical lines are 
owned by a state-owned company. The mobile operator who owns the tower must also provide 
access to the leased optical line to other operators. It should be noted that each mobile operator 
has a large number of mobile towers (approximately 1000), as well as mobile operators 
coordinate the use of the infrastructure with each other, and many mobile operator towers are 
already connected to the main optical wires. 

➢ New mobile communication towers (shared towers) are being built at the existing optical 
network, as well as investments in the necessary technical equipment are being made. The 
new mobile towers built are owned by a state-owned company and mobile operators have the 
option to lease access to the mobile tower. Mobile towers can be used for 4G and 5G data 
transmission. 
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The analysis of white areas should determine how many towers of mobile operators need to be 
connected to the optical line, as well as assess the need for new mobile towers. According to the 
interviews, it would be necessary to add about 150 mobile towers to the optical network, as well as to 
build 180 new mobile towers. 

Organizational approach 

Investments in infrastructure are made by a public institution and the infrastructure created belongs to 
the state or a state capital company. State or municipal land can be chosen for the construction of 
towers. 

Table 4. Strengths and weaknesses analysis 

Strengths Weaknesses 

Improved quality and speed of mobile 
availability. 

Internet access is provided through mobile 
communications, which may not always provide the 
required speed, such as 100 Mbit/s. 

Strategically important Internet access 
infrastructure belongs to the state. 

The required speed of 100 Mbit/s is not provided. 

A shared infrastructure has been set up that can 
be used by different mobile operators. 

Construction of new mobile towers is a complicated 
process related to the purchase or lease of the 
necessary land, obtaining permits. 

Ensured competition between operators (equal 
conditions for the use of infrastructure for all). 

Mobile operators do not actively cooperate on the 
sharing of mobile towers, as there are different 
approaches to the construction of mobile towers that 
affect the possibilities for further sharing. For example, 
to buy or rent land needed to build mobile operator 
towers. In the case of land leases, other mobile 
operators may also need to enter into a land lease 
agreement, which could be difficult if the lessor is a 
state or local authority (tender required). 

The newly built mobile towers can also be used 
to provide 5G services. 

The state will have to ensure the maintenance of the 
established infrastructure. 

The construction of middle mile infrastructure 
can be strategically planned by the state. 

 

There are examples of similar positive practices, 
in Lithuania, the construction of an optical 
network and mobile communication towers is 
integrated. 

  

 

Information about the Lithuanian experience 

In Lithuania, three projects have improved the digital flaw between cities and regions. Within the scope 
of the first project124, 3357 km of fiber optic cables were built, and 3000 km were leased, creating 935 
access points. The infrastructure within the project consists of 51 separate networks - each in one 
municipality, providing a total of 330 schools and 467 sub-regions with broadband access. The 
established network belongs to the Lithuanian Ministry of Transport and Communications. 

                                                
124 Available: https://ec.europa.eu/regional_policy/en/projects/lithuania/improving-broadband-access-in-rural-lithuania  

https://ec.europa.eu/regional_policy/en/projects/lithuania/improving-broadband-access-in-rural-lithuania
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In the second phase of the project, 5,775 km of fiber optic cables were built, creating 2,789 access 
points (during the phase, access was provided to approximately 700 thousand inhabitants, including 
700 schools and 850 libraries). 

The third project125 promoted connectivity in rural activity centers, such as agriculture, food production, 
rural tourism, and elsewhere. 486 km of fiber optic cable infrastructure was built, connecting 443 
agricultural objects. 

In 2018, 55 different Internet service providers used the established network and many of them are 
small operators who have a good understanding of local needs. 97% of Lithuanian municipalities have 
at least two internet service providers and 63% of municipalities have at least 5 internet service 
providers. 

 

6.4 Scenario 2 - Public Managed Network Model - Last Mile 

Scenario 2 describes a situation where municipalities organize the construction of the last mile of 
optical networks mainly for the socio-economic drivers in their territories. 

In the case of scenario 2, it is assumed that the availability of VHCN with an access speed of at least 
100Mbps in 2020 is only in the territories where there is access to broadband optics (in the data layer 
Grid_lv_1k_territorial attribute OPTI> 0). In 2027, the availability of VHCN with an access speed of at 
least 100Mbps is additionally planned for socio-economic drivers who do not currently have access to 
optical broadband, and for residents and businesses located in the respective 1x1km grid cell (see 
figure below). 

 
Figure 13. Areas affected by Scenario 2  

 

                                                
125 Available: https://ec.europa.eu/digital-single-market/en/content/prip-development-broadband-network-infrastructure-
rural-areas-lithuania  

https://ec.europa.eu/digital-single-market/en/content/prip-development-broadband-network-infrastructure-rural-areas-lithuania
https://ec.europa.eu/digital-single-market/en/content/prip-development-broadband-network-infrastructure-rural-areas-lithuania
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Source: Research done by PwC and CSE COE. 

 

Table 5. Description of the scenario 2 

Parameters Description 

Description of the planned 
investment 

Investment in the last mile of the optical network using the existing middle 
mile infrastructure. 

Investment target area Last mile 

Owner of investments made Municipalities that lease the established infrastructure to municipal capital 
companies that provide Internet access services, or local governments lease 
the established infrastructure to an Internet service provider selected through 
a tender procedure. It should be considered that to provide Internet services, 
municipal capital companies must become electronic communications 
merchants by registering with PUC. The requirements of the State 
Administration Structure Law and the Competition Law must also be 
considered. 

The second option - Internet services are provided by an operator 
selected through a tender. 

Technology Optical internet 

Internet connection speed Up to 1 Gbit/s, at least 100Mbit/s. 

Return on investment The return on investment depends on the selected objects to which the 
optical Internet is attracted 

If a decision is made to attract the optical Internet to the main socio-economic 
forces, then this type of investment will have the highest return. 

With the introduction of the optical network, there will be fewer households 
that have access to the Internet compared to the provision of the Internet 
using the services of mobile operators. 

Outcome and result 
indicators 

Below are the project outcome indicators. The methodology for calculating 
the values of the indicators is included in section 5.2 of the report. 

Code Description Value (thous.) 

RCO 41 
Additional households with access to 
very high capacity broadband - 
number of households 

128.4 

RCO 42 
Additional companies with access to 
very high capacity broadband - 
number of companies 

50.6 

RCR 53 
Households subscribing to broadband 
connections to the very high capacity 
network - number of households 

64.2 

RCR 54 
Companies subscribing to broadband 
connections on a very high capacity 
network - number of companies 

25.3 

 

Territories VHCN white areas 

Beneficiaries Residents, businesses, state and municipal institutions 

Project implementer A public body, such as a municipality or planning region 
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Parameters Description 

Involvement of local 
governments 

Municipalities provide the necessary support for the establishment of an 
optical network. The local government leases the built infrastructure to a local 
government capital company that provides Internet access services or leases 
to an Internet service provider selected through a tender. 

Assumptions and limitations Calculations have been made to provide the most important socio-economic 
drivers for the provision of optical network infrastructure: educational 
institutions, health institutions, and cultural institutions. Calculations have 
been made for all socio-economic drivers who do not have access to a high-
speed internet connection. 

It is assumed that the optics connection is provided independently of the 
nearest optics connection or whether the optics network is owned by LVRTC 
or a merchant, such as Tet. 

Health care institutions - for 29 institutions the total length of the optical 
network from the nearest available optical connection point to the institution is 
25.8 km. 

Cultural institutions - the total length of the optical network from the nearest 
available optical connection point to 657 cultural institutions is 398.3 km. The 
remaining 439 cultural institutions have to pull the optics further than 3 km 
and the total distance of the optical network is 4784.3 km and, in this case, 
alternative connection solutions should be sought. 

Educational institutions - the total length of the optical network from the 
nearest available optical connection point to 342 educational institutions is 
166.7 km. The remaining 103 educational institutions have to pull the optics 
further than 3 km and the total distance of the optical network is 1087.7 km 
and, in this case, alternative connection solutions should be sought. 

The developed infrastructure could also be used by other socio-economic 
drivers, as well as households, but the necessary infrastructure provision 
costs are not included in the calculation. 

The duration of use of the investment is 20 years 

The construction cost of the optical network is 30 EUR / m or 30,000 EUR per 
km 

According to the project experts, the average maintenance costs can be 3% 
per year of the investments made. Maintenance costs are covered by the 
municipal authority providing the internet service or the mobile operator 

Revenues from the provision of Internet services are not quantified because 
no information is available on socio-economic drivers' payments for the 
availability of Internet services. Given that the Internet is provided for socio-
economic drivers, the main socio-economic benefits would be. 

Financial return  Summary of return on investment calculations: 

Value Indicator description  

€25,370,040.00 Total revenue per year, EUR 

€316,166,774.88 (1) Total revenue over 20 years, EUR (Net 
Present Value with 5% discount rate)   

€266,400,000.00 (2) Total investment, EUR   

€7,992,000.00 Maintenance costs, EUR / year (3% of 
investments) 
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Parameters Description 

€99,597,985.06 (3) Total maintenance costs over 20 years, 
EUR (Net Present Value with 5% discount 
rate) 

-€49,831,210.18 (4) Calculation of return on investment for 20 
years: (4) = (1) - (2) - (3) 

Detailed calculations are provided in Appendix No.12 

 

Technical solution 

Within the scope of the research, a new infrastructure is being built - the optical network 
infrastructure in the territory of the municipality. The investment priority is the provision of the optical 
network infrastructure to the main socio-economic drivers of the municipality and the municipality 
selects priority investment areas/objects. The infrastructure must also provide access to other 
operators. 

The created optical network infrastructure is connected to the optical network administered by 
LVRTC or to the optical network of private operators, using the most economically advantageous 
solution. 

The construction of the optical network is carried out by an external service provider, which is selected 
by the municipality through a tender procedure. If necessary, the Broadband Competence Center 
provides the necessary advisory support. 

Organizational approach 

Investments in infrastructure are made by the local government, which leases the established 
infrastructure to a municipal capital company, or a service provider selected through a tender. The 
development of the optical network infrastructure must be planned in coordination with other 
infrastructure developed by the municipality, such as street lighting, water, and sewerage (it must be 
assessed whether the optical network infrastructure will not be damaged during the repair works). 
Where possible, optical network infrastructure should be developed at the same time as electrical 
connections. 

If necessary, the necessary support for local governments can be provided by planning regions. 

 Table 6. Strengths and weaknesses analysis   

Strengths Weaknesses 

The established middle mile infrastructure has 
been used 

Municipalities need technical competence and capacity 
to organize an optical network construction project in 
the municipality 

The strategically important Internet access 
infrastructure (last mile) belongs to the 
municipalities 

The municipality may not provide Internet services; 
therefore the function must be delegated to one of the 
municipal capital companies 

A shared infrastructure has been created that 
can be used by municipal capital companies 

Changes to the Law on Local Governments regarding 
the functions to be performed by local governments 
may be necessary 

The municipality can prioritize the connections to 
be developed, such as the main socio-economic 
drivers 

The Internet will be provided primarily to the main 
socio-economic forces and part of the population in 
remote areas may not have access to the Internet. 

Ensuring delivery of high quality and fast internet 
access up to 1Gbit/s 

The municipality will have to ensure the maintenance 
of the established infrastructure 
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The construction of the last mile of infrastructure 
can be strategically planned from the municipal 
side 

Local governments need to establish common 
principles for setting network usage fees, which should 
ensure the availability of the network in different local 
governments 

By investing in the main socio-economic drivers 
of the direction, Internet access can be provided 
to all citizens through the Internet in libraries, 
educational institutions, customer service 
centers 

 

 
 

6.5 Scenario 3 - Privately managed network model  

Scenario 3 aims to provide a VHCN network with access speeds of at least 100 Mbps to end-users 
wherever it is not available in the country through public tenders. The sequence of this competition 
would be determined by the developed ranking of national territories, which is described in section 
5.2.12. 
 
In the case of scenario 3, it is assumed that the availability of VHCN with an access speed of at least 
100Mbps in 2020 is only in the territories where there is access to broadband optics (in the data layer 
Grid_lv_1k_territorial attribute OPTI> 0). In 2027, the availability of VHCN with an access speed of at 
least 100Mbps is additionally planned in areas that currently have mobile coverage (in the data layer 
Grid_lv_1k_territory attribute MOBI = 1) and a fixed broadband connection without access to optics 
(see figure below). 
 
 

Figure 14. Areas affected by Scenario 3  

 
Source: Research done by PwC and CSE COE. 

 



  
  

“Pētījums Eiropas Savienības fondu 2021. -2027. gada plānošanas perioda ieguldījumu priekšnosacījumu izpildei”     (gala ziņojums)
  

   185 

Table 7. Description of the scenario 3 

Parameters Description 

Description of the planned 
investment 

The private operator selected through a tender plan and ensures the 
availability of Internet services in the white areas. 

The competition can be organized in the whole territory of the country, 
planning regions, or local governments (according to the ranking of local 
governments described in section 5.2.12). 

The county ranking described in section 5.2.12 can be used to determine the 
municipalities in which to start organizing tenders as a priority. 

Besides, priority should be given to those areas where there is currently no 
mobile network coverage or 30Mbit/s speed is not provided in such a 
network. 

Competition condition - technologically neutral. 

Investment target area Middle mile and / or last mile - choice of private operator 

Owner of investments made Private operator 

Technology Not specified 

Internet access speed At least 100 Mbit/s - requirements are specified in the tender conditions. 

Defined proportion of time of day (e.g. 90%) when at least the specified 
speed is available. 

Return on investment The number of households that will have access to the Internet depends on 
the offer of the private operator, as well as on how many households do not 
have access to the Internet in the defined area. 

Outcome and result 
indicators 

Below are the project outcome indicators. The methodology for calculating 
the values of the indicators is included in section 5.2 of the report. 

Code Description Value (thous.) 

RCO 41 
Additional households with access to 
very high capacity broadband - 
number of households 

251.1 

RCO 42 
Additional companies with access to 
very high capacity broadband - 
number of companies 

89.8 

RCR 53 
Households subscribing to broadband 
connections to the very high capacity 
network - number of households 

125.5 

RCR 54 
Companies subscribing to broadband 
connections on a very high capacity 
network - number of companies 

44.9 

 

Territories VHCN White areas, but it is possible to improve the availability of Internet 
services also in certain gray and black areas (for example, in areas where 
fixed broadband connections without access to optics are available in 2020). 

Beneficiaries Residents, businesses, state and municipal institutions 

Project implementer Private operator (selected through a tender procedure) 

Involvement of local 
governments 

In cases where a tender for the provision of Internet access is organized at 
the level of the planning region or at the level of the local government, the 
organization of the competition may be provided by the planning region or 
local government. 
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Parameters Description 

Assumptions and limitations Investments are planned to ensure at least 100 Mbit/s speed for all residents 
who do not have access to it in 2020, allowing 100 Mbit/s speed to be 
available in less than 100% of the day, in order not to exclude mobile 
operators and maintain technological neutrality. 

The assessment of the required investment assumes that the last mile is 
provided to households using 5G mobile networks operating in the lowest 
frequency range (650-800MHz). 

The availability of 5G mobile communications requires about 200 mobile 
towers in the white areas and about 305 mobile towers in the rest of the 
country, where fixed broadband connections with access to optics are not 
currently available. The investment cost of each mobile tower is 100,000 
EUR. Mobile towers are located on average 9 km from the nearest optical 
network connection point. 

The duration of use of the investment is 20 years. 

According to the project experts, maintenance costs can be 3% per year of 
the investment. 

Revenue from the provision of Internet services is 5 EUR per month (an 
increase compared to 2020) per person and 20 EUR per month (an increase 
compared to 2020) per company. 

Financial return  Summary of return on investment calculations: 

Value Indicator description  

€46,420,680.00 Total revenue per year, EUR 

€578,504,278.40 (1) Total revenue over 20 years, EUR (Net Present 
Value with 5% discount rate)   

€907,105,000.00 (2) Total investment, EUR 

€684,905,000.00 incl. installation of a new 5G base station on 3341 
existing 4G towers and connection of some towers to 
the optical network (EUR) 

€88,000,000.00 incl. 200 new 5G towers in the White Territories 
(EUR) - tower construction, installation of base 
stations, connection to the optical network 

€134,200,000.00 incl. 305 new 5G towers without optics (EUR) - tower 
construction, installation of base stations, connection 
to the optical network   

€27,213,150.00 Maintenance costs, EUR / year (3% of investments) 

€339,135,999.38 (3) Total maintenance costs over 20 years, EUR (Net 
Present Value with 5% discount rate) 

  

-€667,736,720.98 (4) Calculation of return on investment for 20 years: 
(4) = (1) - (2) - (3) 

Detailed calculations are provided in Appendix No.13 

 

 

 

Technical solution  
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The project provides Internet access to white areas, and it is the choice of the private operator, which 
technical solution and what infrastructure is used to provide the service. 

Organizational approach 

The infrastructure investments described above are made by a private operator selected through a 
tender procedure. The competition is organized for the whole territory of the country or gradually by 
counties, according to the ranking of counties, described in section 5.2.12. In addition, priority should 
be given to those areas where there is currently no mobile network coverage or 30Mbit/s speed is not 
provided in such a network. 

The tender's technical specification criteria could include the minimum speed of Internet access to be 
provided, as well as a defined proportion of time of day when it is available, as well as the minimum 
number of Internet connections to be provided to households, businesses, state and municipal 
corporations. Additional criteria can be the speed of Internet access to the main socio-economic drivers 
of municipalities, as well as cooperation and coordinated approach with other providers of technical 
infrastructure (water supply, electricity). 

According to the interviews, it would take the operator at least 3 years to set up the infrastructure and 
provide the necessary internet access. 

An operator who acquires the right to provide Internet services in specific VHCN white areas through 
a tender procedure allows the infrastructure built for the financing obtained within the tender to be used 
(lease agreement) by other Internet service providers in accordance with the provision of network 
unbundling opportunities. 

Table 8. Strengths and weaknesses analysis  

Strengths Weaknesses 

Very high quality and fast internet is available Strategically important Internet infrastructure belongs 
to the private operator 

Cooperation with other critical infrastructure 
providers, including requirements in tender 
conditions 

The project is more economically advantageous in 
large cities and municipalities of the Riga region and 
surroundings. 

A shared infrastructure has been created that can 
be used by different communication operators 

The Internet may not be available due to insufficient 
customer activity 

Ensured competition between operators (equal 
conditions for the use of infrastructure for all) 

 

Planning regions or municipalities have the 
opportunity to influence and promote the 
availability of the Internet in their territories by 
including requirements in the tender conditions 

In areas where the technological solution chosen for 
the last mile will be 5G networks in the low frequency 
range, additional investments will be required in the 
future to provide end users with speeds of up to 
1Gbit/s. 

 

6.6 Scenario 4 - Operator subsidization model  

Scenario 4 aims to support the development of an optical network in areas where there are currently 
fixed Internet access services that do not provide 100Mbps speeds. 

In the case of Scenario 4, it is assumed that the availability of VHCN with an access speed of at least 
100Mbps in 2020 is only in areas where there is access to broadband optics (in the data layer 
Grid_lv_1k_territory attribute OPTI> 0). In 2027, the availability of VHCN with an access speed of at 
least 100Mbps is additionally planned also in the territories where there is currently a fixed broadband 
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connection (in the data layer Grid_lv_1k_territory attribute FIKS> 0) without access to optics (see the 
figure below). 

Figure 15. Areas affected by Scenario 4  

 
Source: Research done by PwC and CSE COE. 

 

Table 9. Description of the scenario 4 

Parameters Description 

Description of the planned 
investment 

Investments in the creation and expansion of the optical network 

Investment target area Middle mile and last mile 

Owner of investments made Private operator 

Technology Optical internet 

Internet access speed Up to 1 Gbit/s, at least 100Mbit/s. 

Return on investment The return on investment depends on the investment strategy in which 
the investments are made, and which are the primary recipients of 
Internet services, such as the main socio-economic drivers. 

With the introduction of the optical network, there will be fewer 
households that have access to the Internet compared to the provision 
of the Internet using the services of mobile operators. 

Outcome and result 
indicators 

Below are the project outcome indicators. The methodology for 
calculating the values of the indicators is included in section 5.2 of the 
report. 
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Parameters Description 

Code Description Value (thous.) 

RCO 41 
Additional households with access to 
very high capacity broadband - 
number of households 

130.9 

RCO 42 
Additional companies with access to 
very high capacity broadband - 
number of companies 

45.0 

RCR 53 

Households subscribing to 
broadband connections to the very 
high capacity network - number of 
households 

65.4 

RCR 54 
Companies subscribing to broadband 
connections on a very high capacity 
network - number of companies 

22.5 

 

Territories White areas 

Beneficiaries Residents, businesses, state and municipal institutions 

Project implementer Private operator selected through a tender procedure 

Involvement of local 
governments 

Municipalities provide the necessary support for the establishment of the 
optical network, including the coordination of permits and documents 

Assumptions This scenario proposes a subsidy model for the telecommunications 
operator and does not consider the subsidy model for the service user. 
Subsidizing the service user stimulates only the use of the service for a 
certain period, but no real investment is made in the development of the 
infrastructure necessary for the provision of the service. 

Investments are planned to ensure the availability of a high-performance 
network for households that currently have a broadband connection 
without the use of optics. 

According to the information provided in the Tet interview, the average 
cost of building an optical network for a household in white areas is about 
3,000 EUR. 

According to Tet, the real duration of the investment in the optical network 
is 40 years. 

Maintenance costs for the optical network are low. According to the project 
experts, they can make up 1% per year of the investments made. 

Revenue from the provision of optical internet services averages € 20 
per month per household (usually in combination with a television 
service). 

Financial return  Summary of return on investment calculations: 

Value Indicator description 

€23,563,140.00 Total revenue per year, EUR 

€293,648,807.01 (1) Total revenue over 20 years, EUR (Net 
Present Value with 5% discount rate) 

  

€1,030,722,000.00 (2) Total investment, EUR 

€785,178,000.00 incl. household connection to optics (EUR) 

€245,544,000.00 incl. connection of companies to optics 
(EUR) 
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Parameters Description 
  

€10,307,220.00 Maintenance costs, EUR / year (1% of 
investments) 

€128,450,743.69 (3) Total maintenance costs over 20 years, 
EUR (Net Present Value with 5% discount 
rate) 

-€865,523,936.68 (4) Calculation of return on investment for 
20 years: (4) = (1) - (2) - (3) 

Detailed calculations are provided in Appendix No.14 

 

Technical solution 

Within the project, new infrastructure is being built or the existing infrastructure is being replaced by an 
optical network. The competition is organized throughout the country or in specific territories. 

We offer to indicate in the tender regulation’s specific white areas where internet access must be 
ensured, as well as to request cooperation and coordination with other types of technical infrastructure 
providers. The main evaluation criterion of the tender would be the number of provided Internet 
connections for households, companies, state and municipal capital companies, and socio-economic 
drivers. 

According to Tet, 222 884 Tet broadband customers do not currently have access to an optical network. 
Tet has identified a total of 366,706 household addresses where an optical network can be retrieved 
by rebuilding or replacing an existing network. 

Organizational approach 

Investments in infrastructure are made by a private operator selected through a tender procedure. 

Financing 

Funding would be needed for the construction of the optical network. According to the information 
provided in the Tet interview, the average cost of building an optical network for a household in white 
areas is about 3,000 EUR. 

Table 10. Strengths and weaknesses analysis 

Strengths Weaknesses 

Very high quality and fast internet is available Strategically important infrastructure is owned by a 
private operator 

The merchant is selected through a competition Due to the high investment costs per km, the 
availability of the Internet is improved for a relatively 
small number of Internet users 

A shared infrastructure has been created that can 
be used by other communication operators 

The Internet will not be provided in remote 
homesteads, because the cost of installing optical 
Internet will be too high 

Ensured competition between operators (equal 
conditions for the use of infrastructure for all) 

The project is more cost-effective in large cities 

The project can be implemented gradually, as well 
as in different areas in parallel 

A specific technology is supported - construction of 
an optical network 

 One merchant is subsidized 
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6.7 Scenario 5 - 5G Via Baltica  

In the case of scenario 5, a 5G network is provided in the territory 4 km from the middle axis of the Via 
Baltica motorway. 
 
In this scenario, it is assumed that the availability of VHCN with an access speed of at least 100Mbps 
in 2020 is only in those areas of the Via Baltica corridor where access to broadband optics is available 
(in the data layer Grid_lv_1k_territorial attribute OPTI> 0). In 2027, the availability of VHCN with an 
access speed of at least 100Mbps is additionally planned in the remaining territory of the Via Baltica 
corridor (in the data layer Grid_lv_1k_territorial attribute VIA_B = 1) (see the figure below). 
 
 

Figure 16. Areas affected by Scenario 5 

 
Source: Research done by PwC and CSE COE. 

 

Table 11. Description of the scenario 5 

Parameters Description 

Description of the 
planned 
investment 

Investments in support of the 5G network - investments in middle mile optical 
networks and 5G-compliant mobile towers. The built infrastructure is available to 
all mobile operators 

Investment target 
area 

Middle mile 

Owner of 
investments made 

State or public joint stock company 
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Parameters Description 

Technology Mobile internet 

Internet access 
speed 

Up to 1 Gbit/s 

Return on 
investment 

The return on investment depends on the traffic intensity along the Via Baltica 
route, the number of residents, businesses, state and municipal institutions and 
activities in the Via Baltica area. 

Outcome and 
result indicators 

Below are the project outcome indicators. The methodology for calculating the 
values of the indicators is included in section 5.2 of the report. 

Code Description 
Value 
(thous.) 

RCO 41 
Additional households with access to 
very high capacity broadband - 
number of households 

17.6 

RCO 42 
Additional companies with access to 
very high capacity broadband - 
number of companies 

7.1 

RCR 53 
Households subscribing to broadband 
connections to the very high capacity 
network - number of households 

8.8 

RCR 54 
Companies subscribing to broadband 
connections on a very high capacity 
network - number of companies 

3.5 

 

Territories About 8 km wide canal, which includes the Via Baltica route. 

Beneficiaries Road users on Via Baltica, residents, businesses, state and municipal institutions, 
future autonomous car users. 

Project 
implementer 

State joint stock company, such as LVRTC. 

Involvement of 
local governments 

Municipalities provide administrative support for the construction of mobile towers. 

Assumptions and 
limitations 

According to LVRTC calculations, 51 mobile communication towers are needed to 
provide 5G mobile network around the route, 10 of which must be rebuilt. 

Mobile communication towers are connected to the LVRTC medium mile network - 
optics. The project should also finance the construction of an optical network from 
the existing LVRTC medium mile network to the newly built mobile tower. It is 
assumed that an average of 9 km of optics must be extended to each newly built 
mobile tower or 90 km of optics to 10 towers. 

It is assumed that the existing 41 towers are already connected to the optical 
network. 

The return on investment is calculated on the assumption that the number of 
towers required is 2 times higher to ensure the guaranteed required access speed 
in case of many simultaneous users. 

The required investment for the construction of one new mobile communication 
tower is approximately 100,000 EUR. 

Financial return Summary of return on investment calculations: 
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Parameters Description 

Value Indicator description 

€1,761,120.00 Total revenue per year, EUR 

€21,947,447.88 
(1) Total revenue over 20 years, EUR (Net 
Present Value with 5% discount rate) 

  

€25,610,000.00 (2) Total investment, EUR 

€16,810,000.00 

incl. installation of a new 5G base station 
on existing 4G towers and their connection 
to the optical network (EUR) 

€8,800,000.00 incl. new 5G towers to be compacted (EUR) 

  

€768,300.00 
Maintenance costs, EUR / year (3% of 
investments) 

€9,574,716.21 

(3) Total maintenance costs over 20 years, 
EUR (Net Present Value with 5% discount 
rate) 

-€13,237,268.33 
(4) Calculation of return on investment for 
20 years: (4) = (1) - (2) - (3) 

Detailed calculations are provided in Appendix No.15 

 

Technical solution 

The project involves building new infrastructure or upgrading existing infrastructure to complement the 
existing middle mile optical network and build 4G mobile towers. 

According to the information provided by LVRTC, 51 mobile communication towers are needed to 
provide 4G and 5G mobile network around the route, of which 10 must be rebuilt. The return on 
investment is calculated on the assumption that the number of towers required is 2 times higher to 
ensure the guaranteed required access speed in case of many simultaneous users. 

When leasing the established infrastructure to mobile communication companies, it is necessary to 
define the territories at a certain distance from the Via Baltica, where a certain 5G Internet access must 
be ensured. Besides, the availability of the Internet for the main socio-economic drivers of local 
governments, as well as cooperation and coordinated approach with other critical infrastructure 
providers should be determined. 

Organizational approach 

Investments in infrastructure are made by a state joint stock company, which procures the necessary 
works through a tender. 

Table 12. Strengths and weaknesses analysis 

Strengths Weaknesses 

Very high quality and fast internet is available The economic benefits of the project for mobile 
operators depend on the intensity of traffic on the Via 
Baltica 
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The project can be implemented gradually, as well 
as in different areas in parallel 

Due to the high investment costs per km, the 
availability of the Internet is improved for a relatively 
small number of Internet users 

A shared infrastructure has been created that can 
be used by other communication operators 

Internet will not be provided in areas remote from Via 
Baltica 

Ensured competition between operators (equal 
conditions for the use of infrastructure for all) 

 

 

6.8 Scenario 6 - 5G Rail Baltica  

In the case of scenario 6, a 5G network is provided in the territory along the planned Rail Baltica railway 
line (including various variants in separate sections). 
 
In this scenario, it is assumed that the availability of VHCN with an access speed of at least 100Mbps 
in 2020 is only in those areas of the Rail Baltica corridor where there is access to broadband optics (in 
the data layer Grid_lv_1k_territorial attribute OPTI> 0). In 2027, the availability of VHCN with an access 
speed of at least 100Mbps is additionally planned in the remaining territory of the Rail Baltica corridor 
(in the data layer Grid_lv_1k_territory attribute RAIL_B = 1) (see the figure below). 
 

Figure 17. Areas affected by Scenario 6 

 
Source: Research done by PwC and CSE COE. 

Table 13. Description of the scenario 6 

Parameters Description 

Description of the 
planned 
investment 

During the construction of the Rail Baltica railway line, fiber-optic communication 
infrastructure is being built in the technological sewerage parallel to the railway 
line. RB Rail plans to use this infrastructure to meet the technological needs of the 
railway within the private network, as well as to lease the free optical network 
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Parameters Description 

infrastructure capacity to other service providers. This infrastructure can serve as 
a connection to a transnational optical network, which could be used by both 
mobile operators and public sector institutions (e.g. for the creation of a 
transnational university network, corporate intranet, etc.). At these points, it will be 
possible to connect to the optical network infrastructure. Investments supporting 
the establishment of a 5G network - investments for the deployment of 5G mobile 
base stations. The built infrastructure is available to all mobile operators. 

Investment target 
area 

Middle mile  

Owner of 
investments made 

State or state joint stock companies (LVRTC and / or Rail Baltica) 

Technology Mobile internet 

Internet access 
speed 

Up to 1 Gbit/s 

Return on 
investment 

The return on investment depends on the intensity of train traffic, the number of 
residents, merchants, state and municipal institutions and activities in the territory 
of Rail Baltica 5G 

Outcome and 
result indicators 

Below are the project outcome indicators. The methodology for calculating the 
values of the indicators is included in section 5.2 of the report. 

Code Description 
Value 
(thous.) 

RCO 41 

Additional households with access to 
very high capacity broadband - 
number of households 

16.8 

RCO 42 

Additional companies with access to 
very high capacity broadband - 
number of companies 

7.3 

RCR 53 

Households subscribing to broadband 
connections to the very high capacity 
network - number of households 

8.4 

RCR 54 

Companies subscribing to broadband 
connections on a very high capacity 
network - number of companies 

3.7 

 
 

Territories The area around the Rail Baltica route 

Beneficiaries Rail Baltica passengers, residents, merchants, state and municipal institutions 

Project 
implementer 

State or state joint stock companies (LVRTC and / or Rail Baltica) 

Involvement of 
local governments 

Not planned 

Assumptions The 5G network is being built in cooperation with RB Rail. 

Financial return Summary of return on investment calculations: 
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Parameters Description 

Value Indicator description 

€1,781,670.00 Total revenue per year, EUR 

€22,203,546.30 
(1) Total revenue over 20 years, EUR (Net 
Present Value with 5% discount rate) 

  

€18,850,000.00 (2) Total investment, EUR 

€0.00 
incl. installation of a new 5G base station 
on existing 4G towers and their connection 
to the optical network (EUR) 

€18,850,000.00 incl. new 5G towers to be built (EUR) 

  

€565,500.00 
Maintenance costs, EUR / year (3% of 
investments) 

€7,047,379.95 
(3) Total maintenance costs over 20 years, 
EUR (Net Present Value with 5% discount 
rate) 

-€3,693,833.65 
(4) Calculation of return on investment for 
20 years: (4) = (1) - (2) - (3) 

Detailed calculations are provided in Appendix No.16 

It is not possible to make a detailed assessment of the construction of the 5G 
network due to the unavailability of data. A detailed revenue estimate is also not 
possible, as it depends on the number of passengers that will be transported 
along the route. 

According to the information provided by the representatives of RB Rail, at the 
time of the development of the deliverable, no decision has been made yet on 
whether mobile communication towers will also be built at the connection points, 
which are planned on average every 4 km. It depends on the technological 
requirements that will be set for the technologies of the private railway network, 
which will be decided in 2022-2023. If RB Rail builds communication towers, RB 
Rail will have to pay an infrastructure fee, which in the long run can be 
comparable to the cost of building 5G towers. 

 

 Technical solution 

As part of the project, new infrastructure is being built to complement the existing middle mile optical 
network and ensure the deployment of 5G mobile base stations. 

The company RB Rail will build the middle mile along the Rail Baltica route by placing the optical cable 
in 2 sewer pipes. It is planned to create special niches every 4-5 km for the placement of network 
equipment. For the location of base stations, it would be very efficient to use low-altitude towers in case 
RB Rail builds them for its own needs. 

The mobile network around Rail Baltica will be built to ensure: 

➢ High-speed network located in a wider corridor around the Rail Baltica route 

➢ High-speed network for high-speed train passengers 

In the first case, the network is set up as in Scenario 5 and the corresponding calculation of the required 
investment is included in the table above in this section. 

In the second case, a communication corridor must be created directly along the train path. Here it 
would be necessary to get acquainted with the experience of the operator Swisscom, which is already 
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able to provide data transmission speeds above 1Gbps in a high-speed train (while on the move), 
using a mixed 4G and 5G network and a specially designed antenna corridor126. In this scenario, it is 
possible to use lower power transmitters that do not need to be located in high towers, but other factors, 
such as the high-frequency electromagnetic field transmittance of train windows, are also important to 
achieve high data rates. Swisscom promises to share its experience. 

Organizational approach 

Investments in infrastructure are made in accordance with the company's planned works and time 
schedule and considering RB Rail's plan to implement the Rail Baltica project together as a single 
technological solution in all 3 Baltic countries. 

Table 14. Strengths and weaknesses analysis 

Strengths127 Weaknesses 

Very high quality and fast internet is available The high-speed network is only available near the 
train path 

The 5G network provides a very low signal delay 
and can also be used for the technical needs of 
Rail Baltica within the private network 

Due to the high investment costs along the entire 
length of the Rail Baltica route, the availability of the 
Internet is improved for a relatively small number of 
users. 

A shared infrastructure has been set up that can 
be used by several mobile operators 

The intensity of train traffic, and thus the number of 
Internet users, may be too small to ensure the 
interest of mobile operators in building a mobile 
corridor along the entire Rail Baltica route. 

Cost savings by locating a large part of the optical 
network along the transmission line at the same 
time as its construction 

 

 

6.9 Summary of the proposed state financial aid scenarios 

The table below summarizes the proposed state financial aid scenarios, which provides information 
on the main parameters of each scenario. For all scenarios, the assessment of return on investment 
over a 20-year period is negative. This means that these scenarios are not feasible without additional 
support. 

Table 15. Possible support scenarios 

Parameters Scenario 1: 

Public Managed 
Network Model - 
Middle Mile 

Scenario 2: 

Public Managed 
Network Model - 
Last Mile 

Scenario 3: 

Privately managed 
network model 

Scenario 4: 

Operator 
subsidization 
model 

Description of 
the planned 
investment 

Investments in 
connecting the 
existing middle mile 
infrastructure with 
the towers of 
mobile 
communication 
companies, as well 
as the construction 
of new mobile 

Investment in the last 
mile of the optical 
network using the 
existing middle mile 
infrastructure. 

The private operator 
selected through 
the tender plans 
and ensures the 
availability of 
Internet services in 
the white areas of 
the VHCN. 

The competition can 
be organized 

Investments in the 
creation and 
expansion of the 
optical network 

                                                
126 https://www.swisscom.ch/en/about/news/2020/10/21-mehr-bandbreite-im-zug.html 
127 Analizējot scenāriju, kad ātrgaitas tīkls tiek veidots primāri vilcienu pasažieru vajadzībām 
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Parameters Scenario 1: 

Public Managed 
Network Model - 
Middle Mile 

Scenario 2: 

Public Managed 
Network Model - 
Last Mile 

Scenario 3: 

Privately managed 
network model 

Scenario 4: 

Operator 
subsidization 
model 

communication 
towers at the 
existing middle mile 
infrastructure. 

throughout the 
country, planning 
regions or 
municipalities. 

Competition 
condition - 
technologically 
neutral. 

Investment 
target area 

Middle mile Last mile Middle mile and / or 
last mile - choice of 
private operator 

Middle mile and 
last mile 

Owner of 
investments 
made 

State or public 
corporation 

Municipalities that 
lease the established 
infrastructure to an 
Internet service 
provider 

Private operator Private operator 

Technology Technology neutral 
solution 

Optical internet Technology neutral 
solution 

Optical internet 

Internet 
connection 
speed 

At least 100 Mbit/s 

The available 
speed depends on 
the number of 
simultaneous 
Internet users 

Up to 1 Gbit/s, at 
least 100Mbit/s. 

At least 100 Mbit/s - 
requirements are 
specified in the 
tender conditions. 

The proportion of 
time of day when at 
least the specified 
speed is available is 
defined. 

Up to 1 Gbit/s, at 
least 100Mbit/s. 

Evaluation of 
return on 
investment 
(calculations for 
20 years) 

-115.9 mln. EUR 

The return on 
investment 
depends on the 
location of mobile 
communication 
towers and the 
number of planned 
users in a particular 
area. 

The main 
beneficiaries will be 
households.  

-49.8 mln. EUR 

The return on 
investment depends 
on the selected 
objects for which the 
optical internet is 
installed. Socio-
economic forces will 
have the highest 
return on this type of 
investment. 

-667.7 mln. EUR 

The number of 
households that will 
have access to the 
Internet depends on 
the offer of the 
private operator, as 
well as on how 
many households 
do not have access 
to the Internet in the 
defined area. 

-865.5 mln. EUR 

The return on 
investment 
depends on the 
investment 
strategy in which 
the investments 
are made, and 
which are the 
primary recipients 
of Internet 
services, such as 
the main socio-
economic drivers. 

Territories White areas, 
including adjacent 
gray and black 
areas. 

VHCN White 
Territories 

VHCN White areas, 
including adjacent 
gray and black 
areas. 

VHCN White 
Territories 

Beneficiaries Population, 
businesses, state 
and local 
government 
institutions, socio-
economic drivers 

Population, 
businesses, state 
and local 
government 
institutions, socio-
economic drivers 

Population, 
businesses, state 
and local 
government 
institutions, socio-
economic drivers 

Population, 
businesses, state 
and local 
government 
institutions, socio-
economic drivers 
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Parameters Scenario 1: 

Public Managed 
Network Model - 
Middle Mile 

Scenario 2: 

Public Managed 
Network Model - 
Last Mile 

Scenario 3: 

Privately managed 
network model 

Scenario 4: 

Operator 
subsidization 
model 

Project 
implementer 

Public institution, 
such as LVRTC 

A public body, such 
as a municipality or 
planning region 

Private operator 
(selected through a 
tender) 

Private operator 
selected through a 
tender 

Involvement of 
local 
governments 

Municipalities 
provide the 
necessary support 
for the 
establishment of an 
optical network, 
land and permits for 
the construction of 
communication 
towers for new 
mobile operators. 

Municipalities 
provide the 
necessary support 
for the establishment 
of an optical network. 
The municipality 
rents out the built 
infrastructure 

The organization of 
the competition can 
be provided by the 
planning region or 
the municipality 

Municipalities 
provide the 
necessary support 
for the 
establishment of 
the optical 
network, including 
the coordination of 
permits and 
documents 

Source: Research done by PwC and CSE COE. 

 
In order to compare these support scenarios, it should be noted that they have different objectives - 
Scenario 1 addresses the issue of expanding the area where the VHCN network is available with an 
access speed of at least 30Mbps, while Scenarios 2 to 4 address the issue of improving the quality of 
the available VHCN network service, providing an access speed of at least 100Mbps. From this point 
of view, Scenario 1 is not comparable to Scenarios 2 to 4. 

The comparison of scenarios 2 to 4 considers the amount of investment per supposed user of the 
VHCN service and the territory in which the service is improved as a result of the investment. The 
calculation of the number of supposed users considers the outcome indicators of each scenario - 
households subscribing to broadband connections to a very high capacity network and companies 
subscribing to broadband connections to a very high capacity network. Besides, it is assumed that one 
company is 4 times more important than one household (considering the average monthly fee 
increases per household and one company assumed in the calculation of return on investment). 
Scenario comparison calculations are given in the table below. 

Table 16. Comparison of possible support scenarios 

Parameters Scenario 1: 

Public Managed 
Network Model - 
Middle Mile 

Scenario 2: 

Public Managed 
Network Model - 
Last Mile 

Scenario 3: 

Privately managed 
network model 

Scenario 4: 

Operator 
subsidization 
model 

VHCN Planned 
Internet Access 
Speed (Mbps) 

>30Mbps >100Mbps >100Mbps >100Mbps 

 Number of 
households 
subscribing to 
VHCN 

423832 360163 421498 361383 

Number of 
companies 
subscribing to 
VHCN 

89073 73513 93120 70724 

Supposed users 
(number) 

780122 654215 793978 644277 
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Parameters Scenario 1: 

Public Managed 
Network Model - 
Middle Mile 

Scenario 2: 

Public Managed 
Network Model - 
Last Mile 

Scenario 3: 

Privately managed 
network model 

Scenario 4: 

Operator 
subsidization 
model 

Total planned 
investments 
(mEUR) 

88.0 266.4 907.1 1030.7 

Investment per 
supposed user 
(EUR / user) 

113 407 1142 1600 

Area where the 
investment can 
lead to 
improvements 
(km2) 

12091 7513 58035 5078 

Final investment 
estimate (EUR / 
user / km2) 

0.01 0.05 0.02 0.32 

Source: Research done by PwC and CSE COE. 

 
Considering the different objectives of the scenarios in the planned Internet access speed of the VHCN, 
a practical comparison with each other is possible only for scenarios 2 to 4. Calculating the investment 
per 1 km2 per supposed user in these scenarios, it follows that the highest return on investment would 
be achieved by implementing scenario 3. 

 

6.10 Compliance of the proposed state financial aid scenarios 
with the EC framework 

This section analyzes the compatibility of the proposed state financial aid scenarios for broadband 
networks with the COMMISSION REGULATION (EC) No 794/2004 of 21 April 2004 implementing 
Council Regulation (EU) 2015/1589 laying down detailed rules for the application of Article 108 of the 
Treaty on the Functioning of the European Union128. This section analyses Supplementary Information 
Sheet on State aid to broadband in part III.5. 

Table 17. Compliance of the aid scenarios with the EC framework 

Compatibility criteria Description 

The need for state 
intervention, the solution of a 
situation in which the aid can 
provide a significant 
improvement that the market 
itself would not be able to 
provide (p. 1.1.) 

The need for state intervention raises from the fact that in the VHCN white 
areas (internet access below 100 Mbit/s), where state intervention is 
planned under this scenario, the population density is not high enough for 
businesses to make the necessary investments without the state support 
and ensure the return on the investment. 

According to the results of the survey of operators (internet service 
providers) as of September 2020, no investments and provision of 
services in the white territory are planned, thus the market itself does not 
ensure the necessary internet availability. 

Public intervention in the provision of broadband infrastructure will have a 
positive external impact, enabling businesses to provide services to end-
users. 

According to population density savings, broadband deployment is 
generally more cost-effective where the potential demand is higher and 
more concentrated, i.e. in densely populated areas. Due to the high fixed 

                                                
128 Available: https://eur-lex.europa.eu/legal-content/EN/TXT/HTML/?uri=CELEX:02004R0794-20151230&from=EN  

https://eur-lex.europa.eu/legal-content/EN/TXT/HTML/?uri=CELEX:02004R0794-20151230&from=EN
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Compatibility criteria Description 

investment costs, the unit cost increases significantly as the population 
density decreases. As a result, commercial broadband networks are only 
cost-effective for a fraction of the population. 

 

Investments are planned in the white areas of VHCN because 
according to the results of the survey, no investments and provision 
of services are planned, thus the market itself does not provide 
effective results from the public point of view. 

An appropriate instrument to 
pursue an objective of 
common interest. Aid is not 
considered compatible if less 
distortive measures would 
achieve the same positive 
result (p. 1.2). 

The solution is technology-neutral, and investments are made in public 
infrastructure that will be owned by the state, but the state will not provide 
end-to-end services to customers. The established infrastructure will be 
available to all interested operators without restrictions; therefore, the 
proposed solution does not affect competition. The proposed intervention 
is proportionate as the investment is offered at the middle mile that can be 
used by all operators. At the same time, we note that less market-
distorting state aid measures are not identifiable. 

Why is the aid granted 
proportionate, insofar as it 
meets the minimum 
necessary to encourage the 
investment or activities 
concerned (p.1.3) 

The planned support is proportionate as it provides the minimum 
necessary investment in infrastructure (construction of optical networks 
and construction of communication towers for mobile base stations) to 
allow operators to offer last mile Internet access services via mobile 4G 
and 5G networks or fixed connections. 
 
The necessary publicity will be provided for the main features of the event 
and the list of target areas (for example, on the website of the Ministry of 
Transport) by publishing relevant information about the project and 
welcoming comments. Prior to the organization of publicity events, the 
level of detail in which cartographic material may be published without 
disclosing operator’s confidential business information will be assessed. 
 
The aid will be granted to a public limited company, as the state will 
provide the necessary investments. During the implementation of the 
investment project, the applicants will be selected through a tender 
procedure. The selection criteria for the tender procedure will be the most 
economically advantageous tender. 
 
Ensuring access to the constructed infrastructure for all operators ensures 
technological neutrality, as well as the construction of communication 
towers at the existing infrastructure, ensures the use of the existing 
infrastructure. 

Please present the rationale 
for public intervention and 
explain the anticipated 
benefits of the aid measure 
(e.g. economic and social 
benefits, increased 
broadband coverage and 
internet penetration rates, 
etc.) (pp. 1.3). 

Affordable broadband access will have positive external effect by 
accelerating growth and innovation in all sectors of the economy. 
The rationale for state intervention is the fact that the market does not 
provide sufficient broadband coverage in areas with a relatively low 
population density. 
 
The main benefits for the inhabitants of these areas will be access to a 
broadband network for communication and access to information and 
cultural resources, services provided by the state and municipalities, as 
well as the opportunity to work remotely, thus providing employment 
opportunities in emergencies and saving time to work. 
 
The planned investments can have a positive impact and economic 
incentives for entrepreneurship in the white areas, providing employees 
with the opportunity to work remotely. Internet access ensures the 
availability of online services. 
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Compatibility criteria Description 

What is the scope of the aid 
measure in terms of territorial 
coverage? (pp. 2.1.) 

VHCN white areas are shown on the attached map. VHCN white areas 
are defined where the Internet access speed is lower than 100 Mbit/s. 
They make up 98.4% of the entire territory of Latvia. It is also possible to 
improve the availability of Internet services in certain gray and black 
areas. 

The investments are planned mainly to ensure access for the 
population who will live in the white areas of the VHCN in 2027. 

Please provide information, 
including the date, and 
submit the results of the 
detailed mapping and 
coverage analysis 
undertaken to clearly identify 
the target areas (pp. 2.2.). 

Detailed mapping and coverage analysis were performed within this 
project and described in Section 5. 

Please explain what type of 
‘wholesale access’ 
obligations will be imposed 
on the subsidised network 
(including access to passive 
and active infrastructure, the 
right to use ducts and poles, 
dark fibre and street 
cabinets), and how long the 
access obligations will be 
maintained (pp. 2.12.) 

The State will assume wholesale access obligations to the established 
subsidized network, access to the passive and active infrastructure of the 
optical network, the right to use cable ducts and poles, fiber optic and 
outdoor distribution cabinets, as well as the construction of mobile base 
stations of the built towers. 
 
Such wholesale access will enable operators to compete at retail level, 
thus increasing choice and fostering competition in the areas covered by 
the measure, while preventing the creation of regional service monopolies. 
 
The aid will provide wholesale access to the subsidized infrastructure to 
all economic operators for at least seven years. After a period of seven 
years, given the possible development of 5G, the infrastructure set up 
may not have the same impact on the market. 

  

Please explain how access 
prices will be benchmarked 
(pp. 2.13.) 

Wholesale reference prices for access to the established infrastructure will 
be determined based on the maintenance costs of the established 
infrastructure. Also, the prices will be compared with the prices already set 
for the services provided by LVRTC. To ensure effective access, the same 
access conditions will apply to all subsidized infrastructure, including parts 
of it that use existing infrastructure. 

Benchmarking of wholesale prices will be an important tool to ensure that 
the aid granted creates the same market conditions as in other highly 
competitive broadband markets. 

Retail broadband prices in the country in the context of market failures are 
analyzed in section 6.1 of the report. 

As, according to this analysis, retail prices for broadband services in 
the country are currently effectively determined by the market, we 
anticipate that the establishment of reference prices in retail will not 
be necessary. 

Please explain how the 
monitoring of the aid 
measure will be organized - 
What aspects of the measure 
will be subject to monitoring? 
(pp. 2.16.) 

The awarding authorities will monitor all broadband project implementation 
activities throughout the project, considering that the actual development 
of the project's profitability needs to be monitored more closely than in 
cases where the infrastructure manager has been selected through a 
procurement procedure. 

Please explain how the 
monitoring of the aid 
measure will be organized - 

The monitoring schedule will depend on the planned project activities and 
will include monitoring of the selection of specific mobile towers, as mobile 
operators may invest in mobile towers until the project is approved. 
Monitoring will also cover procurement procedures leading to the selection 
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Compatibility criteria Description 

What will be the timing of the 
monitoring? (pp. 2.16.) 

of contractors to implement the project. The results of the project will be 
monitored for at least 5 years after the completion of the project. 

The implementation of the project will be monitored by the Ministry 
of Transport and the Optical Network Monitoring Committee. 

Please describe the role of 
the NRA in particular 
regarding identification of 
target areas, wholesale 
access pricing including 
benchmarking, dispute 
resolution, etc. (pp. 2.17.) 

Tariffs and conditions for the provision of wholesale services will be 
determined by the Ministry of Transport in cooperation with the Optical 
Network Monitoring Committee and coordination with PUC. The Ministry 
of Transport will develop draft wholesale network access conditions and 
coordinate it with PUC. 

The setting of reference prices in wholesale and retail trade is 
described above (pp. 2.13). 

Is the aid measure aimed to 
address well-defined 
objectives of common 
interest? (pp. 3 - a) 

The aid measure aims to achieve the clearly defined general interest 
objectives set out in the European Interoperability Framework - Internet 
access speeds of at least 100 Mbps - for households, businesses, and 
socio-economic drivers. 

Does the aid measure 
address a market failure or 
important inequalities 
hampering the availability of 
broadband services? (pp. 3 - 
c) 

The aid measure addresses a market failure that hinders the availability of 
broadband network services - insufficient interest of market employees 
due to high investments and relatively low profits, as there are relatively 
few potential new customers in the areas where the network will be 
deployed. 

Please demonstrate the 
appropriateness of the aid 
measure. (pp. 3. - e) 

There are large areas in the country where VHCN infrastructure is not 
available. The planned measures are suitable for solving this problem, as 
they provide for state support for the establishment of VHCN 
infrastructure. 

Other support measures, such as demand stimulation, could work if such 
infrastructure were set up but not available due to price. 

Please describe the positive 
effects that the aid measure 
is expected to generate, incl. 
whether and to what extent 
significant new investment in 
the broadband network will 
be undertaken and what new 
capabilities will be brought to 
the market in terms of 
broadband service availability 
and quality. (pp. 3. - j) 

The implementation of the planned state aid measures would create a 
broadband network infrastructure that ensures the availability of VHCN 
networks (optical or 5G mobile networks) to end-users (scenarios 2, 3, 
and 4) or provides the infrastructure for the establishment of mobile 
networks in areas where their coverage is currently insufficient (scenarios 
1, 5 and 6). 

According to the proposed scenarios, the availability of broadband 
network services would be ensured for socio-economic drivers, 
businesses, and citizens, which will provide socio-economic benefits 
for all involved groups. 

Please explain the expected 
changes in the behaviour of 
the beneficiary(s) of the aid 
measure. (pp. 3. - m) 

As state aid will provide infrastructure accessible to all market players, it is 
expected that businesses will start offering services in areas where it is 
not currently beneficial for them. In such areas, where the technical 
infrastructure will be established, smaller companies will also be provided 
with opportunities to enter the market. 

If the planned investments are not made, then no changes in the 
behavior of the beneficiaries are expected and broadband Internet 
will not be available in certain areas of Latvia. 

Please demonstrate that 
similar broadband network 
investment would not have 
been undertaken within the 

The calculations of the required investments and their return for the 
proposed state aid scenarios (see sections 6.3 - 6.8 and the 
corresponding annexes) show that the measures planned without state 
aid are not possible. 
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Compatibility criteria Description 

same time frame and/or 
under the same terms and 
conditions in the absence of 
State aid. (pp. 3. - n) 

Please explain how it is 
ensured that the aid measure 
is limited to the minimum 
necessary. (pp. 3. - o) 

The calculations of the required investments (see Sections 6.3 - 6.8 and 
the corresponding appendices) specifically show the insufficient 
investment in monetary terms. The aid measures will not exceed these 
calculated values. 

Potential negative effects on 
competition and trade and 
specifications to what extent 
the positive effects outweigh 
it (p. 3. - p). 

The extent of the distortions of competition can be assessed in terms of 
the impact on competitors, but in the proposed scenario the beneficiary 
does not provide services to the final beneficiaries but to all interested 
operators, thus leaving no operator in a dominant position and having 
equal opportunities. 
 
The aid will be granted transparently, as it will invest in infrastructure that 
can be used by all service providers. It will be ensured that the Member 
States, economic operators, the public, and the Commission have easy 
access to all relevant documents and relevant information on the aid 
granted. 

Source: Research done by PwC and CSE COE. 

 


